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1  Introduction

WELCOME to form•Z.  This Tutorial complements the other volumes that comprise the form•Z
User’s Manual  (abbreviated UM when references are made to them).  The UM volumes cover
each tool, menu item, dialog, and palette of form•Z in complete detail.

The presentations in this Tutorial are based on examples.  Step by step instructions are given
about how to execute a task.  Explanations are also provided about how an operation works.
When necessary, more extensive paragraphs are inserted that elaborate on a feature.

This Tutorial is intended to be read in the order in which it is written.  It is broken into a number
of sessions or chapters, which are both sequential and independent.  You can quit at the end of
any session and continue with the next later or on another day.  Each session starts where the
previous left off.  Each tutorial session has a topic which is reflected in its title.  At the same time,
each session is also complete as a set of instructions telling you how to perform certain tasks.
These tasks may require the execution of support operations which are not part of the main topic.
Where necessary or useful, a digression is introduced to discuss these supporting operations.

At the beginning, the instructions provided are more complete than in later sessions.  We start
by being as explicit as possible.  When a tool needs to be selected, both the name of the operation
and the tool’s image are shown.  When an object is to be drawn, the exact dimensions are given
as well as its location on the screen.  As you build experience and confidence, the instructions
become less detailed.  Processes that have already been discussed once are not explicitly
described again.  When objects need to be generated and their exact dimensions are not critical,
we suggest that you draw them roughly as shown in our examples.

All the sessions assume the default setup for the system parameters.  form•Z offers you the ability
to save your own defaults and tell the system to apply them when you start up.  However, we ask
you not to do this until you have a sufficient understanding of how the different parameters affect
the performance of the operations.  We also ask you to relaunch form•Z at the beginning of each
session.  This gives us a common base and guarantees system responses consistent with those
we describe.  In each session, only a few of the parameters affect the operations that you may
be executing.  However, if any of these parameters are accidentally or intentionally changed, the
outcome may be different from what we say it should be.  If you get results which differ from what
we describe, and you cannot tell what is causing the difference, relaunch the system and start
again at the beginning of the session.
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1.1  What is covered in this Tutorial

This volume consists of 44 chapters, to be referred to as tutorial sessions.  It begins with an
introductory discussion of the interface of form•Z and the features available to you.  This includes
a presentation of the Help environment, how to use it to turn tools on and off, and how to set up
your own preferences for system defaults.

Next, the workings of the modeling tools are presented in the order in which they appear in the
default tool bar.  You are initially asked to turn most of the tool icons off.  Then, at the beginning
of each session, you are instructed to reactivate the tools that you will be using in that particular
session.  By the time you reach chapter 30, most of your icons will have gradually been turned
on.  At this point you are instructed to turn them all on, by returning to the default tool bar settings.
Note that turning tools off is one of the customization procedures.  In form•Z the tool bars are
completely customizeable, and when you become an experienced user, your tool bar will
probably be quite different from the one we shipped.  However, to do this tutorial we need a
constant base.  As such we use the default tool bars which are shipped with form•Z.  Any
references to columns and rows are to the default tool bar.

The tool bars have been structured in manners that follow the sequence in which entities
(modeling objects and drafting elements) are expected to be created.  Consequently, following
the structure of the modeling tool palette results in a gradual presentation of the features of the
program.  There are only a few exceptions to the sequential presentation of the material.  For
example, even though the insertions are controlled by icons in the very first row of the tool bar,
they are discussed toward the end.  This is simply because their execution requires an
understanding of features that are presented later in the Tutorial.  Another deviation relates to the
geometric transformations (move, rotate, resize, and mirror).  They are discussed earlier than
their order in the tool bar.

After the modeling tools and operations have been presented, two sessions are dedicated to
drafting tools.  One covers the creation of drafting images by working exclusively in the drafting
environment, and the other outlines the process of transporting images from the modeling
environment, which are then refined in drafting.

This Tutorial may be thought of as consisting of two parts.  The first part, which is significantly
longer, consists of sessions that are dedicated to the workings of individual or related groups of
tools, and most of the examples are as simple as possible.  The second part starts with chapter
35, which consists of sessions that are dedicated to specific modeling tasks, rather than to specific
operations.  These sessions mix a variety of tools, as needed for the completion of specific
modeling tasks.

Even though the vast majority of the form•Z features are covered in this Tutorial, a few have been
left out.  However, even the features that are included in the Tutorial are not necessarily covered
in full.  Consequently, the other volumes of the UM should be consulted for complete descriptions
of the form•Z features.
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1.2  The different versions of form•Z

form•Z runs under both the Macintosh and the Windows operating systems. For each of these
platforms there are three versions:  form•Z, form•Z RenderZone, and form•Z RadioZity.

form•Z is the regular version of the application that contains the full set of modeling and drafting
features, but limited rendering. form•Z RenderZone contains all the features of the regular
version of form•Z and, in addition, photorealistic rendering, including raytracing and all the
advanced rendering effects, such as reflections, refractions, bumps, background and fore-
ground effects, both procedural and precaptured textures, five methods of texture mapping,
decals, different types of light, and more rendering features. form•Z RadioZity has all the
advanced rendering of RenderZone and, in addition, radiosity based rendering procedures that
achieve accurate simulations of lights and their effects.

This Tutorial does not cover the advanced rendering of form•Z RenderZone and RadioZity,
whose features are discussed in the respective User's Manual.  It covers the most significant
modeling and drafting features for all versions of form•Z on both platforms.  form•Z is one and the
same program in all versions and on both platforms.  form•Z RenderZone and RadioZity simply
add the advanced rendering modules to the standard features of form•Z.  This results in a few
differences. The most notable difference is that the RenderZone* item appears dimmed in the
Display menu of the regular version of form•Z, and the four RadioZity items are missing.

form•Z is also one and the same application on both the Macintosh and Windows platforms.  All
the tools that execute modeling and drafting operations behave in exactly the same manner.  The
interface of these tools is also the same on both platforms, but there are a few exceptions that
are due to differences inherent in the two operating systems.  Following are the most significant
differences, which are also pointed out throughout this Tutorial.

• The Macintosh has one or two extra menus.  MacOS 9 has the Apple menu ( ) and OS X
also has the form•Z Application menu, of which there are no equivalent on Windows.  The
About form•Z item is under the Apple menu on MacOS 9, under the Application menu on OS
X, and appears at the bottom of the Options menu in the Windows versions.

• There is no option key on Windows keyboards, and a combination of ctrl+shift is used as
an equivalent.  This is important to remember since these keys are used to invoke the dialogs
of menu items and optionally of the tools.  The dialogs of the tools can also be invoked by double
clicking on their icon, on both platforms.  In addition, the content of the dialogs is also displayed
in the tool options palette, whose default position is to the right of the project window.  These
palettes are context sensitive and display the options of a tool as soon as the tool is selected.

• Other keys that perform the same operations but are labeled differently on the two platforms
are:  return on the Macintosh is enter on Windows;  delete on the Macintosh is backspace on
Windows.
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• The cancel command on the Macintosh is command+period, while on Windows it is
ctrl+period.  On both platforms, the esc key can also be used to cancel an operation.

• On Windows, there is no support for a graphic keyboard layout; consequently, Keyboard
Help presents the key command equivalents only in text list format.

• While most of the over twenty file formats are available on both platforms, a few are only on
the Macintosh or only on Windows.  For example, PICT is available only on the Macintosh; BMP
and Metafile are available only on Windows.

• A few dialogs are strongly linked to the operating system and are significantly different in
each platform.  These are: Color Picker, Folder/Directory Selector, File Save, and File Open.

• The file signatures are recognized differently in each platform.

• There are a few differences in the way windows are resized and manipulated under each
operating system.

1.3  The style of this Tutorial

The tutorial sessions in this volume have been structured as sets of instructions that you follow.
There is typically an introductory paragraph that tells you what you will be doing.  Then the
instructions are presented in an outline form, one step at a time.  When you need to select or use
a tool, the icon of that tool is shown at the very beginning of the line.  All other instructions start
with a bullet.

As in the remaining volumes of the form•Z User’s Manual, the names of menus, menu items,
dialogs, and dialog options are shown in the Chicago font.  This is the font which used to appear
in earlier Macintosh versions of the program.  It also works well for highlighting these items when
running the program on Windows.  That is, even though this font is not used anymore (not even
in Macintosh), its bold appearance works well for highlighting names of options and other
features.

The result of an instruction or what to look for is printed in italics.  Bold italics are used for
emphasis or for the introduction of new terms.  Explanatory notes that are not absolutely necessary to read

appear in a smaller font.  Since all of them are rather short, we recommend that you read them.



5form•Z Tutorial  •  Introduction

1.4  Launching form•Z

Before you proceed with this Tutorial you should, of course, install the program properly.  Please,
carefully follow the installation instructions shipped with the product.

If you are a newcomer to the world of the Macintosh or Windows, here is how you start form•Z
in each of these platforms:

Macintosh:  Double click on its application icon. The system will start by presenting its
introductory screen.  Click anywhere on the screen.  Assuming the default system setup, form•Z
will respond by opening a new project and a new modeling window titled Untitled1 - 1
(Model).  When this happens, you are ready to proceed with your tutorial session.   After you
have saved a project document, you will also be able to launch the program by double clicking
on the document icon in the standard Macintosh manner.

Windows:  You can launch the program from the file manager by double clicking on the form•Z
executable.  Or you can launch it from the program manager by opening the form•Z program
group and clicking on the form•Z icon.  As on the Macintosh, the program will first present an
introductory screen.  Click on it to proceed.  As soon as the program opens a window, which is
a modeling window if the default preferences are used, you are ready to proceed with your tutorial
session.

Whether you are running on a Macintosh or on Windows, if you are new to it, we strongly
recommend that you first familiarize yourself with the procedures of your computer and its
operating system by reading its manual.  This Tutorial does not cover such procedures.
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2  The interface

You have just launched form•Z.  If you are running a Macintosh your screen looks like this:
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If you are running form•Z for Windows your screen looks like this:

If you feel there are too many features on the screen, do not worry.  You will soon turn some of
them off and only keep the ones you need for the initial exercises.  As you progress you will
gradually turn features back on, as you need them.  Before you start the exercises, we shall give
you some idea of what everything is, even though you probably recognize most of them. We shall
also tell you a few more things about the differences you see in the previous two images.
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2.1  Screen features

Menu bar:  This is at the top of the screen and consists of nine menus, except that the
Macintosh version has one additional menu, the Apple menu ( ).  The menus contain items or
commands, such as Open..., Paste, Wire Frame*, etc. These are selected in the standard
manner.

Macintosh:  Point the mouse to the title of the menu, press the button, drag the mouse to the item you wish
to select, and release the button when the item is highlighted.

Windows:  Click the mouse on the title of the menu, then click on the item you wish to select.  On Windows
you can also go to the first menu by pressing the alt key and then use the arrow keys to either move to the next
menu, or to move down the menu to select the item you desire.  When the item is highlighted you can also select
it with the enter key.

When a menu item ends with three dots (...), it invokes a dialog box when you select it.  Items with no such
dots execute an operation immediately.   When there is an arrow next to an item, it pulls out a submenu from
which the desired command is selected. When a menu item ends with an asterisk(*), it also executes an
operation when you select it. The asterisk signifies that there is a dialog box associated with this item. You can
invoke this dialog by pressing the option key on the Macintosh or ctrl+shift on Windows, while clicking on the
item with the asterisk.

Tool bar (or iconic menu):  This is at the left edge of the screen, arranged vertically.  By
default it consists of two columns, and it contains fifteen rows of tools in modeling and thirteen
in drafting.  Most of these pop out when you click the mouse on them.

To select the icon of a tool, press the mouse on its row to pop it out, drag it to the tool you wish to select, and
release the mouse button when the icon is highlighted.  The icons in the tool bar have an arrow mark (small
triangle) at the upper right corner of an icon, which signifies that the row can be pulled out.  When this arrow
mark is red (or white on a teal background), it signifies that there is a dialog for this icon.  When it is black, there
is no dialog.  When the icons are pulled out, they may have a red bullet (•), which signifies that there is a dialog
associated with the icon.  If there is no bullet, there is no dialog.  The dialog contains optional parameters which
affect the execution of the tool. You can invoke this dialog by double clicking on the tool.  However, the content
of the dialog is also displayed in the tool options palette as soon as the tool is selected:

Tear off palettes:  If you drag the mouse beyond the end of the popped out row of tools, that
row is torn off and becomes a free standing tool palette.

Both the complete tool bar and the torn off palettes can be positioned anywhere on the screen (press the mouse
on their title bars and drag them to the desired position).  Their orientations can also be changed.  On the
Macintosh this is done by clicking on the orientation box, found on the palette.  On Windows it is done through
the Change Orientation menu item.  The torn off palettes can be closed by clicking on their close box (upper
left corner on the Macintosh or upper right corner on Windows).  The torn off palettes can also be collapsed
using the collapse box on the Macintosh or the Collapse menu item on Windows.  When palettes are
collapsed, only their title bar is displayed.  For more details on how these operations are executed please
consult the manuals of the respective operating systems.
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The tools are color coded:

Operators:  These are the tools shown on white background.  When they are executed, they
typically  cause a visible effect on what is currently shown on the screen.  The operators are
mutually exclusive.  When a new one is selected, the previously active operator is deselected.

Modifiers:  These are the tools with teal (turquoise) and magenta background.  They
determine the behavior of the operators.  On each of the modifier rows only one modifier is active.

Graphics window:  This is the area where all the objects are drawn and where you see your
objects as they are generated and manipulated.  It occupies most of the central portion of the
screen.  The windows on the Macintosh and Windows operating systems contain the features that
are standard on each of these platforms.

Window tool palette (  ):  This consists of the small icons
on the left of the bottom border of a window.  These icons affect the graphics environment of the
window.

Memory box (  ):  This is located to the right of the Window tool palette.  It displays
information about the computer memory currently available to your session.

Zoom percentage (  ):  This is a pop up menu next to the memory box.  It both

displays the Zoom percentage of the current view and allows the selection of another percentage,
which effectively applies a zoom in or out operation.

Reference grid:  This is displayed in the middle of the graphics window together with the
orthogonal axes, labeled +x, -x, +y, -y, +z, and -z, of the Cartesian coordinate system.   The grid
is on the currently active reference plane, which is where you will be drawing, shortly.

Light:  This is displayed as a 3D entity in the graphics window, at the position it has.  The
distant lights (which include the sun) are represented with arrows.  The other types of lights that
are available in RenderZone and RadioZity are represented with other appropriate graphics.
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Palettes:  There are nineteen palettes in modeling and sixteen in drafting.  Quite a few but
not all of these open by default when you launch form•Z.  To the right of the window, top to bottom,
are the Tool Options, Lights, Objects, Layers, and Views palettes.  Under the window are
Prompts  and Animation palettes.  At the upper left corner is the Surface Styles palette and in
the upper right is the Coordinates palette.  You can see the complete list of palettes  by clicking
on the Palettes menu. You notice that the palettes that are already open have a check mark
in front of their names.  You open or close a palette by selecting its name in the Palettes menu.

The palettes are essentially small windows and typically carry most of the features of a window, such as resize
box, scrolling arrows, close box, etc.  However, the exact window features they carry depend on their function.
They also have hide boxes, which can be used to collapse them, and a few of them have orientation boxes,
which can be used to change their orientation.

The names of the palettes should give you some idea of what each is used for.  Except for the
Prompts and the Surface Styles palettes, it will be a while before you use any of the others.  In
spite of this we shall leave them open, and maybe you can start observing what changes occur
in them as you do the tutorial exercises.  On the other hand, if you wish to close them and free
some of the screen real estate, it will be fine, too.

If you close the Lights palette, you probably want to turn off the light that shows up on the screen
beforehand.  This is the arrow that is displayed somewhere on the reference grid.  In your Lights
palette, you read the default name Light 1.  Click twice on the diamond ( ) displayed in the first
column to the right of the name.  You notice that the image of the light on your screen becomes
gray with the first click and disappears with the second click.   Your light is now invisible. Now
you may click on the close box of your Lights palette to close it.



11form•Z Tutorial  •  The interface

•  View: These are used to manipulate 3D views of models.  One of
them (Set View) is also available in drafting, where it is of a 2D
character (see UM section 2.2.8).

•   Zoom:  These are used to zoom in or out and to pan.  Most are affected
by selections in the Zoom Options dialog that can be invoked from them
(see UM section 2.2.7).

•  Object Snap:  When selected, snapping to a part of an object occurs.  Default
is None.  They are affected by the Object Snaps Options dialog invoked
from them (see UM section 2.2.6).

•  Directional Snap:  When one of these tools is on, directional snapping occurs.
Default is None.  These tools are affected by the Angle Snap Options and
Radial Snap Options dialogs, invoked from them (see UM section 2.2.5).

•  Grid Snap Switch:  Clicking on this icon toggles the snapping action on and off.  When
on, graphic input is rounded to the closest increment of a module that is set in the Grid
Snap Options dialog, invoked from it (see UM section 2.2.4).

•  Reference Planes:  These tools are used to define, manipulate, or reset reference
planes.  They are complemented by the Set Reference tools (see below), which are used
to switch reference planes (see UM section 2.2.3).

•  Perpendicular Switch:  Clicking on this switch toggles it on and off.  When on, movement
is locked to a direction perpendicular to the reference plane (see UM section 2.2.2).  It is
available only in modeling.

2.2 The window tool palette

The window tool palette consists of eight icons.

• From left to right, click on each one of them.

When you clicked on them a tool palette popped out from all of
them except the second and the fourth.  When you clicked on
these two, their color was reversed to indicate that they were
selected.  All the icons can be torn off by dragging the mouse
beyond their top end.  Note that the pop out icons are larger than
those on the window.

Here we shall give you a summary of what each group of
window tools does.  They are discussed in detail in the User’s
Manual (UM).

•  Set Reference:  These tools are used to select the reference plane to which graphic input is
mapped.  The reference grid displayed is affected by parameters set in the Window Setup dialog
invoked from these tools (see UM section 2.2.1).  Not available in drafting.



12 form•Z Tutorial  •  The interface

2.3  Viewing and zooming

In form•Z, 3D models can be viewed in axonometric, isometric, oblique, or perspective from a
variety of view points.  Axonometric or perspective views, can be set as follows:

•Preset 3D views and 2D projections views can be selected from the View menu.
•Views can be defined by numeric input through the Set View Parameters... item.
•Views can be graphically set with the Set View, Navigate View, and Walkthrough window tools.
•Perspective views can be extracted from background images with the Match View tool.
•Views can be more accurately manipulated in the Cone of Vision environment.

Axonometric images are derived by projecting a 3D model on the screen, without adjusting the lengths of lines due
to depth.  Perspective images converge to a vanishing point and simulate the effects of depth and varying distances.

Isometric and oblique views are not "natural" but constructed views that do not correspond to real world views. They
are artificial views, useful for enhancing the readability of physical structures, most notably buildings.  Most methods
for manipulating views are also available for isometric and oblique views, but in a restricted manner.

For the first part of this tutorial, the only way you will change views is by selecting preset views built into the View
menu.  Additional methods, including saving your own views, are discussed in chapter 31 of this Tutorial.

Displays are also manipulated by zooming in and out, which is executed with window tools.

There are three methods for zooming:

  Zoom In/Out about Point:  When you select this tool and you click in the window, the

image in the window is zoomed by placing the click point at the center of the window.  It is zoomed
in when a plus sign is displayed on the tool icon.  It is zoomed out when a minus sign is displayed,
which is when you press option (Macintosh) or ctrl+shft (Windows).  The zoom percentage is
set in the Zoom Options dialog that can be invoked from the tool.

  Incremental Zoom In and Out:  Each time you select one of these tools a preset

scaling factor is applied to the display.  The scaling factor is the same for Zoom about Point and
is set in the Zoom Options dialog.

  Zoom In and Out by Frame:  When you select one of these tools you also outline

the area that will be zoomed in or out.  To outline the zoom area, click and drag the mouse from
center to perimeter or from one corner of the frame to the other, depending on the option selected
in the Zoom Options dialog.

The Zoom In/Out about Point and by Frame tools, as well as the other window tools that require
graphic input (Hand, Set View, and Walkthrough), can be executed in either one of two interface
methods.  Which method is applied is controlled by the Continuous Window Tool Control
option selected from the Project: General group of the Preferences dialog invoked from
the Edit menu (see subsection 3.2.6).
When Continuous Window Tool Control is on, which is the default, and one of these tools is selected, all the other
tools are grayed out and exclusive control is designated to the selected tool.  This way the operation can be applied
continuously without having to reselect the tool.  You exit this mode by selecting another tool.  When the option is not on,
one operation is executed each time the tool is selected, and the tool must be reselected for each subsequent operation.
You may want to try the two methods and observe how they behave.  These tools can be used even with no objects
displayed on the screen.
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2.4  The Prompts palette

As we have already seen, the Prompts palette is displayed on the screen at its default position,
which is in the lower left corner under the graphics window.  If for some reason it is not displayed,
invoke it again by selecting: Prompts from the Palettes menu.

The Prompts palette serves three purposes:

• It tells you which tool is active and what to do next.

• It displays the numeric values of the parameters that correspond to the graphic input you
enter with the mouse.

• It allows you to enter numeric values directly in its field, and to execute operations
through numeric input.

At the very beginning, assuming you are using the default preferences, the Pick tool is active and
its name appears in the Prompts palette.  It changes to another name as soon as another tool is
selected.

We recommend that you keep the Prompts palette open and observe the instructions it displays
as we tell you how to execute the examples.  In section 3.11 you will also use it to draw by typing
numbers on the keyboard.

The Prompts palette has most of the characteristics of a window.  It can be resized by dragging
its resize box,  its content can be scrolled from the scroll bar, it can be closed from the close box,
and it can be repositioned by clicking on its title bar and dragging it to the desired position.  It does
not have an orientation box and its orientation cannot be changed.  It can be collapsed.
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2.5  The Colors and Surface Styles palettes and dialogs

When you launch form•Z, the Surface Styles palette  is displayed at the upper left corner of your
screen, assuming the modeling environment is active.  If you switch to the drafting environment
then the Colors palette is displayed instead.  We have not told you yet how to open a drafting
window, which we shall do later in this Tutorial.  Until then, you can take our word about the palette.

The Colors and Surface Styles palettes perform very similar functions.  They carry color
definitions and display the colors that can be assigned to drafting elements or modeling objects.
In modeling these colors are called surface styles because their definition can carry a variety of
additional rendering effects, such as texture maps, reflections, transparencies, bumps, etc.,
when you are running form•Z RenderZone.  In this Tutorial, whose emphasis is on modeling
operations and color plays a very small role, the surface styles will be used for plain colors only.
The operations that can be applied to the Colors and Surface Styles palettes are very similar but
not identical.  They are summarized below.

Colors palette

The Colors palette consists of sixteen boxes, each containing a different color.  More colors can
be added.  The upper left box is highlighted.  This is the default active color.  You make another
box the active color by clicking on it.  The active color will automatically be assigned to the
elements you create.

You can resize the Colors palette by dragging its resize box, as with
any window.  It also has a close box for closing it, it can be collapsed,
and it can be repositioned on the screen.  At its lower left end, there
are three icons that allow you to switch to one of three formats
available for displaying the colors: large image, small image (default),
and name list.

•Double clicking on a color box invokes a Color Editor dialog
where the name and definition of the color can be changed.  To
change the color click on the color box.  This invokes the Color
Picker dialog where the color can be changed in the usual
manner.

Following are the most significant color operations you can execute from the Colors palette:

•Clicking on a color box makes it the active color.

•Clicking anywhere in the Colors palette while you press the option key on a Macintosh or
ctrl+shft  on Windows invokes the Colors dialog.  You can execute a variety of operations

through buttons in this dialog, such as adding new colors.  These are discussed in UM section
2.6.
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Surface Styles palette

Contrary to the Colors palette where colors are displayed on flat
squares, the Surface Styles palette displays the colors on 3D
forms, which are cubes by default but can be changed to
spheres, cylinders, or flat surfaces positioned in 3D space. This
way the rendering effects that may be contained in a surface
style can be displayed better.  At the lower left end of the
Surface Styles palette there are three icons similar to those
found in the Colors palette.  They allow you to switch to one of
three formats available for displaying the surface styles.

Following are the most significant operations you can execute
from the Surface Styles palette.

• Clicking on a surface style box makes it the active surface style.

• Double clicking on a surface style box invokes the Surface Style Parameters dialog.

This dialog contains many options for
defining surface styles, but they will
not concern us in this Tutorial.  You
can read about them in the form•Z
RenderZone User's Manual.  Here
we shall be only concerned about
changing the basic color of a surface
style.  Towards the top of the dialog
there is an area labeled Color.  It
displays the words Plain Color and
to its right there is an Options...
button.  Clicking on it invokes a Color
Picker dialog where a color can be
selected as for the Colors palette.

•Clicking anywhere in the Surface Styles palette while you press the option key on a Macintosh
or ctrl+shft  on Windows invokes the Surface Styles dialog.  You can execute a variety of
operations through buttons in this dialog, such as adding new colors, as discussed in UM section 2.6.

It may appear to you that the discussion of the colors and surface styles here is premature, since we do not yet have any
objects to color.  However, we thought we should explain all the features displayed on your screen, and tell you where
the colors come from.  You will soon be creating objects.  These objects will receive their color from the active color
selected in the Surface Styles palette.  In chapter 30  of this Tutorial we will tell you how to change the colors of your objects.
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2.6   Getting help

You will next learn how to invoke the Help environment and how to access summary information
about what the menu items and tools of the program do.

The last name on the menu bar is labeled Help.  Pressing the mouse on it unfolds its menu items
as shown to the right, for both the Macintosh and Windows.

Note that the Windows Help menu has one more item at its end, About form•Z.... On the
Macintosh, this item is in the Apple menu.

You can access the different sections of
the Help environment either by selecting
General..., which invokes the dialog
shown to the right, or by directly clicking on
the following items:

Introduction...
Keyboard...
Menus...
Modeling Tools...
Drafting Tools...
Window Tools...

Clicking on any of these items invokes
another dialog from which you can access
information about the specific area of the
program.  You will go to the modeling tools.
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    • Click on Modeling Tools....

This invokes the Modeling Tools dialog,
shown to the right for both the Macintosh
and Windows.  It contains two boxed ar-
eas.  The top displays all the tool palettes
and has a scroll bar to scroll up or down.
The lower box is where information about
what each tool does is displayed.  Move
the mouse around the icons and note how
the text changes.  The text gives you
information about the tool whose icon is
pointed at and highlighted.

Selection of the other items work in a very
similar fashion.  When you click on them,
they invoke the dialog that corresponds to
that area of the program.  You may want to
visit them all and familiarize yourself with
them.

•The Drafting Tools, Menus, and
Window Tools dialogs behave exactly
as the Modeling Tools dialog.  You can
move the mouse around to get information
about the item or tool you are pointing at.

•The Introductory Help dialog is
different.  It simply displays textual intro-
ductory information about the program.
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•The Keyboard Help... button invokes dialogs that also work differently.

All the menu items and the tools can
be executed by pressing a combina-
tion of keys on the keyboard pro-
vided such keys have been assigned.
These are known as key equiva-
lents or key commands.  form•Z
ships with a set of preassigned keys
(see Appendix B in the Directory
volume).  These can be changed
through the Key Shortcuts... item
in the Edit menu.

On both the Macintosh and Win-
dows platforms, the Keyboard
Help button invokes a Keyboard
Help dialog, which is different on
each platform.

On the Macintosh the dialog con-
tains an image of your keyboard,
from which information about the
available key commands can be ob-
tained.  You can press a combina-
tion of keys on your keyboard and
see if there is a command assigned
to it. If there is, the information about
that operation is displayed in a rect-
angular area at the top of the dialog.
The Keyboard Help dialog on Win-
dows works the same way but does
not include a pictorial of the key-
board.

Note that the dialogs invoked by
Keyboard Help provide you infor-
mation about which key or key com-
bination executes which operation.
If you need to know the reverse, that
is, which key command may be avail-
able for a menu item or tool, you
should open the dialogs that contain
the information for the respective
items (Modeling Tools..., Draft-
ing Tools..., Menus..., or Win-
dow Tools...).  The summary infor-
mation displayed for a tool or menu
item also includes information about
the key equivalent at its end, if one
exists.
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2.7   Turning tools off and on

Next, you will learn how to customize your tool bar and its tool palettes.  Actually, we shall not be
covering this subject in full detail.  However, you will learn how to turn tools off and back on again,
which is a very convenient feature of form•Z that we shall be using in this tutorial rather
extensively.  But why should you want to do this, and what does it mean to turn tools off?  If you
are not certain what the answers to these questions are, read the following paragraph.
As form•Z aims at offering the complete range of modeling (and drafting) capabilities so that you may create any shape
you imagine, its tool palettes contain many icons, possibly more than any other program you have used to date.  This may
appear intimidating to a novice user.  While each individual tool is easy to learn and use, to learn them all admittedly
requires some time.  Especially if you are new to 3D modeling, as you learn how to use the form•Z operations, you also
learn how to do 3D modeling, and it is frequently the operation itself that needs to be learned, rather than the use of the
tool that executes it.  Whatever the case, there is no need to do it all at once, and the modeling operations should be learned
one group at a time, and progressively.  As you do so, you do not need the tools you do not use, which is why you may
want to turn them off.  This way they do not appear on your screen and they do not interfere with the tools you really want
to use.  As was mentioned earlier, this is how this tutorial has been structured.  You will start with only a few tools displayed
on your screen.  You will be turning more tools back on as the tutorial progresses.

• From the Palettes menu select Customize Tools....  The Icons Customization
dialog, shown below, appears.  Its Category pop-up menu displays Modeling Tools.

• At the bottom of the dialog is the Icon Style pop-up menu.  It has three items, which allow
you to switch the style of the tool icons.  Throughout this Tutorial we shall keep the default style
Color, but you may want to also try the others on your own.

This dialog contains three windows:

•The Tool Bar window displays all
the tools that are currently available.

•The Tool Palettes window shows
all the tool palettes that appear in the
tool bar and also palettes that may be
hidden.  These are separated in two
groups, with the visible tool palettes at
the top and the hidden palettes at the
bottom.  The names of the hidden
palettes are also in italics.  New pal-
ettes can be constructed in this win-
dow and both new and hidden pal-
ettes can be placed into the tool bar.

•The Tool Set window shows all
the tools in form•Z.  From this window
tools can be picked and placed in a
new or existing tool palette.
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You will next hide from the tool bar all the tool icons except the top three (left) and two (right).

• While you press the shift key, click on all the icons below the third, in each column, and
on the second icon of the right column.  As you click, a red frame appears around each icon
indicating that it is selected.  The shift key allows you to do multiple picks.

• Click on Remove (in the Tool Bar window of the Icons Customization dialog).
All the selected icons disappear from the Tool Bar window. In the  Tool Palettes window,
they have been moved to the end of the window and their names now appear in italics.
Note that this operation hides the tool palettes, but does not remove them completely.

• In the Tool Bar window, click on the 2nd right icon and drag it one position down, while
pressing option (Macintosh) or ctrl+shft (Windows).
The only reason you do this is to preserve the default pairing of the tool icons.

You will next also remove some tools from the Lines, Splines, and Arcs palette, to reduce its size.

• While pressing shift, click on the first icon on the left, and also on the last four.
A red frame is drawn around these icons, indicating that they are picked.

• Select the Remove button in the Tool Palettes window.  The picked icons disappear.
The other icons in the tool palette move left to fill the empty positions.
The option to leave the empty positions in place is also available.  You do so if you also press
option (Macintosh) or ctrl+shft (Windows) when you click on the Remove button.

How these operations affect the Icons Customization dialog is shown below.  How they affect
the actual program interface will be noticeable when we return to the main window.  Before we
do, let us review a few more operations that are available for customization.

• You can remove palettes (rather than
just hiding them) by clicking on their name
to highlight them in the Tool Palettes
window  and selecting Remove in that
same window.

• You can move icons around, in both
the Tool Bar and Tool Palettes win-
dows.  You do so by clicking on an icon and
dragging it to a position, which is high-
lighted.  If a frame around an icon is
highlighted, that icon is replaced.  If one of
the edges of an icon is highlighted, the
icon is placed next to that edge.  If the edge
is between two icons, the icon is placed
between the icons.

• You can reinsert a tool palette  you
previously removed back into the tool bar
by clicking on its name and dragging it into
the desired position.
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• You can create a new tool palette by clicking on the New... button in the Tool Bar window.
When you do, a dialog that invites you to enter the name of the new palette appears.  After you
enter a name and you close the dialog, a new blank icon is inserted at the end of the tool bar, and
a new initially empty palette appears in the Tool Palettes window.  You next need to place tools
in the new palette.  You do so either by moving icons around in the Tool Palettes window, or
by picking icons in the Tool Set window and dragging them into the new palette.

After a new tool palette has been constructed, it can be inserted into the tool bar the same way
existing palettes are re-inserted.  While the same tool can be repeated in more than one palette,
the same palette cannot be placed more than once in the tool bar.

In the remainder of this tutorial you will only need one operation: re-inserting the palettes you have
just removed.  That is, assuming you will not on your own want to customize your tool bar.  We
would actually recommend against it for the duration of this tutorial.  You should only consider
customizing your tool bar after you become sufficiently familiar with form•Z.

• Clicking on OK of the Icons Customization dialog returns you to the main window, whose
left end should now look different;  that is, the tool bar is a lot shorter with only four icons.

•Tear them off to see what is in them.  You may want to arrange them as we show, below.
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2.8  Saving your preferences

The vast majority of the form•Z tools and operations are affected by options and parameters that
are set in dialogs corresponding to these operations.  When you launch form•Z for the first time,
these parameters and options take preset values.  The product is shipped with eight sets of default
values for English and Metric units at four levels of magnitude: miniature, small, medium, and
large.  By default, the program uses the medium level values.  However, you can tell it to pick the
defaults from another level.  This is done by clicking on the Default Working Units... button
(found in the Project: General group of the Preferences dialog).  This invokes the Default
Working Units dialog, which contains the Data Scale pop up menu, from which the desired
level of defaults can be selected.  You can also set your own values, save them in your own
preferences files, and tell the system to use them next time you launch form•Z.  Here is how you
can do it.

The Preferences dialog, shown to
the left, is invoked from an item of the
Edit menu.  It contains preference
categories at two levels:  System and
Project, which are saved differently.
The project level preferences are
saved by saving a project, which is
then used as a template.  The system
level preferences are saved by saving
a preference file.

To demonstrate how preferences are
saved and recalled, we shall first
change a few settings.

• From the Windows menu, se-
lect Window Setup... to invoke the
respective dialog.

• On the right are three fields labeled # Divisions.  They
now contain the value 4.  Change it to 2.

Note that, because the XYZ Grid Lock option is selected, when you change
the value of one of the # Divisions fields and click on another one, they all
change to the same value.  Even if you do not click to see the change happen,
they will take the same value when you click on OK to exit the dialog.

• Click on OK to close the dialog.
The grid displayed on the screen has changed.  It now has
only two divisions between the heavier lines.
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• Select Options: Working Units....
The Project Working Units dialog is invoked.
It contains a tab labeled  Numeric Options.

• Select Decimal and click on OK.

Now observe how the format in which numeric values are
displayed in the Prompts palette has changed.  You will
next close two of the palettes on the screen.

• At the upper left (Macintosh) or right (Windows) corner
of the Coordinates palette there is a close box.  Click on it.

• Do the same to the Animation palette.
You have changed two of the default parameters, which are project level,
and you have closed two of the palettes, which is a system level change.

Before you make the next change, make sure that an operator (black tool) is selected (any tool
will do), and move the mouse around the screen.  Observe how the numeric values are displayed
in the Prompts palette, and try to remember the format in which they are displayed.

You will next save the changes.

• From the File menu, select Save
As.... When the Save As dialog
appears, type “Template_project”
(or whatever name you prefer) and
save the current project.

• Select Edit: Preferences... to
invoke the Preferences dialog.

• Click on Project: General to
display the respective options.

• Select Use Template Project and
click on the Choose Template
File... button to select the project file
you just created.  When done
“Template_project.fmz” should be
displayed in  the template box.

• Next, click on System: General,
which displays the respective options.

• Select Use Preference File and
click on the Save Preferences... button.
The standard Save As dialog is invoked.

• Type “My_Preferences” in the name
field (or whatever name you wish);
click Save.
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• Click on Load Preferences... and select the preference file you just saved.
The “My_Preferences” file should now be displayed in the preferences box.

• Quit or Exit.

• Launch form•Z.

After the program is launched, you will see that the changes you made in your previous session
have been preserved: your grid has only two subdivisions between the heavier lines, and, in the
Prompts palette, the numbers are displayed in the decimal format.  Also, the Coordinates and
Animation palettes have not appeared.

Here is what you learned from this exercise:

•Some of the parametric options belong to the project level and different projects may have
different settings.  The grid parameters and the working unit parameters are at the project level.

•Other parameters belong to the system level and are the same for all projects.  The status and
position of the palettes are system level parameters.

You must have noticed that the status of the tools you turned off in the previous section has been
preserved.  Only three rows of icons showed up.  The status of the tool palette is saved by the
program automatically, regardless of whether or not you save and use your own preferences.
However, torn off palettes and their positions are user preferences, saved at the system level.

You also notice that the hierarchical list on the left of the Preferences dialog contains a number
of categories.  Selecting them displays the respective options on the right side of the dialog.  Some
of these options will be explained as this tutorial progresses.  They are all discussed in UM section
3.2.6.

Before completing this section, we shall reset the Preferences dialog so that the next time you
launch form•Z, the grid and the numeric display format will return to their default parameters.
Using the defaults means that all your dialogs (including the two to which you made changes) will
return to their default values.  Whatever tools you activated in previous sessions will remain
active.  However, torn off palettes will be closed.  At the beginning of each session, you will have
to decide again which tools to tear off.  You may certainly avoid all this by saving your set up into
a Preference file.  However, we recommend against it, at least for the beginning sessions of this
Tutorial.

•Select Edit: Preferences... to invoke the Preferences dialog.

•Under both Project: General and System: General, select the Use Defaults options.

•Click on OK.

•Quit or Exit.
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3  Drawing 2D shapes
•Launch form•Z.

If you have followed our instructions to this point, five icons will be displayed in the upper left corner of your screen.
You can tear the three shown below off, to use in this chapter.  The other two you will need later.  You can also place
the ones you tear off wherever you wish, and even click on their orientation boxes to position them vertically.

The tools in the left second palette have a teal background.  These are modifiers which tell the
system what type of object to create from the shape you draw.  They generate 2D and 3D objects.
In this section, you will use the very first tool to create 2D objects.  You will generate 3D objects later.

form•Z is above all a 3D program,
which allows you to create ob-
jects directly in 3D space.  How-
ever, it also allows you to work in
2D space, which is what you will
be doing first.

•From the View menu select
[+XY] Top.

Your screen now displays what is
known as an orthographic pro-
jection or a 2D view.  The XY
plane of the 3D system of coordi-
nates lies on the screen plane,
and there is no 3rd dimension.
The reference grid has been
redisplayed to reflect the 2D na-
ture of the projection.

The other two palettes contain icons on a white
background.  They are used to draw shapes.  The
tools on the left 3rd palette draw closed shapes:
rectangles, polygons, circles, and ellipses.  The tools
on the right 3rd palette draw open shapes that can
also be closed.  These tools draw one segment at a
time and can produce any kind of a shape.  There are
also tools that create curved lines and arcs.
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3.1  Drawing rectangles

You are now ready to draw.  Initially, try to follow our instructions and draw the shapes we suggest
as close to ours as possible, even though it does not really matter if they deviate a bit.  You should
then feel free to experiment further with the drawing tools.

Select the 2D Surface modifier

(1st tool on 2nd palette on the left).
You will keep this tool selected throughout this section.

Select the Draw Rectangle tool (1st tool on 3rd row left).

• Click on point 1.
A rectangle is rubber banded as you move the mouse.

• Click on point 2.
A rectangle is created and is displayed in your window.

You may have worked with other drawing programs that required you to drag the mouse between two points.
In form•Z each point is entered by an independent click (press and release immediately).  The advantages
of this method are discussed in UM section 1.4.

You noticed that, after the first click, the shape of a rectangle was rubber banded.  This allowed you to visually
inspect the size and shape of your rectangle before finalizing its creation with the second click.  Rubber
banding is a dynamic process that is not possible to show in the static images of a printed document.  It is
a standard feature of form•Z and is part of the execution of most of its operations.  All the shapes you will
be drawing will first be rubber banded before they are created by the last click of the mouse.

The first rectangle you drew was restricted to a position parallel to the orthogonal axes.  The 3
Point Rectangle (2nd tool on the 2nd palette) does not have such a restriction and can take any
position.  However, it requires one additional input point (total of 3 points).  You will use it next.

• Select Edit: Clear to clear the screen.

The 2D Surface modifier should still be selected.

Select the 3 Point Rectangle tool (2nd tool on 3rd row left).

• Click on point 1.
A line is rubber banded as you move the mouse.

• Click on point 2.
A rectangle is rubber banded.

• Click on point 3.
A rectangle is created and is displayed.
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3.2  Drawing polygons, simple and patterned

Next, you will draw a polygon.

• Select Edit: Clear to clear the screen.  When a warning dialog
appears, click OK and proceed.

The 2D Surface modifier should still be selected.

Select the Polygon tool.

• Click on point 1.  This is the center of your polygon.
A hexagon is rubber banded.
As you move the mouse the size of your shape changes, and you can also rotate it.

• Click on point 2.  A hexagon is created and displayed.

The Polygon tool defaults to six sides (hexagon).  You can change this and create polygons with
any number of sides.  You select a different number for sides either in the Polygon Options dialog,
which you have to invoke, or in the Tool Options palette to the right of the window, which displays
the options of the Polygon tool as soon as you select it.  In this exercise we shall use them both.

• Double click on the Polygon tool to invoke the Polygon Options dialog, which appears
as shown to the left, below.  The Tool Options palette is also shown below right.

The Edges tab in both the dialog and the
tool palette contains six icons for selecting
a triangle (3-sided), diamond (4),  penta-
gon (5), hexagon (6), octagon (8), or
decagon (10).

Click on one of these icons to select it.  The
number of sides that appears in the numeric
field above them changes.  For example,
selecting the pentagon displays the number
5.  To draw a polygon for which there is no
icon, enter the number of sides you need.
You notice that the options palette and
dialog contain quite a few more options.
Those in the upper part allow you to select
a different method for drawing polygons.

• The default Center & Radius you
already used interprets the first input point
as the center and the second as a point on
the perimeter.  This is the default.

• The Diameter option interprets both
points as points on the perimeter of the
polygon.

1

2
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All polygons are shapes inscribed in a circle.  The two options labeled Construct Through
control how a polygon is inscribed in the circle.

• Point is the option you used above.  It places a point at the position of the second click.

• Segment  places a segment at the position of the second click.

Try all these options to observe the differences in the drawing behavior.

The icons that determine the number of sides in a polygon are in a tab labeled Edges.  This is
open by default.  Next to it is the Pattern tab.  Click on it to open it.  It contains another group
of icons, which allow you to draw variations of the polygons, called patterned polygons.

• Select Edit: Clear.
• From within the Edges tab of the tool options palette (or

the dialog) select the lower right icon (with 10 sides).  Then
open the Pattern tab, turn on the Pattern check box, and
select the upper left icon under it.

The 2D Surface modifier is still selected.

Select the Polygon tool and click on points 1, 2, and 3.

The star shape shown to the top right is drawn.
• Undo.

With Polygon still active, click on points 1, 2, and 4.

The lower star shape on the right is drawn.

These star-like polygonal shapes are patterned polygons and they are just two examples of the
shapes that can be drawn with the Polygon tool.  Try the other options on your own and draw
additional patterned polygons.  Also try the options under them.

While the Polygon is the first tool you encountered that is affected by optional parameters and
settings, this is also true for the vast majority of the form•Z tools.  In all cases you may either invoke
the dialog of the tool and select the desired options from there, or you can do so in the tool options
palette.  The latter is content sensitive, which means that the options of a tool are displayed as
soon as the tool is selected.

Which of the two ways for selecting options is preferable is a matter of personal choice.  The
advantage of the dialogs is that they use larger and more distinct fonts to display their options.
Their disadvantage is that they need to be specifically invoked.  On the other hand, while the
relevant options appear in the tool options palette automatically each time we select a tool, they
frequently do not fit in the space provided for the tool options palette. You can see the options that
do not initially fit either by enlarging the palette or by scrolling its content.  You do the latter by
clicking on some empty space in the palette and dragging the mouse.

1            2     3

1      4     2
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3.3  Drawing circles and ellipses

Next you will draw three circles, using different methods.

• Select Edit: Clear.

The 2D Surface modifier should still be selected.

Select the Circle by Center and Radius tool (4th on 3rd row left).

In its tool palette, the default Smooth should currently be on.

• Select Facetted for Model Type.
We shall explain later why this is desirable, even though the change will make no
visible difference to the shapes you will be drawing here.

There are two tools for drawing ellipses.  You will use them next.

•  Select Edit: Clear.

Select the Ellipse by Major and Minor Radius tool.

• Click on point 6. This is a point on the circumference.
• Click on point 7. This is the center of the ellipse.

An ellipse is rubber banded as you move the mouse away.
• Click on point 8.  An ellipse is created and displayed.

Select the Ellipse by Diameter and Radius tool.

• Click on points 9 and 10.  These are points on the circumference.
An ellipse is rubber banded after the second click.

• Click on point 11.  An ellipse is created and displayed.
• Select Edit: Clear to clear the screen before the next exercise.

• Click on point 1. This is the center of your circle.  A circle is rubber banded.
• Click on point 2.  A circle is created and displayed in the graphics window.

This circle was drawn exactly as the polygon with the Center & Radius  option.  You can also draw a circle as you draw
a polygon with the Diameter option.  It is drawn with the Circle by Diameter tool (5th on 3rd row left).  Try it.

The third method for drawing circles requires three points.

Select the Circle by 3 Points on Circumference tool.

• Click on points 3 and 4.  These are points on the circumference of the circle.
A circle is rubber banded as you move the mouse after the second click.

• Click on point 5.  A circle is created and displayed in the graphics window.

4
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3.4  Generating line drawings

Next, you will draw lines, arcs, and splines.
You will also turn on Grid Snap, which will
cause the points you enter with the mouse
to be locked or snapped to the nearest grid
point.  You will first draw shapes A through
E, one at a time.

Select the Grid Snap tool to turn grid snapping on.  It is the fourth window tool.

2D Surface should still be selected.

Select the Segment tool and click on point a1, then click again on point a2.

The single line object A is created and displayed.

You will next draw shape B.

Select the Vector Line tool (3rd on 3rd row right).

In its tool palette, Facetted should currently be on, for Model Type.

• With the Vector Line tool active, click on points b1, b2, and b3,
in this order.  After each click, a new line is rubber banded that
is anchored on the previous point.

• Double click on point b4.  Object  B is created and displayed.

The double click of the mouse signals completion of the drawing process and creates
an open shape.  A triple click creates a closed shape, as you will see shortly.

• 2D Surface Object and Vector Line are still selected.
• Click the mouse on points c1, c2, and c3, in this order.
• Triple click on point c4.

Object C, which is closed, is created and displayed.

The triple click signals the end of the drawing sequence, and it also closes the shape
by connecting the point where the mouse was triple clicked (c4) with the first point
entered (c1).

A shape can also be closed by positioning the mouse on the first point and double
clicking.   To close the shape, the system should be able to recognize that the first and
the last points are the same.  Consequently, grid snapping should be on when using
the second method for closing a shape.

A   B    C    D         E

a1

a2
A

b3b2

b1 b4

B

c2 c3

c1 c4

C



31form•Z Tutorial  •  Drawing 2D shapes

3.5  Drawing arcs

You will next draw the arc of shape D.  Note that this is an open shape whose endpoints lie on
the Y axis.

The arcs in this section and in section 3.3 were drawn with 23
segments.  This is determined by the default settings in the Display
Resolution tab, shown to the right, which can be opened from
the Circle/Ellipse Options and Spline/ArcOptions dialogs
(or tool options palette).  Currently the default Simple method is on
and the resolution of circles is set by the sliding rule.  There are also
additional methods for setting resolutions with more accuracy.  We
discuss the resolution of objects in section 3.9.

The 2D Surface tool is still selected.

Select the Arc, Clockwise, Endpoint Last tool

(next to last in the palette or left most of Arc tools).

Note that this is a long name.  You should also recall that there are six Arc
tools, four of which you have turned off.  Each of these draws an arc in a
different manner, and their names describe how they are drawn.  In most
cases it will suffice to indicate clockwise and counterclockwise.

• Click on point d1.  This sets the beginning point of the arc.  As the mouse starts to move
away from that point, a circle is rubber banded with its center at the cursor position.

• Click on point d2.  This sets the center of the arc, and the rubber banded circle transforms
to an open arc that is drawn in a clockwise direction.

• Double click on point d3.  This completes the drawing of the arc and creates object  D.
Had you triple clicked on the last point, a closed shape would have been constructed.

You can also draw the arc of shape D in a counterclockwise direction, as follows:

• From the Edit menu, select Undo to erase the previous arc.

Select the Arc, Counterclockwise, Endpoint Last tool (last in palette).

• Click on points d3 and d2, and double click on d1, in this order.

When an arc is by itself, such as shape D, either one of the arc drawing tools can be used.  The direction of the arc is
significant when the arc is part of a continuous drawing, such as object E, which you will draw next.

d2

d3

d1D

You may be noticing that the difference in arc resolution is hardly visible.  While it is always more visible when drawings
are printed, you can also make it more visible by instructing the program to show you the points.  You do this by turning
on the Show Points option in the Interactive tab of the Wire Frame Options dialog, which you invoke by clicking
on Wire Frame* (Display menu) while pressing option (Macintosh) or shft+ctrl (Windows).
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3.6  Mixing straight lines and arcs

You will next draw shape E by switching icons as the drawing is in progress.

While at e3, switch icons and select the Arc, Clockwise, Endpoint Last tool.

Do not worry about the rubber band following the mouse as you go to select the new tool.
It will fall in place as soon as you return to the graphics window.

• Click on point e4 (the center of the first arc) and then e5.

While at e5, select the Arc, Counterclockwise, Endpoint Last tool.

• Click on point e6 (the center of the second arc), then on point e7.

While at e7, select the Vector Line tool again.

• Triple click on point e8.
The shape is closed, the drawing process is completed, and object  E is generated.

If you make a mistake as you draw, you can undo the last line you drew by pressing  on the Macintosh or ctrl+Z on
Windows.  Or you can achieve the same result by selecting Edit: Undo on both platforms.   This way, you can undo a
sequence of drawing steps in reverse order from the order in which you drew them.  If you mix drawing tools as you draw,
then the tool active at the time the Undo is executed will remain active, regardless of the tool used to draw the segment
you are undoing.  We recommend that you redraw the last shape and as you do, apply Undos to get a feel of how they
behave.  At the end, make certain that you have the shape drawn as we show it since you will save it so that it can be
used in another exercise a bit later.

You should have noted by now that if you select the Undo command after you have completed the generation of an object,
it erases the complete object. If you select Undo while you are still drawing, it only cancels the most recent drawing step.

Before you leave this section, save the shapes you have drawn.  You will need them again later.
• From the File menu select Save As....
• In the dialog that appears type “Shapes” (or any other name) and press return/enter.

e1

e2
e3

e4

e5

e6

e7
e8

E

2D Surface should

still be on.

Select the

Vector Line tool.

• Click on e1, e2, e3.
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3.7  Drawing spline curves

You will next generate splines.

• Clear (Edit menu).

2D Surface is still selected.

Select the Spline, Quadratic Bezier tool.

• Click on points 1 through 12, and double click on 13.
After the first click a straight line is rubber banded,
which becomes a curve after the second click.  A curve
continues to be rubber banded until the double click,
which completes the drawing.
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You will next draw another spline of the same kind.

• Undo.

With the Spline, Quadratic Bezier tool still selected, click on points 1 through 11 and

double click on 12 (as shown in b).

Next you will draw three splines of a different type.

• Undo.

Select Spline, Cubic Bezier (second spline tool).

• Click on points 1 through 12, and double click on 13.
(as shown in c).

Repeat the above steps and draw the splines by clicking on the
points, roughly as shown in d and e on the right.

You notice that the Quadratic and Cubic Bezier behave differently when you
draw with them.  Quadratic means of second and Cubic of third degree.  That
is, these curves need two and three control points respectively to be generated.
The Cubic Bezier, after the second click and every other click from there on,
rubber bands a straight line, which is tangent to the curve and rotates about the
tangency point.  This allows you to manipulate the shape of the curve.  The
method used is the same with that found in popular illustration programs.

The smoothness of the curves is controlled by the settings in the
Display Resolution tab that can be opened from the Spline/
Arc Options dialog or tool options palette.  We discuss more
details in section 3.9.  Also note that smooth splines can be
generated as derivative shapes from vector lines that are drawn
first.  You will learn how this is done in chapter 18.
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3.8  Drawing sketches and stream lines

Two tools at the end of the splines group let you draw continuous
types of lines by clicking and dragging, rather than a click-click
process, as the previous examples did.  The resulting splines have
a sketching quality.  You will next do an example of each.

• Clear (Edit menu).
• Deselect the Grid Snap switch.

2D Surface is still selected.

Select the Spline Sketch tool.

• Click to begin, then drag the mouse to draw some shape,
possibly something like the one we show in a to the right.

• Release the mouse and double click to stop drawing.
The shown shape is generated.  We also show it with its
points displayed.  You will learn how to do this a bit later.

With the Spline Sketch tool you draw little line segments, which are generated by the
program automatically each time the mouse travels a certain distance.  Then these
segments are used to generate a curve.  The distance can be set in the Display
Resolution tab that can be opened from the Spline/Arc Op-
tions dialog (or tool options palette), as for the other splines.  This tool can also
be used in a click-click manner, in which case it draws a Quadratic Bezier similar to
that you did in the previous section.

Next you will draw a stream line.

• Undo (Edit menu).
• Grid Snap is off and 2D Surface Object is still selected.

Select the Stream Line tool.

• Click to begin, then drag the mouse to draw some shape,
possibly something like the one we show in c, or you may
want to repeat that in a.

• Place the cursor on point 24, press the button, and drag
along the shown shape.

• At the end, release the mouse and double click to complete
the drawing.

Again, while the Stream Line tool is typically used in a click and drag manner as
above, it can also be used in a click-click manner.  When clicking and dragging,
streams of segments are generated as you drag the mouse.  These segments,
shown in d on the right,  are automatically created by the system when the mouse
travels a certain distance.  That distance can be set in the Stream Distance field
of the Stream Input Options dialog or tool options palette.

a

b

c

d

  24
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3.9  Facetted versus smooth objects

We have already noted earlier that, in form•Z, there are two types of models: facetted and
smooth.  The former approximate curved lines with straight line segments and curved surfaces
with flat bounded surfaces called faces.  In contrast, the smooth lines and surfaces are continuous
and there is typically no need to subdivided them.

How is it decided whether a newly generated object will be facetted or smooth?  In most cases
there is a model type option associated with a drawing tool, as follows:

• The rectangle, polygon, single point, and single segment drawing tools draw facetted shapes only.

• The circle, ellipse, spline, and arc drawing tools can generate either facetted or smooth
shapes, which is determined by selecting either option for model type in their dialogs or option
palettes.  Note that these options are globally set.  That is, the way it is set for, say a circle, will
also apply to a spline drawn during the same session, without changing the option.

• The vector line shapes, in their pure form, can only be facetted shapes.  Yet, the Facetted/
Smooth options are available in their dialog.  This is because of the possibility to mix the vector
lines with arcs and splines.  If a vector line is by itself, it can only be facetted, even when Smooth
is on.  However, if it is mixed with arcs and splines, it will be whatever the model type setting is.

According to the above, the model type is set when a shape is drawn.  This type will then be carried
by whatever object is generated, which can be a 2D surface or a solid, such as an extrusion or
a 3D enclosure.  We discuss how the model type is decided for types of objects such as primitives
and derivatives when these objects are discussed later in this Tutorial.

An implication of the facetted/smooth distinction is that similar forms consist of significantly more
faces in their facetted than in their smooth version.  For example, a facetted cylinder's curved
surface consists of a number of faces approximating its curved side.  In its smooth version, the
curved side of a cylinder is a single face.  Similarly, a smooth sphere consists of a single face,
but its curved surface is approximated by many flat faces in its facetted reincarnation.  Exactly
how many depends on the level at which its resolution is set.

When objects are generated their resolution is set in the Display Resolution tab that can be
found in most of the dialogs associated with drawing and object generating tools, as we have
already seen in section 3.5.  Interestingly, the options in this tab affect both the facetted and the
smooth objects, even though the latter are by definition "resolution independent."  Even smooth
shapes and forms need to be approximated with straight segments and flat facets in order to be
displayed on a computer screen or plotted on paper.  Thus the options in the Display
Resolution tab also control this display approximation, but have no effect on the internal
representation of the smooth objects.  In contrast, they affect how facetted objects are stored
internally.  These are displayed as they are stored.
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3.10  Drawing 2D enclosures

The 2D enclosures are double line (“wall”) shapes that are created from the single line drawings
you draw.  They are appropriate for the representation of architectural floor plans.  They are
created by the system when you select the respective modifier from the Object Type palette and
use one of the drawing tools to draw a shape.

In this section, you will redraw the
shapes you drew in sections 3.4, 3.5,
and 3.6 with the 2D Enclosure modi-
fier active.

•Open the “Shapes” project you
saved at the end of section 3.6, and
draw under the previous shapes.

Turn on the Grid Snap.

Select 2D Enclosure.

• Draw shapes A through E,
as in 3.4, 3.5, and 3.6.

Each single line you drew was transformed into a double line by generating parallel lines to the left
and to the right at a distance of 1'.  The program used the default parameters, which can be changed
in the 2D Enclosure Options dialog or tool palette options.  You can enter different values in the
Wall Width field and you can select Left or Right Justification, instead of the default Center.
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+zWhile you have been drawing on a 2D projection, your shapes
actually exist in 3D space.

• From View menu, select z=30°  x=60° .

You can now see your shapes in a 3D view.  You
will need them again in section 8.1 to derive other
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• From File menu, select Save.

Your project has been saved under the name
“Shapes” you entered earlier.
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3.11  Drawing with numeric input

Objects can be drawn and all the operations of form•Z can be executed by typing numbers in the
Prompts palette, using the keyboard.  In this section you will draw two 2D shapes using numeric
input, rather than the mouse.

• Select Edit: Clear and View: Top.
• Click on the little box labeled “T” in the

Prompts palette to deselect it.

“T” stands for tracking.  When you deselect this box, the
numeric fields in the Prompts palette remain blank until
you type in a number.  We suggested that you deselect it
to be able to read your numbers better.  This is optional.

Select 2D Surface.

Select the Vector Line tool.

• Place the mouse cursor in the Prompts
palette.

• Type:  “-400, 200” and press return
(Macintosh) or enter (Windows).

• Type: “-400, 400”, hit return/enter.
A line is drawn on your screen.

• Type: “-200, 200”, hit return/enter.
• Type: “e”.

The open shape shown is generated.
The system drew to the numbers you typed.  You also
noticed that each time you pressed return/enter, different
numbers appeared where you typed yours.  That is, when
you typed “-400, 200” and pressed return/enter,  the
numbers “-33'-4", 16'-8",  0'-0"” appeared in the Prompts
palette.  The system simply interpreted your numbers as
inches and redisplayed them using the format currently
selected in the Working Units dialog (invoked from the
Options menu).  The “e” told it to terminate the drawing
process.  This is equivalent to the double click when you
draw with the mouse.  You could have closed the shape
by entering the character “c.”  Note that a comma should
be typed between numbers to separate them.   Next you
will draw a rectangle.

Select the Rectangle tool.

• Press return/enter.  This produces zeros.
• Type: “250, 250” and hit return/enter.

A square, with one of its corners at the origin, is created and displayed.
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4  Generating, viewing, and rendering 3D objects

In this section you will learn how to generate 3D objects from the 2D shapes you draw on the
reference grid.  You will create three types of objects:  parallel extrusions, extrusions to point
(or converged objects), and 3D enclosures.   The generation of all these types is controlled by
modifiers you select from the Object Type tool palette.  If you did not Quit at the end of the
previous chapter, do it now.

• Relaunch form•Z.

Turn on the Grid Snap.

As you do the following examples, you will be drawing directly in 3D space.  You notice that a 3D
view of the XY reference grid is displayed on the screen.  This is the default.  The view is set to
z=30°  x=60° .  Press the mouse on the title of the View menu.  You will see that this is the first
item and that there is a check mark in front of it, indicating that it is selected.

• From the View menu select z=45°  x=45° .
Observe how the view of your grid changes.  If you had objects displayed on the screen
(as you will soon) all of them would now be displayed in the new view.

• Continue and select the next three items in the View menu.
Observe how the view changes.

• From the View menu select Custom View Angles....
• In the Custom View Angles dialog that is invoked, type whatever angles you wish

in the X, Y, and Z Angle fields, and click on OK.
• Select View: z=30°   x=60° .

You have just learned how to change views.  There are more methods available which will be presented later.  You need
to change views not only for visualization purposes, but also for better access to areas where you may wish to draw.

You will next change your reference plane by selecting an icon from the window palette, which
is at the lower margin of your window.

• Select the YZ Reference Plane tool (left most position of window palette).
• Select the ZX Reference Plane tool, then return to the XY reference plane.

We returned to the XY reference plane because that is where you will be drawing.  Needless to say, you should also feel
free to experiment with drawing on other reference planes after you complete the examples we suggest.

We did not ask you to select the Arbitrary Reference Plane.  Before you can select such a plane you need to define it.
We will tell you how to do so in section 30.1 of this Tutorial.

As you do the exercises in this chapter, you will use the hidden line display method, which shows only the lines that are
in the front of objects, in addition to the wire frame method you have been using so far, which shows all the lines of an
object.  All display methods available in form•Z are reviewed in section 4.5.
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4.1  3D extrusions

Select 3D Extrusion.

Select the Rectangle tool.

• Click on point 1, then 2.  A 3D cuboid is generated.

Select the Polygon tool.

• Click on point 3, then 4.  A 3D extrusion is generated.

Select the Circle, Center and Radius tool.

• In the tool options palette, in the Model Type group,
select Facetted.

• Click on point 5, then 6.   A cylinder is generated.

Select the Vector Line tool.

• Click on points 7, 8, and 9, and double click on 10.
A 3D surface is generated from the open shape.

The Vector Line tool should still be selected.

• Click on point 11, then 12.

While at 12, select the Arc, Clockwise tool.

• Click on point 13 (center) and then on 14.

At 14, select the Vector Line tool.

• Triple click on point 15.  A 3D extrusion is generated.
• Select Display: Hidden Line*.
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4.2  3D extrusions to point

In this section you will draw the same shapes you drew in the
previous section with the 3D Convergence (extrusion to point)
modifier selected instead of 3D Extrusion.

• Select Display: Wire Frame*.
• Select Clear from the Edit menu (or Undo five times).

Select the 3D Convergence modifier.

• Draw the five shapes exactly as you did in section 4.1.
• Select Display: Hidden Line*.

Compare the results.

4.3  3D enclosures

In this section you will draw the same shapes you drew in
section 4.1, with the 3D Enclosure modifier selected.

• Select Clear from the Edit menu.
• Select Display: Wire Frame*.

  Select the 3D Enclosure modifier.

• Draw the five shapes exactly as you did in section 4.1.
• Select Display: Hidden Line*.

Compare the results.

The parameters of the 3D Enclosures are set in the 3D
Enclosure Options dialog or tool options palette, shown to
the right.  The first two options (Justification and Wall
Width) are the same as those in the 2D Enclosure Options
dialog we saw in section 3.10.  The other options apply only to
the 3D enclosures:

Top, Base Thickness determine how thick the top and
bottom slabs of an enclosure will be, when they exist.  The latter
is set by the Top, Bottom options, each of which can be Open
or Closed.
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• With 3D Extrusion and Rectangle still selected,
click on 3 and 4.

• In the Prompts palette, turn box "T" on.
• From Heights, select Graphic/Keyed.
• Select the 3D Enclosure and Vector Line tools.
• Click on 5, 6, and 7, and double click on 8.

After the double click, a 3D enclosure is rubber
banded and follows the motion of the mouse,
which is locked to the perpendicular direction.

• Watch the values displayed in the Prompts
palette for the height.  When it is 6'-0," click.
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• From the Heights menu select Custom....
• In the Custom Height dialog that is invoked, type 24'

in its text field, and click on the Add To Menu button.

Click on Heights to observe what has changed in the menu.  The 24' height
has been entered at the top of the Heights menu and is selected.

4.4  Heights of objects

You should have noticed that all the 3D objects you generated so far had the same height, and
you may be wondering how this height is determined.

• Press the mouse on the title of the Heights menu.

You see that this menu contains a number of preset heights ranging from 20' to -20'.  There is a
check mark in front of the 10'-0" item, indicating that it is the height value currently selected.  All
the 3D objects you created are 10' high.  You can select other heights, both positive and negative.
You can also enter new heights or delete existing heights.  In general, you can customize the
content of the Heights menu to suit your needs.  You will try different heights next.

• Select Edit: Clear.
• Select Display: Wire Frame*.
• From the Heights menu select -2'-0" (nega-

tive 2 feet).
• Select the 3D Extrusion and Rectangle tools.
• Click on 1 and 2 to draw a rectangle the size

of the grid.
A 3D object is extruded on the negative side of
the reference plane.
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You have just created a 3D enclosure 6 feet high.  You may decide when to click by visually inspecting the rubber banded
image of your object.  You will do this with the next two objects.

• Select the 3D Convergence and Rectangle tools.
• Click on 9 and 10.  When your rubber banded pyramid is roughly as high as ours, click again.
• Click on 11 and 12, then click again when the height of the second pyramid is roughly as ours.
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You will next do a surface render-
ing with shadows.

• From the Surface Render*
item (Display menu) invoke the
Surface Rendering Options
dialog.

• Select Render With Shad-
ows and click on OK.

• Invoke the Surface Ren-
dering Options dialog again
and deselect Show Color.
Both renderings are as shown.

If you are running the regular version of form•Z, in the Display menu there are two
more rendering items: Interactive Shaded*, which is based on OpenGL, and
Shaded Render*.  If you are running form•Z RenderZone or form•Z RadioZity,
there are additional rendering commands that produce photorealistic renderings with
possibly texture maps, reflections, bumps and many other rendering effects, or
accurate simulations of lighting effects. These features are not covered in this Tutorial.

4.5  Plotting and rendering objects
The objects you have been creating have been displayed with all
their lines visible (wire frame).  At the end of most of the exercises
in this chapter, you also displayed your objects in hidden line.  In this
section, you will try more of the rendering methods available.

The objects you created in the most recent example should still be
on your screen.  To see them better, turn the grid and the axes off.

• From the Windows menu, select Show Plane Axis,
Show World Axis, and Show Grid.  This actually deselects
them, which is indicated by the removal of the check mark that
was displayed in front of them.
Your image should now be as shown, with all its lines visible.

• From the View menu, select Sun Position....
• In the Sun dialog enter 30° in the Sun Altitude

and -15° in the Sun Azimuth fields.
• From the Display menu, select Quick Paint*.

Observe the result.
Note that all the objects have the same color, which was automatically assigned to
them when they were created.  It can be changed, which you will learn how to do later.

• From the Display menu select Hidden Line*.

Pull out the Display menu and observe that all the display items have asterisks at
their ends, which indicates that there is a dialog that affects their execution. To invoke
this dialog press option (Macintosh) or ctrl+shft (Windows) while clicking on them.
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4.6  More about types of objects

As we have already seen, form•Z can generate both smooth and
facetted objects.  For directly generated objects, this option is set in
respective dialogs, and you should recall how earlier in this session we
switched the option from the default Smooth to Facetted.  Each of
these types presents distinct advantages and affects the visualization of
objects.  That is, especially when we use hidden line displays, in most
cases, it is easier to read the form of facetted objects.  Smooth objects
consist of less faces that typically include curved surfaces.  While these
render nicely with shaded display methods, they appear flat in hidden line.
In contrast, the surfaces of facetted objects are approximated with sets of
bounded surfaces called facets, which describe their form much better in
hidden line.  These differences are illustrated to the right.

Two main variations of objects are the surface and the solid objects.
All the objects you generated in sections 4.1 through 4.3 (extrusions,
convergences, and 3D enclosures) were solid objects.  These are
objects that are completely enclosed by faces.  All the objects you
generated in chapter 3 were surface objects.  These include the open
lines, the closed shapes, and the 2D enclosures.

Both the surface and the solid objects may be parametric or plain.
They are parametric when their parameters are stored with them and
can be later used to regenerate them.  For example, when the radius of
a circle is stored with it, the circle is parametric.  If not, it is a plain object.
Similarly an extrusion may be stored with its height parameter or as a
plain facetted solid.  We talk more about the parametric/plain distinction
later in this Tutorial.

The open lines, even though they do not delineate any surface, are still
considered to be surface objects.  However, they are not always visible
when surface rendering methods of display (Interactive Shaded*,
Quick Paint*, Surface Render*, and Shaded Render*) are used.
In Hidden Line* the option Include Open Shapes is available in the
Hidden Line Options dialog. When on, open lines are also displayed.

solid objects

surface objects

smooth facetted

wire frame

hidden line

The closed surface objects have a positive and a negative side, which is normally not visible,
when surface rendering displays are used.  However, the Show Surfaces As Double Sided
item is available in the Display menu and is on by default.  When on, both sides of surface objects
are visible and are displayed.  The meshed surfaces are composite types of surface objects.  We
shall see how they are generated in chapter 15.  These also have a positive (visible) and a
negative (invisible) side.
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5  Generating 3D primitives

Primitives are the basic objects of 3D geometry, more specifically of analytic geometry, and are
referred to as analytic primitives.  They are the cube, cone, cylinder, sphere, and torus.  These
are symmetric objects that can typically be represented with one or two parameters.  For example,
a single radius value suffices to describe a sphere.  While the objects you generated up to this
point in this tutorial required two tools - one (the modifier) to tell the program what type of object
you were to generate, and one (the operator) for actually drawing the new object - the primitive
objects you will be creating in this chapter will employ one tool only.

All the primitives are parametric and all except the cube are generated as smooth objects.
Parametric means that they are internally stored with their parameters from which they can be
regenerated.  This makes them easy to edit and change.  As smooth models they are displayed
on the screen with two sets of lines, one in a darker and the other in a lighter color.  We review
their representation at the end of this chapter (section 5.5).  The smooth primitives can be
converted to plain facetted objects using the Convert tool.  In most of the examples in this session,
whenever we show hidden line displays, we show objects as if they have been converted to
facetted.  This is done through an option available in the Hidden Line Options dialog.

•Launch form•Z.

All the tools you need for this
chapter are already in your tool
bar.  They occupy the top rows,
left and right.  They are shown
torn off in the screen capture on
the left and below:

   

This left palette contains the Cube,
Cone, Cylinder, Sphere, and
Torus tools that generate analytic
primitives.  The right palette con-
tains the Spherical Objects and
the Metaballs.
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5.1  Generating a primitive cube

You will first draw a few variations of a cube.

Select the Cube tool.

Which modifier is active is indifferent to this operation.
Take a look at the content of the tool options palette that
appears as soon as the Cube tool is selected.  Or, if you
prefer, double click on the tool to invoke its dialog.

  In the tool options palette select the first icon on the left.

It represents the preset generation method.
• Click on point a.  An 8'x8'x8' cube is generated.

The center of its base is positioned at the click point.

• In the Width field of the tool options palette type 16'.
• Click on point b.

Observe the new cube.  You should be able to tell where
its dimensions are coming from.

The Cube tool is still active.

  In the tool options palette select the second icon It is the

diagonal generation method.
• Click on point c1.  A rectangle is rubber banded.

It is constrained to be parallel to the orthogonal axes.
• Click on point c2.  A cube is rubber banded.

The motion of the mouse is constrained to perpendicular.
• Click on point c3.  A cube is generated.

The motion of the mouse is constrained to perpendicular.
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  In the tool options palette select the third icon, which is the axial generation method.

• Click on point d1.  A line is rubber banded.
• Click on point d2.  A rectangle is rubber banded.
• Click on point d3.  A cube is rubber banded.  The motion of the mouse is perpendicular.
• Click on point d4.  A cube is generated.

The motion of the mouse is constrained to perpendicular.

You have used the three methods that are available for generating primitive cubes.  Similar
methods are also available for the other primitives, as you will see next.  It should be apparent
that each method has its own advantages, depending on the task at hand.
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5.2  Generating cones and cylinders

Next, you will draw primitive cones.

• Select Edit: Clear to clear the screen.

Select the Cone tool and observe the tool options palette.

The one shown to the right does not display the default settings but rather
the changes we made, which are as follows.

  In the palette select the first icon (preset method).

• Click on point a.
A cone of radius 4' and height 8' (defaults) is generated.

• In the palette, change Radius Y to 14' and Height to 18'.
• Click on point b.

An elliptical cone is generated directly.  Its dimensions have
the new values shown in the tool options palette.

For these two cones you just generated you used the preset method.  That is, no
rubber banding occurs and cones are created using parameters set in its dialog or
tool options.  The next methods will utilize variable degrees of rubber banding.

• Select Edit: Clear to clear the screen.

  In the palette select the second icon (radius method).

• Click on points c1, c2, and c3.  A cone is generated.
The first click sets the center and rubber bands a circle.
The second sets the radius and rubber bands a cone.
The third click sets the height.

We mark the last click for the height (c3) on the apex of the cone.  In fact, it can be
anywhere on a plane parallel to the reference plane that passes through the apex.

  In the palette select the third icon (diameter method).

• Click on points d1, d2, and d3.  A cone is generated.
The first two clicks set the ends of the diameter of the base and the third sets the height.

  In the palette select the fourth (left on 2nd row) icon (3 points method).

• Click on points e1, e2, e3, and e4.  The first three clicks set three points on the circle of
the base and the fourth click sets the height, which in this example is negative.

  In the palette select the fifth icon (ellipse method).

• Click on points f1, f2, f3, and f4.  An elliptical cone is generated.
The first click sets the center, the second and third set the two radii of the elliptical base,
and the fourth click sets the height.
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Next, you will draw truncated cones.

• Select Edit: Clear to clear the screen.
• In the Cone Options palette turn on Truncated Cone and

for Radius X, Y, and Height enter 10', 10', and 20'.

  Select the first button (preset  method).

• Click on point a.  A truncated cone of
radius 10' and height 20'  is generated.

Its top circle is by 50% smaller than its bottom, which is
determined by the value in the Top Is n % Of Base field.

For the other methods of drawing cones the size of the top
circle is also drawn interactively:

  Select the second button (radius).

• Click on points b1 and b2.
A cylinder is rubber banded.

• Click on b3, then on b4.
After the third click, the top face is

rubber banded.
The fourth click completes the truncated cone.
We also show a hidden line of its facetted version.

You will next draw partial cones.

• Select Edit: Clear to clear the screen.
• In the Cone Options palette turn off Truncated Cone and

turn on Partial.  Also, in the End field type 220.

  Select the first button (preset).

    Select the first (left) button from the Closure group.

• Click on point c.  A partial cone is generated.

    Select the second Closure button and click on point d.

    Select the third Closure button and click on point e.

The latter two operations generate solid partial cones, closed differently, as shown.

Primitive cylinders are generated in very similar
ways with the cones, except that they have no
truncation option.  We show a few examples on the
left and will let you try them on your own.
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5.3  Generating spheres

Next you will generate primitive spheres, which are drawn in ways
very similar to the primitives you have already experienced.

• Select Edit: Clear.

Select the Sphere tool and observe its tool options palette,

or invoke its dialog.  The upper palette is shown to the right.

  Select the first button (preset) and click on a.

  Select the second button (radius) and click on b1 and b2.

  Select the fifth button (ellipse) and click on c1, c2, c3 and c4.

You must have observed the significance of each click, as you were
generating the three spheres, the third of which has an elliptic
shape.  You may want to try the remaining buttons on your own.

You will next generate partial spheres, using the options on the
lower part of the tool options palette, shown to the right.  This should
already look familiar to you.  However, a sphere can be "partial" in
two directions, as opposed to the cones and cylinders whose partial
generation apply to one direction only.

• Select Edit: Clear.
• Turn on Partial and in the Horizontal and Vertical

fields enter 0, 270, -90, and 30 (as shown to the right).

  Select the second button (radius).

  Select the first Closure button and click on d1 and d2.

  Select the second Closure button and click on e1 and e2.

  Select the third Closure button and click on f1 and f2.

The partial spheres shown to the right are generated.

Note that, horizontally, a complete sphere ranges from 0° to 360°.
Vertically, it ranges from -90° to +90°.
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5.4  Generating tori

Next you will generate primitive tori.

• Select Edit: Clear.

Select the Torus tool and observe its tool options palette,

shown to the right.

Select the first button (preset) and click on a.

Select the third button (diameter) and click on b1, b2 and b3.

Select the fifth button (ellipse) and click on c1, c2, c3 and c4.

Except for the preset method, which simply uses the parameters
typed in the tool options palette and generates a torus centered at
the click point, a torus is drawn by rubber banding two circles,
referred to as major and minor.  Note that with the ellipse method
the major is always a circle, while the minor can be an ellipse,
defined by two distinct radii for X and Y.

You will next generate partial tori, using the options on the lower part
of the tool options palette, as you did for the sphere.  The lower part
of the tool options palette, shown to the right, should look familiar.
However, the meaning of the Start and End parameters are
different than the spheres.

• Select Edit: Clear.
• Turn on Partial and in the Horizontal and Vertical

fields enter 0, 270, 100, and 360 (as shown to the right).  Note that
horizontal corresponds to the major and vertical corresponds to the
minor circles.  They both range from 0° to 360°, where 0° is at 3
o'clock and positive angles are counterclockwise.

Select the first button (preset method).

Select the first Closure button and click on d.

Select the second Closure button and click on e.

Select the third Closure button and click on f.
The partial tori shown to the right are generated. d e f
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 a           b                  c

5.5  How the analytic primitives are displayed

Recall that the facetted objects you did in the previous chapters were displayed by a single set
of lines in wire frame.  In contrast, the smooth analytic primitives you have learned in this
chapter are displayed by two sets of lines.  This is actually true for all the smooth objects.

The smooth objects, including the analytic primitives, are graphically represented with two sets
of lines: by iso lines that run along their surfaces and by facets, which are optional and
approximate these surfaces with a number of planar  polygons.  Both representations may be
shown at the same color intensity or one can be darker than the other.  This is controlled by
options in the Wire Frame Options dialog, which is invoked by selecting the Wire Frame*
item (Display menu), while pressing option (Macintosh) or ctrl+shft (Windows).

In the Wire Frame Options dialog (Wire Frame tab), the
Smooth Objects group of options contains the Facets check
box that can be turned on or off and two Color Intensity slide
bars, one for the facets and another for the iso lines.  These are
used to set the colors of the smooth object representations.

The actual structures and density of the iso lines and facets are set
in the Display Resolution tab (shown to the right) found in the
tool dialogs or tool options palettes, which offer a Simple and a
Detailed method.

Simple is a slide bar that can be used to regulate the density of
the representation lines.  The Detailed method consists of sections
for the wire and facetted representations.

How many wires are used is set by the Iso Line Density pop up menu, the three
levels of which are shown on the right, for a sphere.  The Point Density can be
set using any one of three parametric values.

There are many different options for setting the resolution of the Facets.  A complete
discussion of these would be beyond the scope of this Tutorial.  We recommend
that you only use the Simple slide bar in this Tutorial.  However, if you want to read
more about the Detailed method, it is discussed in subsection 4.1.1 of the form•Z
User's Manual.

How the smooth analytic primitives are displayed by different display
methods is shown to the right. Note that, while display methods such
as Interactive Shaded, Shaded Render, and RenderZone
produce smoothly curved surfaces, the Hidden Line display by
default produces a single circle that is hardly recognizable for a
sphere.  However, the Hidden Line Options dialog also contains
the Show Facets Of Smooth Objects option, which plots an
object as if it were converted to facetted.  This option has actually
been used quite extensively in the examples of this session.

  Quick Paint      Hidden Line      Interactive
 Shaded
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5.6  Generating spherical objects

Spherical primitives can be generated with the Spherical Object tool

( ) found on the first row right column of the default tool bar.  A single

tool can actually generate eight different types of spherical objects,
which are as  shown to the right.   The type of spherical object and a
placement method are selected from the Spherical Objects Op-
tions dialog invoked from the tool or from the tool options palette, when
the Spherical Object tool is active.  The dialog, shown below right, in
addition to the options in the palette, contains a small preview window
that displays the shape of the spherical object currently selected.

You will first generate a spherical object using default settings.  You will
generate a geodesic sphere, using the default  radius method.  The tool you
need is already in your tool bar, so you can proceed as soon as you run.

Select the Spherical Object tool.

• Click in the graphics window, then move the
mouse.

A spherical object is rubber banded and as you move
the mouse the size of the object grows or shrinks.

• When you have the desired size, click again.

This generates a geodesic sphere, as shown.  You will
next repeat the operation and generate a higher den-
sity sphere.

• Invoke the Spherical Objects Options
dialog.  Make sure that the # Of Levels
option is selected, and in its field enter 3.

• Repeat the placement operation as before.
 After the second click of the mouse and a
momentary pause, a geodesic sphere of higher
density is generated, as shown to the far right.
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• In the Spherical Object Options
dialog, select Revolved Sphere and
the last button to the right, which is the
ellipse method.

With the Spherical Object tool active,

click in the graphics window.
A line is rubber banded.

   • Click to set the size of the line.
A 2D ellipse is rubber banded.

• Click the mouse again when you have
reached the shape you desire.
A 3D shape is rubber banded.

 • Click again.
The size and shape of your object is
defined.

This completes the operation.  Note that, when
the final sphere is generated, its density is
determined by the values entered in the Length
and Depth Resolution fields (displayed in
the dialog when Revolved Sphere is se-
lected), while a lower density is used for the
rubber banded form.

All the other spherical objects are generated
the same way as the spheres.  We recommend
that you try them all.

You have probably noticed that there is one
more tool on the top right palette of the tool bar,
labeled Metaballs.  This generates another
type of a spherical primitive that belongs in a
category of objects called metaformz.  While
the other metaformz are derivative objects, the
metaballs are primitives generated directly in a
manner very similar to the spherical objects.
Examples with metaballs are presented to-
gether with the other metaformz in chapter 19.
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You will next generate a lathed sphere using the ellipse method, which allows you to scale any
of the dimensions of the sphere independently of the others to produce elliptical shapes.
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6  Picking and editing objects

To apply an operation to an object, the object needs to be selected or picked.  Picking is possibly
the most frequently used operation.  In form•Z you pick objects using the Pick or Selection Arrow

tool (  ).  The pick operation may also be built into the tool that executes another operation.

This depends on whether the prepick or the postpick method of picking is used.  Both will be
illustrated in the following sections.

Complete objects, groups, or parts of objects can be selected.  These parts are the points,
segments, outlines, faces, and holes.  They are called topological levels.

If you have turned off most of your icons, as we suggested earlier, you will first need to invoke
the customization environment and add the Topological Levels, Pick, and Delete palettes.

• Launch form•Z.
• Select Customize Tools... from the

Palettes menu.
• In the Icon Customization dialog,

the Category pop up menu should
display Modeling Tools.

• Scroll the Tool Palettes window to
find the Topological Level palette.

• Click on its name to highlight it.
Then drag it into the Tool Bar window
to place it.

When you drag the palette to be inserted, you also need to tell the program where to put it.  You
do this by highlighting the edge of an icon next to which you want the new icon to be placed.  The
edge is highlighted when you place the mouse cursor on it.

We placed the Topological Levels palette in the left column under the third icon.
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You will next place the Pick palette
into the tool bar.

•  Click on the Pick palette’s name
to highlight it, then drag it into the Tool
Bar window and place it under the last
icon on the right.

For the exercises in this chapter, you
will also need the Delete tool.  It is on
a palette by itself.  Scroll the Tool
Palettes window to find it.  When you
do, drag it in the Tool Bar window as
you just did with the other tool palette.

You have just added the palettes shown to the left.  You may
tear them off to make the tools more accessible as you proceed
with the exercises in this chapter.  Your screen should now look
as shown below.
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6.1  Picking and unpicking objects

To have objects to pick, you will first generate two cuboids.

Turn on the Grid Snap.

• With 3D Extrusion and Rectangle selected, generate two
24' x 24 ' x 10'  cuboids as shown.

The topological level should be at Object.

With Pick tool click on a point/segment of the left cuboid.
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The object turns red indicating that it has been picked.  Picked objects are highlighted with the
highlight color, which is red by default, and can be changed in the Project Colors dialog
invoked from the Options menu.
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• Do exactly the same operation (click the mouse on the red
object), once again.  Your cuboid turns back to its original color.  You
have just unpicked the object.

• Pick both cuboids, one at a time.  They should both turn red.

Note that you were able to pick the second object while the first object was already
selected.  You did this without pressing the shift key, as other applications would
have required you to do.  In form•Z, by default, you can pick any number of objects
or parts of objects directly.  You do not need to press the shift  key.  However, if you
are used to using the shift key for multi-picking, there is an option in the Pick
Options dialog or tool palette (shown on the right) you can turn on.

• Click the mouse anywhere in the graphics window, away
from the two selected objects.
The system beeps, and both objects turn back to their
original colors.  You unpicked the objects.

Individual objects are unpicked by picking them again.  All picked objects are
unpicked by picking “blank” (clicking away from them).  When you do so, the system
warns you with a beep which can be turned off in the Pick Options dialog.  You can
also deselect all picked objects using the Deselect item from the Edit menu.

You can also pick all the objects in one step by drawing either a
rectangular frame or a lasso shape around them.  You select a
method from the Pick Options dialog.

• From the Pick Options palette select the Frame option.

With the Pick tool, place the mouse on 1, press the button,

drag it to 2, and release it.  Both objects turn red.
This selects all objects that are inside the frame.
There is also an option to Pick Crossing objects.

• Click anywhere in the window.  This deselects all objects.
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6.2  The topological levels

Tear off the Topological Levels tool palette, if not done earlier.

Notice that the Object level is selected, which allowed you to pick
objects in the previous examples.  You can click the mouse on any
of the icons to select another topological level.

Select the Pick tool.

Set the topological level to Point.

• Click on point 1.
The point is highlighted with a small red cross indicating it
is picked.  The program picks the point closest to the click,
provided it is within a distance that is called tolerance.

Set the topological level to Segment.

• Click on point 2, which is on a segment of the right object.
The segment highlights to indicate that it is selected.
The point you picked earlier has remained picked, which
shows that entities at different topological levels may be
selected at the same time.

• Clear the picks (click anywhere in the window).

Set the topological level to Outline.

• Click on points 3 and 4.
The outline on the front of the cuboid to the right is
highlighted, indicating that it has been selected.

Set the topological level to Face.

• Click on points 5 and 6.  A face on the left cuboid highlights.
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The faces and the outlines require two clicks to be picked when the On Edges option (default) is selected in the Pick
Options dialog for picking faces, outlines, and holes.  If the Inside Boundaries option is selected, they can be picked
by clicking once inside their boundary.  While the latter method is frequently more convenient, the former is more general.
It allows you to pick faces and outlines anywhere.  The one point selection method can only pick front facing faces and
outlines.  Note that the two methods may be available independently or simultaneously.  Also note that similar methods
are available for picking complete objects.

On a cuboid, you cannot tell the difference between a face and an outline, because the two coincide.
That is, all the faces of the cube consist of a single outline.  In such cases, it may not really matter
which one you pick.  It does make a difference for objects that include holes, such as enclosures.
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To better show the difference between picking a face and picking an outline, generate two 3D
enclosures in front of the cuboids, roughly as shown.  The colors of the cuboids have also been
changed to a light gray to focus attention on the 3D enclosures.  Since we have not yet covered
the Color tool, do not worry about the color change.

Holes and volumes are picked by clicking on an outline that is an inner outline of a face (hole).  With the topological level
set to Hole/Volume, try to click on other segments of a hole to verify where it can and where it cannot be picked.

You may next also want to try the one point selection method, as it applies to faces, outlines, and holes.  In the Pick
Options palette select Inside Boundaries.  Clear the previous picks.  After setting topological level to Face, Outline,
and then Hole/Volume, click inside the respective entities and observe which you can and which you cannot pick.

There is also a topological level called Automatic and, as its name indicates, it is intelligent and
automatically switches from one level to another on the base of the entity the mouse cursor is the
closest to.  You will try the Automatic level next.

Set the topological level to Outline.

• With the Pick tool still selected, click on points 1 and 2.
The inner outline of the top face of the enclosure to the right
is highlighted.

Set the topological level to Face.

• Click on points 3 and 4.  Both outlines of the top face of the
enclosure to the left are highlighted.

Next you will pick the 3D holes in the middle of the enclosures.

• Clear the picks (click anywhere in the window).

Set the topological level to Hole/Volume.

• Click on point 5 (enclosure to the right).  The 3D hole in the
middle of the enclosure to the right is highlighted.

• Click on point 6 (enclosure to the left).  The 3D hole in the
middle of the enclosure to the left is highlighted.
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Set the topological level to Automatic.

• In the Pick Options palette turn on Show Pick Cursor.
• Move the cursor close to point 1.  Changes to .
• Move the cursor close to segment 2.  Changes to .
• Move the cursor on top of face 3.  Changes to .
• Move the cursor close to a segment or point of object 4,

as you press option (Macintosh) or shft+ctrl (Windows).
Changes to , indicating that it picks an object.
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6.3  Prepicking and postpicking

The Pick tool is used for the prepick method.  By this method, any number of objects (or entities
at any topological level) may be picked, independently of the tool that will be applied to them.
Actually, the program has no idea what tool will be applied when the entities are picked.  For most
operations, prepicked entities remain selected after an operation has been applied to them, which
allows multiple operations to be applied sequentially to the same set of prepicked entities.

With the postpick method, a tool (other than the Pick) is activated first, and then the entity to which
the tool is to be applied is picked.  For a variety of operations the immediacy of the postpick method
offers considerable advantages.  On the other hand, the prepick method allows a tool to be
applied to more than one entity at a time, which is not possible with the postpick method.

You will try both methods using the Delete tool.  The four objects you created previously should
still be displayed on the screen.

• Clear the previous picks.  (With the Pick tool active click anywhere in the graphics
window.)

Set the topological level to Object.

Select the Pick tool (if not already selected).

• Pick three of the objects (click on them).

Select the Delete tool.

• Click anywhere in the graphics window, away from any of the objects.
The three objects you selected disappear.

Next you will use the postpick method.

Make certain that the Delete tool is still selected.

• Click on the remaining object.
It also disappears.  Your project is now empty.

You have just learned one more method for deleting objects and for clearing your project.

When you have prepicked one or more objects, pressing the delete key on your Macintosh
keyboard or backspace on Windows produces the same result as using the Delete tool.
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6.4  Transforming objects with the Pick tool

There are special tools with which you can move, rotate, resize, and mirror objects.  These
operations are more specifically called geometric transformations and are covered in the next
session.  However, the option to also execute geometric transformations with the Pick tool is
available in the Pick Options dialog and you will do a few examples in this section.

-x

+x

-y

+y

-z

+z• Draw a few objects, roughly as shown.
The cube, cone, and cylinder were drawn as
primitives (with tools on the 1st left palette).
The 3D enclosure was drawn with the Rectangle
tool and the 3D Enclosure modifier.

With Pick tool active, in its tool options palette, turn

on the Click And Drag option.
Then click on 1 and drag the mouse to 2.
Next, click on 3 and drag to 4.

As you click on an object, it is highlighted, and as you drag
the mouse it is rubber banded until you release it.  Where
you release the mouse button, the object is moved.
Note that, in our image, we show a gray copy of the object in its original
position.  This is simply for illustration purposes.  No object is left behind
after it is moved with the Pick tool.  The ability to move a copy of an object
is available when using the Move tool (see next session).  Also note that
here you click and drag, which is different from how you will be executing
the geometric transformation tools, where you click and click again.

• With the Pick tool active click on 5 and, while
pressing ctrl (Macintosh) or ctrl+alt (Windows),
drag to 6.  Observe how the enclosure is rotated.

• With the Pick tool click on 7 and, while pressing
option (Macintosh) or ctrl+shft (Windows) drag to 8.
Observe how the cone is resized.

You will next move parts of objects:

Set the topological level to Segment.

• With the Pick tool click on 9 and drag to 10.

Set the topological level to Point.

• With the Pick tool click on 11 and drag to 12.
You have moved a segment of the cube and a point of the
enclosure.
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6.5  Editing parametric objects

You will next use the four objects of the previous section to do some examples with parametric
editing.  Undo twice to return the cube and the enclosure back to their original shapes (with none
of their points or segments moved).  For editing you will use the Edit Controls tool, which is a
special type of a picking tool and is found next to the Pick tool.  In the following images we show
the objects one at a time for better visibility.

1

3

2

7

6

With Edit Controls tool click on the cube.

The cube is redrawn with some arrows, which repre-
sent the parameters that can be edited.  The arrows
can be moved to graphically change the parameters.

• Click on arrow labeled 1 and drag it outwards.
This changes one of the dimensions of the cube, as shown.

• Click away from the cube twice.
This hides the arrows and redraws the cube as it has been resized.

• With the Edit Controls tool still active, click on
the enclosure.
It is redrawn with two arrows, one for its wall
width and another for its height.  They can both
be changed graphically.

• Click on the arrow labeled 2 and drag it inwards.  Observe how the wall width changes.
• Click on arrow 3 and drag it down.  This changes the height of the enclosure.
• Click twice away from the enclosure to complete the operation.

• With Edit Controls still on, click on the cone.
• Click on arrow 4 and drag it outwards.

Observe how the base of the cone is enlarged.
• Click on arrow 5 and drag it outwards.

The cone is transformed to a truncated cone.
• Click away from the cone to hide its arrows.

• Click on the cylinder.
• Click on arrow 6 and drag towards the left.

The cylinder “opens”, as shown.
• Click and drag arrow 7 upwards.

The height of the cylinder changes.

All kind of parametric objects can be edited with the Edit Controls and
also with the Edit Surface tool, which is next to the former.  More
examples will be given later in this Tutorial.

4

5
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7  Moving, rotating, sizing, and mirroring objects

The position of an object or its parts can be changed by applying one of the geometric
transformations that you will learn in this chapter.  Objects can be moved, rotated, sized
(scaled), and mirrored (reflected) in 3D space.

The geometric transformation tools are affected by two sets of modifiers:  the topological levels
you learned in the previous chapter and the self/copy modifiers.  The latter determine whether
a transformation is applied to the object itself or to one or more copies of the object.  The geometric
transformations are the only tools that make use of two types of modifiers.

To do the examples in this chapter you will need to reintroduce a few tools that are not currently
in your tool bar.

• Launch form•Z.

Turn on the Grid Snap.

• Click on Customize Tools... (Pal-
ettes menu) and bring into your tool bar the
following tool palettes:

•Self/Copy modifiers:
•Geometric Transformations:

Note that the last icon of the Self/Copy and the four icons
on the right end of the Geometric Transformations palette
were removed before bringing them into the tool bar.

You may next want to tear off some of your tool
palettes, as we show to the right.

• Generate a 24' x 24' x 10'  cuboid and
a 3D enclosure the same size.
Position them roughly as shown.

Note that both of these are facetted objects.
For the first part of this chapter you will use the
prepick method to move objects and their
parts.
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7.1  Moving objects

Set the topological level to Object.

Select the Pick tool and click on the cuboid.

It turns red indicating that it has been prepicked.

Select the Move tool, click on 1 and move the mouse.

As the mouse moves the cuboid is rubber banded and follows the motion.
• Click at about point 2.  The cuboid is moved by the distance between points 1 and 2.

Note that in our images the original position of the cuboid  is shown in light gray.  However,
when you execute the example, you will see nothing there.  When you move an object,
nothing is left in its original position unless you make a copy, as you will a bit later.

After all the moves that you may have applied, the cuboid will remain highlighted and selected unless, of course, you
accidentally unpicked it.  If you did, pick it again.  Then, also pick the 3D enclosure.  Both objects are now shown in red.
Apply the Move tool a few times, as you did above.  The two objects move together.

All the moves you executed so far have kept the bases of the objects on the XY plane, which is
the active plane.  You can also move objects in other directions, as you will do next.

• Undo as many times as necessary to return the objects
to the original positions.

Select the Perpendicular switch tool.

This tool locks your motions to a direction perpendicular to
the active reference plane.

• The two objects must be picked.  If not, pick them.

With the Move tool click on points 3 and 4.

Your two objects have been moved down.  If  you are not
sure where they went, select View: Front to see them.
Then select View: z=30°  x=60°  again.

• Undo to return the objects to the original positions.

Deselect the Perpendicular switch.

Select the YZ reference plane

• The two objects must be picked.  If not, pick them.

Select the Move tool and click on points 5 and 6.

Your objects moved parallel to the YZ plane.
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7.2  Reading the 3D space

If your prior experience with 3D modeling is limited, you may wish to practice
the visualization of 3D space through the inherently 2D screen.  As the
following examples will show, displays are sometimes illusory.

• Return the objects to their original position by undoing as many
times as necessary.

Select the XY Reference Plane

Make sure that the Perpendicular switch is off.

• Pick the objects.

With the Move tool active click on points 1 and 2.

The objects appear to move down and away from the XY plane,
when in fact they have remained on that plane.

• From the Views menu, select Top view, then Front view.
This must have eliminated any doubts about where the objects are.

Next, you will repeat the operation with the Perpendicular switch on.

• Undo, then select View: z=30°  x=60° .

Turn on the Perpendicular switch.

With the Move tool active click on points 1 and 2.

• From the Views menu, select Top view, then Front view.

You will notice that in the 3D view the positions of your objects in the last two
examples appear to be identical.  However, when you displayed the Top and
the Front views, it was obvious that, in the most recent example, your
objects had moved in different directions than in the previous example.

Even users with extensive 3D modeling experience may occasionally misread the 3D space.
You may sometimes want to move an object up and you simply forget to turn the Perpendicular
switch on, or you may intend to move along a plane and forget to deselect the Perpendicular
switch.  The image appears as if the system had executed what you had in mind, but in fact it
did not.  If not careful, sooner or later you will discover that your object is not where you think.

Sometimes it is appropriate to view a model from different positions simultaneously, in order to
read it accurately.  This can be done by opening more than one associated window in the same
project.  You can open these one at a time, or you can pull out the Tile Windows submenu
(Windows menu) and select Open.  It subdivides the screen into four quadrants and uses them
for different views. Whatever operation you execute in one window is also reflected in all the
others.  Alternatively you can invoke the Window Frames.  These appear similar to the tile
windows but are viewports on a single window and allow continuous drawing between them.
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7.3  Moving entities at different topological levels

In this section you will learn how to move parts of objects, or entities
at topological levels other than Object.   We will use a single object
to make the result of the operation more clearly visible.  Execute the
Clear command (from the Edit menu) and regenerate the cuboid
roughly as shown.

Keep the Perpendicular switch on.

Select the Move tool.

Set the topological level to Point.

• Click on point 1, then on 2.
• When a message asks you whether the object should be

converted to a plain object, say OK.
You have moved a point up.

The objects you have in front of you are parametric or controlled objects.  Parts of
such objects can not be moved.  Parts can be moved if the objects are converted to
plain objects.  This can be done either by using the Convert tool or by responding
OK to the warning message, as you did above.

• Undo.

Set the topological level to Segment.

• With the Move tool active, click on 3 and 4.
You have moved a segment up.

Note that no warning was issued this time since the object is already plain.
• Undo.

Set the topological level to Face.  Make sure that the On

Edges option is on in the Pick Options tool palette.
• With the Move tool active, click on 5 and 6 and then on 7.

You have moved a face down.

You have just moved a point, a segment, and a face of your object, one at a time, using the postpick method.  You can
also use the prepick method to preselect all your entities, using the Pick tool with the appropriate topological level active.
You would then select the  Move tool and click the mouse twice.  The distance between your two click points would
determine where all your preselected entities would move.  Note that when you use the prepick method, all your entities
move with a single operation, and therefore, in the same direction and by the same distance.

Experiment with picking other combinations of entities, at different topological levels, and observe
how they behave when you move them together or individually.

Notice that, if a picked entity is contained within another picked entity of a higher topological level, such as a point being
contained in a segment, the lower level entity is ignored when a move or another geometric transformation is applied.

-x

+x

-y

+y

+z

-x

+x

-y

+y

+z

-x

+x

-y

+y

+z

-x

+x

-y

+y

+z

1

2

3

4

5

6

7



65form•Z Tutorial  •  Moving, rotating, sizing, and mirroring objects

7.4  Rotating objects

Next you will learn how to rotate objects.

• Undo.

Set the topological level to Object.

Turn off the Perpendicular switch.

Select the Pick tool.

• Select the cuboid.

We will use the prepick method, and you have just
prepicked the cuboid.  The execution of a rotation
requires three mouse clicks, as follows:

Select the Rotation tool (next to Move).

• Click on point 1, then on point 2.
Your cuboid is rubber banded and follows the
motion of the mouse.
The first click established the center of rota-
tion. The second click defined the beginning of
your rotation angle.  You can also think of the
second point as the “handle” that is used to
control the angle of the rotation.

• Click on point 3.
Your third click was after you rotated the handle
by about 45° counterclockwise. Right after that
click your cuboid was regenerated in its new
position and should be roughly as shown.

To use the postpick method, the Rotate tool is selected first, while no entities are prepicked.  Then
the  first click of the mouse is used to pick an object or a part of an object, depending on the active
topological level.  The selection of the entity is followed by the same three clicks used for the
prepick method.
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• Undo to return to the original object.
• Make sure the Grid Snap is on.

Keep the topological level at Object.

Turn off the Perpendicular switch.

• Pick the cuboid.

With the Independent Scale tool active click on 1 and 2.

Note that the line connecting 1 and  2 is parallel to the X axis.
As soon as you click on 2, the cuboid is rubber banded and,
depending on which way the mouse moves, it shrinks or
expands in the X direction.

• Click at about the position of point 3.
• To the warning message respond by clicking on OK.

This completes the scaling.  The result should be as shown.
The first click sets the base point of the scale. The second click defines the unit scale
(1/1) that is used to control the magnitude of the scaling factor.  You can think of the
second click as establishing a “handle” that controls the scaling factor.  Because
points 1 and 2 are in a direction parallel to X, scaling is locked to the X direction.

• Undo.

With the Independent Scale tool active click on 4 and 5 .

Note that 4 and 5 are now parallel to the Y  axis, which locks
the effect of the scaling operation to that direction.

• Click at about point 6.  To the message respond OK.
Because point 6 is between points 4 and 5, the object was
scaled down.  It was only scaled in the Y direction.

• Repeat exactly the same steps, but this time enter points 1,
2, and 3 as shown.

This time the first two points were along a diagonal, and therefore the scaling
operation was not locked to a single direction.  As your cuboid is rubber banded after
the second click, you can shrink and/or expand it in either direction simultaneously.
The position of the third click resulted in an object that was shrunk along X and
expanded along Y.  If you wanted to apply the same scaling in both directions, you
would have kept the third point on the diagonal, which is easier to do with snapping.

7.5  Resizing (scaling) objects
There are two tools which can be used to resize objects (and their parts): the Independent Scale
and the Uniform Scale tools.  They will both be illustrated in this section.  The Independent Scale
operator calculates and applies independent scaling factors in each of the directions of the axes
of the active reference plane.  To illustrate the effect of the independent scaling factors, you will
execute the operation four times.
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Next you will apply the Independent Scale tool with the Perpendicu-
lar switch on.

• Undo and turn on Scale by Percentage (Dynamic).

Turn on the Perpendicular switch.

• Pick the cuboid.

With the Independent Scale tool active, click on 4 and 5.

As expected, point 5 and the motion of the mouse are
constrained to the perpendicular direction.  With XY as the
current reference plane, scaling is locked to the Z direction.

• Click at about the position of point 6.
• To the warning message respond by clicking on OK.

The result should be as shown.

As you have been using the Independent Scale tool, we have paid
no attention to the content of the tool options palette.  If you look at
it now you will notice that two variations of the operation are
available and you have been using the default Scale By Per-
centage (Dynamic).  You will next try the other option.

• Undo enough times to return to the original object.
• In the options palette select Scale By Absolute Value.

With the Independent Scale tool active click on the object.

The Modeling Independent Scale dialog, shown to
the right, is invoked.  Its three  X, Y, and Z fields display 24’,
24’, and 10’.  These are the dimensions of your cube.

• Click on the lock option to turn it on.
Now all three fields display 24’, since they are locked to the
same value.

• Click on OK to exit the dialog.
• To the warning message respond by clicking on OK.

As soon as you do so the cube’s dimensions are adjusted
to the values in the dialog.  That is, the cube becomes
24’x24’x24’, as shown to the right.

You should have noted that there are two more options in the Modeling Indepen-
dent Scale dialog.  Apply To Each Selected Entity Individually becomes
relevant when the scale operation is applied to a group of objects.  An example is
included for the Uniform Scale, at the end of this section.  The Relative To
Reference Plane option affects the directions of the scaling.  When off, which is
the default, the directions are parallel to the Cartesian axes.  When on, they are
parallel to the axes of a possibly arbitrarily positioned reference plane, as we shall
see later in this tutorial.
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The Uniform Scale tool applies a uniform scaling factor to all the directions.

• Undo and for the Uniform Scale tool select Scale By Percentage.

Turn off the Perpendicular switch.

• With the Pick tool click on the cuboid to select it.
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With the Uniform Scale tool active click on points 7 and 8.  As the cuboid is rubber banded

after the second click, it shrinks or expands the same amount in all three directions.
• Click on 9.  The third click completes the scaling and regenerates the object.

Note that no warning message was issued this time since scaling a parametric object uniformly is quite acceptable.

The Uniform Scale tool is also affected by the same two options found in the tool options palette.

• Select Scale By Absolute Value and Undo.

With the Uniform Scale tool active click on the object.

This invokes the Modeling Uniform Scale dialog, which con-
tains a single Scale Size field.

• Enter 10’ in the Scale Size field.
• Click on OK to close the dialog.  Click OK again after the message.

The cube becomes 10’x10’x10’.

With the Uniform Scale tool click on the cube again.

• In the Modeling Uniform Scale dialog enter 24’ and click on OK.
The cube becomes 24’x24’x24’.

Next, you will use the Apply To Each Selected Entity Individually
option found in the Modeling Uniform Scale dialog.

• Draw three more cubes, roughly as shown to the right.
• Use the Pick tool to prepick them all.

With the Uniform Scale tool click anywhere in the project window.

• Enter 10’ in the Scale Size field.  All four cubes are scaled as a
group to a 10’x10’x10’ dimension, as shown to the right.

• Undo.  The four cubes should still be selected.

With the Uniform Scale tool click anywhere in the project window.

• Enter 10’ in the Scale Size field and turn on Apply To Each
Selected Entity Individually in the Modeling Uniform
Scale dialog and exit.
Each of the four cubes is scaled individually to a 10’x10’x10’ cube,
as shown to the right.
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7.6  Mirroring objects

You will next apply the reflection or mirror operation.

• Undo and pick the object.

Select the Mirror tool and click on points 1 and 2.

The first click establishes the base for the axis of reflection, which is rubber banded
together with the object.  As the mouse moves it either pulls the axis away from the base
point or rotates the axis around it.
The second click completes the operation.  The axis of reflection is perpendicular to the
middle of the line that connects points 1 and 2.

You have just used what is called the dynamic method for
applying the Mirror tool, which allows you to visually inspect
how your object is transformed.  The mirror operation can also
be executed in a direct manner, without dynamic rubber band-
ing.  Objects can be mirrored about points, segments, or
surfaces.  Which type to apply is selected from the Reflection
Options dialog or palette, shown to the right.

• In the Reflection Options tool palette,
select About A Point, and click on OK.

• Undo.
• Deselect the Cuboid.
• Draw a two segment line, roughly as shown.
• With the Mirror tool click on points 3 and 4.

Clicking on 3 picks the object.
Clicking on 4 makes this point the axis of reflection.
You have reflected your object about a point.

• Select View: Front.

You notice that your object has been reflected in all three directions, which
placed it on the other side of the XY plane.  Is this what you expected?  You can
also execute the point reflection and keep the object in a position parallel to the
reference plane.

• Undo.
• Select View: z=30°  x=60° .
• In the palette select Relative To Reference Plane.
• Repeat the operation (click on 3 and 4).
• Select View: Front.

Observe the difference from the previous operation.
• Select View: z=30°  x=60° .
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You will next execute reflections about a segment and
about a surface.

• Undo.
• In the options palette, select About A Segment

and deselect Relative To Reference Plane.
• With the Mirror tool active, click on points 5 and 6.

The object reflected about segment picked with  6.
• Undo.
• In the tool options palette, select About A Sur-

face/Plane.
• With the Mirror tool active, click on 5, 6 and 7.

You reflected the object about the surface defined
by the open line (which is on the XY plane).
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As was done with all the previous transformation examples, we have been showing the original
object in light gray.  In fact, as you have already noticed, this original object does not exist after
the execution of the Mirror operation.  We show it simply for reference.  However, you may be
wondering: what if I really want to keep the original object as well?  Especially with the mirror
operation, we frequently want to derive the mirror image of an object and keep both objects.  There
is a way to do this.
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+z• Undo.
• From the self/copy modifiers, select One Copy.
• Repeat the most recent operation

(with the Mirror tool, click on points 5, 6, and 7).

You notice that a reflected object has been created as
before, however, this is a copy of the original object, which
has remained in its original position.  We discuss the modes
available for copying in the next section.

As we demonstrated for the Move operation in section 7.3, all the transformations can also be
applied at topological levels other than Object; that is to points, segments, outlines, and faces.
You may repeat the exercises of section 7.3 with transformations other than Move.  If you do, set
the self/copy mode back to Self, since copying entities at levels other than Object is not a
meaningful operation.  Admittedly, applying transformations such as Rotate, Resize, and Mirror
to parts of objects will rarely make sense.  Yet, there are times when they prove very useful.  They
are certainly available.  It is up to you, the user, to decide when they might be used.
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7.7  Copying objects

When geometric transformations are applied to objects, they can be applied to the object itself,
as you have done in most of the examples so far.  You can also make one or more copies and
apply the transformation to the copies.  You made a copy when you executed the last mirroring
example in the previous section.  You tell the system to make copies by selecting the appropriate
self/copy modifier.

For the examples in this section you will use the Move tool.  Copies, repeated copies, and multi-
copies can also be made with the other geometric operations.  You should experiment by yourself
after you complete the examples we suggest.

Execute Clear (Edit menu) to start fresh and draw a 3D extrusion roughly as shown.  We made
the cuboid small to be able to fit more copies of it on the reference grid.

Set the topological level to Object.

Set the self/copy mode to One Copy.

Select the Move tool and click on point 1.

The color of the cuboid changes to red indicating that
it has been picked.  The object is rubber banded.

• Click on point 2.  A copy of the cuboid is placed there.
The original cuboid remains in its place.

Set the self/copy mode to Continuous Copy.

With the Move tool still active click again on 1.

• Then click on points 3, 4, 5, and 6.
At each position you click, a copy appears.

• Double click anywhere in the graphics window.
The double click stops the copying process.
The copies you made should be as shown.

Note that the One Copy operation made a single copy and stopped.  The Continuous Copy operation continues to make
copies and a double click is needed to terminate the copying process.  This is always true for the Move, Rotate, and Resize
operations.  The Mirror operation is an exception and, unless you use the dynamic method of mirroring, it will terminate
without a double click.  This is because additional copies would have coincided with the other copies, which would be
inappropriate.

When you use the dynamic method for mirroring (see previous section), with respect to copying, the Mirror tool behaves
as all the other transformation tools: you need to double click to terminate the copying process.  When you use any of
the other mirroring methods (about a point, segment, or surface), the Continuous Copy behaves like the One Copy
operation.  That is, only one copy is made and the copying process terminates.
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• Undo five times in a row to delete the
copies you made.

Set the self/copy mode to Repeat Copy.

The Move tool should still be active.

• Click on point 1 which is on the cuboid.
The cuboid turns red and is selected.
Your first click both picks the object and
establishes the initial point of the move.

• Click on point 2.
A copy appears where you clicked.
The positions of points 1 and 2 also
establish the distance that will be repeated
for positioning further copies.
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• Click the mouse three more times, anywhere in the graphics window.
Additional copies appear each time you click, but not where you click.  Your click signals
the system to make one more copy by repeating the distance of the first two clicks.

• Double click anywhere in the window.
No copy is made and the copying process stops.  Your copies should be as shown.

Set the self/copy mode to Multi-Copy.

Select the Pick tool.

• Select all five objects.
You can pick the objects one at a time or
you can select them with a frame or lasso.

Select the Move tool.

• Click on point 3, then on 4.
Six copies of the five cuboids are made
and the process stops.

• With the Pick tool click anywhere on the
window to deselect the objects that are still
selected.

• Select Display: Hidden Line*.

The result should be as shown.
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Unless you have taken a look at the Copy Options box in the tool
options palette, you may be wondering why the Multi-Copy
operation made six and not some other number of copies.  If you
look now you will see that there is a # Of Copies field whose
default value is 6.

You can change this number to make as many copies as you
desire.

The Even Increment option repeats the distance of the two input points, the same way the
Repeat Copy mode does.  When the Divide Distance option is selected, the distance between
the two input points is divided by the number in the # Of Copies field, and copies are placed
between the two input points at equal distances.

You will notice that, in the Multi-Copy group of options, under Divide Distance, the Big Angle For Rotation option
is available.  This applies to making multiple rotated copies only.  When you enter the two points that define the angle of
rotation, that angle may be interpreted to have one of two complementary values.  For example, it can be 37° or 323°.
When a single rotation is executed, it does not matter which angle is applied: they both produce the same result.  However,
when multiple copies are to be placed between the two click points, different results may be produced.  This option clarifies
whether the multiple copies will be placed along the small or large angle of rotation.

All the self/copy modes can be used with all the geometric transformations. Practice the geometric
transformations at all levels and with all the self/copy modes until you are comfortable with them.

Even Increment

Divide Distance

1      2         3

The options palette also offers a choice between Even
Increment and Divide Distance to determine how
the multiple copies are positioned relative to the points
where you click the mouse.  We shall illustrate the
difference using a 2D example.

• Clear.
• Select View: Top.
• Draw a rectangle, roughly as shown.

Whether it is a 2D rectangle or a 3D rectangu-
lar extrusion is unimportant since they will both
look the same in a top view.

• Set the self/copy modifier to Multi-Copy.
• Select the Move tool.
• Click on 1 and 2.  Observe the result.
• Undo.
• In the palette select Divide Distance.
• Click on 1 and 3.

Observe the difference from the previous.
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7.8  Numerically defined transformations
You can also apply geometric transformations by entering numeric parameters in the Prompts
palette.  You will do a few such examples next.  The Prompts palette should be displayed in the
lower left corner of your screen.  If not, select Palettes: Prompts to invoke it.

• Clear.
• Generate a cuboid roughly as shown.

Set the self/copy mode to Self.

The topological level should be at Object.

Use the Pick tool to preselect the cuboid.

Select the Move tool.

• In the Prompts palette deselect the box labeled “T”
to deactivate tracking.

• Move the mouse cursor in the Prompts palette so
that it stays idle and press return/enter.
Zeros are entered next to the first prompt.

• Type “100, 300” and hit return/enter.

Observe how the numbers you typed have been interpreted and are
displayed in the palette.  The numbers you type represent inches because
this is the unit selected in the Project Working Units dialog by default.
They are displayed in the Prompts palette using the architectural format.
Also observe how your object has moved.

• Undo.
• Your object should still be selected.

Set the self/copy mode to Continuous Copy.

• In the Prompts palette, click on the little box
labeled “A” to deselect it. Your coordinates will now
be in relative mode (rather than absolute mode).

The Move tool should still be selected.

• Type:  100, 100, and return/enter;
   50,   50, and return/enter;
-200, 200, and return/enter.

• Double click the mouse to terminate the process.
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Three copies of the cuboid have been made, one for each pair of numbers you entered.  Your numbers were interpreted
relative to the previously entered position.  Your starting position was at 0,0,0.
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• Undo.
• The object should still be selected.

Set the self/copy mode to Self.

Select the Uniform Scale tool.

• Hit return.
• Type “1.375” and hit return/enter.

As shown, your object has been scaled in all directions by
a scaling factor of exactly 137.5%.  Note that it is almost
impossible to apply such an exact scaling factor through
graphic input.

• Undo.
• Click on the “A” box (Prompts palette) to return to

absolute coordinates.  The “T” box continues to be
off.

• The cuboid should still be selected.

Set the self/copy mode to Multi-Copy, with

Even Increment selected in the Copy Options.

Select the Rotate tool.

• Hit return/enter  to enter 0,0,0
(center of rotation).

• Type “15” and hit return/enter.
Six copies have been made from your object, each
rotated by 15°.

• Undo.
• The object should still be selected.

Select the Independent Scale tool, with Scale

by Percentage selected in Scale Options.

• Press return/enter.
• Type “1.2, 0.8, 1.2”

and hit return/enter.
• To the displayed mes-

sage respond OK.
The result should be as shown
in both wire frame and hidden
line.
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8  Derivative objects

An object is called derivative  when it is derived from another, already existing object.  The most
common route for generating derivative objects is to first draw one or more 2D shapes and then
generate a 3D solid from them.  However, both surface and solid derivative objects can also be
generated from parts of other solids.

The derivative object generation tools are located on the fifth rows of the default modeling tool
bar.  The first five tools of the palette on the left column generate types of objects that can also
be created directly, as you have already done in previous sections.  They are the 2D Surface, 2D
Enclosure, 3D Extrusion, 3D Convergence, and 3D Enclosure.  Here you will learn how to
generate them from other objects.  The tools you need for the exercises in this chapter are not
currently in your tool bar and you need to reintroduce them.

• Launch form•Z.
• Click on Palettes: Customize Icons....
• To the tool bar, reintroduce the following

three palettes:

Derivatives 1:

Derivatives 2:

Ghost and Layers:

Note that even though these palettes include a few tools that will not concern us in this chapter,
they were left in the palettes.

You will also open the file you saved at the end of section 3.6.

• From the File menu select Open and in the File Open dialog that is invoked find project
“Shapes” and double click on it.  If you saved it with a different name, then find that name.

You may again want to tear off some of the tool palettes, as we show.  The shapes that appear
on the screen should be familiar to you since you drew them in earlier exercises.
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8.1  Derivative 3D objects

• Select Height:10'-0", if not already selected.

Select the Derivative Extrusion tool.

• Click on shape A.  Observe the result.
• Click on shapes B, E, F, G, and I.

Surface objects are generated from shapes A
and B.  True solids are generated from shapes
E, F, G, and I.

Select the Derivative Convergence.

• Click on shape C.
A pyramid is created from shape C.

Select the Derivative 3D Enclosure .

• Click on shapes H and J.  3D enclosures are
created from the 2D enclosures.

Are the derivative objects you just created smooth or facetted?
Some are facetted and some are smooth.  The rule here is that they
are of the same type as the objects they are generated from.  Thus
objects A, B, C, F, and G are facetted.  E and I are smooth.

Finally, to complete this example, you will derive a revolved object
from the arc (shape D).  Such objects can only be created as
derivative objects.  That is, they cannot be generated directly.  An
exception to this is the sphere, which can also be generated directly.

Select the Revolve tool.

• Click on D (point 1) and then on the Y axis (2).
The arc (semi-circle) is rotated around the Y
axis creating the shown ball.

• When the Revolve Edit dialog is invoked,
click OK.

• Select Display: Hidden Line*.
You can now see your objects better.

Note that the revolved sphere is a facetted object even though the arc
that was revolved is a smooth object.  Contrary to the extrusions the
revolved objects do not follow the type of their source, but their dialog
contains an explicit option, which is set to Facetted by default.  This
caused the sphere to be a facetted object.  Also note that the arc that
was revolved had its end points exactly on the axis of revolution,
which resulted in a solid sphere.  If they were not on the axis, a
surface object would have been created.
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8.2  Ghosted objects

The surface objects that were used for the derivative objects
were ghosted after the completion of the operation.  In the
previous example this was not visible, since the surface objects
were covered by the new 3D objects.  However, if you move the
new objects you will see that the colors of the original objects
have changed to gray, the default color for ghosted objects.

The ghosted objects remain, but become inactive and cannot be selected for the execution of
another operation.  As you will see shortly, there is a tool that you can use to unghost them.  When
you do, they return to an active status and are displayed in their original color.

Whether an object used in an operation is ghosted or not depends on the settings in the Status
Of Objects tab found in many dialogs or options palettes.  The other options available are Keep
(which does nothing to the object) and Delete (which deletes it from memory).  The Status Of
Objects palette appears whenever a tool that is affected by its options is active.

You can also ghost and unghost objects yourself, using the respective tools.   You will try them next.

• From the Display menu, select Wire Frame*.
• From the Edit menu, select Select All UnGhosted.

You have prepicked all the active objects.

Select the Ghost tool.

• Click anywhere in the graphics window.
All your objects turn gray.

• Select the Pick tool and click on any of the
objects, trying to select it.
You cannot select any ghosted objects.

Select the Unghost tool.

• Click on the sphere.
It is unghosted and recovers its color.

• Open the Wire Frame Options dialog
and (in its Wire Frame tab) select Hide
Ghosted. The ghosted objects disappear.

• Deselect Hide Ghosted.
The ghosted objects reappear.

• From the Windows menu click on the Window Setup... item to invoke the  Window
Setup dialog, and turn off the grid and the axes.

• From the Display menu select Hidden Line*.
Only the sphere, the only unghosted object, appears.  Ghosted objects are shown only
when wire frame plotting is used and the Hide Ghosted item is deselected.
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8.3  Derivative objects from parts of other objects

Parts of objects, such as segments and faces, can also be used as source shapes for the
generation of other objects.  We will do a few examples.

• Select Display: Wire Frame*.
• Select Windows: Window Setup...

and turn the grid and the axes back on.
• Clear and Clear All Ghosted.

Make sure the XY Reference Plane is

active.
• Draw four 16' x 16' x 10'  cubes, roughly as

shown.

Set the topological level to Segment.

Select the Derivative Extrusion tool.

• Click on point 1 of object A.
The segment picked by point 1 is extruded
at its place, deriving a new object that is a
surface object.

Set the topological level to Face.

• Select the Pick tool to display the Pick
Options in the tool options palette.

• In it turn on the Inside Boundaries
option.

With the Derivative Extrusion tool pick the

top face of cube B (click on 2).
Observe the result.

Select the Derivative Convergence tool and pick the top face of object C (click on 3).

Select the Derivative 3D Enclosure tool and pick the top face of object D (click on 4).

The objects you generated should be as shown, except that we also turned the grid and axes off.

After the execution of each derivative object generation operation, the object that was used for
the generation was ghosted.  This is consistent with what we discussed in section 8.2.
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• Clear and Clear All Ghosted.
• Select 20' - 0" from the Heights menu.
• Generate four rectangular pyramids as shown.

You generate them by selecting the 3D Convergence
modifier and using the Rectangle tool to draw their bases.

The topological level should be at Face.

The XY Reference Plane is selected.

With the Derivative Extrusion tool active click

on 1 to pick one of the side faces of pyramid A.
The face is extruded in a direction perpendicu-
lar to the XY reference plane.

Switch to the YZ Reference Plane.

• Click on 2 to pick the side face of pyramid B.
The face is extruded perpendicular to YZ.
Compare the results of the operations.

• In the tool options palette where the
Extrusion/Convergence Options are
shown, select Perpendicular To Surface.

• Click on 3 to pick a side face of pyramid C.
The face is extruded perpendicular to its plane.

Select the Derivative Convergence tool and

click on 4 to pick a side face of pyramid D.
The face is extruded to a point in a direction
perpendicular to its own plane.

The last four examples showed you that extrusions can be generated
in directions which are perpendicular either to the reference plane or
to the plane of the shape that is extruded.  Which direction applies is
determined by an option selected in the Extrusion/Conver-
gence Options tool options palette.
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8.4  Derivative objects from complete objects

Derivative objects can also be generated from all the faces of an object, through the execution
of a single operation.  Let us do a few examples.

• Clear and Clear All Ghosted.

Select the XY Reference Plane.

• Set the active height to 10' - 0"
(Heights menu).

• Generate three cubes and a pyramid,
roughly as shown.

• Set the active height to 4' - 0"
(Heights menu).

• The Perpendicular To Surface option
should still be on in the Extrusion/Con-
vergence Options tool palette.

Set the topological level to Object.

Select the Derivative Extrusion tool and

click on object A.

Select the Derivative Convergence tool

and click on object B.

From the faces of the remaining two objects you will generate 3D enclosures.  To avoid
intersections, you will first make an adjustment to the Justification option.

Select the Derivative 3D Enclosure tool.

• In the 3D Enclosure Options dialog displayed in the tool options palette select
Left for Justification and in the Enclosure Wall Width field enter 2’.
You are using a 2 feet width simply to make the result more readable.

With the Derivative 3D Enclosure tool active click on object C, then on object D.

• Select Display: Hidden Line* to see your objects better.
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8.5  Derivative surface objects

The first two tools in the Derivative tool palette generate surface objects from other objects.  They
are mostly executed as all the other derivative tools, but also have their own unique ways.

The Derivative Surface Object tool can be used at the Outline or Face topological levels to “copy”
the shape of an outline or a face and to create an object from it.  At the Object level, the tool can
be used to create a surface object from each face of a solid.  This result can be thought of as
“exploding” the faces of an object.  It will be illustrated by the example you will do next.

• Select Wire Frame*, Clear, and Clear All Ghosted.
• Select the 3D Extrusion tool and, in its options palette,

select Perpendicular To Reference Plane.
• Use the Rectangle tool to generate a 32' x 32' x 10' cuboid.

Set the topological level to Object.

With the Derivative 2D Surface tool click on the cuboid.

Even though there is no visible result, there is now a surface
object on each of the faces of the cuboid.
To see them, you need to move the new objects.

Select the Move tool.

Set the self/copy mode to Self.

• Pick each of the surface objects and move them to some
other position, roughly as shown.

Next you will repeat the operation with 2D enclosures.

• Undo as many times as necessary to return to the original
32' x 32' x 10' cuboid.

Select the Derivative 2D Enclosure tool and in the tool
options palette select Left for Justification.
Then, with the tool active, click on the cuboid.
A 2D enclosure is generated for each face of the cube,
which makes it look like a “beam” structure.
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There are additional types of derivative surface objects that can be generated using the Derivative
2D Surface tool.  These types are selected from the dialog or tool options palette of the tool.  They
are discussed in UM subsection 4.5.2.
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8.6  Parallel objects

The Parallel tool can be used to generate objects
parallel to other objects.  These objects can be gener-
ated on either one or both sides of the original object,
which can be a solid, a surface solid, a closed surface
shape, or an open line.  While some of the parallel
objects resemble the enclosures, they are quite differ-
ent as the examples you will do next will show you.

• Clear and Clear All Ghosted.

The XY Reference Plane should still be on.

• 20' is selected in the Heights menu.
• Draw four objects roughly as shown.

A is a rectangular extrusion,
B is a converged rectangle,
C is a 2D rectangle, and
D is an open vector line.

They are all drawn on the XY plane.

Select the Parallel tool and click on object A,

then B, C, and D.  Observe the results.
• Note that Single Parallel and Out are on in

the Parallel Options displayed in the tool
options palette.

• Select Double Parallel and Center.
• Undo four times.

With the Parallel tool active, repeat the previ-

ous operation and click on A, B, C, and D.
Observe the results.

From a practical point of view, the Parallel tool is very
useful when applied to meshed surfaces.  However,
the generation of these objects has not yet been
covered.  You can find examples of parallel meshes in
UM subsection 4.5.5.
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8.7  Unfolding objects

The facets of objects can be unfolded to continuous patterns
projected on the reference plane.  This is done with the Unfold tool,
which is always applied at the Object topological level.  However,
the segment on which you click to select the object for unfolding is
significant as it determines the flow of the unfolding process.

To do a few examples, Clear and Clear All Ghosted and then
generate the three objects we show.  The sphere is the revolved
object we did earlier in this chapter (section 8.1).

The XY Reference Plane is on.

Select the Unfold tool and click on 1 of object A.

Observe the result.
• Undo.

With the Unfold tool click on 2 of B.    Observe the result.

• Undo.

With the Unfold tool click on 3 of C.    Observe the result.

• Undo.

With the Unfold tool click on point 4 of object C.

Observe that a different pattern has resulted.
This is because the unfolding process starts with the
segment where you click and unfolds from there.
Consequently, if you start with a different segment a
different pattern will be generated.

If you have difficulty reading exactly where on the sphere we mark the points to be
clicked, no need to be concerned.  Simply click on different segments and observe
that different patterns are generated.  Actually, you may wish to try more than the two
we show for the sphere.

The Unfold tool is affected by options displayed in the tool options
palette, when the tool is active.  These include the option to also
attach extensions to the open edges of the unfolded pattern, called
connectors.  These allow you to glue the open edges back
together, after the pattern is re-folded to construct a physical model.
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Meshed
terrain model

9  Terrain models

A terrain model is a derivative object that is generated from contour lines and a site.  The contour
lines are open or closed shapes that can be created as surface objects in form•Z, or they may
be drawn in some other application and imported into form•Z.  In practice, they are typically
derived from spot elevations that are measured on the land by surveyors through the use of
special instruments.  The site is always a closed shape and it may be an independent surface
shape or the face of an object.  Three types of terrain models can be created:  mesh, stepped,
and triangulated contour models.  In this section you will generate one of each, using the same
set of contour lines and site.

• Launch form•Z.

Use the Vector Line tool to draw a site and seven contour lines, roughly as shown.

Activate the Terrain Model tool and in the Options tab of the Terrain Model Options

palette that appears select Set New.

With the Pick tool active select the contour lines in the order shown (1 through 7).

With the Terrain Model tool active click on p to select the site.

You have just created a meshed terrain model  that should be as shown.

contour lines

site

p

7 6 5 4        3    2          1
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Stepped
terrain model

Triangulated
contour
terrain model.

You used the default 8' x 8' size for your mesh grid (see the
Mesh Options tab on the right). The direction of your
mesh was determined by the segment where you clicked to
select the site (p).  When you drew the contour lines, they
were all at elevation 0. You told the program to automati-
cally assign heights to them before using them to generate
the terrain model.  You did this by selecting the Set New
option, above.  The system used the default increment of 4'
and assigned heights progressively in the order in which
you selected the contour lines.  You can select parametric
values other than the defaults from the Terrain Model
Options palette displayed on the screen when the Terrain
Model tool is active.

You will next repeat the operation two more times using
exactly the same options, except for the type of model.

• In the Terrain Model palette select Stepped
Model.

• Undo.

Activate the Pick tool and pick the contour lines as

before.

With the Terrain Model tool active click on the site.

You have just created a stepped terrain model
that should be as shown.

• In the Terrain Model palette select
Triangulated Contour Model.

• Undo and repeat the operation, as above.
You have just created a triangulated contour
terrain model that should be as shown.

Terrain models can also be generated on faces of solids
and the three types can be mixed, allowing the incorpora-
tion of landscape features such as roads and flat areas.
You will do a more involved example which illustrates some
of these features in section 37, later in this Tutorial.
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10  Objects of revolution

You have already generated an object of revolution, a sphere, in section 8.1.  You did it by
selecting a semi-circle (called the source shape), and the Y axis (called the axis of revolution).
The source shape was revolved (rotated) about the axis of revolution and, since the end points
of the semi-circle were on the axis, a sphere was constructed.  This derivation process is typical
of all the objects of revolution.  However, some variations apply to the different types of objects
of revolution.  In this chapter you will do examples of most of them.

form•Z generates six types of objects of revolution, namely lathed or revolved objects, surface
or solid helixes, wire helixes, wire helixes from paths, screws and bolts, and spiral stairs.
These types are generated with four different tools, three of which are discussed in this chapter.
The Spiral Stair tool is discussed in the next chapter.

• Launch form•Z.

The tools you will need are already in the tool bar, in the tool palette labeled Derivatives 2.
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10.1  Lathed objects

The sphere you generated in section 8.1 was a lathed or revolved object.  You will do a few more
such objects in this section.  Depending on how the source shape is positioned relative to the axis
of revolution, different types of lathed objects are generated.  When an open source shape is used
and its endpoints are exactly on the axis of revolution, a “ball” type of object (closed topology) is
created.  When the source shape is open or closed and at some distance from the axis of
revolution, then a “doughnut” type of object (torus) is created.
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Select the ZX Reference Plane.

Turn on the grid snap.

• Draw the 2D shapes shown.

Shape A is open with its endpoints on the Z
axis.  You can draw it with the Vector Line tool.
Shape B is a closed diamond, at some dis-
tance from the Z axis.  It can be drawn with the
Polygon or Vector Line tool.

Select the Revolve tool and in the tool

options palette turn on Adjust to
New Parameters and turn off Edit.

• Click on object A, then on the Z axis.

B

A

• Click on object B, then on the Z axis.

Closed source shapes for the lathed objects cannot cross the axis of revolution.  Only the first and last segments of open
sources can cross the axis.  When they do, they are trimmed at the points where they intersect the axis.  While the program
is quite permissive, the lathed objects work best when the source shape and the axis of revolution are on the same plane.

If you look at the Options tab of the Revolve Op-
tions tool palette when the Revolve tool is active,
there is a Facetted and a Smooth option.

• Turn on Smooth and Construct As Nurbz.
Edit should still be off.

• Undo twice and reexecute the two
revolutions, as you did above.
Your objects now look different, as on the right.

You have just demonstrated to yourself that revolved
objects can be generated as facetted or smooth
objects.  The latter can be smooth revolved or nurbz,
which is what you have generated.
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The lathed objects you created so far were produced by
revolving the source shape a complete cycle of 360°.  You can
also generate partially revolved lathed objects. Furthermore,
all the objects you created so far were revolved about one of the
Cartesian axes.  Objects of revolution can also be derived by
rotating the source shape about any line.

• Clear and Clear All Ghosted.

Select the XY Reference Plane.

• Select View: z=45°  x=45° .
• Draw an arc (half a circle) and a line, as shown.

Select the Revolve tool and in the Options tab of the

Revolve Options palette turn on Facetted, enter
225 in the Revolution Angle field (Facetted Op-
tions), and select Clockwise for Direction.

• With the Revolve tool active click on 1 (to select the
arc), and then on 2 (to select the Y axis).

• Select Display: Hidden Line*.
Observe that a 225° revolution is executed and that a
partial sphere is generated.

• Select Display: Wire Frame* and Undo.

Select Counterclockwise for Direction and with

the Revolve tool click on 1 and 3 to select the arc and
the line respectively.

• Select Display: Hidden Line*.
Observe how the same source shape was revolved
about an axis which was not one of the Cartesian axes.
Also notice that the object generated is not a solid
object.  It is a surface object.

• Select Display: Wire Frame* and Undo.
• In the Revolve Options palette, select Per Angle

from the pop up menu next to the # Of Steps field.
• Repeat the most recent operation

(with the Revolve tool click on 1 and 3).
• Select Display: Hidden Line*.

Observe that a denser lathed object is generated,
because of the Per Angle option.
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The Options tab of the Revolve Options dialog contains the # Of Steps field which
determines how many times the source shape will be revolved.  In our examples, we have
been using the default value 16.  When Total is also selected, the 16 steps refer to a
complete revolution (360°), and when we revolve by only 225°, the number is adjusted
proportionally and 10 steps are applied.  When Per Angle is selected, then the 16 steps
are applied to the chosen angle by which the source shape is revolved.

We shall next see how the angle of revolution and other parameters can
be set graphically.  This is possible because the objects of revolution are
parametric objects.

Select the Edit Controls tool and with it click on the revolved

object.  Arrows appear for its parameters.
• Click on the arrow labeled 1 and drag it circularly to close

the arc that was used as source shape for the revolution.
The result should be as shown.

• Click on arrow 2 and drag it circularly about the axis of revolution.
Observe how the shape closes and becomes a solid torrus.

You will do one final example with lathed objects to illustrate the Join
Adjacent Coplanar Faces option available for facetted revolved objects.

• Select Display: Wire Frame*.
• Clear and Clear All Ghosted.
• Draw two squares roughly as shown.
• In the Revolve Options palette enter 360° in the

Revolution Angle field.

With the Revolve tool active, click on 1 to select the square and

then on 2 to select the X axis.
Observe the result.

• In the Revolve Options palette now select Join Adjacent
Coplanar Faces.

• With the Revolve tool click on 3 and 2.
• Select Display: Hidden Line*.

Observe the difference between the two lathed objects.  Copla-
nar faces are generated when the source shape has segments
which are perpendicular to the axis of revolution.  As you have
just experienced, you can tell the program to join such coplanar
faces into one.

Note that the Join Adjacent Coplanar Faces option is only available
in the Facetted Options group and is not available for smooth objects.
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10.2  Helixes

Three different types of helixes can be generated: solid or
surface helixes, wire helixes about an axis, and wire
helixes along a path.  You will do examples for each type.

• Select Display: Wire Frame*.
• Clear and Clear All Ghosted.

Select the ZX Reference Plane.

• Draw a hexagon and a single segment line, as shown.
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Select the Helix tool and

in its options palette set
these:
Facetted is on;
# Of Steps = 36;
# Of Cycles = 3;
Direction =

Clockwise.

In addition to these values, note that in the Helix Options palette,
Length is 20' and the pop up menu next to it reads Total.  Likewise the
pop up menu next to the # Of Steps field reads Total.  Thus the total
height of the helix will be 20’ and the complete helix will have 36 steps.  This
means there will be 12 steps per each of the three cycles.  A cycle is  360°.

With the Helix tool active, in the tool options palette

turn off Edit and click on the hexagon and the Z axis.
A solid helix is generated.  It was derived by revolv-
ing the source shape 36 times, each time by 30°.

Again with the Helix tool, click on the single seg-

ment shape and on the Z axis.  A surface helix is
created with the same parameters.

• Undo twice.
• With the Helix tool active, click on the hexagon and

then on the X axis.  Note that this is a different axis.
• Click on the single segment and the X axis.

Observe the results.
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• Undo twice and in the
Helix Options palette:

select Scale Source,
in X and Y enter 0.1.

If Lock is on, you only
need to enter 0.1 once.

With Helix tool click the

hexagon and the Z axis.
Observe the result.

You will next repeat the generation of these helixes by
applying rotations and scalings to the source and path shapes.
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• In the Helix Options palette:
deselect Scale Source,
select Rotate Source,
and enter 5 in the field under it.

• With the Helix tool click the single segment shape
and the Z axis.  Observe the results.

• Undo twice.
• In the Helix Options palette:

deselect Rotate Source,
select Scale Source and Scale Path,
and in the Width field enter 0.1.

• With Helix tool click the hexagon and Z axis.

• In the Helix Options palette:
deselect Scale Path,
select Scale and Rotate Source.

• With the Helix tool active, click on the single line
shape and on the Z axis.

• Undo twice.
• In the Helix Options palette:

deselect Rotate Source,
select Scale Path,
Width value should still be 0.1,
in Scale Path Length field enter 0.75,
in Length field enter 60',
for # Of Steps enter 144, and
for # Of Cycles enter 12.

• With the Helix tool click on the hexagon and then
on the X axis.
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You will next generate wire helixes about an axis of revolution.  Note that the axis of revolution
can be any of the Cartesian axes or a segment from any previously drawn object.

• Clear and Clear All Ghosted.

Select the XY Reference Plane.

• Draw a line roughly as shown.
• In the Helix Options palette:

select Wire Helix About Axis,
in the # Of Cycles field enter 10,
in the Radius field enter 8'
in the Length field enter 20'.

• Deselect Scale Path, Scale Source, Rotate
Source.

• With the Helix tool click on 1 of the Z axis.
• In the Helix Options palette, enter 2’ in the

Radius field.
• With the Helix tool click on 2 of the X axis.
• Click on point 3, which is on the line you drew.
• In the Helix Options palette:  in the Radius field enter 4', in the Length field enter 40'.
• Select Scale Path and in its Width and Length fields enter 0.1 and 0.75.
• With the Helix tool click on point 4 of the Z axis.  Observe the result.

You should have noticed that where you click is significant since it determines the starting point of the wire helix.  The
helix is generated in the direction of the axis or the line you select.

You will next generate a wire helix along a path.  To do this you will first need to draw a line which
you will then pick as a path.  To make it more interesting, you will draw a curved path line.

• Clear.

Select the 2D Surface modifier.

Select the Spline, Cubic Bezier tool.

• Click on points 1 through 7, and double click on 8.  You
should have drawn a spline roughly as shown.

• In the Helix palette, select Wire Helix About Path,
# Of Cycles = 40, # Of Steps = 12 Per Cycle,
Radius = 2’, and deselect Scale Path.

• With the Helix tool click anywhere on the spline.
Observe the result.
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Wire helixes frequently represent a first step in a modeling process, and provide the path along which source shapes can
be swept by the Sweep tool that is covered in the next chapter.  After you complete that section, you may wish to do just
that with the wire helix along a path you have just generated.  To have it when you will need it, save it.  Call it
“Wire_helix_along_path.”
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11  Stairs

There are two types of stairs in form•Z generated through dedicated tools: the spiral stair and the
stair from path.  There is also a third variety of irregular stairs that can be generated with the
Terrain Model tool.

The spiral stair is a composite object of revolution, which functionally belongs with the more
general type of stairs from path.  The two types share some common characteristics and are
discussed in the two sections that follow.

Both types of stairs are parametric, which has a few implications.

•They are supported by an edit or preview dialog, where different parameters can be applied
and explored, while the effects they have on the shape of the stair can be previewed.  Exiting from
that dialog generates the final object.

•They are internally stored with their parameters, which makes it easy to revisit them and
change them.

• Launch form•Z.

The tools you will need are already in the tool bar, in the tool palette labeled Derivatives 2.
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11.1  Spiral stair

Selecting the Spiral Stair tool displays its options in the tool options
palette, which contains five tabs.  The Options tab is shown to the right.

We shall leave all the parameters as they are with their default
values.  Note that Edit is on.  As with the other parametric
derivatives, when on, this option will cause an edit or preview dialog
to be invoked as soon as you execute the operation.  We shall
change some of the spiral stair settings from within its edit dialog.

XY should be the active Reference Plane.

Select the Spiral Stair tool

and with it click on the Z axis
somewhere close to the world
origin.

Where you click is all very optional, except that
it is appropriate to keep in mind the functionalities
of a stair as a climbing structure.  Where you
clicked will generate a stair about the Z axis,
which is typically considered to be the vertical
orientation.

As soon as you click the Spiral Stairs
Edit dialog is invoked, as shown to
the right.  In its preview window on its
left portion, the stair that would be
derived with the current settings is
displayed.

• In the Edit dialog make the
following changes:
Inside Radius = 4’,
Outside Radius = 6’, and
# Of Segments Per Step = 1.

As you make each change, the pre-
view image in the Edit dialog is ad-
justed to reflect the new values.  The
state of the stair after all three of the
above changes is shown to the right.
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• Next, in the Spiral Stair Edit
dialog open the Tiles And Sides tab,
turn on With Tiles and in the Sides
field enter 2’ (2 feet from 2 inches).
The effect of these changes is shown
to the right.

• Next, in the Spiral Stair Edit
dialog open the Railings tab, turn on
Railings,  and for both Rails and
Columns select the middle icons
with the square profiles.  Or you may
select any profile you prefer.
The preview of the spiral stair is re-
freshed, as shown to the right.

If you next exit the Spiral Stair Edit
dialog, the current state of the spiral
stair model is displayed in the project
window.  It is shown below in both wire
frame and hidden line.

We have indicated a few times that
the spiral stair is parametric and it is
thus easy to edit and change.  But
what exactly does this mean?

With the Spiral Stair tool click

on the stair displayed in the
window.

The Spiral Stair Edit dialog is in-
voked again and you can make more
changes to your stair, such as those
we did.
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11.2  Stairs from paths

Selecting the Stair from Path tool displays its parameters in the
tool options palette, as shown to the right.  It contains the same
five tabs that the Spiral Stairs Options palette does.

As its name implies, the stair from path requires a path line from
which to generate a stair.  Draw one as we show below.  When
you do, you may want to keep a proper scale in mind.  Each
branch of our “pi” shape is 8’.

As we apply the Stair from Path tool,
we shall again start with the default
parameters as they are displayed in
the tool’s options palette.  Edit is on
and we shall use the preview dialog to
explore the possible variations.

With the Stair from Path tool

click on the path you drew.
The Stair From Path Edit dialog is
invoked and displays a preview of the
current state of the stair.

• Click on the TOP icon under
the preview window and select each
of the items in the Layout pop up
menu to see what variations are avail-
able.  Below, we show the preview
window for Per Section and With
Landings.

The Type pop up menu
also determines  the
shape of a stair.  The de-
fault is Solid Stair, which
goes all the way to the
ground, as shown to the
right.  You will next try the
other options.
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• From the Type menu select
Beam Stair.  This changes the shape
of the stair as shown in the Stair
From Path Edit dialog to the right.
Also try the other items in the Type
pop up menu.

• Next, open the Tiles And
Sides tab, select With Side Beams,
and change its Above field to 2’.
Observe the effects of these settings.

• Next, deselect With Side
Beams, open the Railings tab, se-
lect Railings and the profiles you
prefer for Rails and Columns.

When you do the changes will be
reflected in the preview of the Edit
dialog, as shown below, right.

At any time, you can exit the Edit
dialog and your stair model will be
finalized and displayed in the project
window.  Such examples of stairs de-
rived at different stages during the edit
process are shown below.

Keep in mind that, at any time, you can
use the Stair from Path tool to click on
a stair displayed in the project window.
This will enter you back into edit mode,
where more changes can be made.

Since it would be beyond the scope of
this tutorial to try to cover all the pa-
rameters available for the stairs, you
should explore further by yourself.
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11.3  Stairs from contour lines

There are many more less direct ways in which stairs can be constructed in form•Z, using a variety
of tools.  While we shall not try to cover them all, there is one that deserves mention,  the Terrain
Model tool (see chapter 9).  Stepped models are really stairs, and you will do a few here.

1  2

The first task is to draw the shapes we need for the stair.

• Draw rectangle a and straight line b, as shown.

  Select the Multi-Copy modifier and the Move tool.

• In the Copy Options that appear in the tool options palette
set the # Of Copies to 12.

• With the Move tool active click on 1 and 2.
Twelve copies are made of the line, as shown.

In terrain modeling terms, you can think of the lines you just copied as contour lines, and
of the rectangle as the site.  You will prepick the contour lines and then pick the site with
the Terrain Model tool to produce a stepped model, which will be your stair.

Select the Terrain Model tool.

In its options palette select Stepped Model and
Set New, and in the Interval field enter 1’.

Next, you need to preselect the single segment contour lines.  You can
do it individually, or use a trick to speed up the process, as follows:

• In the Edit menu click on Select All Unghosted.
• With the Pick tool click on the rectangle (site) to deselect it.

At this point all the straight lines are red, but the site is not.

ab

With the Terrain Model tool active click on the site.

Observe how your stair has been constructed.  It is actually a stepped terrain model.
A few words about the selection process you applied is appropriate.  You needed to select your contour lines in a certain
order, because the heights will be incremented in that order.  This was exactly the order in which you multi-copied the
lines.  Pick operations such as Select All and frame picking, pick the objects in the order they are drawn, which was the
proper order in this case.  Select All picked one extra entity, the site.  You explicitly unpicked it, which made it possible
to pick it again with the Terrain Model tool, as required for the execution of this operation.

While the example above produced a stair that can
also be created as a stair from path, there are many
other variations of stairs that can be generated with the
Terrain Model tool only.  For example, shown to the
right is a stair with irregular side edges and one with
curved steps.  The Stair from Path tool can not gener-
ate such stairs.
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12  Sweeps along paths

Solid or surface objects can be generated by sweeping a 2D shape (called a source shape) along
another shape (called the path shape).  Four variations of sweeps are available in form•Z, namely
the axial sweep, the two source sweep, the two path sweep, and the boundary sweep.  They
can be generated as facetted or smooth models.  These types are selected from the Sweep
dialog or options palette that is displayed when the Sweep tool is activated.

• Launch form•Z.
The Sweep tool is on the Derivatives 2 tool
palette, which is already in the tool bar.

 Select the Sweep tool to display the Sweep

Options palette, as shown to the right.
Observe the available types and that Facet-
ted and Axial Sweep are selected by de-
fault.
Also notice the option Edit towards the bottom
of the palette and that it is on by default.

Sweeps can be generated directly or by entering an
edit or preview environment, which happens when the
Edit option is on (which is the default).  In the preview
environment you are able to inspect the object that is
about to be generated, and to manipulate the position
of the source shape relative to the path.  When you are
satisfied that the object you are previewing is the one
you want, you click on the OK button of the Sweep
Edit dialog and your object is generated.

You will first generate an axial sweep directly.  You will
then generate the same sweep by first previewing it.

• In the Sweep Options palette turn on
Adjust To New Parameters and
turn off Edit.
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12.1  Axial sweeps

• Draw shapes a, b, and c, as shown.

We also show a top projection where both the points and the
directions in which the shapes were drawn are shown.  These
options can be selected in the Wire Frame Options dialog.

The topological level is set to Object.

Select the Sweep tool.

• Click on source a, then on path c.
Observe the swept object that has been
generated.  It is a solid object.

• Undo.
• Click on source b, then on path shape c.

Observe that, because the source shape is
open, a surface object has been generated.

You will next do an axial sweep in edit mode.

• Undo.
• In the Sweep Options palette select

Edit.

With the Sweep tool click on a, then on c.

The Sweep Edit dialog appears as shown.
Its large window (left) contains a preview of the
object as it will be generated if you click on OK.
Its small window shows an image of the source
shape as it is placed on the path shape.  Under
each of these windows there are a number of
button commands.

Those under the large window manipulate the viewing
angles of the previewed object, and include zooming and
panning.  For some of these buttons, pressing option
(Macintosh) or ctrl+shft (Windows) reverses the action.
For example zoom in (+) becomes zoom out (-), BAK
(back) view becomes FRT (front) view, etc.

The buttons under the small window are used to manipulate the position of the source relative
to the path and include move, rotate, scale, flip horizontally or vertically, and reverse direction
operations, as well as fitting the view of the source in the preview window.  You will try some of
these operations with the next example.

a
b

c

c

a

b
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  Click on the FLPV (Flip Vertical).
Observe the changes.

  Click on the ROT (Rotate) button to
select it, then click in the source shape
preview window (point 1), and start
moving the mouse slowly to be able to
observe the effect of repositioning the
source on the swept object.  When
you like what you see, release the
mouse.  We released it at point 2.

If you are happy with this shape, click OK to
exit the edit mode and generate the object.

As already mentioned, there are more button commands
in the edit dialog and you should experiment with them.

You will next generate axial sweeps using the
scale and rotate options in the Sweep Op-
tions palette.  Note that these options can
also be set in the Sweep Edit dialog.  To
make the effects of the transformation param-
eters more visible, for this exercise you will use
simple shapes.

• Undo three times to clear the screen.
• Draw a circle d, an arc e, and a rect-

angle f, roughly as shown.
• In the Sweep options palette:

deselect Edit,
select Scale under Source and
in its X and Y fields enter 0.25;
select Rotate under Source and
in its field enter 360.

Click on source shape f, then path d.

Select the Unghost tool, and click on f.

With the Sweep tool click on f, then e.

In both cases the source shape has been both
scaled and rotated as it is swept.

d

f

e

1

2
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12.2  Two source sweeps

Sweeps can also be generated from two different source shapes, as you will do next.

• Undo as many times as necessary to clear the
screen.

• Draw four shapes, roughly as shown.
Note that g is an octagon, and h is a diamond (4-
sided polygon).  Path shape i was drawn using the
Spline Sketch tool and moving clockwise.  It does
not matter if yours is not exactly the same as ours.

• Invoke the Sweep Options dialog.
Select Two Source Sweep, and
deselect Source Shape: Rotate.

With the Sweep tool click on g and h, then on i.

• Unghost source shapes g and h, and repeat the
sweep operation with path j.

h
g

i

j

k

l m

o p

n

Observe the result.  The sweep from the open path starts with an octagonal shape and ends with
a diamond.  Similarly, the sweep generated from the closed path changes from an octagon to a
diamond half way along the path.

12.3  Two path sweeps

Sweeps can also be generated by sweeping a single source shape along two paths.  You will do
such examples next.

• Undo to clear the screen.
• Draw six shapes, roughly as shown.
• Invoke the Sweep Options dialog, and

select Two Path Sweep.

Click on source k, then on paths l and m.

• Click on source shape n, then on paths o and p.
Observe the results.

The path shapes should be drawn in the same direction, or
the resulting object will have intersecting faces.

• Undo to return to the original objects.
• Invoke the Sweep dialog, and select Preserve

Height.
• Repeat the sweeps as above.

Observe the results.
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12.4 Boundary sweeps

Boundary sweeps are generated from a single source shape and a single path.  The path can be
either open or closed.  The source can only be an open shape and such that it does not produce
an object with intersecting faces.  If it does, a warning message is presented by the program.
Boundary sweeps are always solid objects.

• Draw shapes p, s1, s2, s3, and s4, as shown.

Notice the directions marked on these shapes and
draw them the same way.  Shapes s1, s2, and s3
are semi-circles, and s3 is also closed.  You can
draw them by using the Arc, Clockwise and Coun-
terclockwise, Endpoint-Last tool, by clicking on
points 1 and 2, and then double or triple clicking on
3, as shown in the detail.  A triple click will close the
shape, which is how s3 was drawn.

• In the Sweep Options palette select Boundary
Sweep.  The Edit option should still be off.

With the Sweep tool selected, click on source

shape s1, then on path p.  Object A is generated.

With the Sweep tool click on source s2, then on

path p.  Object B is generated.
Observe how arcs in opposite directions produce
different results.  These objects are rather typical
examples of the type of objects created with the
boundary sweep.

With the Sweep tool selected, click on source

shape s3, then on path p.
The program beeps and an error message is
issued indicating that boundary sweeps accept
only  open source shapes.  The closed arc shape
will be used in the example of the next section.

Click on shape s4, then on path p.

The result is solid object C.
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12.5  Sweeps along faces of objects

With most sweeps, both the source and the path can be segments, outlines, or faces of other
objects.  Next you will do an example where a source shape is swept along a few faces of the
object you just generated.

• From the Sweep Options palette, select Axial Sweep
and the First Point alignment option.  Also make certain
Scale is set to 1.0 in both X and Y fields under Source
Shape.

• Also from the Status Of Objects tab select Keep.

This will retain the original objects, rather than ghosting them, which
will allow you to execute the operation more than once without
having to unghost the objects.

• Select the Pick tool and in its Pick Options palette for
Pick Outline/Faces/Holes By Clicking, select In-
side Boundaries.   This option will allow you to select
faces with a single mouse click.

Set the topological level to Face.

With the Sweep tool click on 4 and 5.  Observe the result.

• Next, click on 4 and 6.
• Finally, click on 4 and 7.

The resulting objects should be as shown.

We shall use the solid created by this boundary sweep in chapter 21
to do examples with the Section tool.  Consequently, we need to
save it before we end this section.

• Undo three times.
• With topological level at Object, and the Delete tool active,

click on all the other shapes to erase them.
• Clear All Ghosted.
• Select File: Save As..., and in the dialog that appears,

enter “Solid” to name your project.  You can now Quit.

6

7 5
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13  Skinning
Skinning is both similar to the sweep operation and also has its own unique aspects.  When you
execute a skin, you again think in terms of source shapes being swept along path shapes.
However, in contrast to the sweeps, skins can handle a variable number of sources and  variable
number of paths, which need to be at least three.  In addition, the sweeping operations applied to
skinning also involve two directional shape interpolations, which the sweeps do not.

At an extreme or fully defined case, you can think of skinning as the operation that transforms a
wire representation of an object to a facetted representation.  We present an example that shows
this in the first section of this chapter.  However, the real value of skinning is when used with
incomplete data, which it fills in by interpolating what it is given.  In such cases, you can think of
the skinning operation as simply sketching the outlines of a 3D object and instructing the program
to fill in the implied surfaces.  In the latter case, the success of the operation depends on how well
the profiles are drawn and positioned.

In general, you can expect the skin operation to be very powerful relative to the range of forms you
can create with it, but to also require significant attention when its profiles are set up.

• Launch form•Z.
The Skin tool is next to the right end of the Derivatives 2 tool
palette, which is already in the tool bar.  However, in this
chapter we shall also use the C-Curve tool and need to
introduce the Smooth Curves palette it is in.

• Select Customize Tools... from the Palettes menu and
bring in the following palette as you have done before.

Smooth Curves:    

Select the Skin tool to display the Skin Options palette, as

shown to the right.
Observe that you can generate both Facetted and Smooth
skins.  Also observe the two available types: Skinning
Along Path and Cross Skinning.
The former and Facetted are on by default and are covered
first in the first section of this chapter.

Note that there is no Edit option for skin, because, other than the shape and
position of the source and path profiles, there are no real parameters to be
manipulated through a previewing environment.
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13.1  Skins along paths

Before you can apply a skin, you need sets of sources and
paths (these together are referred to as profiles).

• From the View menu select [+XY]: Top.
• Turn on Grid Snap.

You drew the source shapes, which lie on the XY plane.
You will next position them at different heights along Z.

• Turn on the Perpendicular switch.

Select the Move tool and move them roughly as we

show in both the 3D and the front view.  Make sure
the Self/Copy modifier is set at Self.

You will next draw one of the path shapes by snapping to
points of the sources.  You will then copy it 5 times.

• From the View menu select [-ZX]: Front.

With the Vector Line tool draw by clicking on 3, 4,

5, 6, 7, and double clicking on 8.
• From the View menu select [+XY]: Top.

From the window tools select Snap to Point.

Select the Multi-Copy modifier, double click on it,

and in its dialog enter 5 in the # Of Copies field.

Select the Polygon tool and draw six hexagons, in the same direction.  That is, for each,

click at the center (point 1) and then on its point to the right (2), as shown for the largest
hexagon.  Alternatively, you can draw one hexagon and multi-copy it.
Note that the centers (1) of your hexagons are at the origin of the reference plane.

• From the View menu select Custom View Angles... and in the dialog that is invoked
enter 45° for Z and 60 for X Angle.  Exit the dialog and observe the effect on your view.

• Click in the Views palette (it is the last to the right of your window) and click again under
the default name View 1 that appears.
You have just saved the current view to be able to return to it quickly, next time.  How the
Views palette works is discussed in more detail in section 33.

Select the Rotate tool and with it click on 9 (to select the path), 10 (to set the center),

11 (start of the rotation) and 12 (rotation angle).  Observe how more paths are generated.
• Click on View 1 in the Views palette and select Hidden Line* from the Display menu.

Observe the result.  You will shortly need to compare these with some other 3D images.
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You now have all you need to derive a skinned object.  Specifically, you have 6 sources and 6
paths.  That they are the same number is coincidental; they do not have to be.  Before you
proceed, you need to tell form•Z how many sources and paths you will be using.

• Select View: [+XY]: Top and deselect Snap to Point (select , No Object Snap).

Select the Skin and in the tool options palette enter 6 and 6 for # Sources and # Paths.

• With the Skin tool still active, click on all the sources (the closed hexagons) and all the
paths (the open shapes).

The order in which the sources and the paths are selected is not significant.  However, the
sources need to be selected first and the paths second.  While the order of selection is not
critical, the order of the points of closed profiles is.  That is, you should make certain that
the first points of closed sources and paths line up (or otherwise twists will result).

• Click on “view 1” in the Views palette.
• Select Hidden Line* (Display menu).  Observe the result.

Compare this image with the previous 3D image.

Even though both images look the same in wire frame, they look quite different in hidden line,
which makes it obvious that, while the previous structure was a wire frame, the latter is a facetted
object.  In other words, the skin operation has transformed a wire representation of an object into
a facetted representation.  The latter has surfaces that can be meaningfully rendered, while the
previous does not.

This was an example of a skin that was fully defined.  That is, all the points of the sources
coincided with a point of a path.  This is not a necessary condition.  You will next do an example
where a single source and three paths are used.  These are actually the minima required.

• Undo and select View: [+XY]: Top.

With the Ghost tool click on every other path and all the sources except one.

Which source you actually keep is not significant.
Observe the ghosted shapes.

• Select Hide Ghosted* (Wire Frame dialog).
• Click on “view 1” in the Views palette.
• In the tool options palette enter 1 and 3 for # Sources and

# Paths.

With the Skin tool click on the source, then on the paths.

Observe the result.
• Select Hidden Line* (Display menu).

Compare this with the previous image above.



109form•Z Tutorial  •  Skinning

The last example has shown that, especially for symmetrical objects like the one we did, a
complete set of profiles (or a complete wire frame delineation) is not necessary.  The strength of
the skin operation is exactly in its ability to work with incomplete descriptions and interpolate
between given profiles to derive those missing.  However, it should be noted that the operation
needs sufficient information to produce correct results.  What is “sufficient” depends on the
particular shape that one desires to construct.  For example, if a shape has to turn or bend about
a corner, sufficiently dense shapes should be provided to be able to construct the bent area
correctly.  In general, you can always start with the minimum of information and add more profiles
if the resulting shape is not yet what you have in mind.

Another aspect of the skinning operation that needs to be underlined is that it is based on points
from the sources matching with point of the paths.  At best, matching points should coincide; that
is, should be exactly on each other.  While the operation can also work with pairs of matching
points that do not completely satisfy this condition, it can only do it when their distance is within
a certain tolerance.

You will next do a smoother example of a skin.

• Undo.

Select the C-Curve tool.

• In the C-Curve Options palette select Construct Directly, Normal Tangent,
and in the Smooth Interval enter 1’ (assuming your shapes are roughly the size of
ours: diameter of largest hexagon is 12’ and height of paths is 20’).

• With the C-Curve tool selected click on the source and on each of the three paths.
• Click on Wire Frame* (Display menu) while pressing option (Macintosh) or ctrl+shft

(Windows), to invoke its dialog.  In it select Show Points.  Observe the changes.

First, tangent Bezier curves have been generated by using the profiles as control lines.  These curves are discussed in
detail in UM section 4.13.  A characteristic of the tangent curves, which is important for the skin operation, is that they
pass from the control points, that is the points of the original profiles.  This preserves the previous placement of the sources
relative to the paths.  At the end, we also asked form•Z to make the points of the curves visible.  The result is shown above.

Now we are ready to re-execute the skin operation with smoother profiles.

With the Skin tool, select the one source and the three

paths, as you did earlier.

A smoother object is generated from the smoother profiles.

This is still a facetted object, not to be confused with the smooth
skin that you can also generate with form•Z and which you will do
in the next section.
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13.2  Generating nurbz from skins

In the previous section smooth curves were generated from the source and path shapes, which
were then skinned to derive a smoother object.  Two types of smooth objects can also be derived
directly by the operation.  As with the revolved objects and sweeps, these are parametric objects
that use the polygonal profiles of the skin operation to generate smooth or NURBS surfaces.

Looking at the previous examples, you may have been wondering whether the skin operation can only handle symmetrical
objects, which can also be generated as revolved objects.  In this section you will do examples that show the opposite.

• Undo four times, or as many times as necessary to return to the polygonal profiles.
• In Front view, ghost the path to the right, then draw a single segment straight line, as

shown below in both front and 3D view, for which you click on “view1” in the Views palette.

Select the Skin tool and in the tool options palette

enter 1 and 3 for # Sources and # Paths.
• With the Skin tool click on the source (the hexagon)

and on the three paths.
A skinned object is generated, as shown.  The paths we use are not
symmetric anymore.  In addition, they have different numbers of points on
them.  As you see, form•Z automatically adds the necessary points to
match them with the path that has the most.  This is also true with sources.

• Undo and in the options palette turn on Smooth.
In the Smooth Options group, select Con-
struct As Nurbz.

With the Skin tool select the source and paths.

Observe the smoothly rounded nurbz object.
• Execute Hidden Line* from the Display menu.
• Invoke the Hidden Line Options dialog, in it

select Show Facets and let the Hidden Line*
execute again.  Observe the difference.

Next, you will do the variation shown below by yourself.  Use the previous three paths, and draw
one additional triangular source.  Draw it on the reference plane and then move it up to place its
three points exactly on the top points of the path.  In the tool options palette change the # Of
Sources to 2 and execute the operation, as above.  Derive both a Facetted and Nurbz
variation and save each in a file to use later.  Call them “Skin_facet” and “Skin_nurbz”.
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13.3  Cross skinning

Cross skinning is a variation of skinning, where one or more sources are swept in a
circular pattern along a single path, which is always closed.  You will do a few examples.

• Clear (Edit menu) and set the view to Top (View menu).

With the Ellipse, Major and Minor Radius tool active, click on points 1, 2, and 3

to draw ellipse a, as shown.
• Select Front view (View menu).
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• With the Ellipse tool draw ellipse b, as above.
Note that the two ellipses are perpendicular and share two points.

Select the Skin tool; in the options palette select Facetted,

Cross Skinning and in its # Sources field enter 1.
• With the Skin tool click on 4 (source) then 5 (path).  Observe the

results, shown in wire frame and hidden line.
• Undo and repeat the Skin operation, but this time click first on

5 and then on 4.  Observe the difference with the previous.

You will next do another example.

• Clear (Edit menu), set the view first to Top, then to Front,
and draw the two shapes shown to the right (closed path c and
open source d).  Pay attention to where the points are on the
closed path shape, especially the highlighted colinear points.
Without them you will be unable to derive the object we show.

With the Skin tool active and Facetted on click on 6, then 7.

• Undo and repeat the operation with Construct As Nurbz on.
Note that you can not pick these shapes in reverse order, as previously.
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You will next do one more example by yourself.

In Top view, draw the star shape shown (left): it is a10-sided
patterned polygon.  In Front view, draw a two segment (open)
angular vector line as shown.  Its ends are on two opposite
points of the star and its peak is at the center of the star.  Derive
cross skins from them, both facetted and nurbz, as shown.
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14  Lofts

In form•Z, you can generate surface or solid objects by lofting two or more source shapes, which
can be either closed or open (but not mixed).  Lofting is the operation that generates surfaces
which pass through a set of lines (source shapes) and is either coplanar or tangent to the source
shapes at the points it goes through them.  It is coplanar when the source shapes are closed
surface objects.  It is tangent when the source shapes are wires and do not define any surface.
Wires are all the open shapes and also closed shapes that have been converted to wires by
applying the Cover/Uncover tool available in form•Z.  However, this tool is not covered in this
Tutorial.  In the examples in this chapter we use closed surface objects and open wires only.

When lofting is applied to two source shapes only, these source shapes can be selected directly
with the Loft tool, while prepicking them with the Pick tool remains an  option.  However, when
lofting is to be applied to more than two source shapes, these shapes have to be preselected with
the Pick tool.  The Loft tool is then used to click anywhere in the graphics window to trigger the
operation.

The Loft tool you will use in this chapter is at the end of the Derivatives 2 palette, which is already
available.  So you can proceed with the examples as soon as you launch the program.

• Launch form•Z.



113form•Z Tutorial  •  Loft

14.1  Lofts from closed shapes

In this section you will generate objects by lofting
closed shapes.  These shapes need to be drawn
first.

Select the Grid Snap option (optional).

Select the XY Reference Plane.

You will draw three patterned hexagons.

Set the 2D Surface modifier.

Select the Polygon tool and in its tool

options palette open the Pattern tab
and select Pattern.
The upper left pattern icon is on by default.

With the Polygon tool active click on points

1, 2, and 3.  You have drawn a star.
• In a similar fashion draw the other two

hexagonal patterns.

With the Move tool (and the Perpendicular

switch on) move the two latter shapes
down, roughly as shown.

With the Loft tool click on the lower and

then on the upper shape to pick them.
The Loft Edit dialog is invoked and displays the
object that is about to be generated.

• In the Loft Edit dialog, under Direction
select Source Plane Normal and click
on Update.  Observe the result.

• Deselect Source Plane Normal, click
on Update and then on OK.

The object that was shown in the preview dialog is now
generated as a regular object.

• From the Display menu, select Shaded
Render* and then Hidden Line*.

The results should be as shown to the right.
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Your object is regenerated.  While it is rendered in wire frame it
looks the same as before.  However, it will look different as soon
as you do a shaded or a hidden line rendering.

• From the Display menu, select Shaded
Render* and then Hidden Line*.

Observe the results.  Your object is now closed all
around, which makes it a solid.

The object you generated is a surface.  You will next turn it into a solid.

With the Query tool click on the object.

• When the Query Object dialog appears click on the Edit... button.
This invokes the Loft Edit dialog, with your object shown in its preview window.

• In the Loft Edit dialog turn on the Make Solid option, then click OK, which
returns you to the Query Object dialog.  Click OK again to exit the Query dialog.

The object you generated sofar was derived from two source shapes, which allowed you to
postpick the sources directly with the Loft tool.  You will next derive a loft from three sources.  This
requires you to prepick the sources with the Pick tool.

• Undo.

The three patterned polygons you drew at the very
beginning should be displayed on the screen.

With the Pick tool click on each of them,

starting at the lower.
They are now selected and shown in red.

With the Loft tool click anywhere in the

graphics window.
• When the Loft Edit window appears,

click OK.

A different form has now been generated, as shown
to the left.  You will next render it to see it better.

• From the Display menu, select Shaded
Render* and then Hidden Line*.

Observe the results.
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14.2  Lofts from open shapes

In contrast to the previous, in this section you will generate
objects by lofting open shapes.  As in the previous section,
the shapes you will use as sources need to be drawn first.

Deselect the Grid Snap option.

The XY Reference Plane should be on.

You will draw two open splines.

The 2D Surface modifier is on.

With the B-Spline, Cubic tool (or any of the spline

tools you may find convenient) draw two open
lines, roughly as shown.

With the Perpendicular switch on, use the Move

tool  to move one of the splines up, roughly as shown.

Select the Loft tool and in its tool options palette

deselect Preview.
• With the Loft tool active click on each of the two

splines.  A flag like surface object is generated.

The flag you just generated is a bit too flat.  You will next
generate one from three splines, which will be more wavy.

• Draw one more spline and move it between the
other two, roughly as shown.

• With the Pick tool prepick the three splines and
then with the Loft tool click anywhere in the window.

• From the Display menu, select Shaded Render*
and then Hidden Line*.  Observe the results.
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15  Meshes and subdivisions

In form•Z, you can generate plain meshes on closed surface objects (2D shapes) or on faces
of solids using the Mesh tool.  They can also be created on complete solid objects.  The plain
meshes are different from the controlled meshes in that they cannot be edited the way the c-
meshes can.  However, the common geometric transformations (move, rotate, and scale) can be
applied to meshed parts of objects to manipulate their form.  In addition, meshed objects and
surfaces can be smoothly deformed, as you will see in the next chapter.

Before you proceed with the exercises in this chapter you will need to bring back some of the tool
palettes you removed at the beginning of this Tutorial.  You will actually reintroduce both sides
(left and right) of the 6th row of the default tool bar, even though some of the tools you will not need
until the next two sections.

• Launch form•Z.
• Click on Customize Tools...

in the Palettes menu.
• To the tool bar, reintroduce

the following three palettes:

Meshes and Deform:

Round and Draft Angles:

Structure:

Note that the Round and Draft Angles palette also  includes a tool called Draft Angle.  Because
it is not covered in this Tutorial we removed it before reinserting the palette to the tool bar.

Your screen may now appear as shown to the right, if you tear off the new palettes as we did.  You
are now ready to proceed with the exercises in this chapter.
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• Clear and Clear All Ghosted.

Select the Grid Snap option (optional).

Select the XY Reference Plane.

• Draw a rectangle and a hexagon as shown.

We do not show the tools you use to draw these shapes.  By this time,
you should know which ones you need.

Set the topological level to Object.

Select the Mesh tool.

• Click on point 1 of the rectangle.
• Click on point 2 of the hexagon.

You have just generated meshes on the two
shapes you drew earlier.

The meshes consist of 8' x 8' squares, which is the default size that is
set in the Mesh Options dialog.  The options in this dialog are the
same as those in the Mesh Options tab you used in section 9 of this
tutorial.  Where you clicked determined the direction of the mesh.

Undo as many times as necessary to clear the project.
Then generate two solid versions of your previous
objects, roughly as shown on the next page.

• Invoke the Pick Options dialog and
for Pick Outlines/Faces/Holes By Click-
ing select Inside Boundaries.

Recall that this option allows you to pick faces with a single click of
the mouse.

• Invoke the Mesh Options dialog, select the
Center On Line option, and enter 4' in the X,
Y, and Z fields.

Actually, assuming that the All Directions option is still selected
by default in your dialog, you only need to type 4' in the X field and
it will automatically be applied in all the directions.

15.1  Plain meshes

In this section you will learn how to create meshes on previously generated objects.
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Set the topological level to Face.

The Mesh tool should still be selected.

• Click on point 1 of the top face of the rectangle.
• Click on 2 of the top face of the hexagonal solid.
• Click on points 3 (rectangle) and 4 (hexagon).

Observe the results.

You have just “meshed” some of the faces of the two solids you created
earlier.  Again, where you clicked when you selected the faces determined
the direction of the mesh.  That is, the direction was dictated by the
segment that was the closest to the point where you clicked to select the
face.  You can continue and create meshes on all the faces of the solids,
if you like.  In the next example, you will also create meshes on faces that
were produced by the previous meshing operation, as opposed to the
original faces of the object.

• Invoke the Mesh Options dialog again and set
the X, Y, and Z fields to 1'.

The Mesh tool should still be selected.  Click on

points 5, 6, and 7.
Observe the results.  They should be self-explana-
tory.

You will next generate meshes on complete objects.  Undo
enough times to go back to your original objects.

Set the topological level to Object.

• Invoke the Mesh Options dialog and set the X,
Y, and Z fields to 4'.

The Mesh tool should still be selected.

• Click on points 8 (rectangle) and 9 (hexagon).
Observe the results and compare them with the
previous.
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15.2  Subdividing surfaces

Next to the Mesh tool there are two tools that can be used to
subdivide the surfaces of objects.  One does rectangular subdivi-
sions and is called Q-Subz;  the other does triangular subdivisions
and is called T-Subz.  You will do examples with both in this section.

Click on the Q-Subz tool and observe its options,

as displayed in the Q-Subz Options palette.
You will change some of them shortly.

• Draw a hexagonal extrusion, 32' wide, 10' high.
It is similar to that we used in the previous section and
should be roughly as shown.

• In the Q-Subz tool options palette, deselect Edit, in
the Max # Of Subdivisions field enter 1, and deselect
Smoothing.

• With the Q-Subz tool on click on the hexagonal solid.
Observe the results.

• Undo.  In the tool options palette set Max # Of Subdivis-
ions to 2 and click on the object again.

• Undo.  Change Subdivisions to 3 and click on the object
again.

• Undo.  Turn on Smoothing and click on the object again.
Observe how the object has been “rounded”.

On your own, try the other options in the palette to see how they
affect the operation.  If you turn Edit on, which you will do for the
next example, the effects of the different parameters can be
observed directly in the Q-Subz Edit dialog that is invoked.

For the next exercise you will work with a model you saved earlier.

• From the File menu select Open... and in the File
Open dialog that is invoked locate the file called
“Skin_facet” and double click on it.
You may recall that you saved this earlier.
Its contents should be as shown to the left.
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Activate the Q-Subz tool and in the tool options

palette make sure Edit is on.
Also set Maximum # Of Subdivisions to 4,
and select Smoothing, if not already on.

• With the Q-Subz tool active click on the vase like
object you just brought in.

The Q-Subz Edit dialog is invoked.  It is very similar to the other edit
dialogs you are already familiar with.  On its left, there is a preview
window which displays the object you have just selected.

What you see may be not what you expected.  The smooth
mesh operation you just applied appears to have caused
absolutely no change to your object.  This is not so.

At the lower end of your dialog, in a box labeled
Preview, there are two options.  The option that is on
now reads Original Object.

• Select Meshed Object.
Observe how the image changes.

Your object has been “rounded,” which is the effect of the Smoothing
option.

• Move the Curvature slide bar to the right, until its
field displays about 75 (or type 75 directly) and set
Maximum Segment Length to 0’-6”.

• Click on Update in the Preview box.

If the Update button is dimmed after you change a value, click on any field
in the dialog, or press tab, to enter the value (until Update becomes active).

You need to press Update every time you make a
change, if you want to see its effect in the preview window.

Your object at this point is as shown to the left.  You may
want to also change other parameters and observe their
effect on your object.  After you are done with your
experimentation, Undo as many times as necessary to
return to the original object (the one saved in “Skin_facet”).

Activate the T-Subz tool (it is next to Q-Subz), in its

tool palette turn off Edit, and click on the object.

The result should be as shown to the left.
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15.3  Reducing the resolution of meshes

In a way, the Reduce Mesh tool is the opposite of the Mesh and Subdivision tools.  Rather than
adding mesh subdivisions on the surfaces of objects it deletes subdivisions.  It does so on the
basis of the angles at its edges.  Consequently,  this tool may be thought of as a resolution
optimization tool.

Select the Reduce Mesh tool to observe its options displayed in the tool options palette.
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Note that there is an option labeled Show
Preview, which is on by default.  When on
the Reduce Mesh Preview dialog is in-
voked, every time the operation is executed.
Leave the option on for the next example.

• Generate a primitive sphere of about
32' radius, roughly as shown to the left.

• With the Reduce Mesh tool active click on it.

The Reduce Mesh Preview dialog appears, with the
sphere displayed in its preview window.  In the one we show
we changed the view a bit to be able to see its pole better.

At the lower end of the text area you read that 68 faces and 184
edges were merged.  In spite of this the sphere appears
unchanged.  This is because the original object is still displayed.

• Select Reduced Object.
Observe how the display changes.
Note that the default value for Face Angle is 5.

• Change the
Face Angle to 10, press
tab, and click on Up-
date....
Observe the result.

• Change Face
Angle to 20 and repeat
the other steps above.
Once again, observe how
the display changes.

The information fields now tell you that 412 faces and 1568 edges were merged.
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You will next reduce the mesh of a real object.  This is the vase like nurbz
object you did in the previous chapter.  You saved it as “Skin_nurbz”.

• Click on the Open... item (File menu) and invoke the  File Open
dialog. Find the file and open it.

When it opens it should be as shown to the right.  Recall that this is a smooth
object and you need to convert it to facetted.

With the Convert tool click

on the object.
This invokes the Convert
Options dialog.

• In the Convert To
section of the dialog,
select Plain Object
and Facetted.
Then click OK.

Select the Reduce Mesh tool and in the tool

options palette set Face Angle to the default
value 5.
Also, deselect Show Preview.

• With the Reduce Mesh tool active click on the
object. Observe the result.

• Experiment by changing Face Angle to
different values and repeat the operation.

Some of the results you produce may be similar to
those shown to the right.

The object is converted to the facetted object shown to the right.
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16  Deformations

There are four tools for transforming meshes:  Move Mesh, Disturb, Deform, and Displacement.
There is also one more tool, Define Profile, that supports the Move Mesh tool.  These tools are
in the Meshes and Deform tool palette, which is already in the tool bar.  Thus you are ready to
run the exercises of this chapter as soon as you launch the program.

• Launch form•Z.

In this chapter you will be using the 5th through 8th (left to right) tools from the

Meshes and Deform palette:  .

If you tear off the palette, as you did in the previous session, your screen will look the same.

These tools, while they all operate on meshes, work quite differently.  In this chapter, you will first
do a mesh movement, whose form will be determined by the shape of a profile you will select.  This
will be followed by an exercise about disturbing the geometry of points and then by a number of
deformation exercises.  All these tools work on facetted models.  The Deform tool also works on
smooth objects.
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16.1  Profiles and mesh movement

A profile  is a 2D open shape that is drawn in the usual manner and is stored in the Profiles Library,

using the Define Profile tool ( ), which is right before the Move Mesh tool on the Meshes and
Deform palette.   The saved profiles are accessible through the Profiles palette, as shown.  Any
profile in the palette can be selected by clicking on it.  The selected profile becomes the active
profile, which is used by the Move Mesh tool to move meshed areas of an object in a manner that
follows the shape of the profile.  For this example you will not define your own profile, but will use
one of those already stored in the Profiles palette.  You will apply a mesh movement to a meshed
surface.

• Select Palettes: Profiles.
This opens the Profiles palette shown, which already contains
a few profiles.

• In the Profiles palette, click on the box with the dot.
The box is highlighted and becomes the active profile.

Your screen should display a 3D view (x=30°  z=60° ), and the XY
Reference Plane should be active.

Turn Grid Snap on.

The 2D Surface modifier should be selected.

Use the Rectangle tool to draw a square on the grid boundaries.

• Select the Mesh tool and in the X,Y,Z fields displayed in the tool
options palette enter 2'.

With the Mesh tool active click on the rectangle.

You now have a meshed surface for applying a mesh movement.

Turn on the Perpendicular switch.

Select the Move Mesh tool.

• Click on point 1 at the center of the mesh.
This initiates the rubber banding of an octagon.

• Position the octagon roughly as shown and click on point 2.
This rubber bands a bell shaped 3D preview shape that  follows
the perpendicular motion of the mouse.

• Position it at the desired height and click on 3.
This regenerates your meshed surface, an area of which has
been smoothly moved in a manner that follows the shape of the
profile.

1

2

3

•
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In exactly the same way, mesh movements can also be
applied to meshed faces of solid objects.  Do the example
shown to the right.  Generate a 3D cuboid that extends to
the border lines of your reference grid.  Then generate a
mesh on its top face using the same parameters as before.
Then repeat the Move Mesh operation using the profile
shown.  Everything else remains the same, except that the
point you select for the center of your movement is now at
the center of the top face of the cuboid.

You can also apply repeated mesh movements on the
same surface, as the next two examples will show.

• Undo to return to the cuboid with its top face
meshed.

Then, using the shown profile, execute the mesh move-
ment twice, both times selecting a point at the center of the
mesh on the top face.  The first time,  allow the octagonal
shape that is rubber banded after the selection of the point
to partially extend beyond the boundary of the top face.
When the 3D preview shape appears, move your mouse
upwards.  The second time, make your octagonal shape
about half the size of the top face, and move the top of the
3D preview shape downwards.

The final example was derived by applying four mesh
movements, all of which moved points on the corners of the
top face rather than a point at its center.  The two profiles
shown were used.  The points on the right and left were
moved downwards, using profile a.  The back and front
corner points were moved up and down, respectively, using
profile b.

You can also apply linear mesh moves as opposed to the
radial moves executed for the examples in this section.
These and other options can be set in the tool options
palette that appears when the tool is active, or in the Move
Mesh  Options dialog which can be invoked directly from
the tool.  They will not be covered in this Tutorial. They are
discussed in UM subsection 4.11.2

a          b
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16.2  Point disturbances

The Disturb tool is used to generate both random and regular disturbances on facetted surfaces
and objects.  Their options are selected from the tool options palette, when the Disturb tool is
active.

• Clear whatever objects you may have on your screen, and regenerate the meshed
rectangle you made at the beginning of section 15.1.

With the Disturb tool selected, click on the mesh, and

observe the results.
You have applied a Random Disturbance to the
points of the mesh, the default option in the Disturb
Options dialog.

You will next execute wave disturbances, first of a linear, then
of a circular shape.

• Undo.

• Invoke the Disturb Options dialog and in its Op-
tions tab select the Wave Disturbance option.

With the Disturb tool active, click on the mesh, on the

point marked with the dot.  A linear wave is generated.
• Undo.  Invoke the Disturb Options dialog, and for

Type, select Circular.

With the Disturb tool active, click on the point marked

with the dot again.
Observe the result.  Note that where you clicked was
significant, as it determined the center of the wave.

• Undo.  Invoke the Disturb Options dialog, and
select Through Centroid.

With the Disturb tool click on the marked point again.

Observe the result.  Note that in this example, where
you clicked was not significant, and the center of the
wave was positioned at the centroid of the surface.

The Disturb tool can be used to apply both random and regular point disturbances
to both surfaces and objects.  The operation works best on relatively dense meshes.
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16.3  Object deformation

Using the Deform tool, both facetted and smooth objects can be deformed interactively, both
individually and as groups of selected objects.  Undo to clear the screen, and generate the shown
conic mesh as follows:
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• Draw two concentric circles as shown (make certain that
they are drawn in the same direction).

• Turn on the perpendicular switch, then, with the Move tool
active, move the small circle up roughly as shown.

• Double click on the C-Mesh tool (in the Nurbz Surfaces palette)
to invoke the C-Mesh Options dialog.  In its Options tab,
select Construct Directly.  Under Mesh Length, select
At Control Points, under Mesh Depth, select # Of
Segments, and in its field enter 20.  Open the Smoothing
tab and for both Length and Depth select None.

With the C-Mesh tool, click on the large and the small circle.

The resulting meshed cone should be roughly as shown.  You can
now apply some deformations to it.

• Invoke the Deform Options dialog and, in its Options
tab, select  Bulge.  Exit the dialog.

With the Deform tool active, click on the object.  A warning

dialog regarding control parameters is invoked.  Click OK.

A bounding box appears which defines the area that will be
deformed.  This box can be rotated and its top and bottom ends can
be moved.  You will next move its top end.

• While pressing the option key on a Macintosh or ctrl+shft
on Windows, place the cursor on one of the horizontal
edges of the top of the box.  When the cursor changes to

, click on 1.
• Move the cursor down, and click on 2.  This moves the top

end of the bounding box down.
• Position the cursor on one of the corner points of the top end

of the bounding box (causing the cursor to change to  ),
and click on 3.

• Move the cursor away and click on 4.
Observe how the Bulge operation deformed the lower portion of your object.
You will next bend your object.
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• Undo.
• Invoke the Deform Options dialog, and select Radial Bend.

With the Deform tool active, click on the object.

• When the bounding box appears, click on a segment of its top end
(point 5).

• As the bounding box rubber bands, move the mouse in a circular
direction until the bounding box makes about a 270° turn (three
quarters of a circle), and click.

Observe how the object has been bent.

You will next bend your object in a different way.

• Undo.  In the Deform Options dialog select Bezier Bend.
• Click on the object to select it.
• When the bounding box appears, click on a segment of its top end (6),

and move the mouse in different directions to see how it deforms.
• Press the shift key, and move the mouse again.  Do not click the

mouse yet.
• Press the control key on a Macintosh or ctrl+alt  on Windows and

move the mouse.
• Press the option key on a Macintosh or ctrl+shft  on Windows and

move the mouse.
Note that the option (Macintosh) orctrl+shift (Windows) keys were used earlier to vertically
move the ends of the bounding box.  This happens when pressing the keys before clicking
on the bounding box.  When pressed after clicking on the box, they affect the bending.

• Press the command key on a Macintosh or ctrl  on Windows, move
the mouse until you get a deformed shape that you like, and click.

Your meshed cone is deformed and takes a shape analogous to the deformed
bounding box.

You have just observed how different types of Bezier bendings can be
executed by pressing different keys while your bounding box is rubber banded.

You have tried three of the seven available object deformations.  You may wish
to experiment with the others on your own.

5

6

Macintosh: no key shift control   option command
Windows: no key shift ctrl+alt ctrl+shft ctrl
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17  Rounding objects
Vertices and edges, including concave corners, can be rounded individually or simultaneously

using one of the Round tools, namely, the Plain Round (P-Round  ), Controlled Round (C-Round

 ), and Stitch Round (S-Round  ) tools.  The Blend (  ) tool is used to generate a new

surface that smoothly blends two existing surfaces.  The Fillet (  ) tool fits smooth fillets at the

intersection of two surfaces.  You will do examples with all these tools in this chapter.

The Round tools you will need for the exercises in this chapter are already in your tool bar.  Thus
you can proceed as soon as you are running the program.

We need to note that the examples you will be doing in this session can only be rounding applied
to single objects.  Smooth rounding in particular is of special interest when it is applied to more
complex objects that result from Boolean or Trim and Stitch operations.  We shall do a few more
rounding examples in a subsequent session, after we discuss the Boolean operations.

• Launch form•Z.

Turn on the Grid Snap.
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17.1  Plain rounding
• Generate an 8' x 8' x 10' cuboid, as shown.
• Double click on the P-Round tool.  In the Plain

Rounding Options dialog select Facetted
Rounding Of Facetted Objects and
Vertex.

Set topological level to Point.

With the P-Round tool click on 1.

Result should be as in a.
• Undo.
• In the Plain Rounding Options dialog se-

lect Edge.
• Repeat the operation.

The result should be as shown in b.
• Undo.
• In the Plain Rounding Options dialog se-

lect Edges & Vertices.
• Repeat the operation.

The result should be as shown in c.
• Undo.
• In the Plain Rounding Options dialog,

select Use Radius and in the Rounding
Size field type 2'.

Set the topological level to Segment.

With the Pick tool click on 2, 3, 4, and 5.

With the P-Round tool click on the screen.

The result should be as in d.
• Undo.
• Preselect segments as before but also pick

segment 6.
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With the P-Round tool click on the screen.  The result should be as in e.

Note that when combined Edges & Vertices rounding is applied, as you did in the last two examples, points can only
be rounded when the segments that converge to them are also rounded.
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The P-Round tool can also handle concave points.  To illustrate it we need an object such as the
one shown.  However, to generate such an object we need the Boolean Difference operation,
which we have not discussed yet.  Consequently, we shall show you how the rounding behaves
with concave points but will not ask you to execute the example.  You may wish to come back and
do it later, after you know how to generate the object with the concave points.

The object we show contains convex, concave, and mixed points, and each type behaves
differently when rounding is applied to it.  Following is how we generated the examples.

• In the Plain Rounding Options dialog we selected Facetted Rounding and
Vertex.
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We set the topological level to Object.

With the P-Round tool active we clicked on

the object (point 7).
This resulted in the rounding shown in f.
A message was also posted telling that
some of the points could not be rounded.
These are the three points shown
unrounded, for which there is no proper
rounding solution.

• We executed an Undo.
• In the Plain Rounding Options dialog

we selected Edge.

With the P-Round tool active we clicked on

the object.
This produced the rounding shown in g.

• We executed an Undo.
• In the Plain Rounding Options dialog

we selected Edges & Vertices.

With the P-Round tool active we clicked on

the object.
The result was as shown in h.

7

Here is what you should have observed:

• When vertices are rounded by themselves,  concave and convex points can be rounded, but not the mixed points.
• When edges are rounded by themselves, the points are not rounded, except for the mixed points which are rounded
whenever all segments that converge to them are also rounded.
• When both edges and vertices are rounded, all points are rounded, provided that all the segments that converge to
them are also rounded.

h
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17.2  Controlled rounding

Plain rounding can apply only one type of operation at a time, and
only uniform parameters.  In contrast, controlled rounding allows
you to mix rounding types and parameters.  It also remembers the
rounding parameters applied earlier and allows you to change
them.  Controlled rounding is applied through a preview dialog, as
the following example illustrates.

• Generate an extruded hexagon, roughly as shown.
• Invoke the Controlled Rounding Options dialog and

select Keep Facetted.

With the C-Round tool active, click on the hexagon.  When

a warning message appears, click OK.
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The Facetted Round Edit dialog appears.
It consists of a preview window (where the
hexagon is shown), buttons, and numeric fields.
The Round Radius option should be se-
lected, 4'-0" should appear in its field, and 4 in
the # Of Points field.

• Click on point 1, then on the Update button.
Observe the result.

When you clicked on the front top segment of your
hexagonal solid, it was highlighted.  When you se-
lected Update your object was redrawn with its front
top edge rounded.

• In the Round Radius field enter 2', click on
point 1 again, and click on Update.  Then click
on OK.

The Facetted Round Edit dialog goes away and
your object is generated as it was in the preview.
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The Facetted Round Edit dialog appears again and
your hexagonal solid is shown in the preview as it was
the last time you closed the dialog.

You will next round the remaining segments of the top
face, by applying different rounding parameters.

• Change the Round Radius field to 4'-0" and
click on 2 and 3.

• Change the Round Radius field to 6'-0" and
click on 4 and 5.

• Change the Round Radius field to 8'-0" and
click on 6.

• Click on Preview, then click on OK.

You have rounded the segments of the top face of your
object by applying variable size radii, starting with 2'
and going up to 8'.  Variable rounding radii can only be
applied through controlled rounding.

• Undo. Invoke the Controlled Rounding
Options dialog and select Make Smooth.

With the C-Round tool click on the object.

When the warning appears click on OK.
When the Smooth Round Edit preview
dialog appears, select Automatic, click on
the 6 segments of the top face to select them,
then select Circular.  Observe the preview.

• Select Elliptical and enter 10’ to the Major
Radius fields.

• Click OK to exit the dialog.
Your rounded object should be as show below.
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In the next example you will round the top of the hexagonal extrusion by
applying variable size radii.  Such rounding can only be applied through the
rounding preview environment.

With the C-Round tool click on the object.
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17.3  Blending surfaces

While the three rounding operations are applied to parts of existing objects, such as edges and
vertices, and the result becomes part of the object, the blending operation generates a new
curved surface between the boundaries of two surfaces.  The new surface may become part of
the original surfaces and all can be merged into one, or it can remain a separate entity.  You will
do examples of both cases.

• Generate two cylinders, roughly as shown.
One of them is smaller than the other and has
been moved up by using the Move tool and by
setting the Perpendicular switch on.

• After the two cylinders have been generated,
make a copy of them, roughly as shown.

Select the Blend tool and in its tool options

palette open the Status tab.  In it select Keep
(in the Operand Status group of options).

• Invoke the Pick Options dialog and in it,
under Pick Outlines/Faces/Holes By
Clicking, select Inside Boundaries.
The On Edges option remains on.

• Make sure the topological level is set to Object
and with the Blend tool active click on 1 and 2.

The Blend Edit dialog is invoked and shows you the
object that is about to be generated.

• Click OK to exit the dialog.
• With the Blend tool still active click on

3, 4, 5, and 6.
• Again, when the Blend Edit dialog appears,

click OK.
• From the Display menu select Shaded

Render* to be able to see your objects better.
Observe the result which should be as shown
to the right.
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Note that, from the first pair of cylinders, you selected their side surfaces, which are the ones that were blended.  You
selected the side faces with a single click on each, thanks to the option you turned on in the Pick Options dialog.  From
the second pair of cylinders, you selected the top of the lower and the bottom of the upper cylinder.  You did the selection
by clicking twice on each cylinder.  The blending is applied between the top and bottom surfaces you selected.

Both results consist of three separate volumes:  the original two and the blend surface, which is not solid.  However, there
are ways and options to make it a solid and also to produce a single object.  You will do such variations shortly.
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• Clear and Clear Ghosted.

• Draw a square surface on the XY plane and a
cylinder.  Then move the cylinder up.  Your objects
should be roughly as shown to the right.

With the Blend tool active click on 1 and 2,

then 3 and 4.
• When the Blend Edit dialog appears, select

Custom for both Start and End and set the
Bulge sliding bars to 25 and 75%, respectively.
Also select Make Solid and click OK to exit.
Observe the result.

You again selected the surfaces to be
blended using two points.  This time you
selected the side face of the cylinder to be
blended with a surface that is perpendicu-
lar to it.  Also, the order in which you
clicked to select the cylinder side face is
significant, as it determines the direction
of the blending.  You may actually want to
repeat the operation and pick the side face
of the cylinder by clicking in reverse order
to see how the blending result is going to
be different.

• From the Display menu select Shaded
Render* to see your object better.

The result again consists of three pieces, which are the two original
operands (one surface and one solid) and the blend object, which is now
a solid, due to that you selected the Make Solid option in the Blend Edit
dialog.  You can next use the Boolean Union operation to union the two
solids into one solid, but we have not yet covered the Union operation.  In
the next example we shall see how objects with open ends can be stitched
into single objects at the time the blending surface is generated.
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• Clear and Clear Ghosted.

Select the 3D Extrusion modifier, leave Height at its default 10’,

and draw two arcs and a single segment, roughly as shown to the left.

With the Perpendicular switch on, use the Move tool to move the

small arc up and the single segment extrusion down, roughly as shown.

Set the Topological Level to Segment.

With the Blend tool active click on 1 and 2.

• When the Blend Edit dialog appears,
set the Bulge sliding bars for bothStart
and End to 50%, select Stitch Start
and Stitch End, and click OK to exit.
Observe the result.

With the Blend tool active click on 3 and 4.

• When the Blend Edit dialog appears,
leave all the options as they are, and
click OK to exit.  Observe the result.

This time, you selected the edges of the surfaces to be blended, two at a time.  The first click determines the Start and
the second the End of the blend.  After the first operation a blend was generated between the single segment and the
larger arc extrusions.  The blend surface was stitched to the other two and they all became a single surface.  The second
operation blended the result of the previous operation with the smaller arc extrusion.  The result is again a single surface,
thanks to the selection of the Stitch Start and Stitch End options in the Blend Edit dialog.

• From the Display menu select Shaded Render* to see your object better.
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17.4  Filleting surfaces

The fillet operation creates rounded fillets between two faces of existing
objects.  They may be faces of the same or of different objects.  They
may be disjoint or they may intersect.  The result of the operation is a new
object with a fillet that fuses the selected faces.  The fillet operation in
some ways resembles the rounding operation, but it is also in many
ways different.  The most notable differences are in the way the
operands are selected and in that it always produces smooth objects.

The first example you will do is intended to show some of the similarities
and differences with the rounding operation.

• Draw a cuboid (extruded rectangle), roughly as shown.

Select the Fillet tool and in its tool options palette Deselect the

Preview option.
• Invoke the Pick Options dialog and in it, under Pick

Outlines/Faces/Holes By Clicking, select Inside
Boundaries.  The On Edges option remains on.

With the Fillet tool active, click on 1 and 2.

Observe the result.  The front vertical edge is rounded.

With the Fillet tool active, click on 3, 4 and 5, 6.

Observe the result.  The back vertical edge is rounded.

Note that both times I selected faces.  The first time I selected the faces with a single click,
which works fine since the Inside Boundaries option is on.  I can only use this picking
option when the faces are front facing.  Thus for the second operation I had to use two
clicks to pick the faces, because they are both facing to the back.

With the Fillet tool click on 7, 8, and 9.  Then on 10, 11, and 12.

Finally, click on 13 and 14.  Observe the result.
• From the Display menu select Hidden Line* and then

Shaded Render* to see your object better.
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For the previous example we filleted faces that belonged to
the same object.  For the next examples we shall fillet
surfaces from different objects.

• Draw two primitives, a cylinder and a sphere.
Move them as necessary so that they intersect,
roughly as shown.

Select the Fillet tool and in its tool options palette

turn on the  Preview option.

With the Fillet tool active, click on 1 and 2.

The Fillet Edit dialog appears and displays the object you are
about to generate.  It may be what you expected or may be not.

• In the Fillet Edit dialog for Fillet Type select
Concave.
Observe the object in the preview area.

• Click OK to exit the dialog.
Observe the object that has been generated.

top view

• From the Display menu select Hidden Line*
and then Shaded Render* to see your object better.

You should have notice d that there additional options, labeled Ad-
vanced, in the Fillet Edit dialog.  They allow you to generate, in addition
to the Circular, Elliptical and Bevel fillets.  However, they will not
concern us in this Tutorial.
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18  Curves

The seventh left row of the modeling tools palette contains operators that produce special types
of derivative objects.  Curved lines can be derived from straight vector lines.  There are three
types: nurbz, tangent, and spline curves.  Each curve type can be generated as one of two model
types: facetted or smooth.  Once they are generated and stored as parametric entities, a variety
of operations can be applied to them, such as editing and reconstructing them, attaching,
blending, and merging them.  These operations are in the Smooth Curves palette, shown below:

Smooth Curves:

This palette is already in your tool bar and you will be ready to proceed as soon as you launch
the program.

• Launch form•Z

Turn on the Grid Snap.
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18.1 Generating and editing curves

Smooth curves are generated from straight vector
lines, which you will have to draw first.

With the 2D Surface modifier on, select the

Vector Line tool and draw an open and a
closed 2D line, roughly as shown.

• From the Interactive tab of the Wire Frame dialog,
select the Show Points option.

This is to simply be able to read your points better and to visually distinguish between
the smooth and facetted curves.

Select the Curve tool and observe the settings in its tool

options palette.  Turn on Edit and leave the rest as they are.
• With the Curve tool active, click on the open vector shape.

The Nurbz Curve Edit dialog is invoked and, in its preview area,
it displays the curve that is about to be generated.

• In the dialog select Facetted and enter 5 for Degree.
Observe how the curve displayed in the preview area changed.

• Make more changes in the dialog and observe
the effects.  When done, click on Reset and
then on OK to exit.

  Select the Curve tool and in its tool options

palette select Tangent Curve and deselect
Edit.  Then click on the closed vector shape.
Observe the curve that is generated.
You may want to try more options on your own.
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You will next edit the curve you generated to change its shape.

With the Edit Controls tool (located next to the Pick tool

on the 4th row right) click on the open curve.

As soon as you do, two things happen:
the Edit Controls Options palette appears
and your curve is redrawn with its controls, as shown.

The Edit Controls Options palette
contains a sliding bar that controls the
preview graphics and three icons that
represent the actions that are available for
editing.  For the smooth curves these
actions are move, insert, and delete.
You can select an icon to apply the re-
spective action.  Move is already selected
as the default and is the only one you will
use in this Tutorial.

The controls displayed with your curve in edit mode are the points, segments,
and weights.  They can all be moved to change the shape of your curve.

You will move a few of the controls in this example and observe
how they affect the shape of your curve.

• While in edit mode, click on 1, drag the point to 2, and
click again.  Observe how your curve changes.

• While still in edit mode, click on weight point 3, drag it
a bit closer to the corner control point, and click again.
Do the same with weight point 4.
Both times, observe how your curve changes.

• While still in edit mode, click on 5 to pick a segment,
then drag it to 6 and click again.
Observe how the whole segment moves and how it
affects the shape of your curve.
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• Click away from the curve
to exit the edit mode.

You may want to continue experi-
menting on your own by editing
the tangent curve you generated
earlier from the closed vector line.
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18.2  Operating on curves

You shall next apply a few operations on the open curve you
generated earlier.  All the tools you will be using are located on
the Smooth Curves palette, the same palette where the Curve
tool is.

With the Break Curve tool active (2nd from the right end) click on point 1.

If Show Points is still on in the Wire Frame dialog, a point mark
appears where you clicked.  Your curve has been broken to two pieces,
but you can not tell until you actually move one of the pieces.

With the Move tool move the upper piece up and to the left.

  With the Attach Curve tool (3rd from left) click on 2 and 3.

Observe the result.  Note that Equal Tangents is selected by default
from the Alignment pop up menu in the tool options palette (or dialog).
Try some of the other items in the pop up menu and observe the results.

Undo and with the Blend Curve tool (4th) click on 2 and 3 again.

Again, the default Alignment menu item is Equal Tangents and you
may also want to experiment with the other options on your own .

The curve that blends the original two curves is a separate piece.  It is possible to join the
three pieces into one at the time the blend curve is generated.  This is done by turning on
the Merge option available in the tool options palette for the Blend Curve tool.  There is
also a tool that can produce the same result.  You will use it next.

Select the Merge Curve tool (5th) and in its tool options

palette select Positional for Alignment.  Then click
on 4 and 5.  Observe the result and click on 6 and 7.
Observe how the point markings have disappeared.
The curve is now a continuous curve.

Select the Extend Curve tool (6th) and click on 8.

A spline that is attached to the end of your curve is
rubber banded as you move the mouse around.
When satisfied with what you have click again (9).

In the tool options palette for the Extend Curve tool

select Construct Arc, then click on 10 and 11.
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18.3 Controlled curves

The last tool in the Smooth Curves palette contains the C-Curves tool, which generates curves
similar to those generated by the Smooth Curves tool.  However the c-curves are always facetted
curves and deviate from the pure smooth curves in a variety of way which are dictated by practical
consideration.  Also their editing procedures work differently.  You will do a few examples.

• Clear and Clear All Ghosted.

With the Vector Line tool draw a

2D line roughly as shown.

You will use this line to parade through the
different types of available c-curves.

You may draw some other vector lines, open or closed, and use them to generate more curves.

After you have experimented enough, you will learn to generate curved lines in edit mode.  We
assume that some curve that was generated from the vector line you drew at the beginning of this
section is still displayed on the screen.

• Invoke the C-Curve Options dialog and
select Cubic from the Quick Curves group.

  With C-Curve tool click on the curve you

generated earlier.
It is transformed to a different curve.

Repeat the operation once for each type of curves
available in the C-Curve Options dialog.

Invoke the C-Curve Options dialog and select:

Adjust To New Parameters and Construct
Directly.  The default Quadratic should also be on.

  Set the topological level to Object.

  With the C-Curve tool active click on the vector line.

The lines have transformed into a curve, as shown.

Quadratic Quick Curve Cubic Quick Curve
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• From the C-Curve Options dialog select
Edit and Quadratic.

With the C-Curve tool pick the curve displayed

on the screen.
Your image should now look as shown.

Your curve looks different now.  In addition to the curve
itself, the original vector line and two types of circular
marks appear.  Some are on points of the line and
some are in the middle of segments.

The vector line itself is called a control line  and the points on it control points.  The points in
the middle of the segments are called knots.  All together are called controls.  The curves you
have been generating are called controlled curves (c-curves) because they are internally stored
with the controls you see.  These controls can be changed, as you will do in a moment.

Something else happened when you executed the C-Curve operation this last time.  The icons
in the tool palette were grayed out.  This indicates that you are now in c-curve edit mode  and
that your modeling tool palette is inactive.  You can exit the edit mode by double clicking the mouse
or by clicking on the grayed out tools.  Do not exit the edit mode yet.

Move your mouse cursor around the controls.  You notice that the cursor changes and each
different icon indicates a different operation.  When it is

• close to a point it changes to and you can move a point;

• close to a segment it changes to and you can move a segment; and

• close to a knot it becomes and you can move a knot.

Place it close to a point and, as soon as it changes to  , click, then move the mouse.  The point
you selected follows the motion of the mouse and so does your curve.  Click again.  The control
point you selected moves to the new position and the curve is regenerated.  You are now ready
to select another entity and apply a similar operation.  After you have done enough manipulations,
double click to exit the edit mode.

You can repeat the editing process with different types of curves.  You can also use keyboard keys
to apply additional operations, but we shall not discuss them here. You can read about them in
UM section 4.13.9.

A Quadratic Quick Curve in edit mode.

control line
control point

knot
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19  Curved surfaces

The Nurbz Surfaces palette, shown below, is on the 7th row right of the default tool bar.  It is
currently missing and you will have to bring it in before proceeding with the examples in this
chapter.

Nurbz Surfaces palette:  

This palette contains tools that execute operations similar to those on the 7th row left, except that
they apply to nurbz surfaces rather than the curved lines that were covered in the previous chapter.

The first tool (left to right) in the Nurbz Surfaces palette generates nurbz surfaces using one of
five available methods, which is selected from the dialog or options tool palette of the tool.  You
will do examples with four of these methods in this chapter.

The second tool generates nurbz cross sections and the next nine tools execute a variety of operations
similar to those available for curves.  You will be doing examples with most of these operations.

The last tool generates a special type of NURBS and spline based meshed surfaces or solids
called c-meshes.  These are of a hybrid character as they combine NURBS and facetted
representations, which allows them to cover a wider spectrum of forms.  You will do a few
examples of c-meshes in the last section of this chapter.

• Launch form•Z and click on
Customize Tools... in the
Palettes menu.

• Reintroduce the Nurbz Surfaces
palette to the right 7th row of the
tool bar.

Turn on the Grid Snap.

You may tear off the newly reintro-
duced palette, as we did.  Your screen
may now look as shown to the right.
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19.1 Nurbz surfaces by lofting

In this section you will learn how to create NURBS surfaces (called nurbz in
form•Z) from sets of open or closed vector lines or spline.  Before we can do
the first example you need to draw and position the lines we shall use.

With the Vector Line tool draw two 2D lines, roughly as shown.

Note that they are drawn on the upper left quadrant of the ZX plane,
using the front view.  You will next copy-rotate these lines.

From the Self/Copy modifiers select Continuous Copy.

With the Rotate tool make copies of the two vector lines.

Position the copies of the higher line on the axes and the copies of
the lower line on the diagonals, as shown.

With the Pick tool select all the lines in order, except the front one.

With the Nurbz tool (1st on the Nurbz Surfaces palette) click

anywhere in the graphics window.  Observe the generated surface.

• Undo.  The vector lines should still be preselected.  With the Pick
tool select the remaining vector line.

  Select the Nurbz tool and in its tool options palette turn on Closed

In Depth.  With the Nurbz tool active click anywhere in the window.
• In the Hidden Line Options dialog turn on Show Facets Of

Smooth Objects and let the Hidden Line* execute.
Then select Surface Render*.
The images of your nurbz surfaces should be as shown.

A few clarifications should be in order:  Except for the Closed In Depth
option you turned on for the second example, you have sofar used all the
default settings in the tool options palette for the Nurbz tool.  The Surface
Construction type was By Loose Lofting and Degree for both
Length and Depth was 3.  This allowed you to pick 7 and 8 vector lines
for the examples you did.  You needed to pick at least 4, which is the depth
degree plus one.  Had you picked less than this the program would have
issued an error message.

You will next use closed shapes and a few more of the
options available for the Nurbz tool.
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With the Vector Line tool draw four squares on

the XY plane, roughly as shown.

Turn on the Perpendicular switch and with the

Move tool move three of the four squares up,
roughly as shown.  It does not really matter if
you deviate a bit.

  With the Pick tool click on the squares, bottom to top, to select them.

  Select the Nurbz tool and make sure that, in its tool options palette

Closed In Depth is off.  With the Nurbz tool active click anywhere
in the window.  Observe the result.
Shown to the right is a wire frame as well as a hidden line rendering.

• Undo and in the tool options palette for the Nurbz tool turn on
Rounding Start and End.  Your squares should still be picked.

  With the Nurbz tool active click in the window.  Observe the result.

You will next use a different Construction method.

• Undo and, in the tool options palette for the
Nurbz tool, turn off Rounding Start and
End and select By Tight Lofting.
The squares should still be picked.

  With the Nurbz tool active click in the window.

Observe the result.

You may want to try some more of the settings in the tool options palette for the Nurbz tool, such
as different values for Degree and variable settings for Caps and Rounding.  Do not attempt
different Surface Construction methods yet, because they require different type of input.
You will do some more examples with different methods next.
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19.2  Nurbz by boundary and U,V curves

Working on a ZX front view, draw two arcs, as

shown.  Note that their centers are also shown.
• Working on a YZ right view, draw a line that

consists of two arcs and a straight segment,
as shown.

• Working on a 3D view, make a copy of the line
you drew on the YZ plane and move all four
lines so that they touch at their ends, as shown.

With the Pick tool select the 4 lines.

Activate the Nurbz tool and in its tool options

palette select By Boundary Curves.
With the Nurbz tool click in the graphics window.
Observe the result.  You have generated a
nurbz surface from four boundary curves.

• Select Hidden Line* (Display menu).

You will next draw two more curves, one in the U
(length) and the other in the V (depth) direction.

• Undo and working on the ZX and then on the
YZ plane, draw a shape on each, as shown.

When viewing them in a 3D view, the new shapes are in the middle
between the previous pairs of shapes, in each direction.  You now
have 3 shapes in the U and 3 shapes in the V direction.

Activate the Nurbz tool and in its tool options

palette select By U/V Curves and in each of
the Number In Length (U) and Number
In Depth (V) fields enter 3.
With the Nurbz tool active click on the 3 shapes
in the U direction and then on the 3 shapes in
the V direction.  Observe the result.

• Select Hidden Line* and Shaded Render*,
then back to Wire Frame*.

• Undo three times to return to the four bound-
ary curves and use them again to generate the same
nurbz by boundary surface you did earlier.  You will use
it for the exercises you will do next.

ZX plane (front view) YZ plane (right view)

ZX plane (front view) YZ plane (right view)
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Select the One Copy modifier and with the Move tool

click on 1 and 2.  This males a copy of your object, as
shown in top view and a 3D view.

With the Attach Nurbz tool (5th on the Nurbz Surfaces

palette) active, click on 3 and 4.
Observe (right) how the end of one of the surfaces is
extended and fits the end of the other surface.
The two surfaces continue to be separate, but the option Merge is

available in the tool options palette for the Attach Nurbz tool.

• Undo.

With the Blend Nurbz  tool (6th on the Nurbz Surfaces

palette) active, click again on 3 and 4.
• Select Hidden Line* from the Display menu.

Observe (below) how a new surface is generated
between the ends of the two picked nurbz surfaces.
Here again the three surfaces are separate until the Merge option

is turned on in the tool options palette for the Blend Nurbz tool.

• Undo.

With the Blend Nurbz  tool active, click on 4 and 5 .

• Select Hidden Line* from the Display menu.
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19.3  Operating on nurbz surfaces

If you followed our instructions you have the nurbz surface shown to the left on your
screen.  You will make a copy and the use the two copies to execute a number of
operations.  When viewed in a top view your surface looks as on the right.
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• Undo.

With the Extend Nurbz  tool (8th on the Nurbz Surfaces

palette) active, click on 6.  Observe the result.

With the Extend Nurbz tool active inspect its tool options palette.  You
have used Extend At Distance , 4’ for Distance, and Surface
Edge for Extend Direction.  These are all default settings.

• In the tool options palette select Control Points for
Extend Direction, and enter 10’ for Distance.

• Undo.

With the Extend Nurbz  tool active, click on 7.

Observe the result.

You will next use the Extend To Curve variation of the Extend
Nurbz tool.  However, before you can do it you will use a number of
other tools to prepare the objects you will need for the operation.

• Undo twice.

With the Extract Curve tool (3rd on the Nurbz Surfaces

palette) active, click on 8.  Observe the result.

With the Split Nurbz tool (9th on the Nurbz Surfaces palette)

active, click on 9.  Observe the result.

With the Delete tool click on 10 and 11.  Observe the results.

Your data is now ready to execute an Extend To Curve operation.

With the Extend Nurbz tool active, in its tool options palette,

select Extend To Curve, then click on 12 and 13.
Observe the result.
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length depth

Moving two of the lines in the Y direction.

Three lines drawn which
will be used for the

generation of a mesh.

19.4  Controlled meshes

The controlled meshes or c-meshes are generated by lofting sets
of control lines.  They are parametric and can be edited after their
initial generation.  Their representation may be partially NURBS
and partially facetted, which allows them more flexibility than the
pure NURBS (nurbz) you experienced in the previous examples.

• Clear and Clear All Ghosted.

Switch to the ZX Reference Plane (window tool palette).

The 2D Surface tool should be selected.

Select the Vector Line tool and draw three

lines as shown.

  Turn on the Perpendicular switch.

Set the topological level to Object.

Select the Move tool and move two of the

lines along the Y axis, roughly as shown.

You can move the lines while in the 3D view, by turning on the

Perpendicular switch (window palette) or you can go to the Top
view and move them there.

Before proceeding, save your project.  Call it
“Control_Lins1”.

You will next use these lines as control lines to
generate a 3D mesh.  Before you do that you will
select the proper parameters from the C-Mesh
Options dialog or tool options palette.

Invoke the C-Mesh Options dialog and

in it select Edit.  Under Mesh Length
select # Of Segments and in its field
type 15.  Do the same for the Mesh
Depth parameters.
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1

2

Moving segment 1 up. Moving segment 2 down. Moving the corner points outwards.

Select the Pick tool and click on the three lines, front to

back.

Select the C-Mesh tool.

• Click anywhere in the graphics window.
After a second the image on your screen should look as
shown.

You have entered the c-mesh edit  mode  and your tool palette has
been grayed out.  In general, you are under conditions similar to  the
c-curve edit mode and, as you move your cursor around, you will
notice that it changes when it is close to certain entities.

• Close to a point it changes to    and you can move a point;

• close to a length segment it changes to    and you can move a length segment; and

• close to a depth segment it changes to     and you can move a depth segment.

When the cursor changes, you can click and start moving the entity.  You click again to complete the
move.  You need to be aware of where you move in 3D space.  Recall that you move parallel to the
reference plane, or in a direction perpendicular to it when the Perpendicular switch is selected.  While
the modeling tool palette is inactive, the window icons remain active and you can use them.

Apply the moves we show above or try your own.  We moved segment 1 up and segment 2 down.
We then moved all the corner points outwards.  You exit the c-mesh edit mode by double clicking
anywhere in the graphics window.
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The c-mesh surface after exiting the edit mode.

The c-mesh generated after changing the
density parameters and types of curves.

When you exit the c-mesh edit mode by double
clicking, the mesh is regenerated as shown.  You
will next regenerate the c-mesh, once again using
the Edit C-Mesh tool, with different parameters.

From the C-Mesh tool invoke the Con-

trolled Mesh Options dialog.

• At the top, select  Construct Directly
and Adjust To New Parameters.

• Under Mesh Length select
# Of Segments and enter 25.

• Under Mesh Depth select
# Of Segments and enter 20.

 • Open the Smoothing tab.
This tab contains the curve types to be
applied in the length and depth directions.

• For both Length and Depth select Quick
Cubic and the Adjust To New options.

With the C-Mesh tool click on the mesh.

The mesh is regenerated as shown.

This time, in addition to the mesh being denser due
to the higher numbers you entered in the # Of
Segments fields, its curvature is also different.
This was caused by the different type of curves you
selected.

You will do one more example which will show you
that closed shapes can also be used as control lines
for the creation of c-meshes.  You will also see how
square shapes can be used to derive round meshes
and how the mesh can be two sided as opposed to
the one sided meshes you generated in the previous
example.  In this example the  C-Mesh tool will be
used in a direct fashion, without editing.
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• Clear and Clear All Ghosted (Edit menu) to start
with a fresh window.

• From the View menu select the Top view.

Select the 2D Surface tool.

The Grid Snap should be on (window palette).

Select the Rectangle tool and draw six concentric

squares on the XY plane, roughly as shown.
Before proceeding, save this project.
Call it “Control_Lins2”.

-x +x-x +x

Use the rectangle tool to draw six squares from
lower left to upper right.

+y

+z

Move to position the squares along Z.

+z

The moved squares in a
front view.

While the squares do not have to be the exact size we show,
they must all be drawn in the same direction.  We drew ours
from lower left to upper right.

• From the View menu select
z=30°  x=60°  to switch to a 3D view.

Turn on the Perpendicular switch.

• Move and position the squares roughly
as shown.

You may also go to a Front view to move your
squares or to simply verify that they were
moved properly.  A front view is also shown to
the right.

Invoke the C-Mesh Options dialog and in it

select Construct Directly.
• Under Mesh Length,

in the # Of Segments field enter 10.
• Under Mesh Depth,

in the # Of Segments field enter 10.
• Open the Object Type tab and select Two

Sided.

Now that you have drawn your control lines and you
have selected the appropriate parameters you are
ready to create a c-mesh.
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Set your topological level to Object.

Select the Pick tool and pick the six squares in order (bottom to top).

Select the C-Mesh tool.

• Click anywhere in the graphics window.
A meshed “vase” appears on your screen directly and the system does
not enter the edit  mode.  On the right top, it is shown in wire frame.

• Select Display: Hidden Line*.
A hidden line plot is displayed.  Note that both sides (inside and outside)
would be visible even if the Show Surfaces As Double Sided option
were deselected in the Display menu.  Your vase is a surface solid,
which is a two sided surface.

You will next regenerate your mesh with higher density.

Invoke the C-Mesh Options dialog again.

• In the dialog, under Mesh Length, in the # Of
Segments field enter 30.

• Under Mesh Depth, in the # Of Segments
field enter 4, and select Per Segment.

With the C-Mesh tool click on the mesh.

• Select Hidden Line* (Display menu).
A higher density vase has been generated,
using 40 segments for each circle (length) and
20 segments along its height (depth).

The 20 was determined by the 5 intervals between the 6 control squares
and the 4 you entered for the Depth # Of Segments, in conjunction with
the indication that these should be applied Per Segment rather than
from top to bottom, as would have been the case if the latter option were
not selected.

• Invoke the C-Mesh Options dialog and in the Object Type tab
deselect Two Sided and select Closed Ends (Surface/Solid).

With the C-Mesh tool click on the mesh and then select Hidden Line*.

The result should be as shown to the right.
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20  Patches

A patch is a parametric curve-bounded surface of four or three sides.  There are two types of
patches:  bicubic Bezier and Coons.  While the patches are similar to the c-meshes and nurbz in
that they use parametric surfaces to bound an object, they are also different.  The c-meshes and
nurbz by lofting use one set of directional controls, which are parametrically interpolated along their
length and depth to produce 3D surfaces.  Patches and nurbz by boundary curves are multi-
directional.  A characteristic unique with the patches is that their controls are at the patch level.  This
allows them to handle variable local resolutions that is not possible with the c-meshes and nurbz.

The Patches palette that contains the Patch tools is missing from your tool palette and you will
have to reintroduce it.  You will do the same for the Metaformz palette, which you will need in the
next chapter.

• Launch form•Z.
• Click on Customize Tools...

in the Palettes menu.
• Reintroduce the following two

palettes:

Patches:

Metaformz:

Your screen should now look as shown
to the right:
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There are four tools in the Patches palette:  Patch Derive (  ), Patch Grow (  ), Patch Divide

(  ), and Patch Attach (  ).  Examples with all the patch tools are presented in this Chapter.

However, these examples are only intended to introduce the basic functions of the tools.
Modeling with patches tutorials are presented in section 38.

Each of the patch tools represents a distinct method of modeling, as follows:

• A patch can be derived from virtually any object, using the Patch Derive tool.  The original
object typically functions as a low resolution approximation of the intended form, and is usually
referred to as a cage.  A patch can be derived at any density and curvature level.  Then parts of
it can be edited and reshaped.

• After starting with an initial patch, additional patches can be grown from its open edges with
the Patch Grow tool.  These are typically grown in a manner that delineates the surface of a
volume you wish to model.  At every step, editing operations help shape the form.

• Starting with a plain object, for example a cube, its faces can be subdivided any number of
times using the Patch Divide tool.  Curvatures at different resolutions can be applied to them and
editing operations can be used to reshape them.  This way a cube may be transformed to an
organic form.

• Starting with the outline of a 3D form, it can be initially sketched by placing rough patches.
These patches can then be joined into a continuous surface, using the Patch Attach tool.  Again,
patch editing complements the process and leads to the production of a final form.

You will next proceed with a few examples.

Turn on the Grid Snap.
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20.1  Deriving patches

You will first generate a few variations of patch objects from a
hexagonal extrusion.

Select the Patch Derive tool and observe its options in the

tool options palette.
Make sure Subdivide and Smoothing are off.

• Generate a hexagonal extrusion, as shown below
(it is about 32’ in diameter and 10’ tall).

• With the Patch Derive tool active click on the object.
Observe the result.

• Undo, turn on Smoothing, and In.
• With the Patch Derive tool active

click on the object.

• Undo, select Out, and set the
Curvature bar to 0%.

• With the Patch Derive tool active
click on the object.

• Undo and set Curvature to 50%.
• With Patch Derive click the object.

Next, repeat exactly the same operations,
except with Subdivide turned on.

The patch variations are illustrated to the
left:  on the first pair of rows are the patches
with Subdivide off; the top row shows
them in wire frame and the lower in hidden
line.  On the second pair of rows are
variations with Subdivide on, again
shown in both wire frame and hidden line.

Patch surfaces are generated on the faces of the hexagonal extrusion.  The rectangular side faces are not subdivided.
The top and bottom hexagonal faces are subdivided into two 4-sided faces, even though the Subdivide options is off.
This is a normal procedure with patches.  Any surface with more than four sides is decomposed to four or three-sided
pieces.

You will next generate all the variations of patches with Subdivide and Smoothing on/off.
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20.2  Growing, stitching, and attaching patches

Next you will grow patches, a tile at a time, and build a solid.

With the Polygon tool draw a 2D hexagon of radius 8’.

With Subdivide off, with the Patch Derive tool click on the

hexagon (point 1).

Select the Patch Grow tool and in the tool options

palette select Perpendicular To Patch and Stitch.

Set topological level to Object.

• With the Patch Grow tool click on the hexagonal patch object (2).
Observe the result.  A patch has been generated at each edge of the hexagon.

• In the tool options palette, select Align Patch Normals and set the topological level
modifier to Segment.

• With the Patch Grow tool click on point 3 then 4.  Observe the result.

• In the tool options palette, select Between Edges.  Topological level is still at Segment.
• With the Patch Grow tool click on 5 and 6; then click on 7 and 8.

Observe the result.  Patches have been generated between two edges.

• In the tool options palette, select Construct Triangular Patches.
• Keep topological level at Segment and with the Pick tool select segments 9, 10, and 11.
• With the Patch Grow tool click anywhere in the window.
• Repeat the operation by prepicking 12, 13, and 14.

Observe the result.
Triangular patches have been generated between the three segments you preselected.

This completes the generation of your object, which is a solid.  The latter was made possible by
the Stitch option you kept on as you were growing the new patches.  Had this option been off,
the result would have looked the same, but would have been a collection of independent patch
objects, rather than the single object you derived here.

9

12

13

8

7

6

5

4

321

10

11

14

a b c d e f



 160 form•Z Tutorial  •  Patches

You will next do a variation of the previous example, which also uses the Smooth option.

• Undo as many times as necessary to go back to stage d.
• In the tool options palette Between Edges is on and topological level is at Segment.
• In the tool options palette select Smooth.
• With the Patch Grow tool active click on 5 and 6.
• Deselect Smooth with the Patch Grow tool active and click on 7 and 8.

Observe the result.  The patch that has been generated between the two edges is
smoothly rounded, which has also affected the neighboring patches.

• Proceed with the generation of the triangular patches between segments 9, 10, 11, and
12, 13, 14, as you did in the previous example.

After this step is done and you observe your object closely, you will notice that it still has two “free”
edges, and thus the object is not yet a solid.  You will next join or attach the free edges.

Note that you would normally have used the Query tool to check what is the type of the object you have created so far.
Had you done so, it would have told you that it is a meshed surface.  In contrast, if you had queried the previous object
it would have told you solid.  We did not suggest that you use the Query tool because it has not yet been covered.

Select the Patch Attach tool and observe its options in the tool options palette.
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Note that this tool can execute different operations, which include
the default Attach.

• Leave the default settings as they are: Move Edge is on.
• With the Patch Attach tool click on 15 then 16.

Observe the result.  Edge 15 is moved, takes the shape of
edge 16, and the two are stitched.

Your object is now a solid.

Note that, above, we did not bother with the topological level, because it is ignored.
Patch attachments are always executed at the Segment level.

We shall not cover any more details of the patch attachments in this tutorial.
However, you can experiment with them by yourself.  Generate a couple of
rectangular patches and try different options, as with the Patch Attach tool you click
on pairs of segments, one from each patch.
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20.3  Dividing patches

Next you will learn how to divide patches. Note that this is a very significant operation for patch
modeling, as it allows you to introduce variable local resolutions, where more detail and steeper
curvatures are needed.

Select the Patch Divide tool and observe its options, as

they are displayed in the tool options palette.

You notice that there are not too many options.  There are two
operations, Divide and Undivide, and under the former there are
two fields that control how many times the patch will be subdivided
in each direction, which are independent.

There is also the Lock Edge Points option, which is rather important.  When patches are subdivided, the sizes of edges
between neighboring patches that have different resolutions do not match and therefore they can not be stitched.
Consequently, they move independently, if they are not moved together.  This may result in a gap between them, which
disturbs their solidity.  To avoid this, the Lock Edge Points option can be used to restrict them from moving.

From the examples in 18.1, use two of the
patched extrusions.  Both are with Subdi-
vide off.  One is with Smooth off and the
other with Smooth Out at 0%.  They are both
shown to the right, on the top row, in both wire
frame and hidden line.

Patch subdivisions can be generated at the
object or face level.  When the former is in
effect it is executed as if all the faces of the
object were selected.  All the examples to the
right show face level subdivisions.

• Select the Pick tool and in the tool
options palette select the Clicking
Inside Boundaries option.

• Set topological level to Face and leave the Patch Divide options at their default settings.

With the Patch Divide tool click on face 1, then 2.  Observe the result.

• In the tool options palette, change Divisions In 2nd Direction to 4.
• With the Patch Divide tool click on 3, 4, then 5.  Observe the results.

You can continue and experiment some more with subdividing the faces of these or other patch
objects and observe how variable resolutions can conveniently be created on different portions
of patch objects.

1

3

4

2

5



 162 form•Z Tutorial  •  Metaformz

21  Metaformz

A metaform (plural metaformz) is a parametric object that has the ability to blend smoothly with
other metaformz, when they overlap.  Metaformz include the better known metaballs, which have
a spherical shape.

In form•Z, metaballs are generated directly as primitive objects with a tool located on the top right
palette of the modeling tool bar.  This tool has been in the tool bar since the early sessions of this
Tutorial.  Two more tools are on the 8th row right and are also already in your tool bar, since the
previous chapter.  Thus you are ready to go as soon as you run the program.

Metaformz other than metaballs are generated from common form•Z objects and are thus of a
derivative character.  They are presented in the second section of this chapter.  The third section
presents a step-by-step process of modeling with metaformz.

When metaballs and metaformz are first generated, they are in an unevaluated state
and they are represented by wires, as shown to the left.  They can be evaluated
directly and individually, which generates a facetted representation of what is known
as their implicit surface.  Most commonly they are evaluated in groups, which
produces smoothly blended implicit surfaces, when they overlap.  In form•Z, you can
optionally evaluate groups explicitly, using the Metaformz Evaluate tool, or you can
instruct the program to automatically evaluate them every time a new group is
constructed, or a new member is inserted into a group, or when the position of one
of the members of the group is changed.

A significant parameter of the metaformz is their Weight.  Its value
affects how far they blend when they overlap with other metaformz.  Its
sign determines whether their blending will be additive or subtractive.
Both are illustrated on the left.

After metaformz are evaluated, their control wires are still displayed and
they can be picked to transform them.  If the respective option is on, a
group of evaluated metaformz is automatically reevaluated when such
an operation is applied.  In other words, as implemented in form•Z, the
metaform based modeling process is graphically interactive.  You can
always inspect the results of your operations.  The remainder of this
chapter illustrates some of these operations.

• Launch form•Z.

Turn on the Grid Snap.
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21.1  Generating and evaluating metaballs

This and the next section present an overview of the types of metaformz available in form•Z.
Metaballs are covered in this section and the derivative metaform types in the next.  Recall that
the metaballs are primitive objects that are generated directly as all the primitives.

Select the Metaballs tool (from the top right row).

Observe its options as they are displayed in the tool options
palette, shown to the right.

Note that there are four variations.  You will sample them all.

• With the Metaballs tool active and the default Ball selected
in the options palette, click on 1, then 2.
After the first click the wires of a ball are rubber banded.
The second click generates the ball in unevaluated form.
You will evaluate it after all types have been generated.

• In the tool options palette
select Stretched Ball.

• With the Metaballs tool click
on 3, then 4, 5, and 6.
Observe how the wires
rubber hand after each click.

The first three clicks are on the refer-
ence plane; the last is on a line per-
pendicular to it.  The first click is the
center, the second is the radius, the
third stretches the ball horizontally,
and the fourth stretches it vertically.

• In the tool options palette
select Ellipsoid.

• With the Metaballs tool click
on 7, 8, and 9.

After the first click an axis of the ellipsoid is rubber banded as a single line.  After the second click an ellipse is rubber
banded.  The third click generates the ellipsoid.

• In the options palette select Stretched Ellipsoid.
• With the Metaballs tool generate the object with four clicks.

We shall let you figure out what each click does.  If you are not being successful, press esc  to cancel and start again.
Or Undo if you do not like what you did.

You have four metaballs in unevaluated form.  You will next evaluate them, one at a time.
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Select the Metaformz Evaluate tool.

Observe its options displayed in the tool options palette.
Select Evaluate Only When Selected.

• With topological level set to Object and the
Metaformz Evaluate tool active click on
the first metaball (the ball on the left).
The Metaformz Evaluation
Parameters dialog is invoked (left).

• Change nothing and click OK.
When you do, a facetted representation,
which is the evaluated implicit surface of
the metaball, is displayed.

• With the Metaformz Evaluate tool click on the second metaball
(the stretched ball).

• When the Metaformz Evaluation Parameters dialog
is invoked, change the Mesh Resolution X to 1.5'.
Because lock is on, the Y and Z fields will also take the same value.

• Click OK.  Observe the result.

• Repeat the operation with the other two metaballs (the ellipsoid and stretched ellipsoid).
When you are done, you have evaluated all four metaballs.  They are shown below.

• Select Hidden Line* (Display menu).  You can now see them better.
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21.2  Generating and evaluating metaformz
In this section you will generate types of metaformz that are derived from other plain form•Z objects,
rather than directly, as the primitive metaballs are.

• Draw a “pi” shaped open line, a rectangle, a hexagonal extrusion, and a pyramid (a).
Note that the size of the rectangle is 24’ x 12’.  To induce the results shown ,you will need roughly the same size of shapes.

Select Metaformz Derive/Edit.

Note that the palette is empty.
• Click on the open shape.

The Metaformz Parameters dialog is in-
voked.  Observe that Tube is the item displayed
in the Metaformz Type pop up menu box.  If
you look in the menu, there are quite a few more
items that can be selected.

• Without changing anything in
the dialog, click OK.
Observe the result (b).

• Repeat the operation with the
other three objects.
Observe the results (b).

As you pick each of these objects, a different item
is displayed in the Type menu.  The program
evaluates what type of object it is dealing with.  On
the basis of this it selects a default type and the
active items in the pop up menu.

For the 2D rectangle it defaulted to Sheet, while
a few more items were also available.  For the two
solid objects, the default was Polyhedron,
which was the only available selection.  In all
cases, we suggested that you keep the defaults,
as we did in the examples we show to the right.

The resolution of some of the evaluated metaformz appears to need refinement.  Next, you will do just that.

With the Metaformz Evaluate tool click on each of the unedited metaformz in b.

The evaluated result is as in c, also shown in hidden line in d.

• Undo eight times (to a) and repeat the operation with these differences:
• When the Metaformz Parameters dialog is invoked the first time (when selecting

the open shape), change Radius 1 to 1'.
• When the Metaformz Evaluation Parameters dialog is invoked the first time,

change the X, Y, and Z fields to 1’.

Observe the effect.  Above, the last row shows the finer resolution in hidden line only.
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21.3  Modeling with metaformz

In this section you will use a few metaformz, mostly metaballs, to model a dog’s bone.  Having
already learned how to generate metaformz, this section covers how to compose them.

Using the Metaballs tool and working on Top view,

generate two metaballs (of type balls), as shown.
To give you a sense of scale, we use the default grid set up and each

small grid square is 2'x2'.

Observe the Objects palette.  Two names, Object 1 and Object 2 are displayed in blue.  This is
the color used for metaformz.

• Click in the Objects palette.
The name Group 1 appears in edit mode.

• Click again under it to enter it.
You have just created a group, which is still empty.

Select Metaformz Evaluate to display its options.

• Select Automatic Evaluation.
• Click on Object 1 and drag it onto the group name.

The group now has a member.
Object 1 is evaluated and is now shown with a facetted
representation, which is superimposed on the wire
representation that continues to show.

• In the Objects palette, drag Object 2 onto the group.
Observe the result in both the palette and the window.
We show the newly evaluated pair of metaballs in both
top and 3D view.

• Draw two more metaballs, to the
right, at a distance of roughly 4
large grid squares, or about 32'.

Yes, our bone is a “giant”.  We are doing it at this size
to be able to use the default parameters.  After it is
done, it can easily be resized.

• Drag the name of each of the new metaballs (Object 4
and Object 5) and place them onto the group.
Observe the result.  Should be as shown to the left.
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• Draw a line between the two metaball configurations.
Its name, Object 6, now appears in the Objects palette.

With the Metaformz Derive/Edit tool click on the line.

• When the Metaformz Parameters dialog appears,
click on OK.
Observe the result.  The line has been transformed to a
metaform tube of radius 2'.  It is still unevaluated.

• In the Objects palette, drag Object 6 onto the group.
Observe the result.  The tube has blended with the metaballs.
However, when you inspect the form you conclude that its proportions are

not right.  The tube needs to be thicker.

• With the Metaformz Derive/Edit tool click a wire of the tube.
This invokes the Metaformz Parameters dialog.

• In the dialog, change Radius 1 to 4'.  Observe the result.

After looking at your bone, you conclude that it is not quite right yet.

• With the Metaformz Derive/Edit tool, click on the wire
controls of the middle piece again.

• When the Metaformz Parameters dialog appears,
from the Metaform Type pop up menu select Conic
Tube and in the Radius 2 field enter 6'.  Close the dialog.
Observe the result.

Looking at your bone you may conclude that the middle piece is now fine, but its ends still need refinements.  Some balls
need to be moved and some to be resized.  You can do all this using the regular Move and Uniform Scale tools, as follows:

To Move a metaform, with the Move tool active, click on its wires.  This rubber bands it.

Click again to place it to its new position.
Make certain you select the wire of the metaform desired and not the entire metaform.

To resize a metaform, with the Uniform Scale tool click on a wire of the part to be resized,

click to establish the scaling base, click again to set the unit scale factor.  The metaform
is rubber banded.  Click again to complete the scaling operation.

When you move, resize, or transform in any other way a metaform that has been
evaluated as part of a group, it is reevaluated as soon as the operation is completed,
assuming Automatic Evaluation is on, in the Metaformz Evaluate Op-
tions dialog (or tool options palette).

Make your own adjustments to the components of the bone, until
you are happy with its form.  Even if you are already happy apply
some transformations to experience the interactive processes.  At
the end, you may have something similar to what we show.  Execute
the Hidden Line* item to be able to see your final design better.
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22  Boolean, trim, and stitch operations

The first four icons on the eighth row of the default  tool bar execute Boolean operations.  The fifth
icon executes a variety of trim, split, and stitch operations.  While there are some similarities, the
Boolean operations are different from the Trim/Split operations.  The former apply to solids and
coplanar 2D shapes.  The latter are intended to apply to meshed surfaces.

To do examples of both Boolean and Trim/Split operations, you first need to invoke the tool palette
they are on.

• Launch form•Z.
• From the Palettes menu select Customize Tools....
• When the Icons Customization dialog appears, scroll the

Tool Palettes window to find the Booleans and Intersections
palette, and drag it into the tool bar, under the Smooth Curves
palette.

• After you have reinserted the Booleans and Intersections
palette on the left column, move the last two icons on the right
column one position down, to maintain the pairing of the tools.
This results in an empty box to the right of the Booleans and
Intersections palette, as shown to the left.

• After you close the Icons Customization dialog and return
to the project window, you may want to tear off the new palette,
which should be as follows:

.

Turn on the Grid Snap

You are now ready to proceed with the exercises in this chapter.
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22.1  Union, intersection, and difference of 2D shapes

• Select [+XY] Top from the View menu.

Turn Grid Snap on.

• Draw 2D rectangle A and triangular polygon B, roughly as shown.

Select the Union tool and click on 1 and 2.

Observe the result.
• Undo.

With the Intersection tool, click on 1 and 2.

Note that, for the union and the intersection, which shape is picked
first and which second is not significant.  The order in which the
shapes are picked is significant for the difference operation.  To show
this, you will execute the difference twice.

• Undo.

With the Difference tool active, click on 1 and

then 2, in this order.
• Undo.

With the Difference tool click on 2 and then 1.

Observe how the order of selection affects the
result of the Difference.

• Undo.

Select the B-Split tool and in the tool options

palette, observe that there are two variations
of the operations.  The default One Way is on.

• With the B-Split tool click on 1 and 2.
Observe the result, shown to the right.

• Undo.

In the options palette select Two Way and

with the B-Split tool click on 1 and then 2.
Observe the results shown on the right.
They are shown twice, the second time (far
right) with the pieces moved.

Union
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You will next do a more meaningful example.

• Clear and  Clear All Ghosted  (Edit menu).
• Draw a 2D triangular polygon as shown.

This time try to be as close to the example we show
as possible.

Select the Multi-Copy modifier, double click on it to

invoke the Copy Options dialog, and set the
# Of Copies field to 7.

Select the Rotation tool.

• Click on points 1 (picking the triangle), 2 (center),
3 (start of rotation angle), and 4 (end of rotation).

You applied a 45° rotation which was repeated a total of
seven times.  Together with the original shape, you now
have a total of eight triangles in a star-like arrangement.

• Execute Select All UnGhosted (Edit menu).

With the Union tool active click anywhere in the

graphics window.
Observe the execution of the sequence of unions.
When done, the result should be a star shape, as
shown.

You executed the Union using the prepick method.  This
allowed you to pick all eight triangles first, and to then
execute the Union only once.  The Boolean operations are
by definition binary; therefore, they only work on two
objects at a time.  When more than one object is picked the
system applies the operation to the first two, and then
repeats the operation using as operands the result of the
first application and the third object, and so on, until all the
preselected objects are exhausted.
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You will next apply the Boolean operations to 3D solids.
Before proceeding, execute Clear and Clear All
Ghosted  (Edit menu).  Then generate a hexagonal
extrusion and a cuboid as shown.  You may use tile
windows, as we did, to help align the objects.

• Select Windows: Tile Windows: Open.
• Click on the XY window (top) to activate it.
• Turn on the Grid Snap.
• Draw a 10’ high hexagonal extrusion.
• Draw a 2’ high rectangular extrusion.
• Click on the ZX window (front) to activate it.
• Turn on the Grid Snap.
• With the Move tool move the rectangle 2' up.
• Click on the zoom or maximize box (upper right

corner) of the 3D view window.  It expands to
occupy the whole screen.

• Select View: z=45°  x=45° .

Move the two objects you just generated to one of the
four quadrants of the grid, make three more copies and
place them in the other quadrants, as shown.  You will
use each of the four pairs of objects to execute a
different Boolean operation.  That way, at the end you
will be able to compare the results.

With the Union tool click on the objects in A.

With the Intersection tool pick the objects in B.

With the Difference tool click on 1 then 2 (C).

• With the same tool click on 3 then 4 (D).
• From the Display menu select Hidden Line.

The results of all four operations, displayed in
hidden line plots, should be as shown.

Note again that, for the union and the intersection the order in which
the objects are selected is insignificant.  For the difference the order
is significant, and picking the objects in reverse order produces
different results.

22.2  Union, intersection, and difference of 3D solids
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We shall next illustrate an idiosyncrasy of the difference.

• Clear and Clear All Ghosted (Edit menu).
• Generate two copies of a pair of 3D enclosures.

The first enclosure is rectangular and 10 feet high.  The
second is a single “wall” enclosure, which can also be
generated as a 3D Extrusion, and 15 feet high.

• With the 3D Enclosure tool selected and its options
displayed in the tool options palette,
set the Enclosure Wall Width field to 4'.

This is optional and we simply did it to make the enclosures more readable.
You will use the two pairs of objects you just generated to execute two
variations of the Difference operation.

With the Difference tool click on points 1 and 2.

Note that the operation has split the original
rectangular enclosure into two parts.

• Double click on the Difference tool to invoke the
Status Of Objects dialog and in it select
Store All Volumes As One Object.

With the Difference tool selected, click on 3 and 4.

The two results appear identical but they are quite different.
In the example on the left, each of the two volumes into
which the original object was split is a separate object.  In
the example on the right, the two volumes are parts of a
single object.  To verify this, move them.  The two volumes
on the left can be moved independently.  The volumes on
the right move together.
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22.3  Objects splitting each other

The B-Split tool, which you have already used on 2D shapes, is a
composite operation.  It can be executed in One Way or Two Way
mode, which can be selected from the tool options palette, when the
B-Split tool is active.  In one way mode, when object A is split by
object B, the result is the difference of A-B and the intersection of
A and B.  In two way mode, the two objects split each other, and the
difference of B-A is also kept as a result.

Before doing an example of a two way split, below, you need to
generate the objects that will be used in the operation.

• Clear and Clear All Ghosted to start fresh.
• Verify that the Grid Snap is still on (window palette).
• Select Front (View menu).
• Select Heights: Custom....  In the Custom Height

dialog type 32' and click on the Add To Menu button.

Select the 3D Extrusion modifier.

With the Vector Line tool draw the shape shown

(click on points 1, 2, 3, and 4, and triple click on 5).
Note that it is important to draw your object exactly as we
suggest in order to derive the same result.

• Select z=30°  x=60°  from the View menu.
• Use the Move tool to center the object around the origin

of the coordinate axes, as shown.
• Set the self/copy mode to One Copy.
• Use the Rotate tool to make a rotated copy, as shown.

A 90° rotation around the origin has been executed.

Now you are ready to execute the B-Split operation.

• In the tool options palette select Two Way.
Open the Status of Objects tab and select Object Per
Volume.

• With the B-Split tool active, click on each of the two objects.

• To be able to see the result better, move  the pieces,
roughly as we did, and execute Hidden Line*.

Note that it took many more instructions to tell you how to create your objects than
it did to execute the B-Split operation.  This is simply because to produce the same
results, your objects should be symmetric and with coincident points.
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22.4  2D Booleans for 3D modeling

Naturally, the 2D Booleans are faster and easier to
execute than the 3D Booleans.  Often, tasks that
appear to require 3D objects may best be executed
by initially using 2D objects and then extruding the
resulting surface objects.  For example, when
generating building models, it is frequently more
efficient to use 2D surface objects to derive the
“plan” of the building and to then extrude the
resulting shape.  You will do such an example next.

• Clear and Clear All Ghosted.
• Select the 2D Enclosure modifier .
• Use the Rectangle and the Vector line

tools to generate three 2D Enclosures
roughly as shown.

• Use the Pick tool to preselect the three
enclosures.  Select the rectangular shapes
first and the open shape last, that is in the
order shown.

Select the Union tool.

• Click the mouse in the graphics window.
The result should be as shown.

• From the Heights menu select 10' (or
any height you prefer).

Select the Derivative Extrusion tool.

• Click on the composite 2D Enclosure.
A 3D building model appears as shown in
both wire frame axonometric and hidden
line perspective plots.

Had you generated 3D objects first and then applied the Union
operator to them, it would have taken longer to produce the
same result.  That difference in speed becomes even more
apparent when a more complex model is generated.
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22.5  Booleans and rounding with smooth objects

Boolean operations can also be applied to smooth objects, as you will
see in this section.  You will first generate three smooth objects, then
Boolean them, and then round some of the edges of the final object.

• Select [+XY] : Top from the View menu.

Select the 3D Extrusion modifier and select 20’-00” from

Heights.  Make sure Smooth is on in the options palette.
Warning:  the part you will be modeling will be huge.  This is so to simply use default
setups of the program.  Big models can easily be scaled down after they are done.

With the Circle, Center and Radius tool click on 1 and 2.

• Switch to [-ZX] : Front and draw a circle from 3 to 4.
Working next on a Top view, move the second cylinder
so that its ends extend beyond the perimeter of the first.

With the Torus tool, click on 5, 6, and 7.

The three smooth solids should be as shown.

With the Union tool click on the large cylinder

and on the torus.  Observe the result.

With the Difference tool click on the previous

result and on the small cylinder.
Note that, in the Status Of Objects dialog (accessible from all the Boolean tools)
we selected Delete.  Thus we are not accumulating any objects but the operand
objects are deleted after a Boolean.

The rendered image of the result clearly shows that it has some
pretty rough edges.  You will next round some of them.

Select the Segment topological level.

Select the P-Round tool click on 8 and 9.

• Invoke the Plain Rounding Options dialog and under
Smooth Options select Use Radius and enter 2’ in its
two fields.  With the P-Round tool click on 10 and 11.

• In the Plain Rounding Options dialog set the two Use
Radius fields to 4’ and with the P-Round tool click on 12.
Then select Bevel and click on 13.
The final smooth-edge object should be as shown.
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22.6  Trimming and stitching

As already mentioned in the introduction of this chapter, the Boolean and the Trim/Split
operations are both similar and different.  For both, the first step is the derivation of the intersection
line of two objects, which typically splits each of the objects involved into two or more pieces.  From
this point on, they are different.  The Booleans, by using containment tests, are able to figure out
which parts of the two objects should be kept and made parts of the resulting object.  Exactly which
parts are kept depends on whether a union, an intersection, or a difference is executed.  The
Booleans’ ability to select the proper pieces is made possible by the fact that these operations
are applied to solids (or coplanar closed 2D shapes), for which what is in and what is out is well
defined.

In contrast, the Trim/Split operations are intended to be applied to surface meshes which typically
do not enclose any volume.  The Trim operation simply cuts one surface by another surface and,
after this is done, it does not really know which of the pieces to keep as a result.  Because of this,
it requires the user to tell it which one to keep.  It keeps the piece where the user clicked when
the object was selected for the operation.

The next level to Trim is the Split operation.  After a surface is cut into two pieces with another
surface, the Split operation returns both pieces as a result.  While the Trim operation resembles
the Boolean Difference, the Split operation resembles the Boolean Split.

After two meshed surfaces have trimmed each other, they may be stitched together into a single
piece.  This operation resembles the Boolean Union, but again, contrary to the Boolean Union
which is capable of deciding by itself which pieces to merge, the Trim/Split operation is not, and
relies on the user telling it which pieces to keep.  Because of this, where you click when you
execute one of the Trim/Split operations is significant since your click also tells the program which
pieces to keep.

While the  Trim/Split operations are designed to be applied to meshed surfaces, they can also
be  applied to solids, or mixed solids and surfaces.  However, when they do they abide by the
procedures of the Trim/Split and not of the Boolean operations.  The following tutorial examples
should help to further clarify these distinctions.

• Select the Trim/Split tool to display its options in the tool
options palette, as shown to the left.

Note that there are six variations that can be selected and each can
be complemented with a Stitch operation.  To apply some of these
operations you will need two meshed objects, which you will
generate first.

• Clear and Clear All Ghosted.



177form•Z Tutorial  •  Boolean, trim, and stitch operations

-x

+x

-y

+y

-z

+z

1

3

4

5

2

-x

+x

-y

+y

-z

+z

-x

+x

-y

+y

-z

+z

Select the YZ Reference Plane.

Turn on the Grid Snap.

• Draw two squares roughly as shown.
Draw them from the lower left to the upper right corner, and
draw both in the same direction.

Select the XY Reference Plane.

• Draw three squares roughly as shown.
Again, draw them the same way (lower left to upper right).

You may want to turn on the Show First Point and
Show Direction options in the Wire Frame Options
dialog (as we did) to verify that the first points and the
directions are consistent.  This dialog is invoked by press-
ing option (Macintosh) or ctrl+shft  (Windows) as you click
on the Wire Frame* item, in the Display menu.

• Move the squares roughly as shown.

Select the C-Mesh tool and, in the options palette, select

Construct Plain Mesh and Construct Directly.
Also, in the Object Type tab, make certain that Two
Sided is off.

• With the C-Mesh tool active, click on points 1 and 2.

Select the Pick tool and click on 3, 4, and 5.

With the C-Mesh tool active, click in the graphics window.

Recall that the order in which you select your control lines affects
the directions of your surfaces.  Try to follow our suggested order
or you may produce different results.

You have just created two cylindrical surfaces, one roughly pen-
etrating the other.  They are one sided surfaces. If they were two-
sided the Trim/Split operations would not accept them.  This is why
above we asked you to make  certain that the Two Sided option
in the Object Type tab was off.

You are now ready to try the trim, split, and stitch operations.
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Select  the Trim/Split tool and in the tool options palette

select Trim in the First Object column.

Set the topological level to Object.

• With the Trim/Split tool click on points 1 and 2, in this order.

For this operation the position of the second click is actually insignificant.
However, the position of the first click is very significant since it
determines which portion of the first object will be kept after it is trimmed
by the second.

The result, when shown in wire frame, is not very legible.

• Select Display: Hidden Line*.
You can now clearly see the result of your trim operation.

• Select Display: Wire Frame*.
• Undo to return your objects to their original state.

With the Trim/Split tool click on points 2 and 1, in this order.

• Select Display: Hidden Line*.

You have now trimmed the second object with the first.

It is also possible to derive the above two results with a single execution of the trim operation.  This
is done when, in the tool options palette, you select Trim under the Both Objects column.  Such
a selection causes the two objects to trim each other.

While the Trim operation simply cuts a piece away from the trimmed surface, the Split operation
separates an object into two or more pieces.  You will try it next.  You will execute it in a manner
such that the two objects split each other.

• Select Display: Wire Frame* and Undo.

Select the Trim/Split tool and in the tool options palette select

Split under the Both Objects column.  Then click on points
1 and 2.

Your display appears as if nothing happened.  The objects have split
each other, but the pieces have remained in their original positions.  To
be able to better see what happened, move the resulting pieces apart,
as shown.  To see the result more clearly, generate a hidden line plot.

• Select Display: Hidden Line*.
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The Trim and Split operations can also be applied in a manner where one object is trimmed or
split by a line.  This  is done when an operation under the column labeled With Line is selected.
You will try such operations next.

• Select Display: Wire Frame* and Undo enough times to return to the original objects.
• Clear All Ghosted and Delete the second (small) object.
• Working in [-ZX] Front view, use an Arc tool to draw two semi-circles, as shown.

Note that the front projection is the negative side of the ZX
plane.  Therefore, the Clockwise Arc tool will draw in a counter-
clockwise direction, and the Counterclockwise Arc tool will
draw in a clockwise direction.  If the direction of the arc is not the
way you thought it would be, you can still change tools after you
start drawing.

Now you have an object and two lines with which
you can execute trim and stitch operations.

After your objects have been trimmed, you can also stitch the pieces together to produce new
objects.  Again, where you click when you select the objects is significant, since it determines
which of the pieces will be stitched together.  You will next do an example of a trim and stitch
operation.

• Select Display: Wire Frame* and Undo as many times as neces-
sary to return your objects to their original state.

• In the options palette, select Trim under Both Objects, and select the
Stitch option.

• With the Trim/Split tool active click on points 1 and 2.

Again, the result is not readily visible.  Move the piece that is inside the large
object as shown.  Then generate a hidden line plot.  Your display should now be
as shown.

With the Trim/Split tool active, in the tool options palette make sure Stitch is deselected

and select Trim under the With Line column and click on 1 and 2.  While still in front
view, observe the result.

• In the palette turn on Stitch and with the Trim/Split tool active click on 1 and 3.
• Select View: z=30°  x=60°  (or any of the 3D views) and Hidden Line*.

Your hidden line plot should be as shown.  Observe the difference between the two operations
you just executed.  The left side of your object was trimmed and was left with a “hole.”  On the
right side of your object a piece was also stitched to the hole created by the trim, which effectively
closed the hole.

Note that the stitch operation above was included with the trim operation.  There is also the Stitch tool that can be used
to independently stitch touching edges of surfaces.  Being pretty straight forward it is not covered in detail in this tutorial.



180 form•Z Tutorial  •  Sections of objects and contours

23  Sections of objects and contours

The Booleans and Intersections tool palette also includes the Section and Contours tools that are
discussed in this chapter.  Thus you already have the tools you need for the exercises in this
chapter, and you can proceed as soon as you launch the program.  You will use the Section tool
to derive both 2D and 3D sections of solids.  You will use the Contours tool to derive sets of 2D
sections.  The Contours tool is covered in the last section of this Chapter.

• Launch form•Z.

Turn on the Grid Snap.

Select the Section tool and observe its options as displayed

in the tool options palette, shown to the right.

It contains two types of sections, 2D and 3D, and two methods for
cutting the sections, with Plane and with Line.  Notice that 2D and
Plane are the defaults.  You will do examples with all the variations,
using an object you saved earlier.

• Select File: Open and when the Open File dialog appears,
select the “Solid” project you saved in session 12.  When it appears
on your screen, it should be as seen to the right.

Both the 2D and the 3D sections are executed by selecting either a
cutting plane (the Plane option) or a cutting line (the Line
option).  The cutting plane is typically a 2D shape positioned where
the section is to be derived.  The cutting line is a single segment line
from which a plane perpendicular to the reference plane is derived
and is used to cut a section.  You will, therefore, draw a couple of
cutting planes and lines first.

• In Top view, draw a square (a) and a line (b), as shown.
• In Front view, draw another square (c) and two more lines

(d and e), as shown.

These shapes and lines are also shown in a 3D view, on the right.

We have placed these cutting shapes on individual layers, so that we may hide them,
for better clarity, when they are not involved in an operation.  However, we have not
yet covered layers in this tutorial, thus we are not suggesting that you do the same.
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23.1  2D sections

Topological level is at Object.

• Verify that Plane is on in the tool
options palette.

With the Section tool active click s

(whose section will be derived)
and then on a (the cutting shape).
Observe the result.

• Undo and repeat the operation,
this time clicking on s, then on c.

• In the tool options palette,
select Line.

• The XY reference plane is active.
• Undo.
• With the Section tool click on s,

then on line b.
Observe the result.
A section perpendicular to the XY
plane, going through line b, has
been cut through solid s.

• From the window tool palette se-
lect the ZX reference plane.

• Undo.
• With the Section tool click s and d.
• If your objects are being ghosted

as you have been executing these
operations, with the Unghost tool
click on s to unghost it.

• With the Section tool click on s
and e.

Observe the result.
You have derived  two sections
perpendicular to the ZX plane and
going through the lines you picked.
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23.2  3D sections

You will next repeat the operation from the
previous section to derive 3D sections of the
same object with the same cutting planes and
lines.

• Undo.
• In the tool options palette select 3D

and Plane.

With the Section tool, click on s and a.

The result should be as shown.
Your original object has been split into
two pieces.  To verify this, you need to
move the pieces.

With the Move tool move one or both

of the pieces, as we did.  Exactly
where you move them is not signifi-
cant.  Just move them enough to be
able to see the cut.
Note that we show a wire frame of the
object in position and a hidden line
with the parts moved.

• Undo as many times as necessary to
cancel the moves and the section
operation, so that the object is ready
for a different cut.

• With the Section tool click s and c.

• Repeat all the operations you did for
the 2D sections.  Remember to switch
to Line, when ready, and to switch to
the ZX reference plane for the last
operations.
Observe how the solid is cut into solid
pieces by the cutting planes and lines.
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23.3  Deriving contour lines

Contour lines are sets of 2D sections that are typically derived
at even increments.  They are usually used to represent land
forms and, in form•Z, they can be used to generate 3D terrain
models as you saw in chapter 9.  However, contour lines can be
used to represent any solid.

Contour lines are always generated in an orientation parallel to
the active reference plane.  Their exact position is determined
by options displayed in the tool options palette, shown to the
right, when the Contours tool is active.  You will first do an
example using the defaults.

• Undo twice.

Select the XY reference plane, if not already active.

With the Contours tool active, click on object s.

Observe the result, shown in both wire frame and hidden line.
The contour lines are parallel to the XY plane, and are at
increments of 2', which is the default distance set in the
Contours Options palette.

• Undo.
• In the tool options palette select Use # Of Incre-

ments and in the Start At Min Plus and End At
Max Minus fields under it enter 1'.

Select the ZX reference plane.

With the Contours tool active, click on solid s.

As expected, solid s has been ghosted.  You will
unghost it to use it again.

Select the Unghost tool and click on object s.

Select the YZ reference plane.

With the Contours tool click on solid s.

Be careful where you click to select object s.  Do not
select one of the contours you generated earlier.

Do a hidden line, as we have been doing, to observe the results.
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24  Text
Once again, before doing the exercises in this tutorial session you need to activate the Text tool
palette.  We shall actually suggest that you also activate the Symbols palette to have it ready for
the next session.

• Launch form•Z.
• From the Palettes menu click on Customize Tools....
• In the Icons Customization dialog find and insert to the left column of the tool bar

the Text tool palette:  .

• Next to it, insert the Symbols tool palette:  .

The tools on the Text tool palette allow you to place and edit 3D text.  Text can be generated as
plain  or object  text, which can be a one or two-sided surface  or solid object.  Text objects are
typically generated as controlled objects which can be edited and changed after their initial
creation.

The type of text is selected in the Text Placement dialog, invoked
directly from the Text Place tool, or from the tool options palette,
when the Text Place tool is active.  This is shown to the right.

• The Text Place tool (  ) is used to create a new text entity.

• The Text Edit tool (  ) is used to change controlled text

objects, after their initial generation.
• The Edit Controls tool (  ), while not an exclusive text tool, can

be used to change the shape of the control lines on or between
which text may be created .

When using the Text Place and Text Edit tools, when the mouse is
clicked on the screen, the 3D Text Editor dialog appears, in which
the text string is typed and other text parameters are set.  You will
first generate plain and then object text.



185form•Z Tutorial  •  Text

+z

-x

+z

under Plain Text select At Point.
• With the Text Place tool active click on 1.

• When the 3D Text Editor dialog, shown
to the right, appears ignore it and click OK.
Observe the result.

• In the tool options palette, under Text As
Object, select At Point.

• With Text Place click on point 2.
• In the 3D Text Editor dialog, under

Object Type, select Surface and click
on OK.
Observe the results.

Two text strings that spell “<Text>”  are plotted on
the screen.  “<Text>” is the default string that
shows up in the text field of the 3D Text Editor
dialog.  Since you did not change it, it was plotted
as is.  The two text entities shown on the screen
look identical, but are of different types.  The lower
is plain text, while the upper string is object text,
which can be changed to a solid object.

Note that the font shown in the example is Chicago, which is
usually the default on the Macintosh.  A different font will appear
if you are running on Windows.

You will next change the text string, change the text
to a solid object, and rotate the individual characters.

Select the Text Edit tool and click on point

3 to select the text object.

• When the 3D Text Editor dialog ap-
pears in the text field type “Angled Text”.
From the Object Type pop-up menu,
select Solid, turn on the Standing (Perp
To Plane) option, in the Character
Angle field type 45°, and click on OK.
Observe the result.

24.1  Placing and editing text

Select the Text Place tool to display its options and in the tool options palette,
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24.2  Text along path and between lines

Text can also be placed along a control line, which you will do next.
You will first draw the line, and then place the text.

Using the Vector Line tool, draw a line roughly as shown.  It

begins at point 1 and ends at 2 (the direction is significant).

Select the Text Place tool and in the tool options palette,

under Text As Object Along Path, select On Line and
Scale Height & Width.

• With the Text Place tool active, click on the line (at 3).
• When the 3D Text Editor dialog appears, type the

alphabet in its text field.  Solid and Standing (Perp to
Plane) should still be selected.  Click on OK.
Observe the result.

Text can also be placed between lines, which you will do next.

• Undo or Delete to clear the screen.
• On the XY reference plane, draw two open vector lines from

left to right, roughly as shown.

Turn the Perpendicular switch on.

Select the Move tool and click on 4, then 5.

This moves the top line up.

With the Curve tool click on each of the lines (6 and 7) and

turn off the Perpendicular switch.
These two curves are the control lines between which you
will place text.

With the Text Place tool active, in the options palette, under

Text As Object Along Path, select Between Lines.
• With the Text Place tool click on 8 and 9.
• When the 3D Text Editor dialog appears, type “Curved

text,” select Geneva for Font, from the Object Type
pop-up menu select Surface, and click on OK.
Observe the results.

Your text string has been generated following the control lines, and
is unfolding in 3D space.
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24.3  Editing text control lines

You will next edit and change the shape of your control
lines, and watch how the shape of your text also changes.

Select the Edit Controls tool, and click on the text

object  (point 1).

You have entered a line edit mode and the control lines of
your curved text appear.  Also the Edit Controls Op-
tions palette appears, which contains a few operations.
You will only need the first on the left, which is Move and is
already selected.

• Click on 2 to select the control point.  It turns red.
• Click on 2 again and then on 3.

The lower control line is reshaped and your text regener-
ated.

• Click on 4 and as the control point turns red drag it
to 5 and click.

This  reshapes the curvature of the upper control line,
roughly as shown.  The shape of the text also changes.

Feel free to move more points and to experiment with
further reshaping your control lines and you text.  When you
are satisfied with what you have click away from the text to
exit the edit mode.

As you exit the edit mode your text object is generated as
a surface object.  Next, you will edit the text object once
again to change it to a solid object.

With the Text Edit tool selected, click on point 6.

• In the 3D Text Editor dialog that is invoked, from
the Object Type pop-up menu select Solid.
In the Depth field type 1’-6" and click on OK.

Your 3D text is regenerated as a solid object, as shown to
the left.
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25  Symbols and instances

Symbols is a method by which entities that must be repeated in a project may be entered into
Libraries, and then placed as instances as many times as is appropriate.  There are four tools for
symbols located by default in tool palettes labeled Symbols.  There is one in modeling and one
in drafting.  For this tutorial session you will only need the modeling Symbols tool palette, which
is already in the tool bar.

The Symbol Create tool ( ) is used to create a symbol definition by selecting

previously drawn entities.  These definitions are stored in Symbol Libraries,

accessible through the Symbols palette.  The Symbol Place tool ( ) is used to

place symbol instances, and the Symbol Edit tool ( ) is used to edit placed
instances.  Symbol definitions can be edited directly or by first decomposing them

with the Symbol Explode tool ( ).

While form•Z is shipped with a few symbol libraries, the exercises in this session will not use them.
You will create your own mini-library.  Experiment with the other libraries after you do this session.

• Launch form•Z.

Note that the Symbols palette is not displayed and you need to
invoke it before creating any symbol definitions.

• Select Palettes: Symbols.

The Symbols palette has appeared.  It is empty and displays the
message “No Symbol Libraries Loaded.”  To define a new
symbol, you need an open Symbol Library.  You can load an
existing library or you can start a new library.  For this exercise
you will do the latter.

• Click on the top bar of your symbol palette (next to the
word “Library:”).

• When the Symbols dialog appears, click on New....
• The Create New Library dialog appears. Type

“Mary’s_Lib,” and exit.

The name you type appears in the Symbol Libraries window of the dialog.
When you close the dialog, the name also appears in the title of your Symbols
palette.  You will next save a symbol definition in it.
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25.1  Creating symbol definitions

• Generate five rectangular extrusions that
represent a table, as shown.

We did it by working in 1:1 scale, setting the snapping module
to 3" and turning grid snapping on.  You can change the
snapping module in the Grid Snap Option dialog, which you
invoke by double clicking on the Grid Snap icon.  We used
heights 2'-6" for the legs, and 2" for the top piece of the table.
The latter was first created on the XY reference plane and then
moved to the top of the legs.  You will next define a symbol that
consists of the objects you just created.

• Preselect the five objects.
1

Select the Symbol Create tool and click on point 1 (origin of XY plane).

• When the Name New Definition dialog appears, enter “Table,” and click on OK.

You will next define one more symbol.  To better see what you are doing, delete
the previous symbol (with the Delete tool click on it).  Model a chair, roughly as
shown, then define it as a symbol.  Click on point 2 to set its origin, and enter
“Chair” for name.  When done, the new symbol appears in the palette.

On the lower margin of your palette there are a few small icons.  Click on the first (left to right), then
click on the third and observe how your palette changes.  There are three formats in which your
symbols can be displayed in the palette, including one which shows only their names.

The symbol you just defined appears in the Symbols palette, as
shown.  In addition, the objects you selected for the creation of
the symbol definition have been transformed into a symbol
instance, because Replace With Instance is on by default
in the options tool palette for this tool.  You may verify it by
moving it.  All the pieces will move together as a single entity.

Where you click (point 1) when you define a symbol is very significant.  It
establishes the position of the symbol origin.  When placing the symbol, where
you click in the graphics window will define the location of the symbol origin and,
therefore, the position of the symbol.

2
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25.2  Placing symbols

You will next place instances of the symbols you just
defined.  Delete the placed chair symbol to start with a
clear project.

• Click on the Table symbol in the palette to
make it active.

Select the Symbol Place tool.

Observe its options in the tool options palette.

• Click on point 3 (origin of XY Plane).

A symbol instance is placed as shown.

• Make the Chair symbol active.
• Click on point 4.
• With the Symbol Place tool active, in the op-

tions palette, set the Rotation: Z: field to 90°.
• Click on point 5.
• In the options palette, change Rotation: Z:

to 180°.  Then click on point 6.
• Enter -90° in the Z rotation field and click on 7.

Observe the result.

The symbols offer conveniences, save memory, and
allow project-wide manipulations.  Symbols are avail-
able in both the modeling and drafting modules of
form•Z, and there are many options and variations by
which they can be defined, placed, and edited.  These
are discussed in detail in UM section 4.20 for modeling,
and UM section 5.8 for drafting.
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26  Attaching

The attachments, alignments, distributions, segment extensions, and placement operations are
special types of geometric transformations.  They are executed by the tools on the 13th right row
of the modeling tool bar.  Their palette is called Relative Transformations.  This palette should
currently be missing from the tool bar and you need to bring it back before proceeding with the
exercises in this chapter.

The attachment  attaches a point, a segment, or a face of one object to a point, a segment, or
a face of another object.  Segment-to-segment attachments result in the two segments becoming
colinear.  Face-to-face attachments result in the two faces becoming coplanar in opposite
directions.  The attachments can be executed in a manner such that the complete object follows
the movement of the attached entity, or by moving only the attached part of the object while the
remaining object is left behind (in its original position).

Note that the attachments are strictly facetted operations.  That is they apply to
facetted objects only.  This is because they operate on the different topological
levels of objects and require object parts such as segments to be straight and
faces to be planar.  These conditions are generally not available on smooth
objects.

In this section you will do examples for all these operations.

• Launch form•Z.

Turn on the Grid Snap.

• Invoke the Icons Customization dialog, find the Relative Transforma-
tions palette and drag it above the Geometric Transformations.

• You may next take the Geometric Transformations palette and move it
from the right column too the left, next to the Relative Transformations.

You would do the latter to simply return the tool palettes in the tool bar to their
default positions.  If you do, the tool bar should be as shown on the left.
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26.1  Attaching objects

The attachment operations provide the ability to move and position
an object relative to another object, by attaching one of its parts to
a part of the other object.  The attachments can also be thought of
as snapping operations.  There are a few variations that can be
selected from the dialog of the tool or from the tool options palette,
when the Attach tool is active.  This is shown to the right.

The three Attach Kind options affect how the operation is
executed.  With Per Topological Level the currently selected
topological level determines what level of entities will be attached;
for example, point-to-point, face-to-face, etc.  Selected Face To
All Faces attaches the face of an object to all the faces of another
and Selected Face To Ref. Plane does what its name says.

There are two types of attachments:  attach Object Part and attach Entire Object.  These
will be illustrated shortly.  There are also several options that offer justification variations for
attaching segments and faces.  The initial exercises will use the default options.  You will try the
other options in section 24.5.

You will first execute point-to-point attachments, which position a
point of an object on a point of another object (or of itself)  with or
without carrying the remaining parts of the object along.  You will try
both types.  Before you do, you need to generate a few objects to
apply them to.

• Generate two cuboids (4' x 8' x 10' and 4' x 16' x 15') and
position them as shown.

Set the self/copy mode to Continuous Copy.

Use the Move tool to make four more copies as shown.

The copies are labeled A, B, C, and  D.

The original objects will be used to mark the order in which
points will be picked.

• From the File menu select Save As....
In the name field of the Save Project As dialog that is
invoked type “Attach_Point” (or any name you prefer).
You are saving your project so that you  may use the same
set of objects twice,  once to do Object Part and once to
do Entire Object attachments.
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26.2  Point-to-point attachments

• Select  z= 45°  x= 45°  (View menu).

Set the topological level to Point.

The self/copy mode should be at Self.

With the Attach tool active, in the options tool

palette select Object Part.
Per Topological Level should also be on.

• Click on points 1 and 2 (group A).
The first is the point that will be attached.
The second is the point to which the first point
will be attached.  Observe the result.

Continue without changing any of the current settings.

• On pair B, click on 1 and 2, then 3 and 4.

Above, you first repeated the previous attachment to have it as a
reference.  You then proceeded with the new attachments.  You will
continue this practice throughout this example.

• On C, repeat the previous 1 to 2 and 3 to 4 attachments.  Then click on 5 and 6.
• On pair D, repeat all the previous attachments. Then click on 7, then 8.

Observe the results.
• Select Hidden Line* (Display menu).

This has made your results more visible.

You will next execute object attachments.

• Select Display: Wire Frame*.
• Select Revert To Saved (File menu).
• The topological level is still at Point.

Set the self/copy mode to One Copy.

With the Attach tool active, in the options

palette, select Entire Object.
• On pair A, click on points 1 and 2.
• On pair B, click on 3 and 4.
• On pair C, click on 5 and 6.
• On D, click on 7 and 8.

The results should be as shown.
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The Attach tool first calculates the transformation
necessary to position the point of one object on the
point of the other object.  When the Entire Ob-
ject is attached, it applies the transformation to all
the points of the object.  When only Object Part
is attached, the transformation is applied only to
the point that is attached.

It is not necessary for the attach operation to
involve two objects.  A point of an object can be
attached to another point of the same object.  Or an
object may be attached to itself by mapping two of
its own points.  The latter case will be illustrated by
the example you will do next.

• Clear and Clear All Ghosted.

The Grid Snap should be on.

• Generate an 8' x 8' x 8'  cube, roughly in the
position shown.
Note that three of its points have been
labeled  1, 2, and  3.

Set the topological level to Point.

Set the self/copy mode to Continuous

Copy.
• Entire Object should be selected in the

Attach tool options palette.

With the Attach tool selected,

click on point 1, then on point 2.
Observe the result.

• Click on 1, then on 3.
The effects of these two operations should
be as shown.

• Continue and produce the composition
shown.
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26.3  Segment-to-segment attachments

• Clear (Edit menu) to start fresh.
• Generate a pair of cuboids  (8' x 8' x 10'  and

4' x 16' x 15').  Then copy them twice.
The three pairs of objects should be positioned
roughly as shown.

The two copies labeled A and B will be used in this
example.  Before you start,  save your project to be able
to use it again in the next section.

• From the File menu select Save As....
• In the name field of the dialog that is invoked

enter “Attach” or any name you wish.

Set the topological level to Segment.

Set the self/copy mode to Self.

• Object Part is on in the options palette.

With the Attach tool active,

• on pair A, click on points 1 and 2.
Click the mouse where shown or you may
derive a different result.

With the Attach tool still active, in the options

palette, select Entire Object.
• On pair B click on points 1 and 2.

Observe the results of both operations.

-x

+x-y

+y

+z

B

A

B

A

-x

+x-y

+y

+z

In the first example (A), only segment 1 was moved and placed on segment 2.  In the second (B),
the complete object followed the mapping of segment 1 onto segment 2.  Note that, in both cases,
the midpoints of the segments involved in the attachment are lined up.

The location of the cursor when the segments are picked for an attachment operation is significant
to the operation.  It determines the directions in which the two segments will be mapped.  The point
of the segment that is closest to where the mouse is clicked becomes the first point of the segment.
The segment-to-segment attachment positions the segments in such a way that the first point of
one segment is on the same side as the first point of the other segment.

As already noted, the two segments were attached by positioning the midpoint of one segment
on the midpoint of the other segment.  This is the default way to execute the segment-to-segment
attachment.  Additional options are available which will be covered later.

1
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You will next do a more “practical” example of
segment-to-segment attachments.  You will gen-
erate a stair.

• Clear and Clear All Ghosted.
• Generate a 24' x 4' x 2' cuboid at the center

of your grid.
Call it a “step” (even though it is out of
scale as an architectural step).

Set the topological level to Segment.

Set the self/copy mode to Continuous

Copy.
• In the tool options palette, select Entire

Object.

With the Attach tool active,

click on point 1 then on point 2.
• Repeat the same operation a number of

times, each time picking point 2 on the
most recently generated step.
Continue to pick point 1 on the first step.
When done, your stair should be as shown.

You may argue that the stair you just created is not
structurally sound.  You can labor a bit harder to
derive an improved version of a stair.  Below, we
show you the process, which involves seven steps
labeled 1 through 7, which you may follow on your
own, without detailed instructions.
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Hints:  In all steps, Entire Object
Attachments were used, except in step
5, in which an Object Part Attach-
ment was used to attach a segment.
This adjusted the shape of the step.
This newly shaped step was then used
for the remaining attachments.
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26.4  Face-to-face attachments

Next, you will do face-to-face attachments, using the same objects
you used for the segment-to-segment attachments in last section.

• From the File menu select Open and retrieve the “Attach”
file you saved earlier.

Set the topological level to Face.

Set the self/copy mode to Self.

• Activate the Pick tool and in the tool options palette check
that Clicking On Edges is on.
For this exercise, faces will need to be picked with two
clicks because some of them face back.

With the Attach tool on, in the palette select Object Part.

• On pair A click on 1, 2, 3 and 4, in this order.
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With Attach tool on, in the tool options palette select Entire Object

and, for B, click on 1, 2, 3 and 4.  The results should be as shown.

The order in which the segments are picked when you pick the faces is significant.  The segment
picked first on the first face is mapped to the segment picked first on the second face.  You may want
to try a few different combinations to see how the order of picking affects the mapping of the faces.

Next you will do more practical face-to-face attachments.

• Clear and generate three rectangular extrusions of different sizes,
roughly as those shown (A, B, and C).

• Make a copy of A somewhere to its right.
You are now ready to build the “column” shown.

• The topological level should be at Face and the self/copy mode at
Continuous Copy.

• Entire Object should be selected in the options palette.

With the Attach tool, start clicking on faces to vertically line up the

objects, as shown.  Since all the shapes are squares, it does not matter
which segments you click on to pick the faces.

You can repeat the process using any shapes, such as the hexagonal extrusions
shown.  Do this example by yourself.  Note that the six “candles” at the top were
positioned using point-to-point attachments.  All the other objects were posi-
tioned through face-to-face attachments.
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All the available options are illustrated below.  Where to click for selecting the segments and the
faces is also shown.  We suggest that you try them and observe how they affect the segment-
to-segment and the face-to-face attachments.  There are no options for the point-to-point
attachments.

26.5  Setting the justification options

When you executed the segment-to-segment attach-
ments, the segments were attached by aligning their
midpoints.  For the face-to-face attachments, the faces
were attached by aligning their centers of gravity.
These are the default options.  Any of the shown
options may also be selected in the Attach Options
dialog or the tool options palette, when the Attach tool
is active.

Face  justification options:

Endpoint Of Segment

Midpoint Of Segment

Center Of Face (default)

All Points

Scale

Segment justification options:

Endpoint Of Segment

Midpoint Of Segment (default)

All Points

Scale
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1
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26.6  Object-to-object attachments

The term object-to-object attachment is an approximation.  Given the character of the attach-
ments, an object cannot be attached to another object in a solid sense.  It can only be attached
through its surfaces.  The Attach tool can be applied at the Object level; however, it is executed
as multiple face-to-face attachments.  The first face of the first object selected is attached to each
of the faces of the second object.  Since the object-to-object attachments are actually face-to-face
attachments, they are controlled by the face justification options, set in the Attach Options
dialog.

The object-to-object attachments ignore the current self/copy selection and always execute in
Copy mode.  A copy of the first object is made for each face of the second object.  While you can
select the Object Part option with the object-to-object attachments, it is questionable whether
it can produce meaningful results.  In contrast, the Entire Object option adds significant
capabilities to the attachment operations.  You will next do a few examples of object-to-object
attachments.

• Clear.
• Generate two 8' x 8' x 8' cubes, as

shown.

Set the topological level to Object.

With the Attach tool active, in the

palette select Entire Object.
• With the Attach tool on, click on each

of the cubes.
The result should be as shown.

Note that you did not bother to check which justification
option was selected.  Because the two cubes have iden-
tical dimensions, all options would work the  same.

• Clear.
• Generate a 20' x 20' x 20'  cube in the

middle of your reference grid.
• Somewhere on the left, generate an

8' x 8' x 8' 3D enclosure.
• In the tool options palette select

All Points under the Face column.

With the Attach tool selected, click on

the 3D enclosure and the cube.
The result should be as shown.
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You will do a few more examples.

• Clear.

The Grid Snap should be selected.

Select the Spherical Object tool, in the tool options palette

select Octahedron (8), then click on 1 and 2.
• Use the 3D Convergence and Polygon tools to generate a

triangular pyramid 20 feet high.
The two objects should be as shown.  Again, be accurate.

Activate the Attach tool and, in the tool options palette,

under Face, select All Points.
• With topological level at Object and the Attach tool active,

click on the pyramid and then on the octahedron.
The result should be as shown.

• Undo to return to the initial state of the objects.
• In the palette select Center of Face (Face column).
• With the Attach tool click on the pyramid and octahedron.

Observe how the new result is different from the previous.

You will next do an exercise which will show you how you can control
which face is attached when you do object level attachments.

• Delete or hide the pyramid.

With the Text Place tool, generate the letter “T” as a solid

object, by clicking at point 3, as we show.
It is Helvetica font, 16’ tall, 8’ deep, and Standing.

With the Attach tool click on “T” then on the octahedron.

Most likely, the result is not what you had in mind.
• In the palette, turn on Selected Face To All Faces.

With the Attach tool click on points 4 and 5 of the “T” object,

then on any point of the octahedron to select it.
Observe the result.  This time you picked a specific face and
were able to control which face of object “T” was attached.
You also noticed that you mixed topological levels (Face first, then

Object), but did nothing to make it happen.  It was done automatically.
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26.7  Attaching surface objects

The attachment operations also work with 2D surface
objects.  With attachments, surfaces and solids can actu-
ally be mixed.

To illustrate how surface objects are attached you will
generate a few patterns.  You will be working on a top (+XY)
projection.

• Clear.
• Select  [+XY] Top from the View menu.
• Draw two triangular polygons.

One triangle is for reference, the other for the
generation of the pattern.

Set the topological level to Segment.

Set the self/copy mode to Continuous Copy.

• Entire Object should be on in the tool options
palette.

With the Attach tool active, by picking appropriate

segments, attach copies of the triangle to itself.

The key factor here is picking the edges of the triangle
properly.  If you execute an attachment and the copy of the
triangle does not show up, the chances are that you have
placed it on top of another one.  Undo and try again.  At the
end, you should have generated a pattern similar to that
shown.

Next, generate the patterns with the hexagon and the
pentagon, shown on the right.

Similar patterns can also be generated using solid objects.
On your own, create the “brick” pattern shown on the right.
It can be derived using segment-to-segment attachments.
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27  Aligning and distributing
As its name indicates, the Align/Distribute tool can be used to align only, to distribute only, or to
align and distribute a number of objects.  The tool is already available in the tool bar and you can
proceed as soon as you run the program.

• Launch form•Z and turn on Grid
Snap.

The alignment and distribution opera-
tions are relative to the minima, maxima,
or geometric middle of the selected group
of objects, in any of the three Cartesian
directions.  These are typically com-
bined with alignment applied in one and
distribution in another direction.  The
desired combination and other options
are set in the tool’s dialog or the tool
options palette displayed when the Align/
Distribute tool is active.  They are shown
to the right and left, respectively.

Note that the dialog and palette contain
the same options, some of which appear
as icons, representing minimum, center,
and maximum alignment and distribu-
tion.  We have labeled these icons on the
palette to the left.  The dialog, in addition,
has a preview window.  This can be used
to both preview the operation or its appli-
cation to specific objects, as follows:

•   When double clicking on the tool to invoke the Align/Distribute
Options dialog, three non-existing objects appear in its preview
window and their position reflects the currently selected combination of
alignment and/or distribution.

•    Invoke the dialog, change its options, and observe the effect.
• When you execute the operation with a number of objects selected,

and the Show Preview option is on (which is the default), the selected
objects are displayed in the preview window.  Their positions are again
adjusted as you select new options in the dialog.
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You will next do a few examples.  However, the examples will only cover a couple of combinations.
We recommend that you try many more on your own, after you do our examples.

Before doing an example we need some objects to align and distribute.  You will generate some next.

• Clear and draw a cuboid, a cylinder, and a pyramid, as shown.
They are all about 4’ wide and 10’ high.

Set the Self/Copy modifier to Continuous Copy.

With the Move tool make five-six copies of each, as shown.

Try to place them randomly on the reference plane and it does
not matter if yours have different positions.
You now have some object to align and distribute.

• From the Edit menu click on Select All Unghosted.
All your objects turn red.

With the Align/Distribute tool active, in the

options palette, turn off Show Preview, and
turn on Align Minimum for Y.
Leave the other options as they are.

• With the Align/Distribute tool active, click in the
project window.  Observe the result.

• Undo.

With the Align/Distribute tool still active, in the

options palette, turn off Align for Y, and turn
on Align Minimum for X.

• With the Align/Distribute tool active, click in the
project window.  Observe the result.

With the Align/Distribute tool still active,

in the options palette, turn off Align for X,
and turn on Align Minimum for Y.

• With the Align/Distribute tool active,
click in the project window.
Observe the result, shown to the right.

Observe that the setup in the options palette is identical to that used
two steps earlier, however the results are very different.  Can you tell
why?  You did not Undo before the last operation.  Thus the results
you see are accumulative.  That is, the program aligned in Y objects
that were already aligned in X.
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• Undo twice.
• All objects must still be selected.

With the Align/Distribute tool on,

in the tool options palette,
turn on Distribute Minimum for X.
and Align Minimum for Y.

• With the Align/Distribute tool
click in the project window.
Observe the result.  It is shown to
the left together with the Minimum
Y alignment (but no distribution)
you did a bit earlier.  Now the
objects are evenly distributed.

• Undo.
• At the lower end of the

tool options palette are
the Distribution Type
options.  For X,
select At Distance.

• All the objects must still be selected.

With the Align/Distribute tool on,

click in the project window.
Observe the new result, shown below.

The previous distribution was constrained by the
objects at the two ends.  They remained in their
position and all the other objects were evenly distrib-
uted between them.

The new distribution does not have this constraint.
The distribution starts at the minimum position and
the objects are arranged from there by allowing a
space of 4’ between them.  Also note that they are
taken in the order they were created.  You can now
tell in which order we copied the objects.
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28  Extending segments to surfaces

The Extend tool can be used to extend segments of objects to their
point of intersection with a face, or independently by a certain
percentage or length.  Only segments of facetted objects can be
extended.  These segments can be extended individually (seg-
ment-to-face) or in groups, through the faces to which they end
(face-to-face).  These variations can be set in the tool options
palette, displayed when the Extend tool is active, shown to the right.

Recall that a one-segment line is drawn by clicking the mouse twice.  Because you have the
Graphic/Keyed item on, after the second click your 3D object is rubber banded and its height
follows the motion of the mouse cursor, which is locked to a direction perpendicular to the
reference plane.  When you decide that you have the appropriate height, click the mouse once
again to complete the creation of the object.   Exactly how high you make your objects is not
extremely significant.  Try to make the height differences, relative to each other, roughly as
shown.  The shown plan view will also assist you in positioning the walls relative to each other.

In this section you will do both segment-to-face and face-to-face
examples.  You will first create the model shown on the right.  To do it,
you will first generate three individual walls whose height you will define
interactively.  You will then line up the ends of the walls using the Extend
tool. You will finally “glue” the three pieces into a single object using the
Union tool.  This result is shown to the right.

• Assuming you continue to run form•Z, Clear.
• From the Heights menu select Graphic/Keyed.

Recall that selection of this item allows you to determine the height of your objects visually,
rather than using a preset height value.

• In the 3D Enclosure Options dialog or palette, enter 2’
for Wall Width.
This will make your 3D enclosures more readable.

Select the 3D Enclosure modifier.

With the Segment tool draw three one-segment lines to gener-

ate walls, roughly as shown.
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You will next use the Extend tool to “clean” or
“flash” the corners of your 3D walls.

Set the topological level to Segment.

With the Pick tool click on 1, 2, 3, and 4

to preselect the four segments.
• In the tool options palette for Pick make

sure that Clicking On Edges is on.

With the Extend tool click on 5 and 6.

The result should be as in a.
The segments you preselected have been
extended to the face you selected.

Note that the segments you are extending do not have to
intersect the face (to which they are extended) inside its
boundary.  They can be extended to a point of intersection that
is outside the face boundary.  Only when they are parallel to a
face can they not be extended to that face.

Select the Pick tool again and click on

7, 8, 9, and 10.

Select the Extend tool and click on points

11 and 12.
The result should be as in b.

In both cases, you used the prepick method for the execution
of the Extend operation.  This was appropriate since four
segments were to be extended to the same face.  Note that
when you picked the face after you activated the Extend tool,
you did not bother to set the topological level to Face.  This is
because the system knows to pick a face, regardless of what
the currently selected topological level is.  Also note that you
did not select the Clicking Inside Boundaries option in the
Pick Options dialog, which would have allowed you to pick
the faces with a single click of the mouse.  This is because one
of the faces you had to pick is facing back, and you needed two
points to select it.

You should now be able to “clean” the other corner of the walls on your own by repeating the
Extend operation twice, assuming each time you preselect four segments.  The results should
be as in c.  To complete the object we show at the beginning, one more step is required.  Use the
Union tool to make one object out of the three pieces.  Then display a hidden line plot.



207form•Z Tutorial  •  Extending segments to surfaces

-x

+x

-y

+y

-z

+z

+z

-x

+x

-y

+y

-z

+z

A

B

-x

+x

-y

+y

-z

+z

-x

+x

-y

+y

-z

+z

2

3

1

7
6

5 4

A

C

B

-x

+x

-y

+y

-z

+z

Next you will use the Extend tool to do one more
example.  You will flash a roof to another roof, and
you will line up a chimney.  You will do this twice,
using two different options.

Start by creating the three objects you need for the
exercise .  This time we shall only give you general
guidelines rather than detailed instructions.

• Clear and Clear All Ghosted to erase the previous objects.

Select the 3D Extrusion modifier.

With the ZX Reference Plane on and the Vector Line tool draw a

closed triangular shape and generate object A, roughly as shown.

Switch to the YZ Reference Plane and draw another triangle to

generate object B.

Switch to the XY Reference Plane and generate cuboid C.

To the right, the three objects are also shown in 3D and plan view.

• With the Pick tool preselect segments 1, 2, and 3.

With the Extend tool click on 6 and 7 to select a face.

Observe the result

You used segment-to-face extensions to fit one roof to the slope of the other.
You will next redo the operation using a different method, face-to-face
extension.

• Undo.
• With the Extend tool active, in the options palette select To Face

under the Face column.  Then click on 4, 5, 6, and 7.
Observe that the result is identical to the previous.  This time you
extended the segments by selecting the face at which they end.

• Use this same method to extend the lower end of the “chimney” (the
cuboid) to the slope of the roof.
The result should be as we show on the right, in hidden line.
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29  Placing objects on other objects

2D shapes and 3D objects can be placed on other objects using the
Place tool.  The object that is placed is referred to as the source and
the object it is placed on as the placement object.  A number of
optional variations can be selected from the tool options palette,
when the Place tool is active (shown to the left).

In its simplest and most typical variation of placement, 2D shapes
are placed on lines.  You will do such an example first.

• Clear and turn on the Grid Snap.
• Draw a single segment line and a

hexagon, as shown.

The self/copy mode is at Self.

The topological level is at Object.

Select the Place tool.

• Click on the hexagon, then on 1.

Your first click selected the source (hexagon). The
second click, which was on the placement line,
identified the position where the source shape was to
be placed.  The center of the hexagon was placed
where you clicked.  The hexagon is perpendicular to
the placement line.  Both of these are the default
options still on in the options palette.  Note that the
source shape disappeared from where it was and
reappeared at its new position.

• Undo and set self/copy mode to
Continuous Copy.
Keep everything else the same.

With the Place tool selected, click on the hexagon, then click on

2, 3, 4, and 5.
• Double click anywhere in the graphics window.
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The source shape (hexagon) remained at its original position.  Where you clicked copies of the hexagon were placed.
At the end, you double clicked to terminate the copying process.
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• Undo.

Set the self/copy mode to Repeat Copy and keep

everything else the same.

With the Place tool selected, click on the hexagon,

click on 6 and then on 7.
• Anywhere in the graphics window (away from your

objects), click five distinct times.
• Double click anywhere in the graphics window.

Your first two clicks (after picking the source shape) produced two copies of the hexagon at the
points where you clicked.  Each of the next five clicks produced a new copy of the hexagon
positioned on the placement line.  The positions of the latter shapes were determined by repeating
the distance of the first two placements.  You double clicked to terminate the copying process.

• Undo as many times as necessary to return the
source shape and the placement line to their origi-
nal state.

Set the self/copy mode to Multi-Copy and keep

everything else the same.

With the Place tool selected, click on the hexagon,

then click on 8 and 9.

Note that positions 8 and 9 are the same as positions 6 and 7 where you clicked for the previous
example.  Right after your second click (on 9) ten copies of the hexagon were placed on your line
at distances equal to the distance between positions 8 and 9.  This time the system stopped the
copying process by itself and you did not have to double click.  The 10 copies it made was
determined by the # Of Placements parameter in the tool options palette displayed when the
Place tool is active.
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The Multi-Copy mode, the one you used for the last example, is of special interest, and you will
do a few more examples using it.  In these examples you will place shapes on a round vector line,
and you will try all the options available for multi-placement.

Clear your project window and draw the two objects
shown.  If you do not remember how the arc line is drawn,
here is how you do it.

Select the Arc, Clockwise, Endpoint-Last tool, in

its tool options palette select Facetted, and
click on points 1, 2, and 3.

While at 3, select the Arc, Counterclockwise,

Endpoint-Last tool, click on 4, double click on 5.

You are now ready to execute multi-placements.

• The self/copy mode should still be at Multi-Copy
and the topological level should be at Object.

Select the Place tool and click on the hexagon to

pick it, then click on points 6 and 7.

As soon as you click on point 7, ten copies of the hexagon are placed on the arc line, in addition to the copy that was made
at the position of your first click (a total of 11 placements).  This is a repetition of the previous placement example, except
that now the copies of the source shape are placed along a vector line rather than on the single segment placement line
you used before.  The shapes were placed using the default settings of the Place tool in the tool options palette.  You will
next try the other multi-placement options.

• Undo and with Place active, in the tool options
palette select Divide Distance.

With Place active, pick the hexagon, then click on

points 8 and 9.  Observe the difference.

Eleven copies of the hexagon were placed again, but at different posi-
tions.  The points where you clicked determined the beginning and end of
the placement sequence.  The distance between these two points was
divided by ten and copies of the hexagon were placed between them.

• Undo and in the tool options palette, select
End-To-End and, under it, Use Increment.

With the Place tool pick the hexagon and click on

points 10 and 11.  Observe the difference.
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+zThe program used the distance set by the two clicks and, starting at one end
and going to the other end of the placement line, placed as many copies of the
hexagon as it could fit.

• Undo.
• In the tool options palette, keep End-To-End selected

and, under it, select Use # Of Placements.

With the Place tool selected pick the hexagon and the

placement line (click on each).  Observe the difference.

A total of eleven copies are placed, evenly distributed from one end of the
placement line to the other.  Note that this time you only had to select the
placement line, and there was no need to indicate any positions.

• Undo and in the tool options palette, keep
End-To-End on and select On Midpoints.

With the Place tool selected, pick the hexagon and the

placement line (click on each).  Observe the difference.

Copies are placed at the midpoints of all the segments of the placement line (a
total of 29).  Note that again, you only had to click once on the placement line.

• Undo and in the options palette, keep End-To-End
on and select On Point Bisectors.

With the Place tool pick the hexagon and the line.

Observe the difference.

A total of 30 copies are placed on the points of the placement line, from one end
to the other.

You may be wondering what the placements are used for.
There are many applications.  However, the most common use
of placements of shapes on lines is for the creation of mesh
objects.  You can actually tell the program to create a mesh right
after placing.  You will do one example using this feature, next.

• Undo and in the options palette, select Generate Nurbz.
Keep all other options as in the previous example.

• Also, in  the Nurbz Options dialog keep all the
options with their default values.
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With the Place tool active, pick the hexagon and the placement line.  Observe the result.

A nurbz object is generated as soon as the source shapes are placed.  It is shown in both wire
frame and hidden line plot, where the Show Facets Of Smooth Objects option is on.
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While most frequently the Place tool is used for placing 2D shapes
on lines, it can also be used to place 3D objects on other 3D objects
or 2D objects, as the examples you will do next will show.

• Draw a larger cube, a hexagonal pyramid, and a hexagonal
extrusion.  Make sure they are all facetted objects (this is
important).  Strict accuracy is not required for this exercise, but
stay as close to our examples, shown to the left, as possible.

With the Place tool active, in the tool options palette, select:

Orientation: At Normal;
Alignment:  Centroid;
Multi-Placement:

End-To-End and On Point Bisectors;
• With the Place tool click on the pyramid, then on the cube.

Observe the result.
Note that exactly where you click is not significant, as long as you pick the object.  The
Place tool is always applied at the Object topological level.

Your pyramid has gone inwards in the cube.  Here are the rules.  3D facetted objects
are placed through their bases, the same way 2D shapes are.  That is, the positive
side of the base matches the positive direction of the placement object.  To make the
source place the other way, one of the directions will have to reverse.  You will do
such an example next.

• Undo.

With the Reverse Direction tool click on the larger object.

• With the Place tool click on the pyramid and then on the
cube.  Observe the difference.

You have not used the Reverse Direction tool before, but it is quite simple to use, as
you have already found out.  It can be used on any object to reverse it.  However, keep
in mind that this causes solids to turn in-side-out, which results in not very usable
objects.  You should thus be cautious with this tool and should probably reverse the
cube above again if you intend to keep it.  But you still need it for the next operation.

• With the Place tool active, in the options palette, under
End-To-End, select On Midpoints.  Then click on the
hexagonal extrusion and the cube.  Observe the result.

• With the Ghost tool click on the pyramid, the extrusion, and
the cube you reversed earlier.

• Select Hidden Line*.  This helps you see the result better.

Note that, when placing objects on objects, the smooth objects behave differently
than the facetted.  This is simply due to that the first face of objects is used for placing
them and even similar objects have different first faces.  For example, a facetted
cylinder’s first face is its base.  A smooth cylinder’s first face is its curved side face.
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7Next you will place objects on a line that flows
freely in 3D space.  Your first task will actually
be to draw such a line.

• Clear and Clear All Ghosted.
• Draw the shown hexagonal extrusion.

This will be used as a construction aid.  You will snap to its
segments to draw a line in 3D.

Turn on Snap to Segment.

With the Vector Line tool click on

1, 2, 3, 4, 5, 6, 7, double click on 8.
• Ghost the hexagonal extrusion.

• Undo, and with the Place tool click on the pyramid and on the 3D line.
Observe the different result.

You will do one final example:

• Undo, and with the Place tool active, in the options palette,
under Orientation select Perpendicular To Line,
and under End-To-End select Per Length Of Seg.

• Click on the pyramid and the 3D line.
Observe the result.
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1With the C-Curve tool active, in the tool options palette, turn on

Construct Directly and in the Smooth Interval field enter 4’.
Then click on the vector line.  Observe the result.
Turn on Show Points from the Wire Frame Options dialog to see your points.

• Generate a facetted hexagonal pyramid roughly as shown.

With Place active, in the tool options palette, for Orientation select

Parallel To Reference Plane.  Keep the other options as before.
• With the Place tool click on the pyramid and on the 3D line.  Observe the result.

The placed pyramids point down.  If this is undesirable you need to use a reference plane that faces the other way.

• Draw a rectangle, set topological level to Point, select the Define Arbitrary Plane tool
(from the window tool palette), and click on points 1, 2, and 3, as shown.

Yes, you have not done arbitrary planes yet, but what you just did should be simple enough.  You will learn more soon.



214 form•Z Tutorial  •  Attributes, layers, and querying

30  Attributes, layers, and querying

In this chapter you will need the Query (  ), Attributes (  ), and

Ghost/Layers (  ) palettes.  The latter is already in the tool bar, the former two need to

be brought in.  However, it appears that it is time to bring in the complete set of form•Z tools.  You
will soon be doing tutorials that use tools from different areas of the program.

• Launch form•Z and invoke the Icons Customization dialog.
• In it click on the Defaults button.  It is at the lower left of the dialog.
• Exit the dialog, and you may want to tear off the palettes we show above.

If you do, your screen should look as shown to the right.

The Query palette contains the Query, Query
Attributes, and Measure tools.  You will do
examples with Query at the end of this chapter.

The Attributes tool palette contains five tools in
the plain version of form•Z and seven tools in
the RenderZone and RadioZity versions, which
is as shown above.  The additional tools apply
advanced rendering (texture mapping and de-
cals) and will not be covered in this Tutorial.

The first tool in the Attributes palette is used to
assign colors to objects or to faces of objects.
You will soon do examples with it.  The next two
tools are used to assign smooth shading and
other rendering attributes to objects.

The last two tools, Set Attributes and Get Attributes, allow you to change an object's attributes with
one operation, as well as to pick the attributes of one object and assign them to another.  The first
two tools in the last tool palette allow you to ghost and unghost objects.  As you have already seen,
objects that are involved in an operation may be ghosted automatically by the program when Ghost
is on in the Status Of Objects options, or you can ghost objects yourself.  Ghosted objects remain
inactive until you unghost them using the Unghost tool.  You can also make them completely
invisible by turning on Hide Ghosted in the Wire Frame Options dialog.  The third tool places
objects onto layers, which represent a method for organizing the objects of a project in groups.
You will do an example using the Layers tool and the Layers palette.
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30.1  Coloring objects and their faces

In this example you will use the Surface Styles palette to
select colors and assign them to objects and faces.  This
palette should be in the upper left corner of the window.

Generate a row of eight and a row of four cuboids roughly
as shown.  You may create other types of objects.  The only
reason you may wish to generate objects similar to ours is
to follow the markings of the clicks.

• Select Surface Render* (Display menu).
Quick Paint* will also work well if your objects
are like ours and do not intersect.

Note that all your objects have the same color, as expected.  The system
assigned the active color to them when you generated the objects. Unless
you changed it, this must be the color in the upper left box of the palette.

The topological level should be at Object.

Select  the Color tool.

• Click on the second color box on the top row of the
Surface Styles palette to select it as the active
surface style, then click on the second object (2).

• Repeat the process, each time selecting a new
active surface style, by moving left to right, top to
bottom in the palette, and clicking on the next
object (3 to 8).
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You must have observed your objects change colors as you were clicking on them.  Each object in the back row of objects
should now have a different color.  You will next assign colors to individual faces.

• In the Pick Options dialog, select Clicking
Inside Boundaries.

Set the topological level to Face.

Apply the Color tool 8 times, each time selecting a

new color from the Surface Styles palette (left to
right), and clicking on points 9 through 16 to pick
faces of the cuboids on the front row.

When you have finished, all top and front faces of the cuboids on the front row should have different colors.  The image
on your screen should certainly be more colorful than the gray scale image we show in this publication.
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For the next example you will color a tile pattern on a surface.

• Clear and turn on the Grid Snap.
• To have a common reference, select the upper left box of

the Surface Styles palette as the active color.
• Draw a square (surface object as shown).

Select the Mesh tool and click on a segment of the square.

You have created the shown tile pattern (meshed surface)
using the default 8' x 8' size for the mesh tiles.

• Select Quick Paint* from the Display menu.
All your tiles have the same color, as expected.

Set the topological level to Face.

   • Make another color the active color in the Surface Styles
palette.

With the Color tool selected, click on every other tile.

The final result should be a color version of the one we show.

When the Color tool is active and you observe the tool option palette
you notice that two options are available. The final example illustrates
the use of the second option (Clear All Face Surface Styles).

• Generate two cuboids roughly as shown. They should have
the same heights and each should have a different color.

• Use the Union tool to union the two objects.
• Execute Quick Paint* (Display menu).
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Next, you will change the color of the object to a uniform color.

• Pick a distinctively different color as the active color in the Surface Styles palette.

With the Color tool selected and the topological level at Object, click on the object.

Nothing happens.

• In the tool options palette, while the Color tool is active, select  the Clear All Face
Surface Styles option.  With the Color tool active click on the object.

The color of the object changes to the new color.

Observe the colors of the displayed object.  Its left portion has the color of the original object on the left,
and its right portion has the color of the object on the right.  The Boolean operations preserve the colors
of the original objects and assign them to the faces of the new object.  The top face (and the bottom,
which is not visible) resulted from two face, one from each object.  It can only have one color, which it
takes from the object you selected first for the Union operation.  Note that the Booleans are the only
operations that assign colors to faces.  All the other operations assign colors at the object level only.
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30.2  Placing objects on layers

The layers are a method for organizing the objects of a project in a manner that allows you to
isolate some of the objects when you are working on other objects.  Objects are placed on the
active layer when they are created.  Objects can be moved to other layers after their initial creation
and placement on a layer.  Layers can be grouped hierarchically, which further enhances the
ability to organize data.  The tools available for these manipulations are the Layers palette dialog
and the Set Layer tool.  You will use them in this exercise.

• Create a model roughly as the one we show.

There are two wall objects that were generated as 3D
Enclosures, 24 small cuboids (3D Extrusions) that were
created by copying them (we shall call them stools), and a
larger cuboid (that we shall call a table).  Again, the only
reason you may want to do a similar model is so that you
may follow our instructions.

• The Layers palette should already be displayed at the lower-
right corner of your screen.  If not, from the Palettes menu,
select Layers.

The Layers palette initially contains a single layer called “Layer 1.”  This
is the default layer name that the system always starts with.

The check mark in the column in front of the layer name indicates that this is the active layer.
Since there is currently no other layer defined, this is the only layer that could be active.  One layer
is active at any given time.  All the objects that you created were placed on this layer.  Note that
this would have happened even if the palette was not visible, and you could not tell which was
the active layer.

You will next assign to the layer a name of your choice, you will then create more layers, and you
will place some of the objects on the new layers.

• Click the mouse on the name of the layer in the Layers palette
and, when it highlights, type “Walls” over it.

• Click the mouse in the palette in the blank space under the
name you just typed.
You have renamed layer  “Layer 1” to “Walls.”

• Click in the palette under the current layer.
• In the text field that appears, type “Table.”  Click again under it.
• Repeat the operation and type “Stools” this time.

You have just created two new layers called “Table” and “Stools.”  All your objects are still on the
first layer called “Walls” (formerly “Layer 1”).  You will now move some of the objects to the new
layers.
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• In the Layers palette, click in front of layer “Table.”

The check mark moved to position in front of “Table,” indicating that this is now the active layer.

Select the Set Layer tool.

• With topological level set to Object, click on the larger cuboid.

This object has now been moved to layer “Table.”  Nothing changed in your display.  However, we shall soon be able to
verify that the change of layers did in fact happen.

• In the Layers palette, make “Stools” the active layer.

With the Set Layer tool active, pick each of the smaller cuboids.

You have just moved them to Layer “Stools.”  You will next verify that this is true.

In the Layers palette, the column to the right of the Layer Name column controls the visibility of
the objects on a layer.  By default, each new layer is visible.  Its status can be changed to ghosted
or invisible. Next, you will change the status of the “Stools” layer to ghosted, then invisible.

• In the Layers palette click in front of
“Walls” to make it the active layer.

• Click on the black diamond to the
right of “Stools.”

The black diamond changes to a white diamond, the
screen image is refreshed and displays the cuboids
in gray, which is the color used for ghosted objects.

• Click on the diamond to the right
of “Stools.”

The diamond disappears completely as do the
cuboids.  You have made layer “Stools” invisible.

The column to the right of the visibility column is the pickable  column.  It has
a lock sign as its header.  All new layers default to pickable, which is indicated
by a blank.  Any layer can be locked to make its objects non pickable.

• In the Layers palette, on the row of the “Table” layer, click the mouse in the pickable
column.  The lock symbol appears.

• Select the Pick tool and click on the cuboid in your model.
You cannot pick it because the layer it is on is locked.

The last column in the Layers palette is the snapability  column.  It controls whether or not you can snap to the objects
of a layer.  In form•Z, object snapping is set by the tools in the window tool palette.  As already mentioned, layers can
be grouped.  You create a layer group by clicking in the palette while pressing control (Macintosh) or ctrl+alt (Windows).
Once you have a group you can drag layers into it, working on the Layers palette.  More details would be beyond the scope
of this tutorial and can be found in UM section 2.7.
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30.3  Querying objects and their parts

The Query tool can be used to extract information
about objects and their parts.  You will try it in the next
exercise.

The model you used in the previous example should still
be on the screen.  You will inquire about some of the
objects it contains.  Make all the layers visible (click in the
visibility column until the black diamond is displayed for
all the layers).  Also click on the lock symbol that is
displayed for the “Table” layer to make it pickable again.

The topological level is at Object.

Select the Query tool.

• Click on point 1 to pick the larger cuboid (the
“table” you just made pickable).

The Query Object dialog appears.  At its upper part
it tells you that your object is an Extrusion, Facet-
ted, Solid, Well Formed, that it has 6 faces, 12
edges, and 8 points.

• At about its middle it displays the number of
Non Planar Faces, Surface Area, and
Volume of the object.

At the upper right area of the dialog is the Edit...
button.  Clicking on it allows you to edit and change the
parameters of your object.

Set the topological level to Face.

• The Clicking Inside Boundaries option
should be on.

With the Query tool selected, click on 2 to

select the face on the right.

The Query Face dialog appears with information
about the face you selected.  You can also Query at
other topological levels, such as point and segment.
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31  Insertions and deletions

The shapes of surface or solid objects can be changed by executing topological transforma-
tions or editing operations, which complement the geometric transformations.  The topological
transformations change the structure of objects by adding or deleting points, segments, outlines,
or faces.  As we have already seen, the geometric transformations affect the position (coordi-
nates) of objects or their parts, in 2D or 3D space.

The topological editing operations consist of insertions and deletions.  The insertions are
controlled by the magenta icons on the right of the second row of the default modeling tool bar,
which are as follows:

 

• Launch form•Z.

Turn on the Grid Snap.

When one of the insertion modifiers is selected, the lines or shape that will be inserted are drawn
using one of the drawing tools in the modeling tool bar.  Note that the insertion modifiers and the
object type modifiers (teal icons on the same row left) are mutually exclusive, and that they both
rely on the same procedures for drawing shapes, which become the basis either for the
generation of an object, or for an insertion.

All the insertions require you to preselect the face where the insertion will be made.  This is called
the insertion face.  The shape that is inserted is called the insertion shape.  If a face is not
picked, the system beeps and issues an error message to remind you to prepick a face.  However,
the requirement to prepick a face may be bypassed when using the Clicking Inside
Boundaries pick option, as you will see shortly.

For completeness, it should be mentioned that there are two more insertion operations (point and
segment insertion) that do not require preselection of a face and are grouped with the 3D line
editing tools.

The deletions of parts of objects are applied using two tools located on the last row on the right
of the default tool bar.  They are Delete Topology and Delete Geometry.  Complete objects are
deleted with the Delete tool, which you have already used a few times.
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31.1  Inserting outlines

You will first insert outlines to faces of objects.  Recall that an outline is a connected sequence
of segments that may be open or closed.  You will insert both types.  Before you insert an outline,
you need to identify the face where it will be inserted by prepicking it.  All the insertions (except
point and segment insertions) have this requirement.  To execute insertions you will first need to
create two objects.

• Turn on grid snap and from the Heights menu select
the Custom... item and set the active height to 12'.

• Generate two 16' x 24' x 12'  cuboids, as shown.

You are using a 12' height to simplify the snapping to the top surfaces of the
cuboids.  It is not a necessary condition.

• Select the Clicking Inside Boundaries option
(Pick Options dialog).

• Select the Pick tool and click on the top face of the
cuboid on the right to prepick it.

Select the Insert Outline tool.

Select the Vector Line tool and click on points 1,

2, 3, and 4 to draw an open line from one segment
of the cube to another.  When a warning message
appears, click OK.
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The endpoints of the outline you are inserting are required to be on segments or points of the object.  Note that the original
face is split into two new faces and that the face to the right of the vector line is highlighted.

• Double click anywhere in the graphics window but away from any selectable entity.
The highlight is moved to the other face.  This operation is called switch pick  and you can repeat it as many times as
you wish and watch the highlight toggle between the two new faces.

• Select the Pick tool.
• Click anywhere in the graphics window to clear the current pick, then click on the top face

of the cuboid on the left to prepick it.

The Insert Outline tool should still be selected.

With the Rectangle tool click on 5 and 6  to draw a

rectangle.  At the warning message click OK.
The closed shape you drew should be completely contained within the
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boundaries of the insertion face or the system will not accept it.  The newly inserted rectangle is returned highlighted.

   •    Execute a switch pick operation (double click anywhere in the graphics window).
Again, the highlight moves to the other face which consists of an outer and an inner outline (hole).  Both outlines are
highlighted since they are parts of the same face.
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Typically, to produce topologically meaningful results,
outline insertions are applied in a sequence.  Next you
will insert a few more outlines to the cuboid on the left.

• The outer face (the one with the hole) on the
top of the cuboid on the left should be selected.
If not, execute a switch pick operation.

With the Draw Segment tool click on 11 and 12.

• Click on 13 and 14.
• Click on 15 and 16.
• Click on 17 and 18.

The result should be as shown.

You used outline insertions to actually insert segments.  After you
inserted the first segment the whole insertion face remained high-
lighted.  After the second insertion, the face to the right of the
insertion line remained highlighted.  The right and left of a line is
relative to the direction in which the line is drawn.  After the insertion
of an open outline the face to the right is always the one that is
returned highlighted.  You inserted the other two lines by always
working on the highlighted faces.  You did all the insertions without
having to select new faces.

To observe the effects of the outline insertions to the
structures of the objects you will next move the inserted
outlines up.

With the Pick tool selected and topological

level at Face, first click away from the objects
to clear the previous pick, then click on 19 and
20  to prepick a top face of each object.

Turn on the Perpendicular switch.

Select the Move tool and click on 21 and 22.

The two faces should have moved as shown in
both wire frame and hidden line plots.

Note that the face on the right of the right object is not at all planar.
This could have confused the hidden line algorithm, but did not in this
instance.  Normally, one would continue and apply more operations
to properly shape that part of the object.
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31.2  Inserting faces and volumes

The input part of the face insertions is similar to the
outline insertions.  However, the result is substantially
different.

• Undo as many times as necessary to return
the two cuboids to their original state.

With the Convert tool, click on the right cube.

When the Convert Options dialog appears,
for Object Type in the Convert To group
select Plain Object.

• Repeat the operation for the other cube.
You have converted the cubes from parametric to plain objects to
avoid the warning messages as you do more insertions below.

• Draw a line in opposite direction (click 4, 3, 2, and 1, in this order).
Observe the result which should be as shown.

You have just demonstrated some of the rules of face insertions, which are
analogous to the outline insertions:
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Select the Insert Face/Volume tool.

• The Clicking Inside Boundaries option  should still be selected.
• With the Pick tool click on the top face of the cuboid to the right.
• From the Heights menu, select 4'-0".

With the Vector Line tool draw a line by clicking on points 1, 2, 3, and 4.

Note that these are exactly the same points
you drew when you inserted the first outline in
the previous section.  Observe the result.

• Apply a switch pick operation (double click the
mouse anywhere away from the object).
Observe the result.  The highlight has been
moved from the face that was extruded to the
other face.

• Undo and select the top face again.

3 2
1

4

•When an open line is drawn, the part to its right is extruded and is returned highlighted.
•When a closed vector line is drawn, the part that is contained by the closed shape is extruded

and highlighted.
• In both cases, the highlight can be moved to the other part by double clicking anywhere in the

graphics window, away from pickable entities.
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Next, you will work with the cuboid on the left.

• Clear the previous pick (Select the Pick tool
and click anywhere on the graphics window).

• From the Heights menu, select   -8' - 0" (this
is negative eight feet).

Select the Rectangle tool.

• Click on 5 and 6 to generate a rectangle, the
same one you drew for the outline insertion.
Observe the result.

• Undo and repeat exactly the same operation,
but this time select  8' - 0" (positive eight feet)
from the Heights menu.
Observe the difference of the two insertions.

You may be wondering why in the latter two examples you did not
have to prepick the face where the insertion was made.  Actually, the
requirement is still there and you did in fact prepick the face, but you
did it implicitly.  When you draw a closed shape and the first point you
draw is within the boundaries of the insertion face, the system can
use it to first select the face before proceeding with the insertion
operation.  That is how your two last insertions were executed
without preselecting a face.  Note that the implicit pick can only work
when you are using the Clicking Inside Boundaries option (the
one click method of picking).  If two clicks are required for the
selection, the insertion face must be explicitly prepicked.
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As you have seen, the height of the inserted faces is determined by the value selected from the
Heights menu.  Their direction is determined by the sign of that height value.  If the sign is
positive, the faces are extruded on the positive side of the insertion face.  If the height value is
negative, they are extruded to the negative side of the face.  Rather than selecting a height value,
you can also select Graphic/Keyed.  When you do, the insertion part will be rubber banded
as soon as you complete the drawing, allowing you to visually determine where you want to
position it.

When an open shape is drawn for a face insertion, its endpoints have to be on a segment or a
point of the insertion face.  When the input shape is closed, it is allowed to cross the boundaries
of the face.  However, when it does, the face insertion is executed as a Boolean union.  You will
do such an example next.

5
6
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• Clear and generate the shown 3D enclosure.

The two rectangles that you will draw in a moment
are also shown.

With the Convert tool, click on the enclosure.

When the Convert Options dialog appears,
for Object Type in the Convert To group
select Plain Object.

Select the Insert Face/Volume tool.

Turn off the Perpendicular switch.

• Prepick the top face of the enclosure.
• Select  -2' - 0"  (negative 2') from the Heights menu.

With the Rectangle tool  click on 1 and 2 to draw the

rectangle shown on the left side of the enclosure.
• After the operation is completed, switch pick (double

click) to move the highlight to the top face.
• Select  2' - 0" from the Heights menu.
• With the rectangle tool click on 3 and 4  to draw the

rectangle on the right side of the enclosure.
The results should be as shown.

You will conclude the face insertions with a practical
example: one more staircase.

The process starts with an 8 inch slab, which is converted
to a plain object.  Then steps are generated, one at a time,
by executing face insertions.

After you preselect the top face, start at the lower end and
draw lines from right to left (the direction of 5 to 6).  This
moves the portion on the right of the line you draw up, and
returns the face highlighted and ready to accept another
insertion.  After you have generated enough steps, the stair
should be similar to that shown.

If you feel it is too bulky you can adjust its bottom face.  On the
bottom face insert two segments as shown.  This can be done
with a single-segment outline insertion.  Then pick the face
under the stair’s top and move it up (Perpendicular switch on),
until the underside of the stair takes the appropriate inclina-
tion.  Note that, to pick the face under the stair, you will have
to pick with two clicks (Clicking On Edges option).

1
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6

5

segments to
be inserted
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31.3  Inserting holes

Holes are inserted the same way faces are in-
serted.  The insertion of holes to solids is executed
as a Boolean difference.

• Clear and generate a cuboid and a 3D
enclosure roughly as shown.

Convert them to plain objects.

You will first insert a hole on the top of the cuboid.

Select the Insert Hole tool.

• From the Heights menu, select -4' - 0".
• The Click Inside Boundaries option

should be on.

Select the Rectangle tool and click on 1

and 2.
Observe the result.

You may be thinking that the same result could have been
derived through a face insertion.  You are right.  Actually, in
cases like this it is recommended that a face insertion be used
because it is faster.  However, if you want to drill a hole all the
way through an object, or if the shape drawn for the insertion
crosses the boundary of the insertion face, you have to do a
hole insertion.

Next, you will insert three “windows” into the 3D enclosure, each time using a different height.

• Without changing any of the previous selections, click on 3 and 4.
• From the Heights menu select  -20' - 0".
• Click on 5 and 6.
• Change the height to -8' - 0".
• Click on 7 and 8.

The results should be as shown.

The last three examples drilled holes all the way through the object, which was not the case with
the first hole you inserted.  The insertion of the second window actually drilled a hole through two
walls.  How deep the hole is drilled is determined by the height value used for the hole insertion.
You should have noticed that all the height values you used had a negative value.  This is simply
because the direction of the drilling should be toward the inside of the object’s volume.  Positive
heights would have had no effect.
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31.4  Inserting openings

An opening is a different type of a hole.  Actually, the terms “hole” and “opening” have been
assigned to the two distinct insertion operations almost arbitrarily and they have been chosen in
order to avoid calling them “hole type A” and “hole type B.”  The Insert Hole and the Insert Opening
operations, under certain circumstances, derive identical results.  However, they are very
different in the manner in which they are executed internally.

•  The hole insertion is executed as a Boolean.  An opening is inserted directly.  This makes the
opening insertion significantly faster.

•  The hole requires a height to be selected and the hole is drilled to a depth determined by the
height value.  The opening does not require a height and always drills a hole all the way through.

•  For the opening insertion, the shape drawn has to be completely contained within the
boundaries of the face.  Its projection to the opposite face should also be within the boundaries
of that face.  The hole insertion does not have these restrictions.

To illustrate the Insert Opening operation, you will repeat the same examples you did for the hole
insertions, so that the results may be compared.
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• Undo as many times as necessary to
return your objects to their original state.

• The Click Inside Boundaries option
should still be on.

Select the Insert Opening tool.

With Rectangle selected click on 1 and 2.

Observe the result and the difference from
the hole insertion.

• Repeat the insertions on the 3D enclosure
you executed in the previous section.

When the system refuses to execute the last insertion (the
shape that crosses over the boundary of the wall), do not get
alarmed.  It is normal.  Your results should be as shown.  You
must have also noticed that the execution of this operation was
much faster.

In all cases, the opening insertion drilled holes all
the way through.  Again, the attempt to insert a
“corner” opening failed.  To insert an opening, the
shape you draw should be completely inside the
insertion face.   Insertions of crossing shapes can
only be executed as Boolean differences through
use of the Insert Hole tool.

-x

+x

-y

+y

-z

+z

1 2



228 form•Z Tutorial  •  Insertions and deletions

-x

+x-y

+y

-z

+z

31.5  Deleting points, segments, outlines, and faces

The deletions have effects that are the opposite of the insertions.  Entities at different topological
levels are removed from an object’s structure, rather than being added.  form•Z allows the
deletion of entities at any topological level, provided they do not disturb the structure of an object.
The deletions provide excellent methods for reshaping 3D forms.   You will do a few examples.
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• Clear, select 8’ from the Heights menu,
and generate the two cuboids and the two
octagonal extrusions shown.  Convert them
to plain objects.

Select the Delete Geometry tool.

Set the topological level to Point.

• Click on point 1.   Observe the result.

Set the topological level to Segment.

• Click on point 2.
Both results should be as shown.

To demonstrate how a number of deletions can
reshape an object, you will next work with the
octagonal extrusion at the back.

• The Delete Geometry tool is still active and
the topological level is still at Segment.

• Click on points 3 and 4.
• Set the topological level to Point.
• Click on points 5 and 6.

  The octagonal extrusion is not that anymore.

Set the topological level to Face.

• Select the Clicking On Edges option (Pick Options dialog).
• With the Delete Geometry tool still active, click on points 7 and 8, then on 9 and 10.

You have just deleted two faces and transformed the octagonal extrusion to a cuboid.

Even though the deletions you just executed are called geometry deletions, they really affect the
topological structure of objects, which remain solid, when they are solid.  Plain topological
deletions are executed by another tool, Delete Topology, which is not covered in this Tutorial.  You
can read about it in UM section 4.26.
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32  Reference planes and their palette

In the previous tutorial session, when you were drawing on the surfaces of the insertion faces,
you were drawing on a plane that the system was automatically generating which was not visible
to you.  There are also tools which allow you to explicitly create reference planes at any arbitrary
position in the 3D world space.  These planes are called arbitrary reference planes, and they
are defined by selecting parts (points, segments, outlines, or faces) of objects displayed on the
screen.  After they are defined they can be selected as reference planes in place of the Cartesian
(orthogonal) reference planes that you have used in the previous exercises.  You have actually
already used such a plane in chapter 27, when you needed to orient the pyramids you were
placing in a certain direction.

• Relaunch form•Z.

Turn on the Grid snap.

• Because you did not remove any window tools, they are already there for you to use.  In
this chapter you will be using tools from the following window tool palette:

The set of tools you will be experiencing in this chapter are different from the previous ones in that
they are window tools.  All the previous tools you have tried were generating and manipulating
objects.  The Reference Plane tools, while they may interact with objects, generate and
manipulate the planes on which you draw.
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32.1  Defining arbitrary reference planes

In this section you will learn how to define arbitrary reference planes, how to name and save them
in the Planes palette, and how to invoke them after they have been saved.  You will first generate
an object (pyramid) and you will then derive reference planes from the faces of this object.

Select the 3D Convergence tool.

• Height should be at the default 10'.

Use the Rectangle tool to generate the pyramid shown.

From the Set Reference window tool palette (first on

the left), try to select the Arbitrary Reference Plane.
The system beeps and does not switch the reference
plane.  The message says that there is no arbitrary
plane currently defined. You will do this next.

Set the topological level to Point.

Select the Define Arbitrary Plane tool (from the third

window palette).
• Click on points 1, 2, and 3.

The reference plane switches and so does the plane
icon in the window palette.

You have just defined an arbitrary reference plane that passes through the three points you selected.  Its origin is at the
second point, and the X axis is along the line defined by points 1 and 2.  Note that a second set of coordinate axes have
appeared and that the reference grid follows the newly defined reference plane.  There have always been two sets of
axes on your screen:  one for the world space and one for the reference plane space.  If you look in the Window Setup
dialog you will see that there are independent options for turning each set of axes on or off.  The two sets of axes coincide
until you move the reference plane or you define one in a new  position.  You can also define planes by selecting segments,
outlines, or faces, which you will do shortly.  Before you do, you will name and save the plane you just created.

• From the Palettes menu select Planes.
The Planes palette appears as shown.  It is empty.

• Click in its list window.
The name “Plane 1” appears in a text field that is highlighted.

• Type “West,” the name you will use to identify the current arbitrary
plane, and click under it to complete the name definition.
Your arbitrary plane definition has now been saved under the name
“West” and appears in the Planes palette as shown.
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Defining arbitrary planes from points or segments has the advantage that these entities may be
picked from different objects.  However, when generating reference planes on faces of objects,
it is more direct to select the faces, which is what you will do next.  When the faces are facing front,
then the one point method of picking is the most direct.

• In the Pick Options dialog select the
Clicking Inside Boundaries option.

Set the topological level to Face.

Select the Define Arbitrary Plane tool.

• Select z=45°  x=45°  (View menu).
• Click on 4.
• Click inside the Planes palette, type “North,”

and click again under the name.
You changed the view to make the face
selection easier.

• Select z=30°  x=60°  (View menu).
• Click on 5.
• Click inside the Planes palette, type “East,”

and click again under the name.

• Click on 6.
• Click inside the Planes palette, type

“South,” and click again under the name.

You may dislike the fact that the origin of the last
plane you created is at the left end of your face
rather than in a more central position.  You can
change this.

Select the Move Plane tool.

• Click on 7, then on 8.
Your reference plane is now positioned as
shown.

Note that where you click the mouse when you select a face by
the one point method (Clicking Inside Boundaries) is
significant.  The segment which is the closest to the pick point
becomes the X axis of the new reference plane.

-x

+x

-y

+y

-z

+z

-x

+x-y

+y

-z

+z

-x

+x

-y

+y

-z

+z

-x

+x

-y

+y

-z

+z

-x

+x

-y

+y

-z

+z
-x

+x

-y

+y

-z

+z

7
8

4

5

6



232 form•Z Tutorial  •  Reference planes and their palette

32.2  Switching planes from the palette

You have just defined four reference planes, and named and saved them in the Planes palette
which is now as shown.  The last plane, called “South,” has a check mark in front of it indicating
that it is the active reference plane.  When you select the Arbitrary Reference Plane tool in the
window palette to switch from an orthogonal to an arbitrary plane the active plane is invoked.  A
plane does not need to be saved in the palette to be active.  When no plane is saved in the palette
or no plane is selected as active in the palette, then the most recently defined plane is the active
arbitrary plane.
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• Click in front of each of the planes that appear in the palette, one at
a time, and observe the changes on your screen.
We do not show them, but each time you made another plane active
the grid of that plane appeared on the screen.

• At the end, make “South” the active plane.

Select the 3D Enclosure modifier.

Select the Vector Line tool.

• Draw a triangle by clicking on points 1, 2,
and triple clicking on 3.

• Select Hidden Line* (Display menu).
Observe the result.

You drew on the active reference plane, which
coincides with the front (south) face of the pyramid.
You drew in a 3D view.  The result is an extruded
enclosure that sits exactly on the front face and
extends in a direction perpendicular to it.
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• Make “East” the active reference
plane.

• In the View menu, drag the mouse to
Plane Projection and, from the
submenu that pops out, select [+XY]
Top.

• On the displayed 2D projection, with
the 3D Enclosure and Vector Line
tools still selected, draw a triangle by
clicking on points 4, 5, and triple click-
ing on 6.

• Make “North” the active reference
plane.

• From the View menu select Plane
Projection: [+XY] Top, again.

• Draw shape 7, 8, 9, as shown.

• Make “West” the active reference
plane.

• Select View: Plane Projection:
[+XY] Top, again.

• Draw shape 10, 11, 12, as shown.

• From the View menu select z=30°
x=60° .

• From the window palette select XY
Reference Plane.

• From the Display menu, select Hid-
den Line*.

Note that the triangular enclosures you just generated sit
exactly on the surfaces of the faces of the pyramid.  You
can also do this by turning on the Snap to Face tool  ( )
from the window tool palette.  However, when you use
explicitly defined arbitrary reference planes, as you did in
the examples above, you have much better control of
where you draw.
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32.3  The reference plane tools

On the Reference Planes tool palette, there are seven tools.
They all operate on reference planes.  You have already used
the Define Arbitrary Plane and the Move Plane tools.  In this
section you will use a few more.

• Clear.
• Grid Snap should be on.
• Select XY Reference Plane (window palette).
• In the Heights menu select 4'-0".
• With the 3D Extrusion and the Rectangle tools se-

lected, generate the cuboid shown.
Try to position it exactly where it is shown.

• Topological level should be on Face, and Clicking
Inside Boundaries pick option should be selected.

Select the Define Arbitrary Plane tool and click on 1.

The shown reference plane appears.  It is located on
the top face of your object.

Select the Move Plane tool and click on points 2 and 3.

You have moved the plane so that its origin is at the center of the top face.  After
the first click the plane’s axes and boundaries were rubber banded, which
assisted you in determining exactly where to place it.

Select the Rotate Plane tool.

• Click on 4 and then on 5.
Your reference plane has been rotated around the Z
axis and its axes have been placed on the diagonal of
the square face.

Again, the plane is rubber banded after the first click which helps determine
where to place it.  Your first point (4) was on a 45° diagonal of the grid and your
second point (5) on an axis.  Note that the first point (4) should not be on an axis.
If it is, the plane will rotate around the axis that is perpendicular to the axis you
clicked on, rather than around the Z axis, which we want to do here.

• Draw the four columns, as shown.
With the reference plane properly positioned and the
Grid Snap on, this operation should be straightforward.

Next you will move the plane up.

Turn on the Perpendicular switch.

1

32

4

5

-x

+x

-y

+y

-z

+z

-x

+x

-y

+y

-z

+z

-x

+x

-y

+y

-z

+z

-x

+x

-y

+y

-z

+z



235form•Z Tutorial  •  Reference planes and their palette

Select the Move Plane tool and click on 6, then 7.

Your goal was to place the reference plane at the same level as the top faces
of the columns.  How do you know where to click the second time?  There are
a number of different methods you can use:

• We did it by using one of the columns as reference.  We defined  a vertical
motion equal to the height of the little column.  Since the plane is currently
coincident to the bottom face of the column, this motion will place it at its
top face.

• Another way is to read the values displayed in the Prompts or the
Coordinates palette.  This is best done by switching to relative coordinates
(on either palette, deselect the little box labeled “A”).

If you are not sure what the z value at the top face of the column is, select
Snap to Point (window palette) and place the mouse cursor on one of the
points of the top face of the column.  The z field in the Coordinates palette
should display 10'-0" (assuming relative coordinates) which is what you
should have expected, given that the column is 10' high.   You can also use
the Query tool and select any point of the top faces to find out what its
height is.

Once you know the height, you can watch the values displayed in either
the Prompts or the Coordinates palette as you move the reference plane
up and click when it displays the height where you wish to place it.

• Another way is to switch to a side (front, back, right, or left) projection, turn
your grid off to be able to see the axis lines better, and move the reference
plane there.

• Generate a 2' high square extrusion at the shown
position.

• The Perpendicular switch is still selected.

Select the Move Plane tool and move the plane up 2'.

Using Grid Snap and with the snap module (Snap Options dialog) set to 2',
a 2' move is equivalent to one “jump” of the cursor.

• Deselect the Perpendicular tool.

Select the Rotate Plane tool.

• Click on 8 and 9.
You rotated the plane by 45°.
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+z Select the Define Perpendicular Plane tool and click on 10.

A plane perpendicular to the previous is generated as
shown.

You will next generate two pyramids, facing in opposite directions,
on the Perpendicular plane you just defined.

Select the 3D Converged tool.

• From the Heights menu select 20' (or any positive height
you wish).

Select the Rectangle tool.

• Click on points 11 and 12 to create a pyramid, as shown.

• Select -20' (or the negative of whatever height you may
have selected in the previous step).

• Click on points 11 and 12, again, to create a pyramid facing
the other way.
The result should be as shown in both wire frame and
hidden line plots.
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33  Views and their palette

As you build models you need to be able to view them from a variety of angles.  Viewing in 3D
and 3D modeling, while by no means synonymous, are almost inseparable.  As you develop your
model you need to change your view so that you may gain better access to the areas in which
you are working.  After an operation has been completed, you may need to view the result from
different sides.  Views also need to be manipulated for the production of renderings of the final
product.

form•Z offers a variety of viewing methods, some of which you are already familiar with.

•Views can be changed by selecting one of the items in the View menu that produce views
from preset angles, including six 2D projection views for the world space and another six for
the reference plane space.

•Views can be changed by entering your own X, Y, and Z angles in the Custom View Angles
dialog that is invoked from the View menu.

•Views can be produced through graphic interaction using one of the available View tools, at
the right end of the window tool palette.

•Views can be produced through interactive manipulation of more detailed viewing parameters
by invoking the Cone of Vision environment from the View menu.

•The same viewing parameters that are used with the Cone of Vision can be defined through
numeric input in the View Parameters dialog that is invoked from the View menu.

This tutorial session will cover exercises using all the viewing methods except the Cone of Vision,
which is discussed in UM section 3.5.6.

•Relaunch form•Z.

As in the previous chapter, you do not need to turn on any more tools, as you have done at the
beginning of most of the previous sessions.  All the tools you need are already available.
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The shown, up-side-down view is produced.  Any X angle greater than 90° and less than 270° will place the viewer under
the modeling scene.

What if you need this view frequently and want to return to it after some other view, without having
to type the 240° angle every time?  Views and their parameters can be saved in the Views palette,
which should already be displayed on the screen.  If not, open it as follows:

• From the Palettes menu select Views.
An empty Views palette appears, as shown.

• Click in the Views palette, type the name
“UpDown_1,” and click under the name.

This is now the name of the view shown on the screen.  An
eye symbol appears in front of the name, indicating that
this is the active view.

33.1  Saving custom views

You have already experienced the View menu items with the preset angles.  You have also been
using the 2D projection views, and you have been made aware of the Custom View Angles...
item in the View menu.  You will now learn how to save the views that you may define by entering
your own viewing angles.  Before you proceed, you will need a few objects for viewing.

• Use the proper tools to create the
shown objects on the XY Refer-
ence Plane.

We created them using the Graphic/
Keyed item, and their heights are roughly
40', 20', and 4'.  We kept the modeling
scene simple and asymmetric to make the
views we shall be producing more read-
able.  Both axonometric and  perspective
z=30°  x=60°  views are shown.

• From the View menu select Cus-
tom View Angles... and in the
Custom View Angles dialog
type 240° in the X Angle field.
The value of the Z Angle remains
30°.

• From the View menu select any of the preset views.
The view on the screen changes to the one you selected.  The name “UpDown_1” in the Views
palette appears without an eye symbol.

• Click in front of “UpDown_1.”
The eye symbol reappears, and the up-side-down view appears on the screen again.
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33.2  The viewing tools

In this section you will use two of the View tools  from the window
palette to manipulate the view of the models you created in the
previous section.  These tools will not be covered in full detail,
which would be redundant with the UM, where you can read
more about them in section 2.2.8.

• Invoke the Preferences dialog and deselect
Continuous Window Tool Control.

• Select z=30°x=60°  (View menu).
The view should be as shown to the right.

Select the Set View tool.

• Click on 1 and move the mouse to the left.
Observe how the image rotates clockwise about a
vertical axis.

• Click again at about 2 to stop it from rotating.
You have generated a new view as shown to the right.

If you are wondering what the parameters of this view are, you can find out by
invoking the Custom View Angles dialog (from the View menu) and looking
at the angles recorded there.

With the Set View tool active, click on 3 and move the

mouse to the right.  Then click again on 4.
Your image has rotated the other way.

• With the Set View tool, click on 5, then 6.
Your image has rotated about a horizontal axis.

You will next try another viewing tool, which is more dynamic.

• Select z=30°x=60°  (View menu) again.

Select the Walk View tool and click somewhere in the

middle of the image, then move the mouse to the right
and stop.
Even though you stopped, your image continues to
rotate, until you click again.

Apply this tool a few more times, each time moving the mouse
in a different direction to see how dynamic viewing behaves.
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34  Drafting

form•Z also includes a drafting environment that is primarily intended to provide support and to
complement the functions of the modeling environment.  However, the drafting environment can
also be used on its own and independently of the modeling environment.  You will do examples
for each of the two ways the drafting environment can be used.  In this tutorial session you will
produce a drawing from scratch working exclusively in the drafting environment.  In session 36
you will transport drawings from the modeling environment, compose them into a single drawing,
refine them, complement them with textual information, and print them.

The entities that are manipulated in the drafting environment are referred to as elements  to
distinguish them from the objects  of the modeling environment.  There are three types of drafting
elements:  the delineators, the annotations, and the symbols.  There is also a special type of
element that is used to manipulate other elements: the area.  The delineators are the polylines,
which include the specially constrained rectangles, and the arcs.  The annotations are the text,
the dimensions, and the leader lines.  Most of the types of the drafting elements will be covered
in this section.

• The polylines are connected sequences of segments and can be closed or open.  They are
the most general type of element, and they can be freely manipulated.

• The rectangle is a constrained type of a polyline.  It always preserves its rectangular shape
when operations are applied to it.

• The arcs are also a constrained type of an element.  Internally, they are represented by the
parameters that generate them, rather than as sequences of segments.  This guarantees the
preservation of their circular shape when operations are applied to them.  It also imposes certain
restrictions relative to which operations can be applied to them.

Note that, in addition to the arcs, polyarcs are also available, and each type is generated by different tools (see also UM
sections 5.1.3  and 5.1.5).  The arcs and the polyarcs look the same.  However, the polyarcs are polylines and consist
of sets of segments which approximate the arc shape.  The arcs are continuous parametric entities and have no points
and no segments that might be picked individually.

• The constraints of the rectangles and the arcs can be bypassed by exploding them to
transform them to plain polylines.  You will soon have the opportunity to apply the Explode tool.

• Relaunch form•Z.

 As always, the system presents an empty modeling window labeled Untitled1 - 1 [Model].
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34.1 Invoking the drafting environment

• Under the  Windows menu, select  New Draft Window.

The system opens a drafting window labeled  Untitled1 - 2 [Draft].  It is positioned on top
of the modeling window, but a little lower and to the right, which keeps the modeling window still
visible, as shown.  This way you can compare the naming conventions used.

Note that the first numeric index for both windows is “1,” which indicates that both windows belong to the same project.
The second index is “1” for the modeling and “2” for the drafting window.  These indices indicate the order in which the
windows were opened.  You can assign a name of your own choice when you save the project, by executing the Save
As... item in the File menu.

The drafting window you just opened belongs to the project that was already open on the screen.  Note which palettes
are open by default.  Alternatively, you could have opened a new project with a drafting window by selecting the New
[Draft] item from the File menu, as shown below.
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The screen layout of the drafting environment is almost identical with that of the modeling
environment.  It also consists of:

• a horizontal menu bar  at the top:

Menus that do not apply to drafting, namely Heights, as well as a number of individual
menu items that are not used do not show up.

• a vertical tool bar or iconic menu on the left, that consists of two columns:

Some of the icons are different than those in the modeling environment and some are the
same.

• a graphics window  that occupies most of the central area of the screen:

The graphics window of the drafting environment is strictly two dimensional, which is
reflected in the way the grid is presented.  The grid is on the only reference plane
available, which is equivalent to the XY plane.    Other than these differences, a drafting
window works exactly the same way as a modeling window.

• a window tool palette  on the lower border of the window:

Since the drafting window is strictly 2D, the first three window palettes that apply to
modeling do not apply to drafting, and are grayed out.  All the other window palettes are
as in modeling, except that some more tools are dimmed out.

• a number of floating palettes:

Which palettes appear depends on their status at the time the drafting window is opened.
Other palettes can be invoked from the Palettes menu.  The palettes that apply to
drafting, in addition to the Drafting tools and the Window tools, are the Colors,
Coordinates, Hatch Patterns, Layers, Line Styles, Line Weights, Prompts, Symbols, and
Views.  The Hatch Patterns, Line Styles, and Weights apply exclusively to drafting.
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34.2  The drafting tool bar

As in the modeling environment, the tools in the drafting tool bar are color coded.  The tools with
the turquoise background are the modifiers and the tools with the white background are the
operators.  Both types function exactly as their modeling counterparts.

There are thirteen rows of icons in two columns.  They can all be torn off to become independent
tool palettes, as shown.  The drafting tool bar can be customized as the modeling tool bar can.

The 1st row left contains two modifiers: the Shape and Enclosure.  The 1st row right contains
two special modifiers:  the Area and Pane.

Rows 2 and 3, left and right, contain the drawing tools that work as their modeling counterparts.
Note that the arc tools appear twice.  The tools in row 2 generate true arcs (elements that are
constrained and retain their circular shape when operations are applied to them).  The tools in
row 3 generate polyarcs (arcs represented as polylines).

Row 4 left contains the drafting topological levels that consist of the Point, Segment, complete
Element, Compound element, and the Area, which is a special topological level.  Row 4 right
contains the Pick tools.

Row 5 contains the Derivative En-
closure and Parallel Line tools.

Row 6 contains the Boolean opera-
tions and the Compound tool.

Row 7 contains the Line Editing tools.

Row 8 contains the Text and Sym-
bols tools.

Row 9 contains the Dimensions and
dimension related operations.

Row 10 left contains the Self/Copy
modifiers, and row 10 right contains
the Query tools.

Row 11 contains the Geometric and
Relative Geometric Transforma-
tions.

Row 12 contains the Attribute ma-
nipulating tools.

Row 13 left is the Delete tool, and 13
right is the Hatch tool.
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34.3  Creating and drafting the plan of a chapel

Turn on the Grid Snap.

Select the Shape modifier on the 1st row.

Select the Rectangle tool.

• Click on points 1 and 2 to draw a rectangle as shown.
• Draw a second rectangle by clicking on points 3 and 4.

Select the Polyarc, Clockwise, Endpoint-Last tool.

• Click on 3, 5, and double click on 6.

The process of drawing arcs should be familiar to you from the modeling
tutorials.  The shapes you drew should be as shown.  Note that the tool we asked
you to select above is the Polyarc (3rd row) and not the Arc (2nd row).  You need
the polyline to be able to generate dimensions later in this tutorial.

Next you will transform all the shapes you drew to double lines.

Select the Parallel tool to display its options in the tool

options palette, as shown to the right.  In it, select
Absolute.

• With the Parallel tool active, click on points 7 and 8.
Observe the result.  You have just created a parallel
rectangle inside one of the rectangles you drew earlier.
The first click (7) picked the rectangle.  The second
click (8) determined the position of the parallel line.

• Click on 9 and 10; then on 11 and 12.
Observe the results, which should be as shown.  You
have created parallel shapes for all three shapes.

Of the shapes generated so far, the rectangles are of a constrained character.
They can be transformed to common polylines by exploding  them. You will
soon want to delete segments from two of the rectangles.  Segments cannot be
deleted from rectangles for the simple reason that, if such an operation were
allowed, a rectangle would not be a rectangle any more.  To be able to delete
a segment from a rectangle, it first needs to be transformed to a polyline by
exploding it.

Select the Pick tool.
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Set the topological level to Element.

• Click on each of the four rectangles to prepick them.

The four rectangles turn red indicating that they are selected.
As in modeling, red is the default color for highlighting picked
entities.  It can be changed in the Project Colors dialog
invoked from the Options menu.

Select the Explode tool (8th row right).

• Click the mouse anywhere in the graphics window.

This causes no visible result other than the loss of the pick color.
However, the internal representations of the rectangles have
been changed to polyline structures.  This will allow you to
execute the following operations.

Set the topological level to Segment.

Select the Delete tool (last row left).

• Click on 1, then on 2.
You have just executed two segment deletions.

After the deletions, the endpoints of the inside arc (on the top
portion of the drawing) do not touch the vertical lines which are
under them.  One way to repair this deficiency is to make the
vertical lines longer.

The topological level should still be at Segment.

Select the Extend tool (11th row right).

• Click on 3 and 4, then click on 5 and 6.
Observe the results. They should be as shown.
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Next, you will “clean” the corners of intersection to derive a proper double line representation for
your floor plan.  The cleaning process consists of two parts.  First, the crossing segments will be
broken.  Second, they will be trimmed.  The positions where you will click the mouse are noted
on the detail drawing which corresponds to the area outlined with the dashed rectangle.

The topological level is still at Segment.

Select the Break Line tool (7th row left).

• Click on 1, 2, 3, and 4.

No change is visible but the elements have in fact been broken at
the points where the mouse was clicked.

Select the Trim Join tool (7th row left).

• Click on 5 and 6; on 7 and 8; on 9 and 10; on 11 and 12.
• Repeat these operations three more times to clean the

other areas of intersecting lines.
When done, your drawing should be as shown.

There are two Trim tools:  Trim Open and Trim Join.  Both would have worked here.
The former trims and leaves the segments disjoined.  The latter also joins them
into a continuous line.
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You will next refine the interior of the Chapel.

Select the Polyline tool.

• Draw the two vertical lines shown.
They outline two of the openings you will create.
You will next break the lines and trim them, as appropriate.

Select the Break Line tool.

• Click on points 1, 2, 3, 4, 5, and 6.
There is no visible change in the drawing, but, if the
operations were executed properly, the lines have been
broken.  You can now trim them.

Select the Trim Join tool.

• Click the mouse where appropriate to produce the results
shown.

You should now be able to do this on your own, without instructions.
If at some point you make a mistake, Undo it and try again.

Continue and create the other interior openings and an entrance.
The result should be as shown.  We have also changed the
thickness of the lines.  Here is how you do it:

• In the Line Weights palette, notice that there is a check
mark in front of the first line, which signifies that this is the
active line weight.  Click on the second line.  The check
mark is moved to this line, which is now the active line
weight.

• With the Pick tool selected, use the pick by frame method
to prepick all the lines in the drawing.

Select the Line Weight tool (next to last row left).

• Click anywhere in the graphics window.
All the lines are now displayed with thicker lines, as shown.

You generated a plan by drawing it in parts which were then trimmed and cleaned.  You did this
by using some more or less typical drafting operations.  In the next section you will redraw the
plan of the chapel using some special types of elements and operations that are available in
form•Z.  While these will allow you to generate the plan faster and in fewer steps, you should keep
in mind that the operations you experienced in this section are more generic and are typically used
more frequently than the ones in the next section.
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34.4  Generating the chapel plan another way
• Select File: New(Draft) to open a new drafting window.

The Grid Snap should be on.

Option-click on the Enclosure modifier.

In the Enclosure Options dialog, select Left and in the
Enclosure Wall Width field enter 2'. Click on OK.

• The Enclosure modifier should be selected.

Select the Rectangle tool and click on points 1 and 2 to

generate a rectangular enclosure, as shown.

Select the Vector Line tool and click on 3 and 4.

While at 4, select the Polyarc, Clockwise, Endpoint-Last

tool (4th row) and click on 5 and 6.

While at 6, select the Vector Line tool and triple click on 7.

The shape you drew is generated as an enclosure.

Select the Shape modifier.

With the Rectangle tool draw the three shown rectangles.

Select the Union tool and click on the two enclosures.

Set the topological level to Compound.

With the Pick tool selected, click on 8, 9, 10, and 11 to

preselect the shapes they are on, in this order.

Select the Difference tool and click the mouse anywhere in

the graphics window.  Observe the result.
• Change the line weight as in the previous section.
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The result looks identical to the one you derived at the end of the previous section.  However, they
are different.  The plan you just derived consists of a single polyline.  The one in the previous
section consisted of many segmented lines.  Which is preferable depends on what you may want
to do next.  For the example in the next section it does not matter.  You may use either one.
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34.5  Finishing and annotating the drawing

You will next use some more drafting tools to make a few more
refinements to the drawing.  You will use dashed lines to draw the
projections of the dome and the roof of the Chapel.

• In the Line Styles palette, click on the second line to make
the dash line the active line style.

• In the Line Weights palette click on the first line (the thinnest).

Select the Circle, Center and Radius tool.

• Click on 1 (center of circle) then click on 2 (radius of circle).
• Draw a smaller circle inside the previous.

With the Rectangle tool draw the two dashed rectangles.

With the Polyline tool draw the remaining dashed lines.

To complete the drawing you will next add dimensions and a title.
The positions where you will click are shown on a drawing without
the dashed lines, to make them more readable.

The dimensions consist of dimension lines, extension lines, terminators, and
text.  There are four types of terminators.  You will use the default arrow head.
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Select Dimension Horizontal/Vertical.

• Click on 1 and 4, double click on 7,
and click again on 7.
This produced dimension a.

The first two clicks (1 and 4) selected the points to which
the dimension is attached.  The double click (7) estab-
lished an initial position for the dimension.  At this point a
rubber banded image of the dimension appears which can
be moved by moving the mouse.  The final click estab-
lishes the final position of the dimension and plots it.

Note that if this is the first operation involving text, there is
a certain hesitation while loading the text fonts.,

• Click on 1, 2, 3, and 4; double click on
8, and click on 8.
You created chain dimension b.

• To do dimension c, click on 3 and 5,
double click on 9, and click on 9.

• To do d, click on 2, 1, 6, and 5, double
click on 10, and click on 10.
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You should have observed that the same tool was used to generate both horizontal and vertical dimensions.  The options
for this tool are displayed in the tool options palette, when the tool is active.  There are three options for placing the horizontal
vertical dimension: Horizontal, Vertical, and Dynamic, which is on by default.  When this option is selected, the
program switches from vertical to horizontal on the basis of the position of the mouse, relative to the last point selected for
dimensioning.  The last point selected, prior to the double click, is used as a base  for determining whether the dimension
will be horizontal or vertical.  If the x distance of the mouse position from the base is shorter than its y distance, a horizontal
dimension is generated.  Otherwise, a vertical dimension is generated.  You can watch a dimension dynamically switch from
horizontal to vertical, and vice versa, as the mouse moves and the dimension is rubber banded.

Finally, you will create a title for your drawing, using
the Text Place tool.  Before you do it, select
Display: Display Options... to invoke the
Drafting Display Options dialog.  In its Text
tab, select Black/White for both Outline and
Fill.

Select the Text Place tool and click on 11

(under the plan).
• In the Drafting Text Editor dialog that

appears, select Zapf Chancery from
the Font pop up menu (or any font if this
is not available), select Center from the
Justification menu, type “Chapel of St.
Nicholas,” enter 3' in the Height field, and
click OK.

Your drawing should now be as shown.
Now you can make a hard copy of the drawing on the printer.
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35  Modeling a three-story building frame

This tutorial session will not introduce any new tools.
Instead, you will use some of the tools you have
already learned to produce the model of the structural
frame for a three-story building shown.

• Relaunch form•Z.
A modeling  window has opened on the screen.

  Turn on the Grid Snap.

Select the 3D Extrusion modifier.

• From the Heights menu select Custom...
and in the Custom Height dialog that is
invoked enter 0' - 8".  Click on Add To Menu.

With the Vector Line tool selected, click on

points 1 through 7 and triple click on 8 to draw
a slab, as shown.

With  the Rectangle tool draw a 4' x 8' x 8"  step,

as shown.
• Double click on the Grid Snap tool to invoke

the Grid Snap Options dialog.  Make certain
that the XYZ Snap Lock is on, and in the Grid
Snap Module: X field enter 0' - 8".

The same value will be automatically entered in the Y and Z fields,
as soon as you close the dialog.
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+x

• Select  [-ZX] Front from the View menu.

Select the Zoom In Incrementally window tool

three times.

You executed three incremental zoom ins to get a closer front view.

The topological level should be at Object.

The self/copy mode should be at Self.

Select the Move tool.

• Click on the slab (pick it) and move it down by
8 inches.
The two objects should now be as shown in a
and in the detail b.

Set the self/copy mode to Multi-Copy.

• Invoke the Copy Options dialog  (from the
Multi-Copy tool),  and in the # Of Copies field
enter 12.

Select the Move tool.

• Click on point 1 and then on 2.
Observe the result.

You have just constructed a stair, whose side view is as shown in c.
To better see what you have created, display a 3D view.

• From the View menu select  z= 30°   x= 60° .
Your 3D view should be as shown in d.

-x +x+y

-z

+z

1
2

a

b

-x +x+y

-z

+z

-x

+x

-y

+y

-z

+z

c d



253form•Z Tutorial  •  Modeling a three-story building frame

From the Zoom tool palette select the Reset

tool.
This returns you to the original scale.

• From the View menu select  [+XY] Top.
• Execute Zoom In Incrementally twice.

This produces a closer view.

Next, you will place the whole stair in the proper
position on the slab.

Select the Pick tool and, using pick by frame,

select the complete stair.

Set the self/copy mode to Self.

Select the Move tool.

• Click on point 1, then on point 2.
Your stair has moved to a new position, as
shown in f.

Select the Pick tool and clear your picks (click

the mouse anywhere in the window).

You may next want to plot a 3D view to see your model
in 3D space.  If you do, return to the top view and
continue with the next step.

• From the Heights menu select 8' - 0".

Select the Polygon tool and from the tool

options palette select the Diamond (2nd  icon)
or type 4 in the By # Of Segments field.

• Generate a small diamond as shown in g.

This is an 8' high column, even though its height is not
yet visible.  You will look at it in 3D, shortly.  Before you
do, you will make ten more copies of the column to
provide sufficient support for the structure.
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Set the self/copy mode to Continuous Copy.

Select the Pick tool.

• Click on the column you just generated.

Select the Move tool.

• Click at the center of the little diamond.
• Click the mouse ten more times to position the

copies as shown in h.
• Double click to signal the end of the copying

activity.
• Clear the picks (with the Pick tool selected

click anywhere in the graphics window).
• From the View menu select z= 30°   x= 60° .

You can now inspect the results of your operations in
a 3D view as in i.  You may also want to see it displayed
in a hidden line perspective.

• From the View menu select Perspective.
• From the Display menu select Hidden Line*.

Your view is now as shown in j.  We also turned the grid
and the axes off, which you can do from the Windows
menu.

After allowing yourself some time to inspect your
model, continue.

• Turn the grid and the axes back on,
if they are off.

• Select Wire Frame* (Display menu).
• Select Axonometric from the View menu.
• Select [-ZX] Front (View menu).

Select the Incremental Zoom Out window tool.

This will make more room for the next opera-
tion.  Your view should now be as shown in k.
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You may be wondering why we constructed the stair this way and
did not use the Stair from Path tool.  We did so simply to exercise
a number of operations and to show that everything can be
constructed piece by piece.
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The next task is to add multiple stories to the building.

• In the Edit menu pick Select All UnGhosted.

Set the self/copy mode to Repeat Copy.

Select the Move tool.

• Click on point 1, then on 2.

Note that point 1 is exactly on the lower segment of the slab and that
point 2 is at the height of the top end of the column.

• Click once again anywhere in the window, and
then double click.

• Clear the picks (with the Pick tool click
anywhere in the graphics window).

The result should be as shown in m.  You have almost completed the
model of a 3-story building structure.  Needless to say, you could
continue and create additional stories, once you have the repeat
copy parameters in place.  We assume that this is as far as your
budget allows.  Your model still needs a roof.

Set the self/copy mode to One Copy.

Select the Move tool.

• Click on point 3, then on 4.

You have now made a copy of the bottom slab and placed it at the
top of your building.  Next, you can view your building in a 3D hidden
line perspective as shown.
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Before quitting this session you should
save the building frame model you
just constructed.  Call it “Building
Frame.”  It is used in the next session
to produce a drafting plot.  Or you may
continue with the next session right
away, without quitting the program.
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36  Drafting modeling images

The views of models generated in the modeling environment can be printed directly from within
the modeling environment.  The system will print the image shown on the screen, as it is displayed
on the screen.  This can be a  wire frame or a hidden line plot, or a shaded surface rendering
produced by any of the rendering items in the Display menu (Quick Paint*, Surface
Render*, Shaded Render*, etc.).  When views of modeling scenes need to be composed into
a single drawing, to be refined by manipulating the types and weights of their lines, or to be
complemented with textual information such as dimensions, titles, and notes, they can be
transported into the drafting environment.  How this is done is the focus of this tutorial session.
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+zIn the previous session you produced
the model of a building frame, which
you also saved on your disk.  In this
session you will compose and draft a
drawing that contains a top view, two
side views, and a perspective of the
frame model.

If you are continuing from the previous
session, you are ready to proceed.  If
you quit at the end of the last section,
relaunch the program by double click-
ing on the project icon labeled “Build-
ing Frame.”  The system opens the
project in exactly the state it was in
when you saved it.  It should be as
shown.

You are now ready to transport views of your model to the drafting environment.  Two steps are
required:

1.  A view is placed into the form•Z Clipboard.
2.  The view is brought from the Clipboard into a drafting window.

These are standard Macintosh and Windows procedures, except that for transporting 3D objects
and drafting elements, form•Z uses its own Clipboard, rather than the system Clipboard.  The
form•Z Clipboard is capable of storing 3D modeling representations as well as 2D drawings.
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36.1  Transporting modeling views into the drafting environment

An entity is placed in the Clipboard by preselecting it and then executing the Cut or the Copy
command, both in the  Edit menu.  Since you do not want your model to be deleted, you will be
using the Copy command.

When placing modeling objects into the Clipboard, the manner in which they are plotted on the screen at the time they
are placed is significant.  If a wire frame is displayed, the edges of solid objects will have double lines when the images
are brought into a drafting window.  If a hidden line plot is displayed, fewer lines are transported.  However, the option
Remove Duplicate & Overlapping Lines is available in the Paste From Modeling* dialog, which is invoked
from the same item in the Edit menu.  This option is on by default, and we recommend that you keep it this way.  When
modeling images are pasted into drafting and this option is on, duplicate lines are eliminated.
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Top hidden line view in modeling.

Same view as transported into drafting.

• If the image is perspective, replot it in
axonometric (click on Axonometric).

Select the Ghost tool.

The topological level is at Object.

• Click on the top slab.
It turns gray indicating that it is ghosted.

You ghosted the top slab so that when you produce a hidden
line top view the columns remain visible.

• Select [+XY] Top (View menu).
• Select Display: Hidden Line*.

Your image should now be as shown.

• From the Edit menu, select Select
All UnGhosted.

• From the same menu, select Copy.

There is no visible result.  However, a top view of your model
has been placed in the Clipboard.  Next, you need a drafting
window to place your image in.

• Select  New [Draft] (File menu).

This opens a new project with an empty drafting window.

• Select  Paste From Modeling*
(Edit menu).

After a few seconds the top projection of the building
structure is displayed in the drafting window, as shown.

The image also contains a few “construction” lines which we drew to help compose the drawing.  You may do the same.

• Select the Polyline tool, turn on the Grid Snap, from the Line Styles palette select a dashed
line, and draw two horizontal and two vertical lines to subdivide the screen into four quadrants.
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The construction lines will help you position the four views
of your model that you will transport.  They will be deleted
after you are done composing the image.

When the top view was brought into the draft-
ing window it was highlighted, which indicates
that it is selected.  This allows you to move it
and position it as soon as it is displayed.

Select the Move tool and move the top

view into the lower left quadrant of
your screen, as shown.

Now you are ready to transport another view of
the model.  You will follow exactly the same
procedure, except that you will now place a
different view in the Clipboard.

• Reactivate the modeling window
(select its name from the Windows
menu).

• Select Display: Wire Frame*.
• Unghost the top slab.
• Select [-ZX] Front (View menu).
• Select Hidden Line (Display menu).
• From the Edit menu, select Select

All Unghosted.
• Select Copy (Edit menu).
• Switch back to the drafting window.
• Select the continuous line type (top of

the Line Styles palette).
• Select Paste From Modeling*

(Edit menu).

The front view of the building model appears in
the drafting window, as shown.  It appears at
the center of the screen and is highlighted.

• Move it to the upper left quadrant of
your drawing, as shown.
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Repeat the process two more times.

• A [+YZ] Right Side view is placed in the upper right quadrant.
• A z=30°  x=60°  Perspective view is placed in the lower right quadrant of the drawing.
• In the Window Setup dialog (Options menu), enter 1 in # Division, for all directions.

Your drafting window should now appear as shown.  We adjusted the density of the grid to improve
the readability of the drawing.  At the end you will turn the grid off completely.
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36.2  Refining and printing the drawing

The drawing in the drafting window now shows four views of the building model.  There are a
number of ways in which the drawing can be refined using drafting tools you have already used
earlier.  You can do the refinements we show or you can try your own.  We deleted the construction
lines, changed the weights of some of the lines, placed some dimensions, drew a frame around
the drawing, placed some text, and turned the reference grid off.  The drawing you have just
completed can be saved and can be printed, which you will do next.

The items that handle printing are in the fourth group of the File menu.  A number of optional parameters may be set before
executing the Print... command.  They are set in the dialog boxes that are invoked when you select Page Setup...
and Plot/Print Setup....  You may also select Page Preview... to preview the image that will be printed.

For the image we show we used all the default parameters, except that in the Print dialog box we selected  Black &
White rather than the default  Color/Grayscale.  Your printer may or may not have such an option.  form•Z (drafting)
offers a special environment called layout space which specifically supports compositing drawings.  It is done through
special viewports called panes that support variable scales.  The layout space operations are not covered in this Tutorial.
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37  A small building and its site

This section will guide you through the genera-
tion of the small building model shown on the
right.  The whole modeling process involves
the following steps:

(1) The building frame (walls and windows)
will be generated first.

(2) A roof will be placed on top of the little
building.

(3) A site with contour lines will be drawn
around the building.

(4) The site and the contour lines will be
used to create a landform model on
which the building will sit.

• Launch form•Z.
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37.1  Creating the walls

• From the Heights menu, select 16'.

Turn on the Grid Snap.

Select the 3D Enclosure modifier.

Select the Rectangle tool.

• Draw a rectangle to generate a 3D
enclosure as shown.

• In the Pick Options dialog for Pick/
Outlines/Faces/Holes By Click-
ing select Inside Boundaries.

Select the Insert Opening tool.

Select the Rectangle tool.

• Click on points 1 and 2.

Continue and insert three more openings
roughly as shown.  Note that two of the open-
ings are rectangular and one is circular.

Select the Insert Face tool.

• Select 2' from the Heights menu.

Select the Rectangle tool.

• Click near the upper left corner (point
3) of the front face of the 3D Enclosure
and click again near the upper right
corner (point 4) of the same wall.
An overhang has been inserted above
your windows, as shown.

• Repeat the operation and insert one
more overhang on the right wall.
The current state of your model should
be as shown.
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37.2  Creating the roof

Next you will put a roof on your little building.

• Select [-ZX] Front (View menu).
• Invoke the Grid Snap Options dialog and enter 1'

in the Grid Module fields (X, Y, Z).

The 2D Surface modifier and Grid Snap should be on.

With the Vector Line tool draw a roof outline.

Click on 1, 2, and 3, and double click on 4.

You should draw your line exactly as shown.  Point 4 in particular should not
cross the axis (center line of the elevation).  The shape you drew will be used
as a source shape by the Boundary Sweep.  You also need a path for the sweep
and you will generate it next.

Set the topological level to Outline.

Select the derivative 2D Surface tool and click on point

5, which is on the top  face of the enclosure, close to the
outer boundary line.  The result should be as shown.

A surface object has been derived from the outer outline of the
top face.  You will use this as a path.

Select the Sweep tool and in the options palette select:

•  First Point for Alignment;
•  Boundary Sweep for Type;
•  select Adjust To New Parameters and
   deselect Edit.

Set the topological level to Object.

• With the Sweep tool click on the source (6) and path (7).
The result should be as shown.

You will next put a little “steeple” on the top of the roof.

• Topological level is at Face and Heights is 8'-0".

With the derivative 3D Converged tool click on the little

square face at the very top of your roof.

• Unghost the ghosted objects and select Hidden Line*.
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Drawing a shape for the generation of a roof.
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Deriving a 2D shape from the outer outline
of the top face of the enclosure.

Source shape

Path
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Using Boundary Sweep to create a roof.

The small building shown in hidden line.
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Selecting the site for the 3D extrusion.
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2
3

Drawing a site and boundaries for flat area.

Drawing smooth contour lines.
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37.3  Creating the site

Next, you will place your building on a site with a slope.

• Select [+XY] Top (View menu).
You are now looking at a top view of your building.

  Select the 2D Surface modifier.

  With the 3 Point Rectangle tool click on 1, 2, and 3.

This produces a rotated rectangle, which represents
the boundaries of your site.

With the Vector Line tool draw an open line around the

building (click on 4 through 10, double click on 11).

This line represents an area around the building that will be kept flat when a
landform model is derived for the rest of the site.

Next, you will draw contour lines representing site elevations.

With the Spline Sketch tool, at the lower right of your

drawing click on 12, 13, 14, and double click on 15.
This produces the curved line shown.

Continue and draw more contour lines roughly as shown.  Two more contours
are shown with the straight lines that were drawn for their generation.  The
others you will draw on your own.  If you deviate a bit it does not really matter.
Just make certain that the contour lines are proper: they should not intersect
each other but should intersect the site.

The contour lines do not really need to be curves.  Straight line approximations
would do just fine for the landform model you will be generating in this example.

Next, you will use the site boundary and the contour lines to
build a landform model.  It will be done in three stages:

1. A solid site will be created, first.
2. A flat area around the building will be engraved.
3. A meshed terrain model is created for the remaining

portions of the site.

• From the Heights menu select 2'-0".

With topological level set to Object and the derivative

Extrusion tool active click on the site (point 1).
A 2 foot high extrusion is derived from the rectangle of
the site, as shown.
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The stepped terrain model that engraved a
flat area around the building.

Meshed model before and after triangulation.

8  7 6 5  4
       3  2    1

S

Selecting the contour lines and the site for
the terrain model.

• With the Terrain Model tool active, in the tool options
palette select Stepped Model, Set New, and type
-2' in the Interval field.

The topological level is at Object.

With the Pick tool click on 2 to select the line.

Set the topological level to Face.

• The pick option is Inside Boundaries.

With the Terrain Model tool, click inside the top face of

the site (point 3).  The result should be as shown.

Finally, you will generate a landform model for the site.

• With the Terrain Model tool active, in the tool options
palette select Mesh Model, enter 2' in Interval,
and, in the Mesh Options tab, enter 5' in the X, Y,
and Z fields.

With topological level at Object, with the Pick tool

select the contour lines in order, right to left, as shown.
Selection of the contour lines in the proper order is necessary, because heights
will be assigned in that order.

Set the topological level to Face.

With the Terrain Model tool click inside the top face of

the site object (point S).
The result should be as shown.

You notice that the square “tiles” used for the mesh are not planar.  This is
generally the case with mesh models.  You had the option to generate a mesh
with triangular tiles (by selecting the Triangulate option in the Mesh
Options tab).  However, you can also triangulate your model after it has been
generated.  You will do this next.

With topological level at Object, with the Triangulate

tool active, click on the terrain model.
The result should be as shown.
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38  A sail boat

For this tutorial session you will construct the
sail boat shown on the right.  It will be done in
four stages, one for each of its parts:  the hull,
the mast, the large sail, and the small sail.
They will all be generated using the mesh
tools.  However, a different mesh modeling
technique will be used in each case.

(1)  For the hull you will use seven control
lines, all copies of a single original line.  The
shape of each line will be manipulated as
appropriate for the position in the mesh it will
be placed to control.  The hull will be generated
in a direct mode (no editing) and it may require
a few trials before you can be satisfied with
what you have generated.

(2)  The mast will be generated from two circular control lines, facing each other, and placed
in two vertical positions.

(3)  The large sail will be generated using c-mesh editing.  A fairly simple rectangular mesh will
be generated first.  Its points will then be manipulated in c-mesh edit mode to produce the
appropriate shape.

(4)  The small sail will be generated differently.  A simple rectangular mesh will again be
generated, but this time in direct mode.  Three lines will be drawn to delineate the shape of the
sail.  These lines will then be curved and will be used to trim the rectangular mesh to the desired
shape.

• Relaunch form•Z.
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Generating the control lines for the hull of the boat.

38.1  Modeling the hull
To generate the hull of the boat, you will first draw a flat
control line.  Drawing this line is possibly the most critical
step of the whole process.

• Invoke the Spline/Arc Options dialog, select
Facetted and, in its Display Resolution
tab, select Detailed, # Of Segments, and in
its field enter 96.

• From the Viewmenu select [+XY] Top.

Select Arc, Clockwise, Endpoint-Last.

• Draw two continuous arcs, as shown.  Click on
points 1, 2, 3, and 4, and then double click on 1
to close the shape.
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It is important that these arcs be quarter circles, in order to have evenly
distributed points.  Note that you do this by placing the centers of the arcs on
the 45° diagonals that extend from the end points of the arcs.  The grid shown
is at 8' increments.  To verify that your points are proper, use area pick with
topological level at Point to select all the points, as we show.  Or you can see
the points by selecting the Show Points option in the Wire Frame
Options dialog.  They are distributed symmetrically, as they should be.  If
you used area pick to see your points unpick them before proceeding.
Having drawn quarter circles, the form is not quite right for
the hull of the boat.

The self/copy mode should be at Self.

With the Independent Scale tool scale the shape

you just drew in the Y direction, as shown in c.

Set the self/copy mode to Continuous Copy.

With the Independent Scale tool derive six scaled

copies of the original shape, as shown in d.

  Use the Move tool to position the seven shapes

along the perpendicular axis (Z).

Use the Rotate tool to slightly rotate the two

upper shapes.
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The control lines of the
boat in 3D space.

An approximate section of
the hull showing the
position of the control lines
and the order of selection
(side view).

A low resolution mesh model of the hull.

At this point in the Tutorial, we are giving you general
rather than detailed step by step instructions for the
generation of the shapes of the control lines.  You should
be able to work out the details on your own.  Try to make
the shapes and their positions as close to ours as possible.
However, if you end up with a boat that is different than
ours, it does not matter.  Yours may even be better, as a
naval architect’s certainly would be.

As you shape your control lines you should
have a precise understanding of how they are
intended to be selected when the mesh is
generated.  The approximate section shown
should assist you in this.  Each number corre-
sponds to a control line.  Note how two of the
lines are actually positioned inside the others
to produce the “groove” at the top of the hull.
The numbers also show the sequence in which
the control lines will be selected.

You will first generate a rough (or low resolution)  mesh.  Before you do you will set the proper
parameters in the mesh dialog.

• Select the C-Mesh tool to display its options in the tool options palette.
• At the top of the palette select Construct Directly.
• For Mesh Length select At Control Points.
• For Mesh Depth select At Control Lines.
• In the Smoothing tab select None for both Length and Depth.
• In the Object Type tab select Closed Ends.

You are telling the system to generate a mesh exactly where the control points are.  You are also
telling it to generate a completely closed solid object.

Select the Pick tool.

• Prepick the control lines in the order
shown.

Select the C-Mesh tool.

• Click anywhere in the window.
The hull of your boat appears on the
screen.  It is shown plotted in hidden
line, which you can also do.
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Front view.Side view.

Bottom view.Top view.

A higher resolution mesh model of the hull.

Most likely you will not find the smoothness of the mesh satisfactory.  You will do a smoother mesh
next.

• With the C-Mesh tool active, in the Options tab of the tool options palette:
• Select Adjust To New Parameters.
• For Mesh Depth select # Of Segments, Per Segment,

and in the # Of Segments field enter  5.
• In the Smoothing tab, under Depth (V) select Quick Cubic.

With the C-Mesh tool active, click on the mesh of the boat.

A new mesh appears on the screen.
The Quick Cubic option you selected above applies smoothing to the hull mesh.  This smoothing is also affected by the
value entered in the Interval field, which we left at the default value of 2’.  This will work fine if you followed our
instructions and the hull is about 64’ long.  If not, the Interval value will have to be adjusted accordingly.

Hidden line plots of a 3D view and four projections are shown below.
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Positioning the circles in 3D space.

Drawing two little circles.

The mast.

38.2  Modeling the mast

You will next model the mast, which admittedly is the easiest part of the boat.  You will use the
mesh operations again. You will work in another window to avoid the overhead of carrying the
model of the hull.  At the end, you will merge all the parts together.  To work in another window,
you will need a reference shape so that you know where the top of your hull ends.  This will be
the top inside control line (the last line you selected for the hull mesh).

Select the Unghost tool and click on the

top inside control line to unghost it.

With the Pick tool select the line.

• Select the Copy item (Edit menu).
• Select New [Model] from the File menu.
• Select Paste (Edit menu).
• Click anywhere in the window to deselect

the shape you just pasted.

• Select [+XY] Top (View menu).

Turn on Ortho Snap (window palette).

Grid Snap should be on.

• In the Grid Snap Options dialog, set the
Grid Snap Module to 3".

• In the Spline/Arc Options dialog,
Facetted, Detailed, and # Of Seg-
ments should be on. In its field enter 16.

• At the center (where the two axes meet), draw two little circles, one a bit smaller than the other.

Make certain to draw the circles in the same direction.  The Ortho Snap will help you to do so.

• The circles have been drawn on the XY plane.  Change your view and move the larger
circle roughly to the height of the reference shape and the other to some height in the sky,
roughly twice the length of your hull, as shown.

• Invoke the options of the C-Mesh tool in the tool options palette.
•  At the top of the palette select Construct Directly.
•  For Mesh Length select At Control Points.
•  For Mesh Depth select  At Control Lines.
• In the Smoothing tab select None for both Length and Depth.

With the C-Mesh tool active, click on one of the little circles, then on the other.

Your mast is constructed as a mesh and appears on your screen as shown.
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38.3  Constructing the large sail

For the large sail you will use four copies of the same
control line, which you will draw first.

• Turn off Ortho Snap (window palette).
• Select [+XY] Top from the View menu and

draw a line roughly as shown in a.

• Position the line a bit over the reference shape
and copy it three more times, as shown in b.

• Invoke C-Mesh Options dialog:
• At the top select Edit.
• For Mesh Length:

select # Of Segments;
enter 8 for number of segments.

•  For Mesh Depth:
select # Of Segments;
deselect Per Segment;
enter 12 for number of segments.

•  In the Smoothing tab select Quick Cubic
for both Length and Depth.

• In the Object Type tab
select Open Ends (Surface).

With the Pick tool select the sail lines, from

bottom to top.

Select the C-Mesh tool and click in the

graphics window.

A “square” mesh is generated and the modeling tool
palette turns gray.  This means you are in c-mesh edit
mode.

• Move as many points as necessary until your
sail takes a shape roughly as shown.

• When your shape is ready, double click to exit
the edit mode.
Your sail is regenerated and should be as
shown in d.
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38.4  Constructing the small sail

For the second (small) sail you will use a different
method.  Instead of shaping the sail in edit mode, you
will generate a mesh and you will then trim it to the
desired shape.

The mesh generation part is similar to the previous.

• Go to the Top view and draw a line to the right
of the mast, as shown in a.

• Position and copy it two more times, as shown
in b.

• In the C-Mesh Options palette or dialog
• select Construct Directly;
• for Depth change # Of Segments to 8.

• Preselect the lines.

Select the C-Mesh tool

and click anywhere in the graphics window.
A mesh is generated  to the right of the mast,
as shown in c.

• Go to a Front view and ghost the other parts
of the model (or place them on an invisible
layer).

• Draw three vector lines roughly outlining the
shape of your sail, as shown in d.

• In the C-Curve Options dialog select:
Construct Plain Curve,
Construct Directly, and Quadratic.

Select the C-Curve tool and click

on each of the three lines you drew earlier.
The result should be as shown in e.  You will
next use these lines to trim your sail.

• Invoke the Trim/Split Options dialog and
select the Trim With Line option.

Execute the Trim/Split operation three times.

Each time click at the center of the sail first (1)
and then on a line (points 2, 3, and 4).
At the end your sail should be as shown in g.
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The completed model of the sail boat.

38.5  Merging the pieces

Finally, you will merge the pieces of your boat into a single project to complete the model.

• Use the Pick tool to select the two sails and the mast.
• Select Copy (Edit menu).
• Switch back to the original window.
• Select Paste.

As you generated them, the sails are single
sided meshes.  This means that if the Show
Surfaces As Double Sided item in the
Display menu is off and you attempt to do
hidden line plots from different sides of the
boat, the sails may not always be  visible.  To
avoid such situations you will make the sails
double sided surface solids.

Topological level is at Object.

Select the Make One/Two Sided

tool.  Note in the tool options palette
that Make Surface Solid (Two
Sided) option is on by default.

• Click on each of the two sails.
You have transformed them into
double sided surface objects.

You can now plot them or render them from
any view point and all sides will be visible
even if the Show Surfaces As Double
Sided item is off.

One final note:  one of the four mesh objects you
generated, the small sail, is different from the other
three objects.  While the hull, the mast, and the large sail
continue to be controlled meshes (and can be edited
again), the small sail is a plain meshed object and
cannot be edited.  This was caused by the trimming that
was applied to it.  When c-meshes are trimmed, their
shapes change beyond what the control parameters
would generate, and they subsequently lose their con-
trols.
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39  A nurbz flower

This tutorial is about modeling the flower shown to the left, using differ-
ent types of nurbz.  Recall that among the available types of nurbz are
those that can be generated from control lines, from objects of revolu-
tion, and from sweeps.  This tutorial includes an example of each of
these types.

The petals will be modeled first, using control lines that will be
converted into nurbz surfaces.

• Draw an eight point vector line, shaped roughly as the
profile shown.

• Copy this line ten times.  Rotate and scale the lines
into their approximate position, which should be
roughly as shown.

Note that your lines do not have to be exactly like ours, since
the shape you will be modeling is of a free form.

• With the Pick tool, preselect the lines in the order they
should be used in the nurbz mesh.

• With the Nurbz tool active and the default By Loose
Lofting on in its options palette, click anywhere in
the project window.  This produces the nurbz surface
shown on the far left, which is a parametric object.
You can thus edit it to further articulate its shape.

• With the Edit Controls tool, click on the nurbz surface.
This places it in edit mode and displays its controls,
which can next be moved to manipulate its shape.

Recall that, in edit mode, the Edit Controls Options palette appears and contains
the editing operations that can be applied.  Transform the geometry of the nurbz sur-
face as you see fit to make it look more organic.  Feel free to experiment.  Keep in mind
you can always Undo if not happy with your initial achievements.  Try to produce
something similar to our example, shown to the left.

• Create the small petal the same way.
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The inner petals will be modeled next, as a nurbz object of
revolution.

• Draw a 5-point profile of the inner petals with one
of its end points on the Z axis.

• Activate the Revolve tool and in its tool options
palette select Smooth and Construct As Nurbz.
Leave all other settings with their default values.

• With the Revolve tool active click on the profile,
then on the Z axis.
This creates the surface object shown to the left.
If Edit is on in the options palette, an edit dialog
is invoked with a preview window, where you can
inspect the shape before accepting it.

• With the Edit Controls tool click on the object and
articulate the geometry of its surface to give it a
less regular and more organic appearance.

• Using the Uniform Scale tool and the One Copy
modifier, create a smaller copy of the object.
Place it inside the larger one and edit it to
transform its surface a bit more, so that it does
not look exactly the same with the one it was
copied from.

• Make also two more copies of each of the (small
and large) petals, edit them to make them look
slightly different from the ones they were copied
from, and assemble the pieces into a complete
flower, as shown to the left.

While the flower itself is finished, it still needs a bud, a
stem, and leaves, which will be modeled next.
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The bud is again created as a nurbz revolved object, from a profile
drawn as shown to the left.

The stem will be created as a nurbz sweep.

• Draw a 6-point vector line, which is slightly bent.
This will be the  path for the sweep.

• Also draw a small square to be used as the source.

• With the Sweep tool active, in the tool options palette,  select
Smooth and Construct As Nurbz.
Leave the other options at their default settings.

• With the Sweep tool, click on the source and then on the path.
Observe the result.  Again, this is an artistic exercise, and you
should not hesitate to experiment and do things your way.

The final parts of the flower, the two leaves,
can be modeled as the petals were.  That is,
as nurbz from control lines.  You can actually
model one, then make a copy, edit it, and ma-
nipulate its geometry to make it look different.

• Draw a 4-point profile, copy it 9 times,
preselect all ten lines, and with the
Nurbz tool click in the window.
The nurbz surface produced initially
has rectangular edges.

• Edit it and move its end points to give
it the shape of a leaf.

The result should be as shown to the left.

After you put the leaves in place, the nurbz
model of the flower has been completed, as
shown to the right.  For better visualization you
can render it, as we did (see the beginning of
this chapter).  Texture mapping it will produce
an even more realistic image.  If you are not
yet comfortable with rendering, you may come
back and do it later.
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40  A nurbz lawn chair

This tutorial is one more example of how to model the lawn chair shown to
the left exclusively as a nurbz object.  As we shall see, different nurbz
operations are better suited for different parts of the chair.

You will first build the back of the chair from its boundary shape.

• Draw 4 curves that outline the boundary shape of the upper
part of the chair, roughly as shown.

• From the Nurbz Options dialog, under Surface
Construction, select By Boundary Curves.

With the Nurbz tool select the four curves in any order.

A nurbz surface is generated, which you can still edit or
adjust, using the Edit Controls or the Reconstruct Nurbz tool.

With the Reconstruct Nurbz tool click on the nurbz object

and, in its dialog, reduce the density of its control points.
This makes it easier to edit its shape, if desired.

You will next build the seat of the chair from its U/V curves

• Draw 3 or more curves that define sections of the intended
shape in the U (horizontal) direction, roughly as shown to the left.

• Also draw 3 or more curves that define sections of the
intended shape in the V (vertical) direction, as shown.

• In the Nurbz Options dialog select By U/V Curves and
set Number In Length (U) = 3 and
Number In Depth (V) = 3.

With the Nurbz tool active select the U curves in order, then

the V curves.  The order of selection is significant.
After the nurbz surface is generated, you can still
reconstruct and edit it to make adjustments.

You will next attach the seat piece to the back piece.

• In the Attach Nurbz Options dialog select Merge.

With the Attach Nurbz tool click on the lower edge of the

back and the upper edge of the seat, as shown.
The two surfaces are attached and the result is a single
continuous nurbz surface.
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An important feature of the nurbz surfaces is that they can be trimmed to open holes or to adjust
their boundary shape and they can still be edited to refine their curvatures and overall form.
Different methods are available for applying trimming.  One method is to draw a shape away
from a nurbz surface and then place it on the surface and use it for trimming.  Another method
allows you to draw directly on the nurbz surface.  We shall do examples of both.

• Draw a 2D profile on the XY plane, as shown.
• In the Curve On Nurbz Options dialog

select Map Existing Curve, Trimmed
Nurbz, and Curves Enclose Holes.

With the Curve on Nurbz tool click on the

profile, then the nurbz surface.
The profile is placed on the surface and is
trimmed from it, as shown.

• In the Curve On Nurbz Options dialog select
Sketch On Surface and choose the Spline ( ) icon.

With the Curve on Nurbz tool active, click once on the

nurbz surface to select it, then draw the desired profile,
roughly as shown. Draw as many slots as desirable.
The drawing of each shape is completed by triple-clicking.

Note that the drawing conventions are as when you use the regular drawing tools
and that the sketching conforms to the nurbz surface.  As soon as a shape is
drawn, it is trimmed from the surface.  You may also use the Edit in Parameter

Space tool ( ) to make adjustments.

We shall next cut the front legs and arm rest.

• Working in Front view, draw an open profile, as shown.

With the Trim/Split tool set to Trim With Line, click on

the surface, then on the profile, as shown.
Note that the click location on the surface is significant.

• Working on Right view, draw a closed profile, as shown.

With the Trim/Split tool set to Trim With Line, click on

the surface, then the profile, as shown.
Observe the result.

Use the Edit in Parameter Space tool to Move ( ) the trimmed profile, as shown.
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With the Join tool, join them into a

single object.

With the Trim/Split tool set to Trim

First Object, click on the surface
then the solid, as shown.

Next we shall cut more slots from the upper portion of the chair.  We shall do it using solids.

• Working in Front view, draw two extruded solids to the left of the existing hole.
Then copy-reflect them on the other side of the hole.

We shall next add the back legs of the chair.  We shall first cut two symmetric notches, where
the back legs will attach to the chair.

• Generate a 3D surface extrusion and place it inside the chair, where the leg should attach.
• Copy-reflect this surface to the opposite side of the chair, for the other leg, as shown.

With the Trim/Split tool set to Trim

First Object, click on the chair
surface, then the trimming surface.
Repeat the operation for the other
trimming surface.

We shall next generate the back legs and attach them.

With the Vector Line tool, draw cross sections for the leg,

roughly as shown.
You may next round the corners to make them smoother.

• In the Nurbz Options dialog select By Tight Lofting.

With the Pick tool select the profiles from top to bottom.

With the Nurbz tool active click anywhere on the screen.

The result should be as shown.
After the nurbz surface is generated, you can still edit it
to make adjustments.
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With the Pick tool active and Topological Level set

to Segment, select the top segment of the leg,
the intermediate profile, and the trimmed edge on
the chair.

With the Loft tool active click on the screen.

The leg is attached to the chair with a
transitional piece.

• Repeat the operation for the other leg.

We shall next make the transition from the back legs to the chair.

• Position the leg close to the corresponding notch of the chair and draw an intermediate
profile between the leg and the chair, roughly as shown.

We shall next put some finishing touches to the chair.  After stitching, the chair is now a
continuous surface.  To complete it, we shall first apply some thickness to it and then some
rounding.

• In the Parallel Options dialog select Double Parallel and Out.
Enter 1/16” to all the fields, select Relative To Curvature, and for
Max Normal Deviation enter 5º.

With the Parallel tool click on the chair.

The surface is converted into a solid of uniform thickness.

• In the Stitch Rounding Options dialog, set the Use Radius field
to the desired size, which should not be too large.

With the Stitch Round tool

active, click on an edge of the
boundary and the holes you
wish to round.
Observe the results.

form•Z automatically determines the continuous closed path boundary and
applies the specified smooth rounding, as shown.  You can repeat this
operation for as many of the chair’s boundary curves as you desire.  The
end result should be as shown to the left.
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41  Modeling with patches

There are at least three methods by which patches can be used for modeling irregular forms:

• A low resolution approximation of a form (called cage) is constructed, it is transformed to a
patch mesh, and its shape is refined through editing.

• The patch mesh is grown one patch at a time from one initial patch.

• One starts with a rough volume, such as a cube, which is transformed into a patch, then
subdivided globally or selectively, and reshaped through editing.

This section presents three tutorial examples, one for each of the above methods.
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41.1 A toy duck by patching a cage

A cage is a low resolution approximation of a real model.  In this
section, such a cage and patches will be used to construct the toy
duck shown to the right.

The first task is to build the cage of a duck, which you should do
with the following principals in mind:

• Use 4-sided faces and minimize the number of triangles.
• Maintain continuity along the edges of the cage.
• Keep a small face count and let the patches do the smoothing.

Here is how to do it:
• Create a ten-sided cylinder and mesh it in the vertical direction to create 11 faces top to bottom.
• Working at convenient views, move points as appropriate to approximate the shape of the duck.

You should find the Independent Scale tool effective for moving points symmetrically.
After this stage the cage should be as shown below.

You will next convert the cage to a patch object, but first you need to set up the proper options.

Activate the Patch Derive tool to display its options in the tool options palette and in it

select:  Bezier, Smoothing, and In.

Smoothing will produce rounded patches from the faces of your cage.   In will place the patches
inside the cage, which has a shrinking effect. Out would have caused the cage to expand.

In the tool options palette’s Resolution
tab, select Detailed and Max # Of
Facets.  For both Length and Depth,
enter 4.

With the Patch Derive tool click on

the cage.
This produces a patch model of
the  duck, as shown to the right.
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Recall that the option not to display the facets is available in the Smooth
Objects group of the Wire Frame Options dialog.  Unchecking Facets
causes the facets to disappear.  This may make it easier to see the patch
cage as you proceed with the next editing phase of this example.

With the Edit Controls tool active, click on the patch

model of the toy duck.
This puts the model in edit mode and invokes its
controls, which should appear as shown to the left.

While in edit mode you can further refine the shape of your
model by moving its controls.

Observe that, by building a proper cage, the model of the duck is already in good shape and will
require little editing, even though a variety of editing operations are available, which allow you to
perfect the 3D form before you.  Note, however, that shape editing is an artistic process and
there are no precise instructions we can offer.  Given this, we shall simply point out the editing
tools that are available and let you experiment with them until you derive a satisfactory duck.

• You can pick and drag individual points and segments, you can shift-click to pick more than
one entity, or you can use the lasso option (found in the Pick Options dialog) to select many
entities.  This may make it easier to manipulate a symmetric patch model, such as the duck.

You may next wish to change the smoothing type of the patch to something that is easier to
work with, when you edit.

• While in edit mode, lasso around all of the controls to pick and highlight them.
• From the Edit Controls Options palette choose an Action icon (type of

transformation), and the smoothing type from the Point Type pop up menu.
• From the menu select Smooth Corner.

This type of point will allow you to manipulate the controls individually without affecting their neighbors.  This makes it
easier to move the points freely into the position you want.  You may, however, also want to experiment with the other
smoothing types to see how each behaves when a vertex is moved.  You may actually conclude that another smoothing
type works better for what you want to do.

During the editing process, your model may look rough.  Do not worry; being parametric, it will render smoothly.  Actu-
ally, you should be rendering it every now
and then, during the editing process, since
a rendered image shows you better how
the shaping of your model proceeds.  Note
that, in the final rendering, an orange de-
cal has been used for the bill and the eyes
have been added as separate entities (see
beginning of this section).
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41.2  Building a face by growing patches

An effective method of patch modeling is to start with a single patch and to
proceed with adding and attaching patches to its free edges.  This is more
specifically called growing patches, and there is a tool in form•Z that does
exactly this. It is called the Patch Grow tool.  This tutorial is about how to model
a human head, such as that shown to the left, using this tool.

As a first step it is recommended to do a sketch of the contours of the face,
using the 2D drawing tools.  These lines will be used as your template and,
because they play an important role in the process, take the time to draw
them correctly.  After they are drawn, possibly as shown to the left, ghost
and lock them.  Notice that, in our example, we only did half of the face.  At
the end we shall copy-mirror it to generate the other half.

After sketching your template, you are ready to proceed with the
patch growing process.

• Pick a point to start from, such as the center of the chin,
and draw a 2D rectangle.

With the Patch Derive tool click on it to convert it to a

patch.  Do not smooth the patch.
Without smoothing, each of the controls can be moved
individually, which makes it easier to fit the patches
to the contours of the face.

After the first patch is in place, you can start to grow from it.

• Set the topological level to Segment.
• Select the Patch Grow tool and in the tool options palette select:

From Edges, Align Patch Normal, and Stitch.

With the Patch Grow tool active, click on the top and then on the right side edge.

A patch appears next to each edge (see b and c).

Your new patches initially have “rough” shapes and their curvatures need to be adjusted to the shape of the chin.  You
do this by editing the patches.

With the Edit Controls tool active, click on the object with the three patches.

This places the object in edit mode and displays the controls of its patches.
• Follow the shape of your template and move the points of your patches as appropriate.

If you need to, review the editing operations that are available.  After the editing is completed, your three patches should
look something like those shown in c, above.
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Throughout the process of building a patch face, each stage consists of two or three steps.  (i)
A patch is first grown.  (ii) If one or more of its sides are unattached, they get attached (using the
Patch Attach tool).  (iii) The points of the new patch are adjusted to the shape of the face.  We
shall specifically show this for the next step.

With the Patch Grow tool active and topological level set to

Segment, click on point 1.
This generates a patch as shown in a.

Select the Patch Attach tool to display its options.

In the tool options palette select:
Move Edge, Align Normals, and Stitch.

• With the Patch Attach tool active and topological level set to Segment, click on 2 and 3.
The edge you clicked on first is attached to the edge you clicked on second.
The two are stitched together.

• Make the necessary adjustments to properly shape the patch points, as shown in b.

These basic steps are repeated till there are enough patches to cover the complete face.  Again,
this is an artistic process and there are not too many specific instructions we can offer.  Yet,
there are certain techniques that can be underlined.

On the left, notice how the patches are laid out in a radial pattern around the mouth.
This makes it easy to manipulate them and to allow different expressions, by deform-
ing the area around the mouth, in still images or animations.

It helps to periodically check the patch structure by doing a shaded rendering to con-
firm that it is contouring correctly.  Do not be concerned about a facetted appearance.
Being a parametric surface, it should smooth properly when rendered.

As you continue building the surface, expanding upwards to the eye
area, you may notice that there are not enough patches around the
eye opening to produce the desired detail.  In such cases the patches
can be subdivided either globally or locally.  The latter operation will
be applied next to the cheek area.

With topological level set to Segment and the Patch Divide

tool active, click on the segments marked with bullets, as
shown in a, on the left.
The result should be as shown in b.
Where you clicked, the patches on both sides of the edge
were subdivided, increasing the resolution of the patches.

Subdivision of patches may be used as necessary to increase the
resolution of the model where more detail is required.
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The areas around the eyes are probably some of the more
difficult areas to sculpt.  Grow the patches in a radial pattern
and allow for an eye socket.  This is not too different from the
way the mouth was modeled.

Finish the nose area by pulling up nostril openings, with the
use of the Edit Controls or Edit Surface tools.  Continue and
move as many control points as necessary to properly shape
other areas of the face.  Make sure you maintain smooth con-
tours with no drastic changes in direction.  Rendering tests
every now and then will help you confirm that your surfaces
are smoothly shaped.

• After the half face is finished, use One Copy mode
and the Mirror tool to make a symmetric copy.

With the Patch Attach tool active, select Move Edge

and Stitch in the tool options palette.
• With the Patch Attach tool active, click on pairs of

edges from the original and copied half face.
Segment by segment you work your way along the
seam, until the two half faces are stitched together, as
shown in b, on the left.

After the two halves are attached and stitched,
you may still have to adjust some of the con-
trols around the seam to correct any creases
that may appear down the middle of the face.

The finished face shown with just the patch
cage has been narrowed slightly with the
Scale tool. You have so far only modeled the
face part of the head.  You could continue
growing the surface to complete the rest of
the head and neck.

At this point, the head is still just a face mask.  You may
add some hair, eyebrows, mustache, eyes, and eyelids
to finish the model, as we did.  These were actually built
using modeling techniques other than patches.  That is,
the hair, mustache, and eyebrows were done using nurbz.
Partial analytic sphere primitives were used for the  eye-
lids and full spheres for the eyes.
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41.3  Patching a cube into a mouse head

Another patch modeling technique is to start with a simple 3D form,
transform it to a patch, then gradually subdivide it, globally and
locally as appropriate at different stages, and edit it to refine its
shape.  With this technique a cube can be turned into a head, such
as the mouse head shown, which is what this tutorial covers.  The
key to this method of patch modeling is to start with a very simple
shape and to gradually work towards a more complex form.

• Draw a plain cube such as the one shown in a.

With the Patch Derive tool active, in the options palette,

pick Smoothing and In.
• With topological level set to Object and the Patch Derive

tool active, click on the cube.  The result should be as in b.

The cube has been transformed into a control net, which will be
visible when you edit the patch object.  This resembles a low reso-
lution polygonal object and will be referred to as control cage.

With the Edit Controls tool active click on the patch object

to display its controls.  Frame pick to highlight its controls.
• From the Edit Controls Options palette, select Smooth

Corner.
Transforming all the points of the patch to this type will
allow you to shape them individually or in groups without
being concerned about the effect to their neighbors.

You will next sculpt and deform the shape of the cube to turn it into
a head.  You do this working as an artist and by visually inspecting
each of your steps.  While we include illustrations of the process
we followed, we do not attempt to offer detailed descriptions of
what we did.  However, a few hints follow:

Given the symmetries of the intended shape, for the first series of deformations, we
use top and side views to select groups of controls that need to transform the same
way.  Where useful, we used lasso to select around controls.

• At this initial stage, concentrate on pulling out the snout and
cheeks and pulling up the head.  You also need to narrow the snout
a bit and to round its back.  Next, pull down the ridge between the
head and the snout and shape the front end of the snout.  Your
object should now look as in g and h.
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As you continue shaping the object, it should at some
point look roughly as that shown in a-c, to the left.
When you reach this point, you probably cannot con-
tinue with the current number of controls.  Thus, you
next need to subdivide the patch object.  Four times
the number of controls you now have should provide
sufficient resolution for the next editing steps.

With topological level at Object and the Patch

Divide tool on, click on the object.
All the patches of the object are subdivided into four
physically smaller patches.  That is, the patches are
divided by two in each direction.  This comes from the
Patch Divide Options dialog, where the default
value 2 is set for both directions.

• After the patch object has been subdivided,
use the Edit Controls tool again to edit it.
While in edit mode, select all its control points
and convert them to Smooth Corner.

This conversion should not change the shape of the
object much. You may, however, want to make some
slight adjustments, if they appear desirable, in order
to retain the smooth curvature of the object.  This stage
of the process is really intended to prepare the patch
for the second and final division of the patch object.

• With the Patch Divide tool click on the object
to subdivide it once again.

• Use the Edit Controls tool to edit the object
and to convert all of the control points to
Smooth In Equal.

This will prepare the object for the putty type of defor-
mation that will be applied next to shape the mouth.

Recall that, in edit mode, if you hold down control (MacOS) or ctrl+alt (Windows) and click on
a corner control vertex, you select the vertex and all its adjoining vertices, in one step.  You will
need this type of picking next.

What needs to be done next is to form the mouth area of the mouse head.  Once again this is an
artistic process for which we can not give many exact instructions.  While we point out a few key
areas that need to be moved, a lot more will depend on your visual inspection of the shape you
are producing.
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With the Edit Controls tool click on your object.

While in edit mode, click and slightly drag point 1, as
marked on the left.  Move it just enough to expose its
symmetric point on the other side of the object.
While pressing shift, click on both points to select them.
While selected, click on one and move them as shown.

• Continue to work in side view and using the same
techniques as above, select point 2 and its symmetric and
pull it back and upwards, as shown.

• To form the lower jaw, next, pick the control points shown,
convert them to Smooth Corner, and move them.

These being the main transformations required to shape the mouth, you will prob-
ably need additional point movements and refinements to keep your model smooth.
For example, as you moved the points to shape the mouth you may have disturbed
the points on the top of the opening that would normally delineate the roof of the
mouth. Apply additional point manipulations as dictated by inspections of the shape
you wish to model.  Doing such refinements will complete the model, except that
you still need to add a nose and ears.

• For the nose, create a cube and transform it to a smooth
patch, as shown in e.  Use Smoothing, Out, and 50%.

• For the ears, create an extruded square, then a smaller
extruded square, and difference the latter from the former,
as shown in f.

• From the object that resulted from the difference generate
a patch object using Smoothing, In, and Equal.
This creates a nice circular shape slightly smaller than the
original geometry.

• Make a copy of this to create the second ear.

This should complete the mouse head and the final patch mesh
should be something like the one we show.  One can certainly
proceed and model the whole body, using very similar techniques
with the ones presented.

At the end, we also rendered the mouse, as shown at the beginning of this section.
Note that, to render the eyes, it was necessary to detach these faces in order to
map a texture on them.  This is not possible to do directly to a patch structure.  In
general, patches are typically used for their smooth meshing flexibility and ability to
sculpt organic form.  When modeling is done, more frequently than not the patches
are expected to be transformed into a facetted object before the final rendering.
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42  A meta-mouse

In this tutorial session we describe how the mouse shown to the
left was constructed, using metaformz.  We shall only be
providing approximate dimensions for the different parts of the
model, since most of them will be generated through graphic
input.  Our model was constructed at the default medium level
scale (1/16"=1' in English units) and the mouse is about 80'
high.  Apparently it is a giant!

Our main intention in this tutorial is to illustrate how complex
models are broken into parts, which are initially modeled
separately, and are then grouped and blended together.  Re-
garding the dimensions of the parts, what counts is their relative
proportions.  The exact dimensions will depend on the scale
you will be using.  If you reproduce the mouse model, yours may
be fatter or taller, which does not really matter.  You may
actually construct a complete family of mice, where each
member is of a different size and has a different position, but
they are all of the same species.  If you do, you will have
demonstrated to yourself the essence of metaformz modeling.

To construct the mouse, we first made the torso, using two metaballs.  We then added a neck,
which is a chain of balls.  Next we added legs and feet, and then arms and hands.  Then we
constructed the head and the tail as separate pieces.

To make the torso, you will use a stretched ball and a stretched
ellipsoid.  Stretched metaballs use variable radii in the X, Y, and
Z directions, which derives shapes not strictly spherical.

With the Metaballs tool draw  a stretched ball (the larger

piece) and then a stretched ellipsoid (the smaller
piece), as shown in a.  The type of the metaball is
selected from the tool options palette.

With the Group tool click on the two metaballs.  This invokes the Metaformz

Evaluation Parameters dialog.  Leave all the options at their defaults and click OK.
As soon as you exit the dialog, the metaformz are evaluated, as shown in b.

a b
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Metaformz are automatically evaluated at the time they are grouped, when the default Auto-
matic Evaluation option is selected in the Metaformz Evaluate Options dialog (invoked
from the Metaformz Evaluate tool).

There are two options in the Metaformz Evaluation Parameters dialog that you may wish
to experiment with: Blend and Join.  The former produces smoother blends, while the latter
produces sharper blends, which may actually be desirable for the model of the mouse.

Leaving all the options in the Metaformz Evaluation Parameters dialog with their default
settings includes a mesh resolution of 2'.  This makes sense for the scale we are working at.
However, you may have to change this value if you are working at a different scale.  Regarding
the size of the torso, since we drew its parts graphically, we did not have to set any dimension
numerically, but we determined their sizes visually.  The height of the torso is a bit more than one
fourth of the complete mouse.  At our scale it is about 25'.

To add a neck to the torso, you will use a tube
type of metaform.

• Draw a 4-point vector line where the
neck will be, as in a, on the left.
You can think of this line as being
roughly the axis of the neck.

Select the Metaformz Derive/Edit tool

and click on the vector line.
• When the Metaformz Parameters

dialog is invoked, select Ball for type.
Also set Radius 1 to 6' (or about 1/3
of the width of the top part of the torso)
and click OK.

The result is a chain of four balls, as shown in b.  That is, one ball was generated and placed at
each point of the vector line.  The chain of balls is shown in their unevaluated representation.

• Place the chain of balls into the torso group of metaballs.
The easiest way to do this is by working in the Objects palette.
Click on the name of the chain balls and drag it onto the name of the group.
This makes the chain a member of the torso group and invokes the Metaformz
Evaluation Parameters dialog.

• Click on OK; the torso is evaluated with the neck piece blended into it, as shown in c.

a   b       c
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You will next attach two legs and feet to the torso.
The legs are constructed as chains of balls and the
feet are stretched balls.

• Draw two vector lines, one for each leg (a).

Select the Metaformz Derive/Edit tool and

click on one of the vector lines.
• When the Metaformz Parameters

dialog is invoked,
select Ball for type,
set Radius 1 to 6',
select the By # Of Primitives option,
enter 18 in its field,
select Scale Radius, enter 0.75 in its field, and click OK.

• Repeat the operation for the other vector line.
The result (shown in b) is two chains of 18 balls that are scaled down as they are placed from the
top to the bottom end of the vector line.

With the Metaballs tool draw two stretched balls at the lower ends of the legs.

• Place the four new metaformz into the torso group.  Again, the easiest way to execute
the grouping is through the Objects palette.
As each new metaform is placed into the group, the complete group is evaluated.
At the end the evaluated torso with legs and feet is as shown in c.

You will next attach arms, which are again
scaled chains of balls.

• Draw two vector lines on the left
and right of the torso (d).

With the Metaformz Derive/Edit

tool click on a vector line and
when the  Metaformz
Parameters dialog is invoked,

select Ball, set Radius 1 to 6',
select By # Of Primitives,
enter 18 in its field,
select Scale Radius, enter 0.50 in its field, and click OK.

• Repeat the operation with the other vector line.
The result is as shown in e.

• Place the two arm metaformz into the torso group, which causes them to be evaluated.
The result is shown in f.

a      b     c

d           e     f
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c     d

e            f        h

            i

You will next place hands at the ends of the
arms.  These will be generated from three
metaballs.  Note that the hands will not be
blended into the rest of the torso, but will
remain independent pieces.

With the Metaballs tool generate three stretched balls (a).

• Group them, which causes them to be evaluated (b).  When the
Metaformz Evaluation Parameters dialog is invoked, set
the Mesh Resolution to half of what you used before.
This is proper, given the relatively smaller size of the hand piece.

You will next construct the head, made out of four metaballs.

• With the Metaballs tool draw four balls (c).
• Group them, which also evaluates them (d).

The head has no ears and nose, which you will do next.  For the ears you will use
two circular sheets, for the nose a single ball.  Note that neither the ears nor the nose
will be blended with the rest of the head.  They will be attached as separate pieces.

• For the ears, draw two circles, the one smaller than the
other, as shown in e.

• With the Metaformz Derive/Edit tool click on each of the two
circles and, when the Metaformz Parameters dialog
appears, select Sheet for type.
The resulting unevaluated sheet objects are as in f.

When you derive the sheet objects from the larger and smaller
circles, set the Weight value to 1 and -1, respectively.  The
negative weight value assigned to the second object will have a
subtractive effect when the two are evaluated together.

• Group the two circular sheets together, which evaluates
them, as shown in h.  This is one of the ears.

• Make a copy for the other ear.
• For the nose, use the Metaballs tool to generate a little ball.
• Use the Metaformz Evaluate tool to evaluate it by itself.
• Position the two ears and the nose as shown in i.

Note again that these pieces are simply attached to the rest of the head.  They are
not grouped and blended with it.

a b

• Make a copy for the second hand and place one hand at the end of each arm, after you
rotate them to match the positions of the left and right arms.
The complete torso now looks as shown to the right.
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The only piece that remains is the tail.  You will construct it using  a
conic tube.

• Draw a vector line as shown in a.
• With the Metaformz Derive/Edit tool click on the tail line.
• When the Metaformz Parameters dialog appears,

select Conic Tube,
set Radius 1 to a relatively small value,
Radius 2 to a value about one sixth of Radius 1,
and click OK.

This produces the conic tube shown in b.
• With the Metaformz Evaluate tool click on the tail tube.

This produces the evaluated metaform shown in c.
• Place the tail at the proper position, if not already there.

It is simply attached to the torso of the mouse and is not
grouped and blended with it.

The complete mouse is shown below.

a

b

c
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43  A composite order column
The composite order is a combination of the Ionic and Corinthian orders.  It combines the volutes
of the Ionic with the foliage of the Corinthian.  Both orders have a base and a fluted shaft.  We
chose the composite order because it is the most challenging and contains elements that can
nicely be modeled as nurbz.  It actually offers an opportunity to apply a variety of nurbz operations.

You will first build the pedestal and the base as revolved objects.

• With the 2D drawing tools, draw an open shape on the ZX plane,
whose end points are on the Z axis.

• In the Revolve Options dialog, select Facetted, enter 4 for # Of
Steps, and select Join Adjacent Coplanar Faces.

You will next generate a different type of a revolved object for the base of the
column.

• Draw a 2D profile, on the ZX plane
and with its ends on the Z axis.

• In the Revolve Options dialog,
select Smooth and Construct As
Smooth Revolve.

You will next model the shaft of the column.

Note that a classical column, which is an anthropomorphic shape, has a diameter to height ratio of
1:6.  We use a shorter body here to allow for better visualization of the construction process.  It can
be scaled to the appropriate ratio after it has been modeled.  Also, even though the classical column
has 20 flutes, we use 12.

• Generate a thicker primitive cylinder for the column body and a thinner
one for the flute, roughly as shown.

With the Revolve tool active, click

on the profile you drew and then
on the Z axis.  This generates a
4-sided pedestal, as shown.

After the initial generation the 3D form can
still be edited and reshaped, using the Edit
Controls tool, as shown.

With the Revolve tool click on the base profile, then the Z axis.

A round form is generated.
This can again be edited and reshaped after its initial generation with
the Edit Controls tool.
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Using the same diameter with the thinner cylinder generate two primitive

spheres on its top and bottom.  Use Center and Endpoint snaps to
generate the spheres.

 With the Boolean Union tool active click on the flute cylinder then the top

sphere. Repeat the operation with the bottom sphere.

Use the Move tool to reposition the flute cylinder into the shaft cylinder.

Use top and side views to assist in moving.
• In the Copy Options dialog select Divide Distance and

enter 11 for # Of Copies.

Set the Self/Copy modifier to Multi-Copy.

With the Rotate tool active, and working in top view, click on

the flute, then at the center of the shaft, and then on the
center of the flute twice.
A total of 12 copies of the flute are now evenly distributed
along the perimeter of the shaft cylinder.

• Select all the flute cylinders with the Pick tool and join them with the Join tool.

With the Boolean Difference tool active, click on the shaft, then on the joined flutes.

The shapes of the small cylinders are subtracted from the larger cylinder and
become its flutes, which can still be edited using the Edit Controls tool, with
Topological Level set to Face, as shown to the left.

The shaft has a characteristic called entasis, which is a taper in the column to make it look
straight, even at a distance, when viewed from eye level. This will be added using the Deform tool.

In the Deform Options dialog select Taper and with the Deform tool click on the shaft.

This causes a deformation box to appear.
• Click on the top corner of the box and move it

towards the center of the shaft.  Then click again
to complete the deformation.
A taper is applied as shown.

We can next scale the shaft to give it the proper propor-
tions (1:6), which will complete the model of the body of
the column.  The capital will be modeled next.
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You will next model the capital details.  You will use variations of the
Sweep tool to create acanthus leaves, ornamental foliage, ionic
scrolls, and the abacus.

You will first create one of the ornamental foliages as an axial sweep.

• Draw the shown source and path profiles.
• In the Sweep Options dialog select

Axial Sweep and set Scale X and Y
to 0.1 and Rotate to -90°.

With the Sweep tool active click on the

source then the path.
A leaf shape is generated, as shown.  This shape can still be edited using the Edit Controls tool.

Next we shall model another ornamental foliage as a 2-source sweep.

• Draw two source shapes and one path, as shown.
• In the Sweep Options dialog select Two Source Sweep.

With the Sweep tool active, click on each source and the path.

Observe the result.

We shall next model a third ornamental foliage, which we will refer to as an acanthus leaf.  While
similar to the previous one, we shall generate this differently.

• Draw 8 or more “approximate” cross sections for the leaf.
These are drawn on the same plane and they are then
moved perpendicularly to different elevations.

• With the Pick tool select the profiles from top to bottom.
• In the Nurbz Options dialog select By Loose

Lofting and set Caps Start and End to 100%.

With the Nurbz tool click anywhere on the screen.

Observe how loose lofting adds smoothing to your
profiles and capping the ends generates a solid.

After the nurbz surface is generated, you can still edit it to make further adjustments.

• In the Deform Options dialog choose Radial Bend, Through Center and
set Base Reference Plane = YZ.

With the Deform tool active click on the leaf.  After a bounding box appears, click

and drag one of its vertical lines approximately -60°.
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• Select the ZX Reference Plane.
• In the Helix Options dialog, select Wire Helix About Axis

and set Radius = 20”, # Of Cycles = 2, Length = 1/16”,
# Of Steps = 12 Per Cycle, and Scale Path Width = 0.1.

With the Helix tool active, click on the Y axis.

The helix is generated as shown on the left.

• In the Deform Options dialog choose Radial Bend,
Through Center, and set Base Reference Plane = XY.

With the Deform tool click on the leaf.  When a bounding box

appears, hold down the option key (Macintosh) or the ctrl+shift
keys (Windows) and resize the bounding box to cover only the
top half of the leaf.  Then click on the top front edge of the
bounding box, drag forward to bend by approximately 180°, and
click again.  The result should be a deformed leaf, as shown.

You will next generate an ionic scroll as a 2-path sweep.  Before you do this you need to draw
two path profiles and a source shape, which is done as follows:

With the Vector line tool, draw a continuation of the path.

Be sure to leave a gap between the two profiles.

With the Curve tool, click on both profiles to convert them

to nurbz curves, as shown.

In the Attach Curve Options dialog select Merge, and with

the Attach Curve tool click on the two ends of the profiles.
They are attached and merged into one curve, which is one of
the paths you will need for the sweep.

You will next apply one more deformation to complete the shape of the acanthus leaf.
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In the Projection Options dialog select Orthographic Projection, and with

the Projection tool click on the helix.  This projects it on the ZX plane, which flattens it
and transforms it into a 2D shape.

The second path is generated using the same method of drawing,
projecting, attaching, and merging curves to obtain the desired
shape.



299form•Z Tutorial  •  A composite order column

You will next create the capital shaft and the abacus on top of it.  The capital shaft will be
modeled through a combination of revolved objects and the Blend tool.  It will then be engraved
with the use of the displacement tool.

The source shape is generated by drawing a 4-sided pattern and generating a nurbz
curve from it, as follows:

• In the Polygon Options dialog, in the Edges tab select By # Of Segments
and the 4-sided icon.  In the Pattern tab, select Pattern and the upper-left icon.

Make sure the Grid Snap is on and with the Polygon tool click on p1, p2, and p3.

With the Curve tool (and all the default settings) click on the 4-sided pattern.

The result should be as shown, which is the source shape needed for the sweep.

p1

p2

p3

We are now ready to derive the 2-path sweep.

With the Sweep Options dialog set to Two Path

Sweep and the Sweep tool active, click on the source,
then on each path, as shown.
The source shape sweeps along both paths
simultaneously, as shown.

Generate a small sphere and place it in the center of the

scroll, as shown.
This completes the form of the acanthus leaf.

With the Vector Line tool draw a line, which corresponds to an axis of

rotation located at the center of the capital.  Then, by combining the
Vector Line and Arc tools, draw one 2D profile for the bottom and another
one for the top cap of the capital shaft, as shown to the left.

• In the Revolve Options dialog, select Smooth and Construct As
Smooth Revolve.

With the Revolve tool click on the top profile and on the axis line.

Then repeat the operation with the lower profile.
The result is two “discs” that correspond to the top and bottom ends of
the capital shaft, as shown.

You will next blend the two discs.
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You will next engrave the capital shaft using the Displacement tool.

• Generate or scan a bitmap image of a desired pattern to be
engraved on the shaft.  The one we used is shown to the right.

With the Displacement tool click on the capital shaft made above.

• In the Displacement Edit dialog set
Mapping Type: Cylindrical, Lock Size To: None,
Horizontal Tiling Size = 30° and Infinite,
Vertical Tiling Size = 5”, Min. = 0, Max, = -1/2”,
Smoothness = 15%, Adaptive Meshing = on,
Max Segment Length = 1/8”, Snap = off, Draw Tiles = on.

• For the preview window select the Right view, Displaced, and
move the cylindrical mapping towards the top of the shaft.

• Click Update to preview the displacement in the preview area.
• When satisfied, click OK and the displacement is added to the

capital shaft, as shown to the right.

p1

p2

Set the Topological Level to Face.

With the Blend tool selected, click on two edges of each inside

face of the cap discs, as shown.  For each cap, be sure to select
the inside segment (p1) first because this determines the
blending direction.

• When the Blend Edit dialog appears, select Make Solid and
Custom for both the Start and End Parameters.
Then move the Start Bulge slider to the right and
the End Bulge slider to the left, or wherever you prefer for
controlling the blending.  When the preview displays a satisfactory
form for the shaft, click OK to exit the preview dialog.
The blended surface is generated as shown.
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path

source

1    2          3

You will next model the abacus as a boundary sweep.  You need to first draw a path
and a source shape.

• The shown path shape can be drawn by combining the Vector Line and
the Arc tools.  It can be drawn as a single shape or a quarter of it can be
drawn first, then copy-rotated 3 times, and then joined into a single object.

• The source shape, which is the section of the abacus, can be drawn as a
combination of 3 arcs.

Once the shapes have been drawn a boundary sweep can be generated:
• In the Sweep Options dialog select Boundary Sweep and with the

Sweep tool active click on the source, then the path.
The result is the abacus form shown.  After the sweep is generated, you
can still edit it to make adjustments, using the Edit Controls tool.

Note that the shape we show is a lot larger than its real size.
You can use this shape as it is, or you can refine it further,
as follows:

• You can move points to adjust the shape.
• You can then use the Curve tool to click on the

shape and create a smooth profile.

You will next construct the little cross-like shapes that decorate the abacus.

• In the Polygon Options dialog, select Construct Through
Segment, By # Of Segments and the octagon icon.
Under the Pattern tab, select Pattern, the lower-middle
icon ( ), and Lower First.

 With the Polygon tool click three points along a horizontal axis.

Once an appropriate shape has been derived, it can be extruded to a
solid, moved inside the abacus, and copy rotated 3 times, as shown.
These can now be unioned to add little ornaments to the abacus.  Four
more copies of the ornament can also be placed in the middles of the
curvy sides of the abacus.

Now that all the parts have been modeled, the final assembly is created by moving
each part into position, then copy-rotating it around the capital.  At the very end, if
you have the RenderZone or RadioZity version, you may use the hammered gold
from form•Z’s predefined materials to render the column.
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44  Concluding the Tutorial

Having reached this point implies that, by now, you have a pretty good understanding of how
form•Z works and what it can do for you.  However, you also have to recognize that the more you
use the program the better user you become.  Please, note that knowing how the tools work and
what they can do is certainly a fundamental step but only the first in the learning process.
Developing the ways in which you can use the tools to support your creativity comes next and no
manual can be written about it.  form•Z offers the tools and the User’s Manuals explain how they
work.  It is up to you to use them imaginatively.

This Tutorial covered most of the modeling tools but certainly not all of them.  For example, it did
not cover the macro transformations, the projections, the cages, etc.  Many of the tools that have
been included have not been covered in full.  This is done in the remaining volumes of the form•Z
User’s Manual.  Our recommendation is that you read these volumes, at least once, so that you
may be informed about the capabilities and the variations that are available to you.
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